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[TALIANO

Info sulla guida per l'utente

Grazie per aver scelto questo prodotto LG. Per garantire un uso sicuro e corretto
del dispositivo, si prega di leggere con attenzione la guida per l'utente prima di
utilizzarlo per la prima volta.

Utilizzare sempre accessori LG originali. Gli elementi forniti in dotazione sono
progettati esclusivamente per questo dispositivo e potrebbero non essere
compatibili con altri dispositivi.

Le descrizioni si basano sulle impostazioni predefinite del dispositivo.

Le app predefinite presenti sul dispositivo sono soggette ad aggiornamenti e il
supporto per tali applicazioni puo essere sospeso senza preawiso. Per eventuali
domande relative alle app preinstallate sul dispositivo, contattare un Centro di
assistenza LG. Per le app installate dall'utente, contattare il provider del servizio
di riferimento.

La modifica del sistema operativo del dispositivo o linstallazione di software
provenienti da fonti non ufficiali potrebbe danneggiare il dispositivo e causare
il danneggiamento o la perdita di dati. Tali azioni costituiscono una violazione
dellaccordo di licenza LG e annullano la garanzia.

Alcuni contenuti e illustrazioni potrebbero differire dal dispositivo acquistato
a seconda dellarea, del provider del servizio, della versione del software o del
sistema operativo e sono soggetti a modifiche senza preawiso.

| software, laudio, gli sfondi, le immagini e gli altri elementi multimediali forniti
con questo dispositivo sono concessi in licenza per uso limitato. Lestrazione e
[utilizzo di questi materiali per scopi commerciali o altri scopi potrebbe costituire
una violazione delle leggi sul copyright. La piena responsabilita per ['utilizzo
illegale degli elementi multimediali spetta agli utenti.

| servizi relativi ai dati, come ad esempio messaggistica, caricamento e
download, sincronizzazione automatica o servizi di posizionamento, potrebbero
comportare costi aggiuntivi. Per evitare costi aggiuntivi, selezionare un piano
dati adeguato alle proprie esigenze. Per ulteriori informazioni, rivolgersi al
proprio gestore di telefonia mobile.

La presente guida per l'utente e redatta nelle principali lingue per ogni paese. A
seconda della lingua di redazione, i contenuti potrebbero in parte variare.



Notifiche informative

& ATTENZIONE: situazioni che potrebbero provocare lesioni all'utente e a terze parti.

ATTENZIONE: situazioni che potrebbero provocare lesioni lievi o danni al
dispositivo.

E NOTA: awisi o informazioni aggiuntive.

Info sulla guida per lutente
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Indicazioni per un uso sicuro ed
efficiente

Leggere le semplici indicazioni riportate di seguito. Il mancato rispetto di tali indicazioni pud
rivelarsi pericoloso o illegale.

Nel caso si verifichino errori, il software integrato nel dispositivo crea un registro degli errori.
Questo strumento raccoglie solo i dati specifici dellerrore come l'intensita del segnale, la “cell ID
position” quando la chiamata viene interrotta e le applicazioni caricate. Il registro viene utilizzato
solo per determinare la causa dellerrore. Questi registri sono crittografati e possono essere
aperti solo nei centri di riparazione LG autorizzati, nel caso sia necessario restituire il dispositivo
per la riparazione.

Esposizione all'energia elettromagnetica a
radiofrequenze (RF)

Informazioni sullesposizione alle onde radio e sulla SAR (Specific Absorption Rate)

Questo dispositivo e stato progettato in conformita ai requisiti di sicurezza vigenti per
lesposizione alle onde radio. Tali requisiti si basano su precise indicazioni scientifiche che
definiscono, tra laltro, i margini di sicurezza necessari per salvaguardare tutte le persone,
indipendentemente dalleta e dalle condizioni di salute.

Le indicazioni sullesposizione alle onde radio fanno riferimento a un'unita di misura detta
SAR, acronimo per Specific Absorption Rate. Le prove relative ai valori SAR sono state
condotte mediante metodi standardizzati con il dispositivo in stato di trasmissione al
massimo livello di alimentazione certificato, con qualsiasi banda di frequenza.

+ Anche se si possono riscontrare differenze tra i livelli SAR nei vari modelli di dispositivi
portatili LG, questi sono comunque stati progettati con unattenzione particolare alle
normative vigenti sullesposizione alle onde radio.

La commissione internazionale ICNIRP (International Commission on Non-lonizing
Radiation Protection) raccomanda un limite SAR pari a 2 W/kg in media per dieci grammi
di tessuto.

Il valore SAR pili elevato registrato per questo modello per ['uso vicino allorecchio & pari a
0,555W/kg (10 g)eparia 1,310 W/kg (10 g) a contatto conil corpo.

Questo dispositivo e conforme alle direttive sullesposizione alle radiofrequenze quando
utilizzato nella normale posizione d'uso vicino allorecchio o posizionato a una distanza di
almeno 5 mm dal corpo. Se una custodia, una clip per cintura o un altro sostegno vengono
posizionati a stretto contatto con il corpo, tali accessori non devono contenere metallo ed &
importante mantenere il dispositivo a una distanza di almeno 5 mm dal corpo. Il dispositivo
richiede una connessione ottimale alla rete per poter trasmettere file di dati o messaggi.

In alcuni casi, la trasmissione di file di dati o messaggi potrebbe essere ritardata fino a che
tale connessione diventi disponibile. Le istruzioni relative alla separazione del dispositivo dal
corpo devono essere rispettate fino alla fine della trasmissione.



Informazioni fornite dalla FCC in merito
all'esposizione alle frequenze radio

Nellagosto del 1996, la Federal Communications Commission (Commissione federale per

le comunicazioni, FCC) degli Stati Uniti, attraverso lazione in Report and Order FCC 96-326,
ha adottato uno standard di sicurezza aggiornato relativo allesposizione umana allenergia
elettromagnetica delle frequenze radio emessa dai trasmettitori con normativa FCC. Tali linee
guida sono coerenti con gli standard di sicurezza in precedenza determinati da standard sia
internazionali sia statunitensi. La progettazione del presente dispositivo e conforme alle linee
guida FCC e a tali standard internazionali.

Parte 15.19

Questo apparecchio & conforme alla parte 15 delle norme FCC. Il funzionamento & soggetto
alle due condizioni riportate di seguito:

(1) Il dispositivo non deve generare interferenze dannose.

(2) Il dispositivo deve accettare eventuali interferenze ricevute, incluse quelle che potrebbero
comportare errori di funzionamento.

Parte 15.21

Modifiche non espressamente approvate dal produttore potrebbero annullare (autorita
dellutente allutilizzo dellattrezzatura.

Indicazioni per un uso sicuro ed efficiente



Funzionamento del dispositivo indosso all'utente

Il presente dispositivo ¢ stato testato per le tipiche funzioni in cui lo siindossa, mantenendo

la parte posteriore del dispositivo a 1 cm (0,39 pollici) di distanza da corpo dell'utente. Per
rispettare i requisiti FCC relativi allesposizione alle frequenze radio, & necessario mantenere
una distanza di separazione minima tra il corpo dell'utente e la parte posteriore del dispositivo
di 1 cm (0,39 pollici). Potrebbe non essere possibile utilizzare fermagli da cintura, custodie

e accessori simili contenenti componenti in metallo. Gli accessori da indossare che non
mantengono una distanza di separazione di 1 cm (0,39 pollici) tra il corpo dellutente e la parte
posteriore del dispositivo e che non sono stati testati per le tipiche funzioni in cui si indossa il
dispositivo potrebbero non rispettare i limiti FCC relativi allesposizione alle frequenze radio e
devono dunque essere evitati.

Parte 15.105

Questa apparecchiatura e stata testata e rispetta i limiti di un dispositivo digitale di Classe B,

ai sensi della parte 15 delle norme FCC. Questi limiti sono stabiliti per fornire una protezione
adatta dalle interferenze dannose in un'installazione residenziale. Questo apparecchio genera,
utilizza e puo irradiare energia in radiofrequenza; inoltre, se non viene installato e utilizzato
secondo le istruzioni, puo causare interferenze dannose alle comunicazioni radio. Tuttavia, non
esiste alcuna garanzia che queste interferenze non si verifichino in una particolare installazione.
Se la presente apparecchiatura causa interferenze dannose o ricezione di canali televisivi,
determinabili accendendo e spegnendo il dispositivo, si consiglia vivamente di tentare di
correggere linterferenza attuando una o piti delle sequenti misure:

+ Orientare o posizionare di nuovo lantenna di ricezione.
Aumentare lo spazio che intercorre tra lapparecchio e il ricevitore.

Collegare lapparecchio a una presa su un circuito differente rispetto a quello a cui &
collegato il ricevitore.

« Per assistenza, consultare il rivenditore o un tecnico radio/TV esperto.

Indicazioni per un uso sicuro ed efficiente 8



Manutenzione e cura del prodotto

Utilizzare solo gli accessori forniti autorizzati da LG. Qualsiasi danno o guasto causato da
accessori di terze parti non é coperto dalla garanzia LG.

Alcuni contenuti e illustrazioni possono differire dal dispositivo senza preawviso.

Non smontare [apparecchio. Se & necessaria una riparazione, rivolgersi presso un centro
assistenza autorizzato LG.

La garanzia copre, a discrezione di LG, la sostituzione di parti o schede nuove o riconvertite,
funzionalmente equivalenti.

Tenere lontano da apparecchiature elettriche quali TV, radio e PC.

Tenere lontano da fonti di calore quali termosifoni o fornelli.

Non far cadere apparecchio.

Non sottoporre [apparecchio a scosse, urti o vibrazioni.

Spegnere il dispositivo nelle aree in cui e specificamente richiesto. Ad esempio, non
utilizzarlo all'interno di ospedali, in quanto potrebbe interferire con il funzionamento di
apparecchiature mediche sensibili.

Non afferrare il dispositivo con le mani bagnate mentre € in carica. Cio potrebbe provocare
scosse elettriche o danneggiare seriamente il prodotto.

Non ricaricare il telefono vicino a materiali infiammabili che potrebbero provocare incendi a
causa del calore sviluppato dal dispositivo.

Usare un panno asciutto per la pulizia esterna del cellulare (non usare solventi come
benzene, acquaragia o alcol).

Non caricare il dispositivo quando si trova su superfici morbide.

Il dispositivo dovrebbe essere caricato in unarea ben ventilata.

Non esporre [apparecchio a fumo o polvere.

Tenere lontano il dispositivo da carte di credito o supporti magnetici per evitarne la
smagnetizzazione.

Non toccare lo schermo con oggetti appuntiti per evitare di danneggiare il dispositivo.

Non esporre il dispositivo a umidita o a contatto con liquidi.

Usare gli accessori con attenzione e delicatezza. Non toccare [antenna se non strettamente
necessario.

In caso di vetro rotto o scheggiato, non utilizzare il dispositivo, non toccare il vetro, né
tentare di rimuoverlo o ripararlo. I danni al display in vetro dovuti ad abuso o utilizzo non
corretto non sono coperti dalla garanzia.

Il dispositivo & un dispositivo elettronico che genera calore durante il normale
funzionamento. Il contatto diretto e prolungato con la pelle e lassenza di unadeguata
ventilazione possono provocare disagi e piccole bruciature. Pertanto, € necessario
maneggiare con cura il dispositivo durante o subito dopo ['utilizzo.

Indicazioni per un uso sicuro ed efficiente 9



Se il dispositivo si bagna, scollegarlo immediatamente e farlo asciugare completamente.
Non tentare di accelerare il processo di asciugatura con una fonte di calore esterna, ad
esempio un forno, un forno a microonde o un asciugacapelli.

Il liquido presente nel dispositivo bagnato potrebbe modificare il colore delletichetta del
prodotto presente allinterno. | danni al dispositivo derivanti dallesposizione ai liquidi non
sono coperti da garanzia.

Un dispositivo mobile ha bisogno di una corretta circolazione dell‘aria per disperdere il
calore. Il contatto diretto con la pelle ed un'insufficiente circolazione daria sul dispositivo
potrebbe causare un surriscaldamento. Il dispositivo deve trovarsi ad almeno 1,0 cm dal
corpo dell'utente.

Evitare che la polvere di sostanze estranee entri nel caricatore / porta del cavo USB. Puo
generare calore o fuoco.

Evitare di esporre il dispositivo a basse pressioni dellaria ad alta quota.

Non esporre il dispositivo a pressioni dellaria estremamente basse. Altrimenti cio puod
causare lesplosione della batteria o perdite di liquido o gas infiammabile.

Evitare che il prodotto venga a contatto con liquidi. Non utilizzare o caricare il prodotto se
& bagnato. Se il prodotto si bagna, lindicatore dei danni causati dai liquidi cambia colore.
Tenere presente che cio limitera la possibilita di ricevere eventuali servizi di riparazione
gratuiti previsti dalla garanzia.

Funzionamento efficiente del dispositivo

Dispositivi elettronici
Tutti i dispositivi possono subire interferenze che influiscono sulle prestazioni.

Non utilizzare il dispositivo in prossimita di apparecchiature mediche senza autorizzazione.
Consultare un medico per determinare se ['uso del dispositivo possa interferire con il
funzionamento dell'apparecchio medico.

+ | produttori di pacemaker raccomandano una distanza minima di 15 cm da altri dispositivi e
pacemaker per evitare possibili interferenze con quest'ultimo.

Il dispositivo potrebbe produrre una luce forte o lampeggiante.
Il dispositivo potrebbe interferire con alcuni tipi di apparecchi acustici.
+ Il telefono potrebbe interferire con apparecchi televisivi, radio, computer, ecc.

« Utilizzare il dispositivo a una temperatura compresa tra 0 °C e 40 °C, se possibile.
Lesposizione del dispositivo a temperature estremamente alte o basse puo causare danni,
malfunzionamenti o perfino esplosioni.

Indicazioni per un uso sicuro ed efficiente 10



Sicurezza in automobile
Verificare le leggi e le normative che riguardano ['utilizzo dei dispositivi quando si guida.

Non utilizzare il dispositivo in modalita manuale durante la quida.

Prestare la massima attenzione alla guida.

Se le condizioni di guida lo richiedono, accostare e parcheggiare prima di telefonare o
rispondere a una chiamata.

L'energia RF puo influire sul sistema elettronico del veicolo, ad esempio sullo stereo o sulle
apparecchiature di sicurezza.

Se il veicolo  dotato di airbag, non collocarvi accanto oggetti come apparecchi wireless
portatili o installati per evitare lesioni gravi causate dallerrato funzionamento dellair bag.

Durante lascolto della musica tramite il cellulare, assicurarsi che il volume sia
ragionevolmente basso da consentire il rilevamento dei rumori circostanti. Cio &
particolarmente importante in prossimita di strade.

Come evitare danni all'udito

Per evitare eventuali danni all'udito, non ascoltare audio ad alto volume per
lunghi periodi.

L'udito potrebbe danneggiarsi se viene esposto a volumi eccessivi e prolungati nel tempo. Si
consiglia pertanto di non accendere o spegnere il telefono indossando gli auricolari e di tenere il
volume di ascolto delle conversazioni e della musica a un livello ragionevole.
Quando si utilizzano gli auricolari, abbassare il volume se non si riesce a sentire le persone
nelle vicinanze o se il volume é tale da essere udito dalla persona accanto.

E « Lutilizzo di auricolari e cuffie a volume troppo elevato pud causare |a perdita
delludito.

Parti in vetro

Alcune parti del dispositivo sono in vetro. Se il dispositivo cade su una superficie rigida o subisce
un forte impatto, il vetro pud rompersi. Se cio accade, non toccare o tentare di rimuovere il
vetro. Non utilizzare il dispositivo finché il vetro non viene sostituito da un centro di assistenza
autorizzato.

Aree a rischio di esplosione

Non utilizzare il dispositivo in aree dove sono in atto operazioni di detonazione. Rispettare le
restrizioni e osservare tutte le norme o i regolamenti al riguardo.

Indicazioni per un uso sicuro ed efficiente 11



Atmosfere potenzialmente esplosive
+ Non utilizzare il dispositivo in prossimita di stazioni di servizio.
+ Non utilizzare apparecchio in prossimita di combustibili o prodotti chimici.

+ Non trasportare né conservare sostanze esplosive, liquidi o gas infiammabili all'interno
dellautovettura in cui si trovano il dispositivo o i relativi accessori.

A bordo di aeromobili
L'uso di dispositivi portatili pud causare delle interferenze al velivolo.
+ Spegnere il dispositivo prima di imbarcarsi su qualsiasi aeromobile.
+ Utilizzarlo a terra (prima o dopo il decollo) solo con il permesso dellequipaggio.

Bambini

Conservare il dispositivo in un posto sicuro, lontano dalla portata dei bambini. Lapparecchio
& composto da parti smontabili di piccole dimensioni che, se ingerite, possono provocare
soffocamento.

Chiamate di emergenza

Le chiamate di emergenza potrebbero non essere disponibili su tutte le reti cellulari. Pertanto,
si consiglia di non affidarsi solo al dispositivo per eventuali chiamate di emergenza. Contattare
il fornitore di servizi locale per conoscere la disponibilita dei servizi di emergenza nel proprio
paese.

Manutenzione e informazioni sulle batterie

+ Non e necessario scaricare completamente la batteria prima di ricaricarla. A differenza
di altri sistemi a batteria, questo cellulare non presenta un effetto memoria in grado di
compromettere le prestazioni della batteria.

« Utilizzare solo batterie e caricabatterie LG, in quanto sono progettati per consentire una
maggiore durata della batteria.

Non smontare né cortocircuitare la batteria.
- Tenere puliti i contatti metallici della batteria.

+ Sostituire la batteria quando le prestazioni non sono piu accettabili. La batteria puo essere
ricaricata centinaia di volte prima che sia necessario sostituirla.

Se la batteria & rimasta inutilizzata per un lungo periodo, ricaricarla per ottimizzarne le
prestazioni.

+ Non esporre il caricabatterie alla luce solare diretta e non utilizzarlo in ambienti
particolarmente umidi, ad esempio nel bagno.

+ Evitare di lasciare il dispositivo in luoghi con temperature eccessivamente basse o elevate
per non comprometterne le prestazioni.

Indicazioni per un uso sicuro ed efficiente 12



L'uso di un tipo di batteria errato pud comportare il rischio di esplosioni. Attenersi alle
istruzioni per lo smaltimento delle batterie usate.

Quando il dispositivo & completamente carico, scollegare sempre il caricabatterie dalla presa
di corrente per evitare consumi energetici non necessari.

La durata della batteria effettiva varia a seconda di configurazione di rete, impostazioni del
prodotto, uso, batteria e condizioni ambientali.

Assicurarsi che la batteria non venga a contatto con oggetti affilati come ad esempio,
forbici, denti o unghie di animali. Cio potrebbe causare incendi.

Protezione delle informazioni personali

+ Assicurarsi di proteggere le informazioni personali per evitare la perdita e [uso improprio
delle informazioni sensibili.

Esequire sempre il backup dei dati importanti durante ['utilizzo del dispositivo. LG non &
responsabile di eventuali perdite di dati.

+ Assicurarsi di eseguire il backup di tutti i dati e di ripristinare il dispositivo durante lo
smaltimento del dispositivo per impedire ['uso improprio delle informazioni sensibili.

Leggere attentamente la schermata delle autorizzazioni durante il download delle
applicazioni.

Utilizzare con cautela le applicazioni che hanno accesso a piti funzioni o a informazioni
personali.

+ Controllare regolarmente gli account personali. In caso di uso improprio, chiedere al provider
del servizio di eliminare o modificare le informazioni del proprio account.

In caso di perdita o furto del dispositivo, modificare la password dellaccount per proteggere
le informazioni personali.

Non utilizzare applicazioni provenienti da fonti sconosciute.

Indicazioni per un uso sicuro ed efficiente 13



Indicazioni per un uso sicuro ed efficiente

Awviso sulla sostituzione della batteria

+ Una batteria agli ioni di litio & un componente pericoloso che puo causare lesioni
gravi.

« Lasostituzione della batteria da parte di personale non qualificato puo causare
danni al dispositivo.

+ Non sostituire la batteria autonomamente. La batteria potrebbe essere
danneggiata, surriscaldarsi e provocare lesioni. La batteria deve essere sostituita
da personale qualificato. La batteria deve essere riciclata o smaltita separatamente
rispetto ai rifiuti domestici.

Nel caso in cui il prodotto contenga una batteria incorporata nel prodotto che
non puo essere facilmente rimossa dall'utente finale, LG raccomanda che la
batteria venga rimossa solo da professionisti qualificat, sia per la sostituzione sia
per il riciclaggio al termine della vita del prodotto. Per evitare danni al prodotto,

e per la propria sicurezza, gli utenti non devono tentare di rimuovere la batteria,
ma contattare il Servizio clienti di LG o altri fornitori di servizi indipendenti per
ottenere consiglio.

La rimozione della batteria comporta lo smantellamento della custodia del
prodotto, la disconnessione di cavi/contatti elettrici, e [attenta estrazione della
cella batteria utilizzando strumenti specifici. In caso di bisogno di istruzioni per
professionisti qualificati su come rimuovere la batteria in modo sicuro, si prega di
visitare http//www.lge.com/global/sustainability/environment/take-back-recycling.
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Funzioni di registrazione audio

LG 3D Sound Engine

La funzione LG 3D Sound Engine consente di sentire un suono stereoscopico e
ottimizzato. Durante la riproduzione di musica o video, & possibile ascoltare un
suono stereoscopico e awolgente come se fosse dal vivo.

1 Trascinare verso il basso il pannello notifiche.

7 Toccare Impostazioni > Suono > Qualita del suono ed effetti> LG 3D Sound
Engine e toccare (D per attivare la funzione.

E « Sesi connette al prodotto un dispositivo audio esterno come cuffie o un
altoparlante, appare un pop-up che richiede di attivare la funzione LG 3D Sound
Engine.

Assistente Google

Panoramica Assistente Google

Il tuo dispositivo dispone di Assistente Google incorporato. Trova le risposte e fai
cose mentre sei in giro.

E « Per utilizzare questa funzione, stabilire prima la connessione alla rete.

Awvio di Assistente Google

T Premere il tasto Assistente Google sul lato sinistro del dispositivo.
oppure
Scorrere diagonalmente da un angolo inferiore dello schermo.

7 Tocca INIZIA.

3 Seguire le istruzioni visualizzate sullo schermo.
- Il dispositivo salva i dati della tua voce per il riconoscimento.

4 Imposta se usare la funzione di sblocco con Voice Match.
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« Utilizzando la funzione di sblocco con Voice Match, e possibile sbloccare il
dispositivo anche quando ha lo schermo spento o ¢ in carica, pronunciando
“OK Google” o0 “Hey Google.".

E + Questa funzione puo risultare pit vulnerabile in termini di sicurezza rispetto ad
altri metodi di blocco schermo come Sequenza, PIN o Password.
Se si utilizza un voce somigliante o una voce registrata, & possibile che il blocco
schermo venga rimosso.

« Per usare questa funzione, nella schermata Home toccare Impostazioni > Blocco
schermo & sicurezza > Impostazioni di Blocco con sicurezza > Smart Lock, e
quindi usare il metodo di blocco schermo impostato per sbloccare il dispositivo.

« Senon si riesce a sbloccare il dispositivo usando il riconoscimento vocale,  necessario
sbloccare il dispositivo usando il metodo specificato. Per ulteriori dettagli, consultare la
sezione Impostazione di un blocco schermo.

5 Toccare Fine.

Accesso vocale

1 Quando la schermata Home & spenta o bloccata, pronuncia “OK Google” o
“Hey Google".

7 Quando appare la schermata di Assistente Google, pronuncia un comando o
poni una domanda.

Accesso dalla schermata Home

1 Premere il tasto Assistente Google sul lato sinistro del dispositivo.
oppure
Scorrere diagonalmente da un angolo inferiore dello schermo.

2 Pronuncia un comando o una domanda quando sulla parte inferiore dello
schermo appare *+ -«
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5

« Inun ambiente in cui la connessione Wi-Fi o dei dati mobili € scarsa, la funzione

Assistente Google potrebbe essere limitata e la precisione del riconoscimento
vocale potrebbe essere ridotta.

Se la pronuncia & ambigua, il microfono & coperto, un lettore multimediale &

in riproduzione o 'ambiente circostante & rumoroso, il grado di precisione del
riconoscimento vocale potrebbe essere ridotto. Quando si utilizza il prodotto
mediante i comandi vocali, pronunciare le parole con precisione in un ambiente
silenzioso per una migliore precisione del riconoscimento vocale.

Riconoscimento delle impronte digitali

Informazioni generali sul riconoscimento delle
impronte digitali

Prima di utilizzare la funzione di riconoscimento delle impronte digitali, & necessario
registrare la propria impronta sul dispositivo.

La funzione di riconoscimento delle impronte digitali pud essere impiegata nei casi
seguenti:
+ Per sbloccare lo schermo.

« Per visualizzare i contenuti bloccati nella Galleria.

+ Per confermare un acquisto effettuando laccesso a unapp o identificandosi
tramite limpronta digitale.

5

+ E possibile utilizzare i dati dellimpronta digitale per [autenticazione dellutente. E
possibile che il sensore di impronte digitali possa riconoscere un'impronta digitale
diversa ma molto simile a unimpronta digitale registrata. Per una maggiore
sicurezza, si consiglia di utilizzare il metodo della sequenza, del PIN o della
password per sbloccare lo schermo.

Se il dispositivo non riesce a individuare le impronte digitali o se si dimentica il
valore specificato per |a registrazione, recarsi presso il pit vicino Centro di servizio
clienti LG con il dispositivo e la scheda di identificazione.
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Precauzioni per il riconoscimento delle impronte digitali
L'accuratezza del riconoscimento delle impronte digitali potrebbe diminuire a causa
di diverse regioni. Per massimizzarla, eseguire le sequenti verifiche prima dell'utilizzo
del dispositivo.

In basso al centro dello schermo del prodotto, & presente un sensore integrato
che riconosce le impronte digitali. Fare attenzione a non graffiare o danneggiare
il sensore diimpronte digitali con oggetti metallici come monete o chiavi.

In presenza di sostanze estranee (sudore, creme, acqua, sporco, grasso ecc.) sul
sensore di impronte digitali o sul dito da applicare sul sensore, il riconoscimento
delle impronte digitali potrebbe non funzionare correttamente. Pulire il sensore
e il dito e rimuovere tutta 'umidita prima di posizionare il dito sul sensore.

Se la superficie del dito e ruvida a causa di una cicatrice o di unimmersione
prolungata in acqua, il sensore potrebbe non essere in grado di riconoscere
limpronta digitale. In tal caso, registrare unaltra impronta digitale.

Se si piega il dito o si usa solamente la punta del dito, il riconoscimento
dellimpronta potrebbe non avere esito positivo. Assicurati che il tuo dito copra
lintera superficie del sensore per impronte digitali.

Eseguire la scansione di un solo dito per ciascuna registrazione. La scansione
di piti di un dito potrebbe compromettere |a registrazione e il riconoscimento
dellimpronta.

Il dispositivo potrebbe generare elettricita statica se laria circostante é secca. Se
laria circostante & secca, evitare la scansione delle impronte digitali o toccare un
oggetto metallico, quale ad esempio una moneta o una chiave, prima di eseguire
la scansione delle impronte al fine di eliminare lelettricita statica.
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Registrazione delle impronte digitali
E possibile registrare e salvare la propria impronta digitale sul dispositivo per
utilizzare l'identificazione tramite impronta digitale.

T Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza
> Impronte digitali.

E « E necessario impostare una schermata di blocco per poter utilizzare questa
funzione.

+ Seil blocco schermo non é attivo, configurare la schermata di blocco seguendo le
istruzioni visualizzate sullo schermo. Per i dettagli, vedere, consultare la sezione
Impostazione di un blocco schermo.

7 Posizionare il dito sul sensore per impronte digitali del dispositivo e regolarlo un
po'alla volta.

E + Premere delicatamente il sensore per impronte digitali in modo che il sensore

possa riconoscere [impronta digitale dell'utente.

« Assicurarsi che il dito copra l'intera superficie del sensore delle impronte digitali.

@* L

3 Seguire le istruzioni visualizzate sullo schermo.

« Fino al completamento della registrazione dellimpronta digitale, muovere
poco a poco il dito sul sensore.

- Posizionare il dito sul sensore. Quando si averte una vibrazione, rimuovere il
dito dal sensore.
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/A Una volta completata la registrazione dellimpronta, toccare OK.

+ Toccare Aggiungi altro per registrare unaltra impronta digitale. Poiché il
grado di successo del riconoscimento delle impronte digitali dipende dalle
condizioni dellimpronta digitale registrata, si consiglia di registrare diverse
impronte digitali.

Gestione delle impronte digitali

E possibile modificare o eliminare le impronte digitali registrate.

1 Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza
> Impronte digitali.

2 Sbloccare in base al metodo di blocco specificato.

3 Dallelenco delle impronte digitali, toccare un'impronta digitale per rinominarla.
Per eliminarla, toccare [ii].

Sblocco dello schermo con un'impronta digitale

E possibile sbloccare lo schermo e visualizzare i contenuti bloccati utilizzando la

propria impronta digitale. Attivare la funzione desiderata:

T Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza
> Impronte digitali.

7 Sbloccare in base al metodo di blocco specificato.

3 Nella schermata delle impostazioni dellimpronta digitale, attivare la funzione
desiderata:
+ Blocco schermo: Sbloccare lo schermo con un‘impronta digitale.

+ Blocco del contenuto: consente di sbloccare un contenuto con un'impronta
digitale. A questo scopo, assicurarsi che sia impostato il blocco contenuto.

+ Sblocco dello schermo quando lo schermo & spento: consente di
sbloccare lo schermo anche quando & spento posizionando il dito sul sensore
per impronte digitali.
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Funzione Multitasking

Schermata Utilizzi recenti

Scorrere verso lalto e trattenere il pulsante Home = per visualizzare la cronologia
di utilizzo recente.

Finestra pop-up

E possibile aprire piti app sullo schermo e passare facilmente da una allaltra in

qualsiasi momento.

1 Scorrere verso lalto su — dal lato inferiore dello schermo.

2 Toccare licona dellapp nella parte superiore sinistra della schermata dellapp e
selezionare Finestra pop-up.

+ Se si tocca licona dellapp, appaiono le opzioni Informazioni applicazione,
Multi Window, Finestra pop-up e Appunta app.

3 Lapp appare sullo schermo nella forma di una finestra pop-up.

5 + Questa funzione potrebbe non essere disponibile per alcune app o schermate.
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Utilizzo delle finestre popup
+ — :Riduce a icona |a finestra pop-up. La finestra pop-up viene ridotta a icona
mobile dell'app e puo essere spostata dove desiderato sullo schermo.
- T 7:Espande lapp a schermo intero.

- X :Chiude lapp.

« E possibile aprire fino a 5 app usando le finestre popup.

« Per selezionare un‘app tra quelle aperte, toccare la relativa finestra pop-up. La
finestra pop-up selezionata viene portata in primo piano.

+ Lefinestre popup non possono essere spostate nellarea della barra di stato o della
barra di navigazione.

Uso della cartella delle app per le finestre popup
Toccando — sulla finestra pop-up, |a finestra popup viene ridotta a icona dellapp.
E possibile trascinare licona dell’app in qualsiasi punto trascinandola.

Se due o pit finestre popup sono ridotte a icong, viene creata la cartella delle app
per contenere le icone delle app.

E - Llicona dellapp utilizzata piti di recente viene usata come icona della cartella delle
app. Toccando licona, tutte le icone delle finestre popup ridotte a icona appaiono
nella cartella delle app.

«+ Sesitocca a lungo la cartella delle app delle finestre popup e si trascina la cartella
della app in Rimuovi, la cartella delle app viene rimossa.

Per rimuovere una delle app dalla cartella delle app, aprire la cartella delle app e
trascinare licona dell'app fuori dalla cartella delle app.
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Finestra multipla

Quando si usa la navigazione a gesti

1 Scorrere verso lalto su — dal lato inferiore dello schermo.
+ Vengono visualizzate le app utilizzate di recente.
+ Se si tocca licona dellapp, appaiono le opzioni Informazioni applicazione,
Multi Window, Finestra pop-up e Appunta app.
2 Toccare licona dellapp nella parte superiore sinistra dellapp da visualizzare nella
finestra multipla e selezionare Multi Window.
« Le app selezionate vengono visualizzate nella parte superiore dello schermo.

3 Toccare laltra app da visualizzare nella finestra multipla.

« Le applicazioni selezionate vengono visualizzate nella parte inferiore dello
schermo.

Quando si usa la navigazione sono con i pulsanti

1 Toccare E] nella barra di navigazione.
+ Vengono visualizzate le app utilizzate di recente.
+ Se si tocca licona dellapp, appaiono le opzioni Informazioni applicazione,
Multi Window, Finestra pop-up e Appunta app.

2 Toccare licona dellapp nella parte superiore sinistra dellapp da visualizzare nella
finestra multipla e selezionare =

+ Le app selezionate vengono visualizzate nella parte superiore dello schermo.

3 Toccare laltra app da visualizzare nella finestra multipla.

E + Perregolare le dimensioni dello schermo diviso, trascinare la barra al centro dello
schermo

« Per disattivare la funzione di finestra multipla, trascinare la barra al centro verso
lalto o verso il basso fino allestremita dello schermo.

« La funzione Multi Window non é supportata da alcune app LG o da alcune app
scaricate dal Play Store.
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Componenti e accessori del prodotto

I sequenti articoli sono forniti in dotazione con il dispositivo.

+ Dispositivo + Caricabatteria
.+ Cavo USB + Guida introduttiva
+ Spillo di espulsione

A

Gli elementi descritti sopra possono essere facoltativi.

Gli elementi forniti in dotazione con il dispositivo ed eventuali accessori disponibili
possono variare a seconda dell'area e del provider del servizio.

Utilizzare sempre accessori LG Electronics originali. Lutilizzo di accessori di altri
produttori puo influire sulle prestazioni di chiamata del dispositivo o causare
malfunzionamenti. Il servizio di riparazione LG potrebbe non coprire simili
situazioni.

Alcune delle componenti del dispositivo sono fatte di vetro temperato. Se si lascia
cadere il dispositivo su una superficie dura o lo si espone a un urto violento, il vetro
temperato potrebbe danneggiarsi. In questi casi, interrompere immediatamente
['uso del dispositivo e contattare un Centro di assistenza clienti LG.

E + In mancanza di uno di questi elementi di base, contattare il rivenditore presso cui &
stato acquistato il dispositivo.
« Per acquistare altri elementi aggiuntivi, contattare un Centro di assistenza clienti
LG.
« Alcuni elementi contenuti nella confezione del prodotto sono soggetti a modifica
Senza preawiso.

L'aspetto e le specifiche del dispositivo sono soggetti a modifica senza preawviso ai
fini del miglioramento del prodotto.

Le specifiche del dispositivo possono variare a seconda dell'area o del provider del
Servizio.

Rimuovere la pellicola protettiva dal sensore di impronte digitali prima di utilizzare
la funzione di riconoscimento delle impronte digitali.
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Panoramica delle parti

Altoparlante auricolare

Obiettivo fotocamera anteriore

LD

Tasti volume (+/-) —I:

Tasto Assistente Google —e

Sensore di prossimita/
luminosita ambientale

— Tasto di accensione/blocco/
Sensore di impronte digitali

Touchscreen

Jack stereo per auricolare

Obiettivi fotocamera

posteriore

Flash

Altoparlante —————*
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Porta per caricabatteria/cavo USB

s Microfono

|

+— Alloggiamento scheda
J Nano-SIM

— NFC

t Microfono
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A Non tentare di rimuovere da sé il coperchio posteriore.

« Fare cio potrebbe danneggiare gravemente la batteria e il dispositivo, e cio
potrebbe causare surriscaldamento, incendi o infortuni. Il coperchio posteriore e
la batteria del dispositivo non devono essere rimossi o sostituiti da personale non
qualificato.

« Il telefono e un dispositivo elettronico che genera calore durante il suo normale
funzionamento. Il contatto diretto ed estremamente prolungato con la pelle
in assenza di un'adeguata ventilazione puo provocare disagi e piccole ustioni.
Pertanto, maneggiare con cura il telefono durante o subito dopo ['utilizzo,

+ Sensore di prossimita/luminosita ambientale

- Sensore di prossimita: Nel corso di una chiamata, il sensore di prossimita
spegne lo schermo e disattiva la funzionalita touch quando il dispositivo
si trova molto vicino al corpo umano. Riaccende lo schermo e attiva la
funzionalita touch quando il dispositivo si trova al di fuori di un campo
specifico.

- Sensore di luminosita ambientale: il sensore di luminosita ambientale analizza
lintensita della luce ambientale quando é attiva la modalita di controllo
automatico della luminosita.

+ Tastivolume

- Consentono di regolare il volume delle suonerie, delle chiamate o delle
notifiche.

- Durante utilizzo della Fotocamera, premere delicatamente un tasto volume
per scattare una foto. Per scattare foto in maniera continua, tenere premuto
il tasto volume.

- Quando lo schermo e spento o bloccato, premere il tasto volume giti due
volte per awiare [app Fotocamera. Premere due volte il tasto volume su per
awiare Capture+.

- Tasto accensione/blocco
- Premere brevemente il tasto se si desidera accendere o spegnere lo schermo.
- Tenere premuto il tasto se si desidera selezionare unopzione di alimentazione.
- Tasto Assistente Google

- Premere brevemente una volta per aprire Assistente Google. Tenere premuto
per aprire Assistente Google, quindi rimuovere il dito dal tasto per esequire la
funzione di comando vocale.

- Per ulteriori dettagli, consultare Assistente Google.
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+ Sensore per impronte digitali
- Attivare la funzione di riconoscimento delle impronte digitali per semplificare
il processo di sblocco dello schermo. Per i dettagli, vedere, consultare la
sezione Informazioni generali sul riconoscimento delle impronte digitali.

E Alcune funzioni potrebbero essere limitate a seconda della regione e delle
specifiche del prodotto dei diversi fornitori di servizi di telecomunicazione.

Nel lato posteriore del prodotto € integrato il chip NFC. Fare attenzione a non
danneggiare o coprire il chip NFC.

Non poggiare oggetti pesanti né sedersi sul dispositivo. In caso contrario, il
touchscreen potrebbe danneggiarsi.

La pellicola o accessori di protezione dello schermo potrebbero interferire con il
sensore di prossimita.

Se il dispositivo & bagnato o viene utilizzato in un luogo umido, il touchscreen o i
pulsanti a sfioramento potrebbero non funzionare correttamente.

Nel prodotto sono integrati due microfoni. Fare attenzione a non coprire i microfoni.
Mentre si parla al telefono, non coprire il microfono con le mani o le dita.

Non utilizzare custodie per telefono non originali, né coprire il microfono con
accessori, nastro adesivo ecc.

Quando si utilizza il prodotto, tenerlo correttamente, come mostrato nellimmagine.

Microfono Non coprite il microfono.
1

|

™~

Microfono Non coprite il microfono.
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Accensione o spegnimento

Accensione
Quando il prodotto e spento, tenere premuto il tasto di accensione/blocco.

E + Quando si accende il dispositivo per la prima volta, viene avviata la configurazione
iniziale. La durata del primo awio dello smartphone potrebbe essere piti lunga di
quella abituale.

Spegnimento
Tenere premuto il tasto di accensione/blocco, quindi selezionare Spegni.

Riavvio del dispositivo

Se il dispositivo non funziona oppure non risponde ai comandi, riawviarlo seguendo
le istruzioni sottostanti.

1 Tenere premuti contemporaneamente il tasto di accensione/blocco e il tasto
volume giti fino a quando il dispositivo non si spegne.

7 Quando viene riawiato il dispositivo, rilasciare il tasto.

Opzioni di alimentazione

Tenere premuto il tasto di accensione/blocco, quindi selezionare unopzione.
+ Spegni: Spegnere il dispositivo.
+ Spegni e riavvia: consente di riawviare il dispositivo.
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Installazione della scheda SIM

Inserire la scheda SIM (Subscriber Identity Module, modulo d'identita dell'abbonato)
fornita dal provider del servizio per iniziare a utilizzare il dispositivo.

A « Utilizzare lo spillo di espulsione con cautela, poiché e dotato di unestremita
appuntita.

E « Affinché le caratteristiche di resistenza allacqua e alla polvere siano efficaci, &
necessario che lalloggiamento della scheda sia inserito correttamente.

1 Inserire la graffetta nel foro dellalloggiamento della scheda e premere la
graffetta, quindi estrarre lalloggiamento della scheda dal prodotto.

2 Allineare le schede Nano-SIM sullalloggiamento delle schede e premere la
scheda nella direzione della freccia come illustrato nella figura.

<2

/ Scheda Nano-SIM 2
L3

’/‘[\1— Scheda Nano-SIM 1
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E + Questo dispositivo supporta solamente le schede Nano SIM.

Nano Micro

« Affinché non si verifichino problemi di prestazioni, si consiglia di utilizzare il
dispositivo con il tipo corretto di scheda SIM. Utilizzare sempre una scheda SIM
realizzata in fabbrica, fornita dall'operatore.

« Non perdere la scheda SIM. LG non é responsabile di eventuali danni e altri
problemi causati dalla perdita o dal trasferimento di una scheda SIM.

Fare attenzione a non danneggiare la scheda SIM durante le operazioni di
inserimento e rimozione.

+ Quando siinserisce la carta SIM o la scheda di memoria, & necessario collocarla
correttamente nel foro di alloggiamento della scheda.

+ Quando inserisci di nuovo il foro di alloggiamento della scheda nel dispositivo, &
necessario inserirlo orizzontalmente seguendo la direzione della freccia, come
mostrato in figura. Assicurati che la scheda collocata sul foro di alloggiamento
della scheda non si sposti dalla posizione corretta.

Inserire la scheda SIM sull'alloggiamento con i contatti color oro rivolti verso il
basso.

Assicurati di inserire la carta SIM nel dispositivo seguendo le istruzioni nel manuale
utenti.

Se inserisci o rimuovi ['alloggiamento dal dispositivo, assicurati che non vi entrino
acqua o altri liquidi. Se un alloggiamento o una scheda bagnati vengono inseriti nel
dispositivo, questo potrebbe danneggiarsi.

« Lascheda di memoria e un elemento opzionale.

Operazioni frequenti di cancellazione e scrittura dei dati possono ridurre la durata
della scheda di memoria.

Alcune schede di memoria potrebbero risultare non completamente compatibili
con il dispositivo. Lutilizzo di una scheda incompatibile potrebbe causare il
danneggiamento del dispositivo o della scheda di memoria, oppure la corruzione
dei dati salvati al suo interno.
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Inserimento della scheda di memoria

Inserire la scheda di memoria nel dispositivo.

[l dispositivo e in grado di supportare una scheda microSD fino a 2 TB. A seconda
del produttore e del tipo di scheda di memoria, alcune schede di memoria
potrebbero non essere compatibili con il dispositivo.

1 Inserire lo spillo di espulsione nel foro dellalloggiamento della scheda.
7 Estrarre lalloggiamento della scheda.

3 Posizionare la scheda di memoria sull'alloggiamento con i contatti color oro
rivolti verso il basso.

\§% iy h

Scheda di memoria
(Opzionale, venduta separatamente)

Scheda SIM

4 Inserire nuovamente lalloggiamento nello slot.

A « Alcune schede di memoria potrebbero risultare non completamente compatibili
con il dispositivo. Lutilizzo di una scheda incompatibile potrebbe causare il
danneggiamento del dispositivo o della scheda di memoria, oppure la corruzione
dei dati salvati al suo interno.

E + Operazioni frequenti di cancellazione e scrittura dei dati possono ridurre la durata
della scheda di memoria.
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Rimozione della scheda di memoria

Per ragioni di sicurezza, disattivare la scheda di memoria prima di rimuoverla.
7 Nella schermata Home, toccare Impostazioni > Archiviazione > /\.

2 Inserire lo spillo di espulsione nel foro dellalloggiamento della scheda ed
estrarlo dal dispositivo.

w

Rimuovere la scheda di memoria.

4 Inserire nuovamente lalloggiamento nello slot.

A + Non rimuovere a scheda di memoria mentre il dispositivo sta trasferendo o
accedendo a informazioni. In caso contrario, potrebbe verificarsi la perdita o la
corruzione dei dati, oppure il danneggiamento della scheda di memoria o del
dispositivo. LG non & responsabile di eventuali perdite causate dallabuso o dall'uso
errato delle schede di memoria, compresa la perdita di dati.

Batteria

Carica della batteria
Prima di utilizzare il dispositivo, caricare completamente la batteria.
Caricare il dispositivo con il cavo USB tipo C.

Terminale del cavo di ricarica
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Non utilizzare o caricare il prodotto in presenza di umidita sulla porta di ricarica,
su terminali esposti, sul cavo di ricarica, sulladattatore di ricarica ecc. Il prodotto
potrebbe non funzionare correttamente o rompersi o danneggiarsi, e sussiste

il rischio di lesioni causate da scosse elettriche, incendio, surriscaldamento,
esplosione ecc. Se si nota la presenza di umidita in tali aree, interrompere
immediatamente ['utilizzo o la ricarica del prodotto e rimuovere completamente
l'umidita.

Non staccare il coperchio della batteria.

Questo prodotto utilizza una batteria non rimovibile. Non rimuovere o sostituire
il coperchio della batteria o la batteria. Se si rimuove o sostituisce il coperchio
della batteria o la batteria, il prodotto potrebbe venire danneggiato, e potrebbe
surriscaldarsi o esplodere.

Usare solo il cavo USB e ladattatore di ricarica forniti con il prodotto come
componenti di base.

Il dispositivo e dotato di una batteria ricaricabile interna. Per motivi di sicurezza,
non rimuovere |a batteria incorporata.

Lutilizzo del dispositivo durante il caricamento potrebbe causare scosse elettriche.
Per utilizzare il dispositivo, interrompere il caricamento.

Rimuovere il caricabatteria dalla presa di alimentazione una volta completato il
caricamento del dispositivo. In questo modo si evita un inutile consumo di corrente.

Per caricare |a batteria, & anche possibile collegare un cavo USB tra il dispositivo
e un computer desktop o portatile. Questo metodo puo richiedere piti tempo
rispetto al collegamento delladattatore a una presa a parete.

Non caricare a batteria con un hub USB non in grado di mantenere la tensione
nominale. Il caricamento potrebbe non riuscire o arrestarsi inavvertitamente.
Quando ci si reca presso un centro di assistenza per un problema della batteria,
portare con sé il prodotto e il caricabatterie. Poiché |a batteria & un materiale di
consumo, la durata della batteria potrebbe ridursi con il passare del tempo.
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Precauzioni per l'utilizzo del dispositivo
« Assicurarsi di utilizzare il cavo USB fornito in dotazione, non utilizzare cavi USB
o caricabatterie di terze parti con il dispositivo. La garanzia limitata LG non copre
['uso di accessori di terze parti.
+ Ilmancato rispetto delle istruzioni contenute in questa guida e ['utilizzo non
corretto potrebbero portare al danneggiamento del dispositivo.

E + Se latemperatura della batteria supera un certo livello quando il dispositivo & in
carica, sara necessario interrompere |a ricarica.

« Se materiali magnetici, metallici o conduttori dovessero trovarsi vicino al retro del
dispositivo, oppure fosse inserita una custodia protettiva, il dispositivo potrebbe
non essere caricato adeguatamente.

+ LG Electronics declina ogni responsabilita per problemi riguardanti accessori di
altre marche. Per tali problemi, contattare il produttore dellaccessorio.

Utilizzo efficiente della batteria

La durata della batteria puo diminuire se sul dispositivo sono in esecuzione diverse
app e funzioni contemporaneamente e in maniera continuativa.

Annullare le operazioni in background per aumentare la durata della batteria.
Per ridurre al minimo il consumo della batteria, sequire questi Consigli:

Disattivare la funzione Bluetooth® o rete Wi-Fi quando non le si utilizza.

Impostare lo spegnimento dello schermo su un lasso di tempo il piti breve
possibile.

Ridurre al minimo la luminosita dello schermo.

Impostare un blocco schermo quando il dispositivo non & in uso.

Controllare il livello della batteria quando si utilizza una qualsiasi delle app
scaricate.
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Touchscreen

E possibile imparare a conoscere le modalita di controllo del dispositivo mediante
[utilizzo di gesti touch sul touchscreen.

Toccare

Toccare leggermente con la punta del dito per selezionare o eseguire unapp o
unopzione.

Tenere premuto

Toccare e tenere premuto per diversi secondi per visualizzare un menu con le
opzioni disponibili.
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Toccare due volte

Toccare rapidamente due volte per eseguire lo zoom avanti o indietro su una pagina
\Web o su una mappa.

Trascinamento

Toccare e tenere premuto un elemento, ad esempio un‘app o un widget, quindi
spostare il dito in un'altra posizione con un movimento controllato. E possibile
utilizzare questo gesto per spostare un elemento.

Trascinare

Toccare lo schermo e muovere velocemente il dito senza fermarsi. E possibile
utilizzare questo gesto per scorrere un elenco, una pagina Web, delle foto, delle
schermate e altro ancora.
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Awvicinare e allontanare le dita

Awicinare due dita per eseguire lo zoom indietro, ad esempio su una foto o una
mappa. Per eseguire lo zoom avanti, allontanare le dita.

B

Non esporre il touchscreen a eccessivi urti fisici. Il sensore touch potrebbe
danneggiarsi.

Se il dispositivo viene utilizzato vicino a materiale magnetico, metallico o
conduttore, potrebbe verificarsi un guasto del touchscreen.

Se si utilizza il dispositivo sotto luci intense come la luce solare diretta, lo schermo
potrebbe non essere visibile a seconda della posizione. Utilizzare il dispositivo

in una posizione ombreggiata o con una luce ambiente non troppo intensa, ma
sufficientemente luminosa da consentire [a lettura.

Non premere lo schermo applicando una forza eccessiva.

Toccare delicatamente ['opzione desiderata con la punta del dito.

Il controllo touch potrebbe non funzionare correttamente se si tocca lo schermo
indossando un guanto o con la punta dell'unghia.

Il controllo touch potrebbe non funzionare correttamente se lo schermo e umido
o0 bagnato.

Il touchscreen potrebbe non funzionare correttamente se sul dispositivo &
applicata una pellicola o un accessorio di protezione dello schermo acquistati da un
negozio di terze parti.

La visualizzazione di un'immagine statica per lunghi periodi di tempo potrebbe
causare il fenomeno delle immagini residue o di ritenzione delle immagini.
Spegnere lo schermo o evitare di visualizzare la stessa immagine per un lungo
periodo quando il dispositivo non & in uso.
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Sfondo

Informazioni generali sulla schermata Home

La schermata Home ¢ il punto di partenza per accedere a diverse funzioni e app
sul dispositivo. Scorrere verso lalto dal bordo inferiore di qualsiasi schermata per
andare direttamente alla schermata Home.

Sulla schermata Home & possibile gestire tutte le app e i widget. Scorrere sulla
schermata verso sinistra o destra per visualizzare in un colpo docchio tutte le app

installate.

Layout della schermata Home

E possibile visualizzare tutte le app e organizzare i widget e le cartelle sulla
schermata Home.

5

Barra di stato — P |

Widget meteo —

e— Widget di ricerca di Google

Cartella ——

‘ Icona della pagina

m.— Area di accesso rapido

Barra di navigazione — I e———

+ La schermata Home puo variare a seconda della politica del produttore, delle

impostazioni dell'utente, della versione del software o del provider del servizio.
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Barra di stato: consente di visualizzare le icone di stato, lorario e il livello della
batteria.

Widget meteo: consente di visualizzare le informazioni meteorologiche e
l'orario di una zona specifica.

Widget di ricerca di Google: digita o parla per aprire Google Search.

Cartella: £ possibile creare cartelle per classificare le app in base ai criteri
desiderati.

Icona della pagina: consente di visualizzare il numero totale di aree della
schermata Home. E possibile toccare licona della pagina desiderata per
accedere alla pagina selezionata. L'icona corrispondente allarea corrente verra
evidenziata.

Area di accesso rapido: e possibile fissare le app principali nella parte inferiore
dello schermo in modo che siano accessibili da qualsiasi area della schermata
Home.

Barra di navigazione: consente di andare alla schermata precedente o alla
schermata Home durante ['uso dellapp, e controllare lelenco delle app usate di
recente.

Uso della barra di navigazione
Questa ¢ la guida alle gesture per il controllo della barra di navigazione.
- Per andare alla schermata Home, scorrere verso 'alto dal bordo inferiore dello
schermo.
+ Per tornare alla schermata precedente, scorrere verso linterno dal bordo sinistro
o destro dello schermo.
+ Per andare alla schermata Panoramica, scorrere verso lalto e tenere premuto
dal bordo inferiore dello schermo.
+ Per passare rapidamente tra le app, scorrere verso destra sul bordo inferiore
dello schermo per andare alle app utilizzate in precedenza.

5 « Gesture é [impostazione predefinita per la barra di navigazione. Per cambiarla
aSolo pulsanti <] 1Q/ D nella schermata Home toccare Impostazioni >
Display > Barra di navigazione, quindi selezionare Solo pulsanti.
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Icone di stato

Quando & presente una notifica relativa a un messaggio non letto, un evento del
calendario o una sveglia, nella barra di stato viene visualizzata licona di notifica
corrispondente. Verificare lo stato del dispositivo visualizzando le icone di notifica
presenti nella barra di stato.

4

Nessun segnale

Trasmissione di dati tramite la rete in corso

"
@ Sveglia impostata
n(d Modalita vibrazione attiva

Bluetooth attivo

Collegato a un computer tramite USB

Livello batteria

Modalita Aereo attiva

Chiamate senza risposta

Wi-Fi attivo

Modalita silenziosa attiva

GPS attivo

Hotspot attivo

Nessuna scheda SIM

La modalita NFC ¢ attiva

Alcune di queste icone potrebbero apparire in modo diverso o non apparire
affatto a seconda dello stato del dispositivo. Fare riferimento alle icone in base
all'ambiente e alla zona effettivi in cui si utilizza il dispositivo nonché al provider
del servizio.

Le icone visualizzate possono variare a seconda dell'area o dei provider dei servizi.

Funzioni di base 42



Pannello notifiche
E possibile aprire il pannello notifiche trascinando la barra di stato verso il basso
sulla schermata principale.
- E possibile trascinare verso il basso la finestra di awiso o toccare l'icona della
freccia per aprire l'elenco delle icone di impostazione rapida.
- E possibile toccare 0 peraggiungere, eliminare o disporre le icone nella finestra
diawiso.
+ Tenendo premuta licona, viene visualizzata la schermata delle impostazioni
relative alla funzione in questione.

E - E possibile utilizzare il pannello notifiche anche durante il blocco schermo. Trascina
il pannello notifiche quando lo schermo é bloccato per accedere rapidamente alle
funzioni desiderate
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Cambio di orientamento dello schermo

E possibile impostare il cambio automatico di orientamento dello schermo in base
allorientamento fisico del dispositivo.

Nel pannello notifiche, toccare Rotazione nellelenco delle icone di accesso rapido.

E possibile anche toccare Impostazioni > Display e attivare Rotazione automatica
nella schermata Home.

Modifica della schermata Home
Nella schermata Home, toccare e tenere premuto uno spazio vuoto, quindi avviare
l'azione desiderata da sotto.
+ Perridisporre le aree della schermata Home, toccare e tenere premuta un'area e
trascinarla in un'altra posizione.
+ Per aggiungere un widget alla schermata Home, toccare e tenere premuta
un‘area vuota della schermata Home, quindi selezionare Widget.
+ Per modificare sfondi e temi, toccare e tenere premuta un‘area vuota della
schermata Home, quindi selezionare Sfondo & Tema.
E inoltre possibile toccare Impostazioni > Sfondo & Tema nella schermata
Home, quindi selezionare sfondi e temi da applicare al dispositivo.
+ Per modificare la griglia, toccare e tenere premuta un'area vuota della
schermata Home, quindi selezionare Griglia. Toccare la griglia desiderata, quindi
toccare Applica.
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+ Per configurare le impostazioni della schermata Home, toccare e tenere
premuta un'area vuota della schermata Home, quindi selezionare Imposta
schermata home. Per i dettagli, vedere, consultare la sezione Impostazioni della
schermata Home.

Per visualizzare o reinstallare le app disinstallate, toccare e tenere premuta
un'area vuota della schermata Home, quindi selezionare Cestino app. Per i
dettagli, vedere, consultare la sezione Cestino app.

Per cambiare la schermata predefinita, toccare e tenere premuta un'area vuota
della schermata Home, spostarsi sulla schermata desiderata, toccare O, quindi
toccare nuovamente la schermata.

e——————— Schermata predefinita
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Visualizzazione del tema di sfondo

Nella schermata Home & possibile visualizzare solo l'immagine di sfondo
nascondendo app e widget.
Allontanare due dita sulla schermata Home.
+ Per tornare alla schermata originale con la visualizzazione di app e widget,
awicinare le dita sulla schermata Home o trascinare verso lalto — dal bordo
inferiore dello schermo.

Spostamento di app sulla schermata Home
Nella schermata Home, toccare e tenere premuta un'app, quindi trascinarla in
un‘altra posizione.

+ Perinserire le app utilizzate pili spesso nella parte inferiore della schermata
Home, toccare e tenere premuta un'app, quindi trascinarla nellarea di accesso
rapido nella parte inferiore.

+ Per rimuovere un'icona dallarea di accesso rapido, trascinarla nella schermata
Home.
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Utilizzo delle cartelle dalla schermata Home

Creazione di cartelle

Nella schermata Home, toccare e tenere premuta un'app, quindi trascinarla su
un'altra app.
+ Viene creata una nuova cartella e le app vengono aggiunte al suo interno.

Modifica di cartelle

Nella schermata Home, toccare una cartella ed eseguire una delle seguenti azioni.
- Per modificare il nome della cartella, toccare il nome della cartella.
- Per modificare il colore, toccare il cerchio in alto a destra.

« Per aggiungere app, toccare e tenere premuta una app, quindi trascinarla sopra
la cartella e rilasciarla.

+ Per rimuovere un'app dalla cartella, toccare e tenere premuta l'app, quindi
trascinarla all'esterno della cartella. Se l'app rimossa e ['unica esistente nella
cartella, viene rimossa automaticamente anche la cartella.

- E possibile anche aggiungere o rimuovere le app dopo aver toccato ().

E + Quando si utilizza un tema scaricato, non e possibile modificare il colore della
cartella.

Impostazioni della schermata Home
E possibile personalizzare le impostazioni della schermata Home.

1 Nella schermata Home, toccare Impostazioni > Display > Schermata Home.

7 Personalizzare le sequenti impostazioni:

- Seleziona Launcher: consente di selezionare una modalita per la schermata
Home.

+ Sfondo: consente di cambiare lo sfondo della schermata Home.

- Effetto scorrimento schermo: consente di selezionare un effetto da
applicare quando si passa a un'altra area della schermata Home.

« Aspetto delle icone: consente di scegliere se si desidera che le icone
abbiano gli angoli squadrati o arrotondati.

- Feed Google: consente di visualizzare alla sinistra della schermata Home
principale.
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Ordina le app per:Impostare la modalita di ordinamento delle app sulla

schermata Home.

+ Nascondi applicazioni: consente di selezionare le app da nascondere nella
schermata Home.

+ Scorrimento continuo: attivare per consentire lo scorrimento continuo della

schermata Home (ritorno alla prima schermata dopo 'ultima schermata).

Scorri verso il basso su Sfondo: consente di cercare app o contenuti, o
visualizzare le notifiche scorrendo verso il basso sulla schermata Home.

Sfondo Lock: consente diimpedire che le app o i widget siano spostati o
rimossi.

Blocco schermo

Informazioni generali sul blocco schermo

Lo schermo del dispositivo si spegne e si blocca se si preme il tasto di accensione/
blocco. Il blocco awiene anche quando il dispositivo viene lasciato inattivo per un
determinato periodo di tempo.

Se si preme il tasto di accensione/blocco senza limpostazione di un blocco schermo,
viene immediatamente visualizzata la schermata Home.

Per maggiore sicurezza e per impedire ['accesso indesiderato al dispositivo,
impostare un blocco schermo.

E « Il blocco schermo impedisce inutili input tocco sullo schermo del dispositivo
e riduce il consumo della batteria. E altamente consigliabile attivare il blocco
schermo mentre non si usa il dispositivo.

Impostazione di un blocco schermo

Per la configurazione delle impostazioni del blocco schermo sono disponibili varie
opzioni.

7 Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza >
Seleziona il blocco dello schermo e quindi selezionare il metodo preferito.

2 Personalizzare le seguenti impostazioni:
+ Nessuno: consente di disattivare la funzione di blocco schermo.
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+ Trascina: consente di scorrere con un dito sullo schermo per sbloccarlo.

+ Sequenza: consente di disegnare una sequenza per sbloccare lo schermo.

+ PIN: consente di immettere una password numerica per sbloccare lo
schermo.

« Password: consente di immettere una password alfanumerica per sbloccare
lo schermo.

+ Impronte digitali: consente di sbloccare lo schermo utilizzando le impronte
digitali.

Personalizza Blocco schermo

Puoi personalizzare il blocco schermo.

1 Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza >
Personalizza Blocco schermo.

2 Seleziona una funzione che vuoi impostare.
« Sfondo: Consente di impostare lo sfondo del blocco schermo.
+ Orologio: Consente di impostare il punto in cui posizionare ['orologio sul

blocco schermo.

« Collegamenti: Consente di scegliere le app da eseqguire sul blocco schermo.
Questa impostazione appare solo quando uno schermo di blocco viene
impostato.

« Informazioni di contatto per telefono perso: Consente di impostare il
testo da visualizzare sulla schermata di blocco per identificare il proprietario
del telefono.

Impostazioni di Blocco con sicurezza
Puoi impostare blocchi schermo sicuri.

1 Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza >
Impostazioni di Blocco con sicurezza.
2 Seleziona una funzione che vuoi impostare.
- Rendi visibile la sequenza (visualizzato solo quando come blocco schermo
& impostata una sequenza): attivare questa opzione per rendere visibile la
sequenza.
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+ Blocco timer: Consente di impostare l'intervallo di tempo prima che
lo schermo si blocchi automaticamente dopo lo spegnimento della
retroilluminazione (time out a causa di inattivita).

« Blocco istantaneo con tasto accensione: Attivare questa opzione
per bloccare istantaneamente lo schermo quando si preme il tasto di
accensione/blocco. Questa impostazione supera le impostaszioni del timer
del blocco di sicurezza.

+ Mostra blocco (visualizzato solo quando & impostato un blocco schermo):
Attivare questa opzione per visualizzare l'icona di blocco tenendo premuto
il pulsante di accensione/blocco. Toccare l'icona di blocco per disattivare il
smart lock, lo sblocco biometrico e le notifiche sulla schermata di blocco.

+ Smart Lock: Consente di impostare dispositivi, luoghi, voce e/o rilevamento
su corpo affidabili che permettono al tuo telefono di restare sbloccato.

E + Le opzioni di menu disponibili possono variare a seconda del metodo di blocco
schermo selezionato.

Toc Toc
E possibile accendere o spegnere o schermo toccandolo due volte.
E « Questa opzione é disponibile solo sulla schermata Home fornita da LG. Potrebbe

non funzionare correttamente su un launcher personalizzato o sulla schermata
Home installata dall'utente.

Quando si tocca lo schermo, utilizzare la punta di un dito. Non utilizzare un'unghia.

Per utilizzare la funzione Toc Toc, assicurarsi che il sensore di prossimita/luminosita
non sia ostruito da un adesivo o da un‘altra sostanza estranea.

Accendi lo schermo
Toccare due volte il centro dello schermo.

+ Sesitocca la parte superiore o inferiore dello schermo, la velocita di
riconoscimento potrebbe essere pit bassa.

Spegni lo schermo
Toccare due volte uno spazio vuoto nella schermata Home e nella schermata di blocco.
In alternativa, toccare due volte uno spazio vuoto sulla barra di stato.
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Disattivazione di Toc Toc
Se non si desidera utilizzare la funzione Toc Toc, impostare come segue:

Nella schermata Home, toccare Impostazioni > Estensioni > Toc Toc e trascinare
per disattivare la funzione.

Crittografia della scheda di memoria

E possibile crittografare e proteggere i dati salvati sulla scheda di memoria.

L'accesso ai dati crittografati sulla scheda di memoria non sara possibile da un altro

dispositivo.

1 Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza >
Crittografia e credenziali > Cripta la Scheda SD.

2 Leggere le informazioni generali sulla crittografia della scheda di memoria
visualizzate sullo schermo, quindi toccare Continua per continuare.
3 Selezionare un'opzione e toccare Crittografia.

- Crittografia del nuovo file: consente di crittografare solo i dati salvati sulla
scheda di memoria dopo la crittografia.

Crittografia completa: consente di crittografare tuttii dati attualmente
salvati sulla scheda di memoria.

Escludi file multimediali: consente di crittografare tutti i file ad eccezione di
quelli multimediali come musica, foto e video.

E + Una volta awiata la crittografia di una scheda di memoria, alcune funzioni non
sono disponibili.

Se il dispositivo si spegne mentre |a crittografia e in corso, il processo di crittografia
non riuscira e alcuni dati potrebbero danneggiarsi. Occorre percio assicurarsi che il
livello della batteria sia sufficiente prima di awviare la crittografia.

L'accesso ai file crittografati & possibile solo dal dispositivo in cuii file sono stati
crittografati.

« Lascheda di memoria crittografata non puo essere utilizzata su un altro
dispositivo LG. Per utilizzare la scheda di memoria crittografata su un altro
dispositivo mobile, formattare la scheda.

E possibile attivare la crittografia della scheda di memoria anche se nel dispositivo
non é installata alcuna scheda di memoria. Qualsiasi scheda di memoria installata
dopo la crittografia verra automaticamente crittografata.
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Acquisizione di screenshot

E possibile acquisire screenshot della schermata che si sta visualizzando.

Tramite un collegamento rapido

Tenere premuti contemporaneamente il tasto di accensione/blocco e il Tasto
volume giu per almeno due secondi.

+ Gli screenshot possono essere visualizzati nella cartella Screenshots nella
Galleria.

Tramite screenshot

Nella schermata di cui si desidera acquisire uno screenshot, trascinare verso il basso
la barra di stato, quindi toccare @).

5 + Peridettagli vedere, consultare la sezione Scrittura di note su uno screenshot.

Condivisione di contenuti

Riproduzione di contenuti da un altro dispositivo
E possibile riprodurre foto, video o canzoni salvate sul proprio dispositivo da una TV,
1 Connettere laTV e il dispositivo alla stessa rete Wi-Fi.

7 Mentre sivisualizzano gli elementi dell'app Galleria o Musica, toccare = >
Riproduci su un altro dispositivo.

3 Selezionare la TV a cui si desidera connettersi.

E « Per [utilizzo con Chromecast, & consigliabile che i servizi di Google Play siano
aggiornati

Visualizzazione di contenuti da dispositivi vicini

E possibile visualizzare contenuti da diversi dispositivi, come ad esempio un
computer, un dispositivo NAS o un dispositivo mobile, utilizzando le app Galleria o
Musica.
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Connessione dei dispositivi

Connettere sia il proprio dispositivo che un altro dispositivo in grado di supportare
la funzione DLNA alla stessa rete wireless.

E « Assicurarsi che la Condivisione file (DLNA) sia attiva sia nel dispositivo mittente
che nel dispositivo connesso.

Ricerca di dispositivi vicini
E possibile visualizzare un elenco di dispositivi DLNA connessi alla stessa rete
selezionando il menu ¢ > Dispositivi nelle vicinanze in ciascuna app.

Si possono utilizzare i contenuti di dispositivi vicini come se li si stesse utilizzando
sul proprio dispositivo.

Invio o ricezione di file

E possibile condividere file tra il proprio dispositivo e un altro dispositivo LG oppure
un tablet.

Invio di file

Dalla Galleria o altre app, toccare + > Condividi 0 o<, quindi selezionare un
dispositivo dallelenco di condivisione file.

Ricezione di file
Trascinare verso il basso la barra di stato e toccare Condivisione File.

Se il proprio dispositivo non supporta la funzione di condivisione file, nella
schermata Home toccare Impostazioni > Dispositivi connessi > Condivisione File
> SmartShare Beam () ).

E « Assicurarsi che il proprio dispositivo sia connesso alla stessa rete wireless a cui e

connesso il dispositivo destinatario del trasferimento file.

« Assicurarsi che la Condivisione file sia attiva sia in entrambi i dispositivi.
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Non disturbare

E possibile limitare o disattivare laudio delle notifiche per evitare di essere disturbati
per un determinato periodo di tempo.

Nella schermata Home, toccare Impostazioni > Suono > Non disturbare.
+ Toccare Modo e selezionare la modalita desiderata:

- Solo priorita: consente di ricevere le notifiche sonore o con vibrazione per le
app selezionate. Anche se ¢ attiva la modalita Solo priorita, le sveglie suonano
comunque.

- Silenzio totale: consente di disabilitare sia laudio che la vibrazione.

- Seleziona le priorita: rricevi allarmi e le notifiche per le app selezionate.
- Chiamate da:imposta una serie di notifiche quando ricevi una chiamata.

E « Chiamate ripetute: [a seconda chiamata dalla stessa persona entro 15 minuti non
viene resa silenziosa.

- Messaggi da:imposta una serie di notifiche quando ricevi un messaggio.
Utilizza modalita Non disturbare: Attiva la funzionalita Non disturbare.

Sonno:imposta il programma in base al quale attivare la funzionalita Non
disturbare.

Guida: Visualizzare la quida per Non disturbare.
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Installazione e disinstallazione di app

Installazione di app
E possibile accedere a uno store di app per cercare e scaricare delle app.

+ Sipuo utilizzare SmartWorld, Play Store o lo store di app fornito dal proprio
gestore del servizio.

E « Alcuni store di app potrebbero richiedere la creazione di un account e la
registrazione.

« Alcune app potrebbero essere a pagamento.

« Sesi utilizzano dati mobili, potrebbe esserne addebitato il costo a seconda del
proprio piano tariffario.

+ SmartWorld potrebbe non essere supportato a seconda dell'area o del provider
del servizio.

Disinstallazione di app
Disinstallare le app inutilizzate dal dispositivo.

Disinstallazione con il gesto di tocco e pressione lunga

Tenere premuta unarea vuota della schermata, e quindi premere € dellapp da
eliminare.

Disinstallazione tramite il menu delle impostazioni

Nella schermata Home, toccare Impostazioni > Applicazioni > Informazioni
applicazione, selezionare unapp e quindi toccare Disinstalla.

5 « Alcune app non possono essere disinstallate dagli utenti

Disinstallazione di app dallo store di app

Per disinstallare un'app, accedere allo store di app da cui e stata scaricata e
disinstallarla.
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Installazione e disinstallazione di app durante il setup
Quando si accende il dispositivo per la prima volta, e possibile scaricare le app
consigliate.

E possibile saltare alla fase successiva senza linstallazione.

Cestino app
E possibile visualizzare le app disinstallate. E inoltre possibile reinstallare le app che
sono state disinstallate nelle ultime 24 ore.
T Nella schermata Home, toccare Gestione > Cestino app.
Si puo inoltre toccare e tenere premuta unarea vuota della schermata Home,
quindi toccare Cestino app.
7 Attivare la funzione desiderata:
« Ripristina: consente di reinstallare lapp selezionata.
- 1] : consente di rimuovere definitivamente dal dispositivo le app disinstallate.

E + Le app disinstallate vengono rimosse automaticamente dal dispositivo 24 ore
dopo la disinstallazione. Se si desidera reinstallare le app disinstallate, & necessario
scaricarle nuovamente dallo store di app.

« Questa funzione ¢ attiva solamente sulla schermata Home. Se si disinstallano delle
app mentre si utilizza la schermata EasyHome o un altro launcher, queste vengono
immediatamente e definitivamente rimosse dal dispositivo.

Scorciatoie applicazioni

Nella schermata Home, toccare e tenere premuta l'icona di una app come Chiama,
Invia messaggio, Camera, Galleria e Impostazioni per mostrare un menu di accesso
rapido. Utilizza le app in maniera piti semplice grazie alle scorciatoie per app.

- Toccare & per impostare i widget per 'app.

+ Toccare (§) per visualizzare le informazioni sullapp.
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E + Questa funzione e disponibile solo in alcune app.

Telefono

Chiamata vocale

Per eseguire una chiamata vocale, utilizzare uno dei metodi disponibil, ad esempio
immettere manualmente un numero di telefono e selezionarlo dall'elenco dei
contatti o dallelenco delle chiamate recenti.

Esecuzione di una chiamata dal tastierino numerico
7 Nella schermata Home, toccare (® > Componi.
7 Eseguire la chiamata utilizzando un metodo a scelta:

+ Immettere un numero di telefono e toccare (@.

+ Toccare e tenere premuto un numero di composizione veloce.

« Cercare un contatto toccando |a lettera iniziale del relativo nome nell'elenco
dei contatti, quindi toccare °

E « Perimmettere "+" quando si esegue una chiamata internazionale, toccare e tenere
premuto il numero 0.

« Peridettagli, vedereAggiunta di contatti per ottenere ulteriori informazioni su
come aggiungere numeri di telefono all'elenco di selezione rapida.
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Esecuzione di chiamate dalla Rubrica
1 Nella schermata Home, toccare (@ > Rubrica.

2 Dopo aver selezionato il numero da chiamare dallelenco dei contatti nella
rubrica, toccare ...

Risposta a una chiamata

Per rispondere a una chiamata, trascinare ° sulla schermata della chiamata in
arrivo.

Se e collegato un auricolare stereo, e possibile eseguire le chiamate utilizzando il
pulsante di chiamata/fine sull'auricolare.

Per terminare una chiamata senza spegnere lo schermo, nella schermata Home
toccare Impostazioni > Rete & internet > Chiamata > Rispondi e termina
chiamate e quindi attivare Termina le chiamate con il tasto di accensione.

E « Nella schermata Home, toccare Impostazioni > Rete & internet > Chiamata >
Rispondi e termina chiamate > Termina le chiamate con il tasto di accensione,
& possibile terminare le chiamate premendo il tasto di accensione/blocco mentre &
attiva la schermata della chiamata in corso.

Rifiuto di una chiamata
Per rifiutare una chiamata in arrivo, trascinare @ attraverso la schermata della
chiamata in arrivo.

+ Perinviare un messaggio di rifiuto, trascinare l'opzione del messaggio di rifiuto

per la schermata.

+ Per aggiungere o modificare un messaggio di rifiuto, nella schermata Home
toccare Impostazioni > Rete & internet > Chiamata > Blocco chiamate &
Rifiuta con messaggio.

+ Quando e in arrivo una chiamata, premere il tasto volume su, volume giti o il
tasto di accensione/blocco per disattivare laudio della suoneria o la vibrazione,
oppure per mettere in attesa la chiamata.
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Verifica di una chiamata in arrivo durante ['utilizzo
di unapp
Quando si riceve una chiamata mentre si sta utilizzando un‘app, & possibile

visualizzare una notifica pop-up nella parte superiore della schermata. Si puo
accettare la chiamata, rifiutarla o inviare un messaggio dalla schermata pop-up.

E « Nella schermata Home, toccare Impostazioni > Rete & internet > Chiamata >
Altre impostazioni > Pop-up di chiamata in arrivo e quindi selezionare il modo
in cui si desidera visualizzare la chiamata in arrivo quando si usa un'app.

Visualizzazione delle chiamate perse

In caso di una chiamata persa, nella barra di stato nella parte superiore dello
schermo viene visualizzato X,

Per visualizzare i dettagli della chiamata persa, trascinare la barra di stato verso il
basso. E inoltre possibile toccare (& > Chiamate nella schermata Home.

Funzioni disponibili nel corso di una chiamata

Nel corso di una chiamata e possibile accedere a varie funzioni toccando i pulsanti
visualizzati sullo schermo:

Rubrica: consente di visualizzare |'elenco di contatti durante una chiamata.

Attesa: mette in attesa la chiamata corrente.

Tastiera: consente di mostrare o nascondere la testiera del telefono.

Vivavoce: consente di attivare la funzione vivavoce.

Muto: consente di silenziare la propria voce in modo che non possa essere udita
dall'interlocutore.

Bluetooth: consente di passare la chiamata a un dispositivo Bluetooth associato
€ connesso.

. ° :consente di terminare una chiamata.
- % :consente di accedere a opzioni di chiamata aggiuntive.

E « Levodi delle impostazioni disponibili possono variare a seconda dell'area e del
provider del servizio.
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Esecuzione di una chiamata a tre vie
E possibile esequire una chiamata a un altro contatto nel corso di una chiamata.

1 Durante una chiamata, toccare + > Aggiungi.

2 Immettere un numero di telefono e toccare .
+ Le due chiamate vengono visualizzate contemporaneamente sullo schermo
e la prima chiamata viene messa in attesa.

3 Per awiare una conferenza telefonica, toccare Unisci.

E « Puo essere addebitato il costo di ogni chiamata. Rivolgersi al proprio provider del
servizio per ulteriori informazioni.

Visualizzazione dei record delle chiamate

Per visualizzare i record delle chiamate recenti, nella schermata Home toccare (8 >
Chiamate. £ quindi possibile utilizzare le sequenti funzioni:
« Per eliminare i record delle chiamate, toccare > Elimina.

E « Ladurata visualizzata delle chiamate potrebbe essere diversa da quella addebitata.
Rivolgersi al proprio provider del servizio per ulteriori informazioni.

« Lacronologia delle telefonate non puo essere recuperata una volta cancellata.

« Stringi due dita o allargale per regolare la dimensione del carattere per i registri
delle chiamate o i contatti.

Configurazione delle opzioni di chiamata
E possibile configurare diverse opzioni di chiamata.

71 Nella schermata Home, toccare (% > Componi o Chiamate.

7 Toccare : > Impostazioni chiamate e quindi configurare le opzioni in base alle
proprie preferenze.
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Messaggi

Invio di un messaggio

E possibile creare e inviare messaqgi ai propri contatti utilizzando lapp di
messaggistica.

E « Linvio di messaggi all'estero potrebbe essere soggetto a ulteriori costi. Rivolgersi al
proprio provider del servizio per ulteriori informazioni.

1 Nella schermata Home, toccare ).

2 Sfiorare Cl.

3 Specificare un destinatario e creare un messaggio.
- Per usare le opzioni multimediali, tocca ().
« Per accedere alle voci di menu opzionali, toccare .

4 Toccare B> per inviare il messaggio.

Lettura di un messaggio
E possibile visualizzare i messaqgi scambiati organizzati per singolo contatto.
T Nella schermata Home, toccare ).

2 Selezionare un contatto dall'elenco dei messaggi.

Configurazione delle impostazioni dei messaggi

E possibile modificare le impostazioni dei messaggi in base alle proprie preferenze.
1 Nella schermata Home, toccare B

2 Toccare : > Impostazioni dall'elenco dei messaggi.

E - E possibile specificare le impostazioni per la finestra di awiso, il blocco delle
chiamate, ['awiso di emergenza, i messaggi multimediali ecc.
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Fotocamera

Awvio della fotocamera

E possibile scattare una foto o registrare un video per conservare tuttii momenti
memorabili.

Nella schermata Home, toccare (&).

5

Prima di scattare una foto o registrare un video, pulire l'obiettivo della fotocamera
con un panno morbido.

Prestare attenzione a non macchiare [obiettivo della fotocamera con le dita o altre
sostanze.

+ Leimmagini incluse nella presente guida potrebbero essere diverse da quelle
effettive del dispositivo.

« Lefoto e i video possono essere visualizzati o modificati dalla Galleria. Per i
dettagli, vedere, consultare la sezione Informazioni generali sulla Galleria.

Non utilizzare il prodotto per scopi che potrebbero violare la privacy o i diritti di
altre persone

Scatto di una foto
E possibile scattare foto con la fotocamera del prodotto.
T Toccare (&) e mettere a fuoco il soggetto.
- E possibile toccare il soggetto da mettere a fuoco.
- E possibile allontanare o awicinare due dita per ingrandire o ridurre.
7 Sfiorare | per scattare una foto.
- Einoltre possibile premere il tasto volume su o volume gili per scattare una
foto.
- E possibile scattare una foto durante la registrazione di un video premendo
® sullo schermo.

+ Le informazioni visualizzate nella schermata di ripresa possono variare a
seconda della fotocamera selezionata (anteriore o posteriore) e alla modalita
fotocamera.

« Lafotocamera si disattiva automaticamente se non la si usa per un po’ di
tempo dopo aver aperto lapp Fotocamera.
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Awvia Google Lens.

Imposta il timer
Passa alla fotocamera
—r ~ anteriore/posteriore

Imposta il flash —1

Applica leffetto filtro —3) o= — Scatta foto

Imposta le proporzioni —s
della fotocamera
Imposta la fotocamera —

o — Anteprima
Modalita corrente della
fotocamera

Selezionare lo zoom

E + E possibile aprire [app della fotocamera premendo brevemente due volte il tasto
diaccensione. Nella schermata Home, toccare Impostazioni > Estensioni >
Collegamenti e quindi toccare Apri Fotocamera per attivarla.

Quando lo schermo e spento o bloccato, awiare la fotocamera premendo due
volte il tasto volume gili.

Nella schermata Home, toccare Impostazioni > Estensioni > Collegamenti e
quindi toccare Apri Fotocamera @ ) per attivarla.

Personalizzazione delle opzioni della fotocamera
E possibile personalizzare varie opzioni in base alle proprie preferenze.
Toccare §63 sulla schermata.

E + Le opzioni disponibili potrebbero variare a seconda della fotocamera selezionata
(anteriore o posteriore) e alla modalita fotocamera selezionata.

Consente di selezionare i valori relativi a proporzioni e dimensioni per

Dimensioni foto
le foto da scattare.

Consente di ottenere foto dai colori vividi ed effetti compensati
anche quando le foto sono scattate contro luce. Queste funzioni sono

HDR disponibili grazie alla tecnologia High Dynamic Range (HDR) integrata
nella fotocamera.
Consente di visualizzare le griglie di guida in modo da poter scattare
Griglia foto o registrare video in base alle linee di riferimento orizzontali e

verticali.
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Consente di scattare una foto pronunciando ‘Cheese; ‘Smile;

Scatto al Cheese ‘Whiskey; Kimchi o LG!

Tag posizione Consente di salvare limmagine completa di dati sulla posizione GPS.

Consente di selezionare se si desidera archiviare le immagini e i video
Archiviazione nellArchivio interno o nella Scheda SD. (Disponibile quando la scheda
di memoria & inserita.)

Guida Fornisce una guida per ciascun menu della fotocamera.

Opzioni aggiuntive della fotocamera anteriore

Salva come

Salva le immagini come capovolte dopo aver scattato dei selfie.
capovolta

Scatta un selfie selezionando le sue opzioni tra Scatto tramite gesto

Scatto di selfie .
della mano e Scatto automatico.

E « E possibile applicare leffetto make-up quando si scatta un selfie con la fotocamera
anteriore.
« Scatto con gesture viene effettuato mediante il riconoscimento della forma di
una mano e Scatto automatico viene effettuato mediante il riconoscimento di
un viso

Selezione della modalita

E possibile selezionare comodamente tra le modalita visualizzate sullo schermo, che
sono selezionate per adattarsi all'ambiente di ripresa.

Toccare (&) e scorrere le modalita della fotocamera verso sinistra o destra, oppure
scorrere lo schermo a sinistra o a destra per selezionare una modalita della
fotocamera.
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Modalita della fotocamera

Uso delle modalita della fotocamera

Registrazione di un video
1 Toccare @ e selezionare Video scorrendo le modalita della fotocamera.

2 Toccare (= per registrare un video.

Imposta la fotocamera ——=J8

e —— |mposta il flash

Imposta la risoluzione video Applica leffetto filtro

e clezionare lo zoom

Anteprima — =S¥ =Y e Passa alla fotocamera

anteriore/posteriore

Registrazione di un video

App utili 66



+ Per scattare una foto mentre si registra un video, toccare ©.

- Per mettere in pausa la registrazione del video, toccare (11). Per riprendere la
registrazione del video, toccare (e .

« Mentre registri un video, puoi stringere o allargare due dita per ingrandire o
rimpicciolire.

+ Mentre registri un video, puoi toccare |'area desiderata per regolare la
luminosita.

3 Toccare (= per terminare la registrazione del video.

Scatto di una foto
Toccare () e selezionare Foto scorrendo le modalita della fotocamera.
Per ulteriori informazioni, consultare la sezione Scatto di una foto.

Scatto di foto con la funzione Al

Quando si scatta una foto, la funzione Al riconosce il soggetto e applica l'effetto
ottimale alla foto.

E - Toccare ‘ per disattivare la funzione Al.

Uso di altre modalita della fotocamera
Toccare (&) e selezionare Altro scorrendo le modalita della fotocamera.

Macro
E possibile riprendere un primo piano di un soggetto.
1 Toccare Q> (&), quindi toccare Altro > &,

2 Sfiorare () per scattare una foto.

Panoramica

E possibile creare una foto panoramica spostando la fotocamera nella direzione da
fotografare e unire gli scatti continui di una vista ampia.

T Toccare (&) e selezionare Altro scorrendo le modalita della fotocamera.
2 Sfiorare )XY
- Selezionare uno zoom tra @9 / @3.
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3 Toccare , quindi spostare lentamente la fotocamera in una sola direzione.

/' Toccare @) per interrompere acquisizione della panoramica.

Imposta la fotocamera —e|

E + Quando si sposta la fotocamera in una direzione, assicurarsi che linquadratura
ripresa non sia fuori dalla linea guida.
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Jump-cut flash
Le foto scattate a intervalli regolari sono salvate come file GIF
1 Toccare @ quindi toccare Altro > @
7 Sfiorare per scattare una foto.
« Le foto sono scattate ogni 3 secondi e sono salvate come file GIF
+ Tocca (@] sullo schermo per selezionare il numero di foto che vuoi scattare.

- Quando scatti foto, tocca @ per creare file GIF cono foto scattate in
precedenza.

Il flash si accende automaticamente e agisce come un timer.

5

Gli scatti realizzati questa volta e il numero totale di scatti vengono visualizzati in
fondo allo schermo.

Tutte le foto scattate sono salvate come file GIF

« Non puoi modificare la velocita dei GIF né ['ordine delle immagini.

YouTube Live
E possibile registrare un video e caricarlo direttamente su YouTube.

Per utilizzare questa funzione, & necessario soddisfare i requisiti di idoneita. Per i
requisiti, contattare YouTube.

T Nella schermata Home, toccare (&).
2 Selezionare Altro scorrendo le modalita della fotocamera, quindi toccare (o).
E « YouTube Live e disponibile solo quando il proprio dispositivo & connesso a Internet.

Se si utilizzano dati mobili, potrebbe esserne addebitato il costo a seconda del
proprio piano tariffario.
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Utili funzioni della fotocamera

Ricerca visiva

Potrai ottenere maggiori informazioni o effettuare azioni su oggetti intorno a te
usando Google Lens, come pietre miliari, poster, menu di ristoranti, animalj, fiori, o
codici a barre, direttamente nel tuo dispositivo.

Blocco Esposizione automatica/Messa a fuoco automatica

E possibile fissare il livello attuale di esposizione e mettere a fuoco la posizione
toccando e tenendo premuta lo schermo nella modalita automatica. Per disattivare
la funzione, toccare unarea vuota sulla schermata.

Blocco Esposizione
automatica/Messa a
fuoco automatica

E + Questa funzione ¢ disponibile solo in alcune modalita specifiche.
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Passaggio dalla fotocamera posteriore a quella anteriore e
viceversa

E possibile passare dalla fotocamera anteriore a quella posteriore e vice versa in
base allambiente circostante.

+ Per passare tra la fotocamera anteriore e posteriore, scorrere o schermo verso

[alto o verso il basso nella schermata di ripresa dellapp Fotocamera.

E « Utilizzare la fotocamera anteriore per scattare i selfie. Per i dettagli, vedere,
consultare la sezione Scatto di selfie.

Zoom avanti o indietro

E possibile allontanare o awicinare due dita per ingrandire o ridurre quando si
scattano foto o si registrano video.

E + Lafunzione di zoom avanti/indietro non ¢ disponibile in modalita selfie

(fotocamera anteriore).

+ Questa funzione non & supportata in diverse modalita.
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Utilizzo di Burst Shot

E possibile scattare foto consecutive e visualizzarle come immagini in movimento
nella Galleria.

1 Toccare (&) e selezionare Foto.

2 Tenere premuto
+ Vlengono scattate pili foto consecutive mentre si tiene premuto

Scatto tramite gesto della mano
E possibile scattare selfie tramite gesti.

Mostrare il palmo della mano alla fotocamera anteriore e quindi stringere il pugno.

E inoltre possibile stringere il pugno e poi aprirlo verso la fotocamera anteriore.
+ Dopo tre secondi la foto viene scattata.

W

"

Per utilizzare questa funzione, passare alla modalita fotocamera anteriore, quindi
toccare §63 > Scatto di selfie> Scatto tramite gesto della mano.

i

Assicurarsi che il palmo e il pugno siano all'interno della linea di riferimento in
modo che la fotocamera possa rilevarli

+ Questa funzione potrebbe non essere disponibile mentre sono in uso alcune altre
funzioni della fotocamera.
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Scatto automatico

E possibile utilizzare la funzione di rilevamento del volto per scattare selfie in
maniera semplice e comoda. Si pud impostare il dispositivo in maniera tale che,
quando ['utente quarda verso lo schermo, la fotocamera anteriore rilevi il volto e
scatti automaticamente un selfie.

+ Quando la fotocamera anteriore rileva il volto, viene visualizzata la cornice guida
di colore bianco. Se il soggetto allinterno della cornice guida smette di muoversi,
la cornice guida diventa blu, quindi la fotocamera scatta una foto.

E - Toccare §83 > Scatto di selfie > Scatto automatico per attivare la funzione
Scatto automatico.

Scatto intervallato
E possibile scattare selfie a intervalli regolari.

Mentre & in uso la fotocamera anteriore, mostrare il palmo della mano alla
fotocamera, quindi stringere rapidamente il pugno per due volte.

+ Vengono scattate quattro foto a intervalli regolari dopo un timer di ritardo di tre
secondi.

Salva come capovolta

Prima di scattare una foto con la fotocamera anteriore, toccare §33 > Salva come
capovolta. 'immagine viene capovolta in senso orizzontale.

E « Durante [utilizzo della fotocamera anteriore, & possibile modificare le modalita di
scatto dei selfie nelle opzioni della fotocamera. Per i dettagli, vedere, consultare la
sezione Personalizzazione delle opzioni della fotocamera.

Scatto di selfie

E possibile utilizzare la fotocamera anteriore per visualizare il proprio volto sullo
schermo e scattare selfie.

1 Toccare G e selezionare Foto scorrendo le modalita della fotocamera.
7 Toccare {oY per passare alla fotocamera anteriore.

3 Toccare per scattare le foto.
« Toccare §) per applicare vari effetti estetici.
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Galleria

Informazioni generali sulla Galleria
E possibile visualizzare e gestire le foto e i video salvati sul dispositivo.

Visualizzazione delle foto
E possibile visualizare le foto salvate nel prodotto.
T Toccare (Y e selezionare la cartella desiderata.

7 Toccare la foto desiderata.
+ Lacartella Galleria contiene Foto, Album, Ricordi e Play.

Consente di tornare alla —¢J

&— Consente di accedere a opzioni
schermata precedente.

aggiuntive.

Galleria anteprime

|

I .

.

Consente di eliminare

le immagini

Consente di condividere le
immagini

Consente di aggiungere a o
rimuovere dai preferiti.

Consente di modificare le
immagini

5 « Toccando leggermente lo schermo, appare il menu Dettagli. Toccando nuovamente
lo schermo, il menu scompare.
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Riproduzione di un video
E possibile riprodurre i video salvati nel prodotto.

#ee— Consente di accedere
a opzioni aggiuntive

Consente di tornare ——e¥4
alla schermata
precedente

Consente di riprodurre
o sospendere la
riproduzione del video

Galleria anteprime

Consente di eliminare le
immagini

Consente di aggiungere a o _-.
rimuovere dai preferiti.

Consente di condividere le

Consente di modificare le immagini

immagini

Per regolare il volume dell'audio, trascinare in alto o in basso il lato destro della
schermata del video.

5

Per regolare la luminosita dello schermo, trascinare verso lalto o verso il basso il
lato sinistro della schermata.

Trascinando lo schermo a sinistra nella schermata di riproduzione video e possibile
riavolgere (REW) e trascinando a destra & possibile avanzare rapidamente (FF).

Eliminazione di file
E possibile eliminare file utilizzando una delle sequenti opzioni:
+ Toccare e tenere premuto un file nell'elenco, quindi toccare Elimina.

- Ifile eliminati vengono spostati automaticamente nel + > Cestino e possono
essere ripristinati nella Galleria entro 7 giorni.

- Toccare [x] per eliminare completamente i file. In questo caso, i file non potranno
essere ripristinati.
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Condivisione di file
E possibile condividere file utilizzando una delle sequenti opzioni:

« Mentre si visualizza una foto o un video, toccare OQ per condividere il file
utilizzando il metodo desiderato.

E + Se si scattano foto o si registrano video dopo aver toccato (8) > §63 > Tag

posizione @ ), dopo un pa’ di tempo nella scheda Memorie di Galleria viene creato

automaticamente un album di memorie specifiche della posizione.

«Alcuni formati file potrebbero non essere supportati a seconda del software installato.

«Alcuni file potrebbero non aprirsi a causa della codifica
I file di dimensioni superiori al limite massimo potrebbero generare un errore.

Devi attivare la funzionalita GPS per creare album di Memoria.

Creazione di un filmato

E possibile creare un nuovo filmato, mettendo insieme immagini e video.
1 Toccare [ e selezionare = > Crea filmato.
7 Selezionare immagini o video per il filmato e toccare Crea filmato.

3 Modificare le immagini e i video selezionati, quindi toccare Salva.

& ——— Reimpostazione dei
file

Anteprima di un file

Eliminazione di file —————; =
H ~e—————— Aggiunta difile
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E « Per creare un filmato possono essere utilizzati un massimo di 50 video.

Realizzazione di una GIF
E possibile realizzare una GIF con facilita utilizzando un video registrato.
Toccare (¥ e selezionare : > Crea GIF.

Creazione di un video

1 Durante la visualizzazione del video, in corrispondenza del punto di partenza
desiderato, toccare @r).

7 Selezionare la durata della GIF che si desidera creare.

« Viene generata una GIF della durata desiderata a partire dal punto iniziale
specificato.

« Perivideo di durata inferiore ai 5 secondi, le immagini GIF vengono generate
automaticamente per il tempo restante.

Creazione di fotografie GIF
T Nellelenco delle fotografie nella galleria, toccare & > Crea GIF.

7 Selezionare unimmagine da trasformare in fotografia GIF e quindi toccare Crea
GIF.

- E possibile aggiungere/eliminare una fotografia, regolare la velocita o le
proporzioni dello schermo e impostare ['ordine delle fotografie.

E « La creazione di fotografie GIF e una funzione che consente all'utente di
produrre immagini creative. La violazione dei diritti di proprieta intellettuale o la
diffamazione della reputazione di altre persone mediante la funzione di creazione
di fotografie GIF possono comportare responsabilita civili o penali in conformita
con le leggi vigenti. Fare attenzione a non copiare o trasmettere opere di altre
persone senza autorizzazione. LG Electronics declina ogni responsabilita per tali
azioni degli utenti

Quando si crea una fotografia GIF, & possibile selezionare di produrre fino a 100
fotografie.
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Rubrica

Informazioni generali sui contatti
E possibile salvare e gestire i contatti.
Nella schermata Home, toccare Essenziali > Rubrica.

Aggiunta di contatti

Aggiunta di nuovi contatti

T Nella schermata dell'elenco dei contatti, toccare .

« Appare un pop-up che consente di selezionare la posizione di salvataggio del
contatto. Selezionare la posizione desiderata.

7 Immetterei dettagli del contatto e toccare Salva.

Importazione di contatti
E possibile importare contatti da un altro dispositivo di archiviazione.

1 Nella schermata dell'elenco dei contatti, toccare > Gestisci contatti >
Importa.

2 Selezionare le posizioni di origine e di destinazione del contatto che si desidera
importare, quindi toccare OK.

3 Selezionare i contatti e toccare Importa.

Aggiunta di contatti all'elenco di composizione veloce

1 Nella schermata dell'elenco dei contatti, toccare > Selezione rapida.
7 Toccare Aggiungi contatto da un numero di composizione veloce.

3 Selezionare un contatto.

E + Mentre siaggiunge un nuovo contatto, toccare [3{3 per aggiungere un numero di
chiamata rapida.
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Ricerca di contatti
E possibile ricercare contatti utilizzando una delle sequenti opzioni:

+ Toccare la barra di ricerca nella parte superiore della schermata Rubrica e
inserire il contatto o il numero di telefono che si desidera cercare.

« Scorrere |'elenco dei contatti verso lalto o verso il basso.

« Dall'indice della schermata dell'elenco dei contatti, toccare la lettera iniziale di
un contatto.

E « Premendo la barra di ricerca nella parte superiore della schermata Rubrica e
inserendo un contatto o un numero di telefono, vengono visualizzati i risultati della
ricerca integrati dalla cronologia delle chiamate e dall'elenco dei contatti salvati
nel prodotto.

Elenco dei contatti

Modifica di contatti
1 Nella schermata dell'elenco dei contatti, selezionare un contatto.
7 Nella schermata dell'elenco dei contatti, toccare f e modificare i dettagli.

3 Toccare Salva per salvare le modifiche.

Eliminazione di contatti
E possibile eliminare contatti utilizzando una delle sequenti opzioni:

+ Nella schermata dellelenco dei contatti, toccare e tenere premuto un contatto
che si desidera eliminare, quindi toccare _|L']|_

- Toccare : > Elimina nella schermata dellelenco dei contatti.

E « | contatti cancellati non possono essere recuperati.

Aggiunta ai preferiti
E possibile registrare i contatti utilizzati pili spesso come preferiti.
1 Nella schermata dell'elenco dei contatti, selezionare un contatto.

7 Nella schermata dei dettagli dei contatti, toccare ﬁ;
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Creazione di gruppi

1 Dallelenco dei gruppi di contatti, toccare -

2 Immettere il nome del nuovo gruppo.

3 Toccare Aggiungi iscritti, selezionare i contatti, quindi toccare Aggiungi.

/. Toccare Salva per salvare il nuovo gruppo.

QuickMemo+

Informazioni generali su QuickMemo+

E possibile generare note creative utilizzando una varieta di opzioni su questa
funzione avanzata del blocco note, come ad esempio la gestione immagini e gli
screenshot, che non sono supportati dal blocco note tradizionale.

Questo dispositivo supporta Active Pen AES2.0 (Active Electrostatic).

Creazione di una nota
71 Nella schermata Home, toccare Essenziali > QuickMemo+.
2 Toccare @ per creare una nota.
- @ : consente di salvare una nota.
+ <5 :Annullare le modifiche precedenti.
+ 7 :Applicare di nuovo le modifiche annullate di recente.
T :consente di immettere una nota utilizzando la tastiera.
- 9 :consente di salvare i tipi di penna preferiti.
-/ :consente di scrivere delle note a mano.
- & :consente di cancellare le note scritte a mano.
: :Consente di accedere a opzioni aggiuntive.

3 Toccare @ per salvare la nota.
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Scrittura di note su uno screenshot
1 Mentre sivisualizza la schermata che si desidera acquisire, trascinare la barra di
stato verso il basso, quindi toccare o
« La schermata viene acquisita e visualizzata come miniatura nella parte
inferiore destra dello schermo.
7 Per scrivere note sullo schermo, toccare :d:
3 Scrivere note usando gli strumenti.
- T3 : consente diingrandire o ridurre, oppure regolare larea da acquisire.
+/ :consente di scrivere delle note a mano.
- & :consente di cancellare le note scritte a mano.
+ €5:Annullare le modifiche precedenti.
« 7 : Applicare di nuovo le modifiche annullate di recente.
+ (35 consente diritagliare lo schermo come desiderato.
/L Toccare N/ e salvare le note.
+ Le note salvate possono essere visualizzate in Galleria.

Funzioni aggiuntive dopo aver acquisito uno screenshot

Toccare per acquisire l'intero
schermo utilizzando la funzione
di scatto di scorrimento.
- Toccare per riprodurre lo
E screenshot acquisito.
EI Toccare per eliminare lo

screenshot acquisito.
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Puoi scattare una foto dellintero schermo, utilizzando la funzione di scatto di
scorrimento.

i

« Durante [uso di un'app come Messaging e Chrome, trascinare verso il basso il
pannello notifiche e quindi toccare O Toccare quindi :sbz per acquisire lintera
schermata visualizzata come unico file.

« Questa funzione é disponibile solo in alcune app che supportano la funzione scatto
di scorrimento.

Stringi due dita o allargale per regolare il layout del promemoria.

Orologio

Sveglia

E possibile impostare una sveglia in modo che si attivi a un orario specificato.
T Nella schermata Home, toccare Essenziali > Orologio > Sveglia.

7 Toccare -} per aggiungere una nuova sveglia.

3 Configurare le impostazioni della sveglia e toccare Salva.

+ Se si seleziona una sveglia impostata in precedenza, e possibile modificarla.

« Per eliminare una sveglia, toccare E > Elimina nella parte superiore dello schermo.
In alternativa, toccare e tenere premuta la sveglia.

Fusi orari
E possibile visualizzare ['ora attuale delle citta di tutto il mondo.
T Nella schermata Home, toccare Essenziali > Orologio > Fusi orari.

2 Toccare -} e aggiungere una citta.
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Timer

E possibile impostare il timer in modo da attivare un segnale acustico dopo un
periodo di tempo specificato.

T Nella schermata Home, toccare Essenziali > Orologio > Timer.

7 Impostare il tempo e toccare Inizio.

« Per sospendere il timer, toccare Pausa. Per riprendere il timer; toccare
Riprendi.

3 Toccare Stop per arrestare la sveglia del timer.

Cronometro
E possibile utilizzare il cronometro per registrare un tempo.
1 Nella schermata Home, toccare Essenziali > Orologio > Cronometro.

7 Toccare Inizio per awiare il cronometro.
« Per registrare un tempo, toccare Giro.

3 Toccare Pausa per sospendere il cronometro.
+ Per riprendere il cronometro, toccare Riprendi.

« Per cancellare tutte le registrazioni e awiare di nuovo il cronometro, toccare
Reset.

Calcolatrice

E possibile utilizzare due tipi di calcolatrici: la calcolatrice semplice e la calcolatrice
scientifica.

71 Nella schermata Home, toccare Essenziali > Calcolatrice.

2 Utilizzare il tastierino numerico per eseguire un calcolo.
+ Per calcolare dallinizio, toccare e tenere premuto {XJ
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Musica

E possibile riprodurre e gestire canzoni o album musicali
1 Nella schermata Home, toccare Essenziali > Musica.
7 Selezionare una categoria.

3 Selezionare un file musicale.

Accendi/spegni Flash Light.
Consente di impostare effetti

sonori
Consente di tornare alla —s i || :e—— Consente di accedere a opzioni
schermata precedente. aggiuntive.

—— Consente di riprodurre o
sospendere la riproduzione.

Toccare per riprodurre il file —— Toccare per riprodurre il file
corrente dall'inizio / Toccare due f— successivo / Toccare e tenere
volte per riprodurre il file premuto per avanzare

precedente / Toccare e tenere velocemente.
premuto per riawolgere.
EO T I | T
Consente di riprodurre in ordine Lt T Consente di selezionare una
casuale. modalita di ripetizione.
—
Consente diregolare il volume — o 7r Ze— Andare allelenco In

dellaudio ] riproduzione ora.
Consente di aggiungere a 0

rimuovere dai preferiti.

Alcuni formati file potrebbero non essere supportati a seconda del software
5 installato.

I file di dimensioni superiori al limite massimo potrebbero generare un errore.

| file musicali potrebbero essere protetti dai titolari di copyright internazionali o da
leggi sul copyright. Prima di copiare un file musicale, potrebbe essere necessario
ottenerne l'autorizzazione legale. Per scaricare o copiare un file musicale, verificare
prima le leggi sul copyright del relativo paese.

Questo modello supporta la riproduzione audio Hi-Fi. | file audio Hi-Fi presentano
licona Hi-Fi.

Se si imposta la torcig, la torcia lampeggia a tempo con la musica riprodotta.
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ThinQ

E possibile collegare facilmente il prodotto a dispositivi IoT per monitorarli e
utilizzarli comodamente.

Nella schermata Home, toccare Essenziali > ThinQ.

E « Lavatrice, asciugatrice, styler; lavastoviglie, forno e robot aspirapolvere possono
essere registrati solo quando il prodotto & in modalita standby.

« Cercare il marchio ThinQ sul prodotto per vedere se puo essere collegato all'app
ThinQ.

Toccare — per vedere le varie funzioni dellapp ThinQ.

Registratore audio

Consente di registrare e salvare la propria voce o quelle di altre persone, ad esempio
durante eventi importanti. | file vocali registrati possono essere riprodotti e condivisi.

7 Nella schermata Home, toccare Essenziali > Registratore Audio.

2 Sfiorare @.

« Per mettere in pausa |a registrazione, toccare 0.

3 Toccare @ per terminare la registrazione.
« Il file viene salvato automaticamente e viene visualizzata la schermata di
preascolto.

4 Toccare @ per ascoltare la voce registrata.

+ Toccare =8 per visualizzare i file registrati. E possibile riprodurre un file vocale
registrato dall'elenco.
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Launcher Del Gioco

E possibile impostare se utilizzare il launcher del gioco, dove & possibile visualizzare
I'elenco dei giochi installati nel prodotto e selezionare le impostazioni di gioco quali
la disattivazione dellaudio multimediale, la limitazione degli awvisi ecc.

71 Nella schermata Home, toccare Launcher Del Gioco.

2 Selezionare lopzione desiderata.

Smart Doctor

E possibile utilizzare Smart Doctor per esequire una diagnosi dello stato del
dispositivo e ottimizzarlo.

Nella schermata Home, toccare Gestione > Smart Doctor.

LG Mobile Switch

E possibile trasferire dati con facilita da un dispositivo usato a un dispositivo nuovo
mediante LG Mobile Switch.

1 Nella schermata Home, toccare Gestione > LG Mobile Switch.
E possibile anche toccare Impostazioni > Sistema > Backup > LG Mobile
Switch.
+ Sel'app non e installata nel prodotto, scaricare e installare ['app LG Mobile
Switch dal Google Play Store.

7 Sequire le istruzioni visualizzate sullo schermo per selezionare il metodo
desiderato per il trasferimento.

E « | datiin un account Google non saranno sottoposti a Backup. Quando si
sincronizza l'account Google, le app di Google, i contatti di Google, il calendario di
Google, i dati delle app di promemoria di Google e le app scaricate dal Play Store
vengono archiviati automaticamente sull'app Drive.

Caricare completamente la batteria prima del trasferimento di dati per evitare lo
spegnimento involontario durante il processo.
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Cestino app

E possibile vedere lelenco delle app disinstallate sulla schermata Home. Le app
eliminate nelle ultime 24 ore possono essere recuperate.

Nella schermata Home, toccare Gestione > Cestino app.

Per maggiori informazioni, vedere Cestino app.

RemoteCall Service

Il dispositivo puo essere sottoposto a diagnostica in modalita remota per risolverne
i problemi. Innanzitutto, eseguire una chiamata telefonica a un Centro di assistenza
clienti LG come segue:

« Per servirsi di questa funzione, & prima necessario accettarne ['utilizzo.

« Sesi utilizzano dati mobili, potrebbe esserne addebitato il costo a seconda del
proprio piano tariffario.

71 Nella schermata Home, toccare Servizi > RemoteCall Service.
2 Collegare una chiamata al centro di assistenza clienti LG.

3 Alcollegamento della chiamata, sequire le istruzioni dell'addetto al servizio per
immettere un numero di accesso a sei cifre.

- Il dispositivo viene connesso in modalita remota e viene awiato il servizio di
assistenza remota.

Messaggio CB

E possibile visualizzare trasmissioni di testo in tempo reale su situazioni di
emergenza, come tifoni, inondazioni e terremoti.

Nella schermata Home, toccare Servizi > Messaggio CB.
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App di Google

E possibile utilizzare app di Google impostando un account Google. Quando si
utilizza un'app di Google per la prima volta, viene visualizzata automaticamente

la finestra di registrazione dell'account Google. Se non si dispone di un account
Google, crearne uno dal dispositivo. Per i dettagli su come utilizzare un'app, vedere
la Guida contenuta nell'app.

E « Alcune app potrebbero non funzionare a seconda dell'area o del provider del servizio.

Calendario

L'app Calendario consente di tenere traccia del proprio programma di eventi (che e
stato creato), organizzato per Giorno, 3 giorni, Settimana o Mese.

Chrome

Un browser web veloce, semplice e sicuro, costruito per la rete moderna.

Documenti

Docs e uno strumento collaborativo di elaborazione di testi che aumenta la
produttivita. Usa Docs per creare, modificare e lavorare insieme in tempo reale.

Drive

Drive & un'app di condivisione e immagazzinaggio di file che facilita l'individuazione,
la condivisone e la collaborazione su progetti di lavoro ovunque e in ogni istante.

Gmail

Gmail & un'app facile da usare che tiene al sicuro i tuoi messaggj, rende piti smart la
tua casella di posta e ti aiuta a restare organizzato.

Google

L'app Google ti tiene aggiornato sulle cose che ti interessano. Trova risposte rapide,
esplora i tuoi interessi e ricevi un feed di storie e aggiornamenti su argomenti
importanti per te.

Maps

Stai andando da qualche parte? Vai con Maps, l'app con GPS in tempo reale sulla
quale puoi fare affidamento per navigazione, traffico, transito e dettagli su milioni di
luoghi, come recensioni ed eventi popolari.
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Foto

La casa di tutte le tue foto e video, organizzata automaticamente per condividere e
salvare le cose piti importanti.

Play Film
Consente di utilizzare il proprio account Google per noleggiare o acquistare film. E
possibile acquistare contenuti e riprodurli ovunque.

YT Music

Un nuovo servizio di streaming musicale da YouTube.

Fogli
Sheets e un foglio di lavoro collaborativo che aumenta la produttivita. Usa Sheets
per importare, organizzare e analizzare informazioni in tempo reale.

Presentazioni

Google Slides e uno strumento per presentazioni in tempo reale che aumenta la
produttivita. Usa Slides per organizzare informazioni, presentare risultati e prendere
decisioni insieme in tempo reale.

YouTube

Guarda i tuoi canali preferiti, ascolta la musica che ami e carica video da condividere
con le persone intorno a te.

Assistente

Il tuo dispositivo dispone di Assistente Google incorporato. Trovale risposte e fai
cose mentre sei in giro. per inizare, basta toccare il tasto Assistente Google sul lato
del telefono o tenere premuto il pusante home del telefono.

E « Assistente Google non é disponibile in tutte le lingue o paesi.

Files
E possibile visualizzare e gestire file salvati sul dispositivo.
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Impostazioni

E possibile personalizzare le impostazioni del dispositivo in base alle proprie
preferenze.

Nella schermata Home, toccare Impostazioni.

E « Inserendo una parola chiave nella finestra di ricerca nella parte superiore dello
schermo, e possibile trovare comodamente gli elementi da impostare

Rete & internet

Dual SIM
E possibile configurare le impostazioni dual SIM.
1 Nella schermata delle impostazioni, toccare Rete & internet > Dual SIM.

2 Personalizzare le seguenti funzioni:
+ Scheda SIM 1: modificare il nome e licona della scheda SIM 1.
+ Scheda SIM 2: modificare il nome e licona della scheda SIM 2.

« Colore del tema della scheda SIM: modificare i temi del colore per le schede

SIM.

+ Modalita Risparmio: attivare o disattivare la modalita risparmio: In modalita

Risparmio, se si effettua una chiamata a un contatto al quale e assegnata
una specifica SIM, tale SIM viene utilizzata per la chiamata anche se laltra

SIM e attiva, ad esempio in caso di utilizzo dei dati mobili.

+ Dati mobili: selezionare una scheda SIM da utilizzare per il servizio dati
cellulare. E possibile anche disattivare questa funzione.

- Roaming dati: selezionare questa opzione per attivare il dispositivo affinché

utilizzi i dati mobili durante il roaming al di fuori dell'area della propria rete

domestica.

- Dati mobili durante le chiamate: Accedere ai dati mobili usando la scheda
SIM dati non predefinita temporaneamente durante una chiamata HD con la

stessa scheda.
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Wi-Fi

E possibile connettersi a dispositivi vicini tramite una rete Wi-Fi.

Connessione a una rete Wi-Fi
1 Nella schermata delle impostazioni, toccare Rete & internet > Wi-Fi.

7 Toccare per attivarlo.
+ Vengono visualizzate automaticamente le reti Wi-Fi disponibili.

3 Selezionare unarete.
« Potrebbe essere necessario immettere la password Wi-Fi della rete.

+ Questo processo viene ignorato in caso di reti a cui e gia stato effettuato
l'accesso in precedenza. Se non si desidera esequire automaticamente la
connessione a una determinata rete \Wi-Fi, toccare la rete, quindi toccare
ELIMINA.

Impostazioni della rete Wi-Fi
Nella schermata delle impostazioni, toccare Rete & internet > Wi-Fi.

- Passa a rete dati: se la funzione connessione dati mobile & attiva e il dispositivo
non e in grado di connettersi a Internet tramite la connessione Wi-Fi, il
dispositivo si connette a Internet tramite la connessione dati mobile.

E « Questa funzione dipende dal provider del servizio.

-+ :consente di personalizzare le impostazioni della rete Wi-Fi.

Wi-Fi Direct
E possibile connettere il dispositivo ad altri dispositivi che supportano la funzione
Wi-Fi Direct per condividere direttamente i dati con essi. Non & necessario disporre

di un punto di accesso. Utilizzando la funzione Wi-Fi Direct, & possibile connettere
pit di due dispositivi.

1 Nella schermata delle impostazioni, toccare Rete & Internet > Wi-Fi > >
Avanzate Wi-Fi> Wi-Fi Direct.
+ Vlengono automaticamente visualizzati i dispositivi vicini che supportano la
funzione Wi-Fi Direct.
7 Selezionare un dispositivo.
+ La connessione awiene quando il dispositivo accetta la richiesta di connessione.
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E « La batteria potrebbe scaricarsi piti rapidamente quando si utilizza il Wi-Fi Direct.

Dati mobili

E possibile attivare o disattivare i dati mobili. E inoltre possibile gestirne 'utilizzo.

Attivazione dei dati mobili
1 Nella schermata delle impostazioni, toccare Rete & internet > Dati mobili.

7 Toccare ()) per attivarlo.

Personalizzazione delle impostazioni dei dati mobili
1 Nella schermata delle impostazioni, toccare Rete & internet > Dati mobili.
7 Personalizzare le sequenti impostazioni:

+ Dati mobili: consente di utilizzare le connessioni dati su reti mobili.

- Limita l'utilizzo dei dati mobili: consente di impostare un limite di utilizzo
dei dati mobili in modo da bloccarli al raggiungimento della soglia.

: - consente di personalizzare le impostazioni dei dati mobili.

+ Il volume di utilizzo dei dati misurato in base al prodotto e il volume calcolato
dal proprio gestore di telefonia mobile potrebbero essere diversi.

Impostazioni chiamate

E possibile personalizare le impostazioni di chiamata, ad esempio le opzioni per le
chiamate vocali e per quelle internazionali.

E « Alcune funzioni potrebbero non essere supportate a seconda dell'area o del
provider del servizio.

71 Nella schermata delle impostazioni, toccare Rete & internet > Impostazioni

chiamate.

7 Personalizzare le impostazioni.
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Tethering
Tethering USB

E possibile connettere il dispositivo a un altro dispositivo tramite USB e condividere
i dati mobili.

1 Connettere il dispositivo e gli altri dispositivi tramite il cavo USB.

2 Nella schermata delle impostazioni, toccare Rete & Internet > Tethering >
Tethering USB e quindi toccare () ) per attivarlo.

E + Questa opzione utilizza i dati mobili e potrebbe comportare costi di utilizzo dei
dati, a seconda del piano tariffario. Rivolgersi al proprio provider del servizio per
ulteriori informazioni.

Quando si esegue la connessione a un computer;, scaricare il driver USB da
wwwlg.com e installarlo sul computer.

+ Non e possibile inviare o ricevere file tra il dispositivo e un computer quando il
tethering USB ¢ attivo. Disattivare il tethering USB per inviare o ricevere file.

| sistemi operativi che supportano il tethering sono Windows XP o versione
superiore, 0 Linux.

Hotspot Wi-Fi

E possibile impostare il dispositivo in modo da farlo funzionare come un router
wireless affinché altri dispositivi possano connettersi a Internet utilizzando i suoi
dati mobili.

T Nella schermata delle impostazioni, toccare Rete & internet > Tethering >
Hotspot Wi-Fi e toccare () ) per attivare la funzione.

2 Toccare Imposta hotspot Wi-Fi e immettere il Nome Wi-Fi (SSID) e la
password.

3 Attivare il Wi-Fi sull'altro dispositivo e selezionare il nome della rete del
dispositivo nell'elenco delle connessioni Wi-Fi.

/4 Immettere la password di rete.
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E « Questa opzione utilizza i dati mobili e potrebbe comportare costi di utilizzo dei
dati, a seconda del piano tariffario. Rivolgersi al proprio provider del servizio per
ulteriori informazioni.

« Ulteriori informazioni sono disponibili su questo sito \Web:
http//www.android.com/tetherswifi

Timer per lo spegnimento automatico dell'hotspot Wi-Fi

Se I'hotspot Wi-Fi non viene utilizzato per un determinato periodo di tempo,
viene disconnesso in automatico. Puoi impostare il periodo di tempo per la
disconnessione automatica.

Tethering Bluetooth

Un altro dispositivo connesso tramite Bluetooth pud connettersi a Internet
utilizzando i dati mobili del proprio dispositivo.

1 Nella schermata delle impostazioni, toccare Rete & internet > Tethering >
Tethering Bluetooth e quindi toccare (1)) per attivarlo.

7 Attivare il Bluetooth su entrambi i dispositivi e associarli

E « Questa opzione utilizza i dati mobili e potrebbe comportare costi di utilizzo dei
dati, a seconda del piano tariffario. Rivolgersi al proprio provider del servizio per
ulteriori informazioni.

« Ulteriori informazioni sono disponibili su questo sito \Web:
http//www.android.com/tether#Bluetooth_tethering

Guida

E possibile visualizzare la quida sull'utilizzo del tethering e degli hotspot.
Nella schermata delle impostazioni, toccare Rete & internet > Tethering > Guida.

Modalita aereo

E possibile disattivare le funzioni di chiamata e dei dati mobili. Quando questa
modalita e attiva, restano disponibili le funzioni che non implicano il trasferimento di
dati, ad esempio i giochi e |a riproduzione di brani musicali.

7 Nella schermata delle impostazioni, toccare Rete & internet > Modalita aereo.
2 Toccare () ) per attivarlo.
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Reti mobili
E possibile personalizzare le impostazioni delle reti mobili
1 Nella schermata delle impostazioni, toccare Rete & internet > Reti mobili.
7 Personalizzare le sequenti impostazioni:
+ Modalita rete: consente di selezionare un tipo di rete.

+ Nomi punti di accesso: consente di visualizzare o cambiare il punto di
accesso per |'utilizzo dei servizi di dati mobili. Per cambiare il punto di
accesso, selezionarne uno fra quelli disponibili nel relativo elenco.

« Operatori di rete: consente di cercare gli operatori di rete e di connettersi
automaticamente a una rete.

VPN

E possibile connettersi a una rete virtuale sicura, ad esempio a una Intranet. £
inoltre possibile gestire la rete privata virtuale connessa.

Aggiunta di una rete VPN

1 Nella schermata delle impostazioni, toccare Rete & internet > VPN.

2 Sfiorare+

5 + Questa funzione e disponibile solo se il blocco schermo é attivato. Se il blocco
schermo e disattivato, viene visualizzata una schermata di notifica. Toccare Cambia
dalla schermata di notifica per attivare il blocco schermo. Per i dettagli, vedere,
consultare la sezione Impostazione di un blocco schermo.

3 Immettereii dettagli della rete VPN e toccare Salva.

Configurazione delle impostazioni della rete VPN
1 Toccare una rete VPN nell'elenco VPNS.

7 Immetterei dettagli relativi all'account utente della rete VPN e toccare
Connetti.

« Per salvare i dettagli dell'account, selezionare la casella di controllo Salva le
informazioni sull'account.
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DNS privato

E possibile configurare le opzioni del DNS (Domain Name System) privato.
71 Nella schermata delle impostazioni, toccare Rete & internet > DNS privato.

7 Selezionare [opzione desiderata e toccare Salva.

Dispositivi collegati

Bluetooth

E possibile connettere il dispositivo a dispositivi vicini che supportano la funzione
Bluetooth per scambiare direttamente i dati con essi. Connettere il dispositivo a un
auricolare Bluetooth e a una tastiera. In questo modo sara piti semplice controllare
il dispositivo.

Associazione a un altro dispositivo

1 Nella schermata delle impostazioni, toccare Dispositivi connessi > Bluetooth.

2 Toccare () ) per attivarlo.
+ Vengono automaticamente visualizzati i dispositivi disponibili.
- Per aggiornare l'elenco dei dispositivi, toccare ().

E + Nellelenco sono visualizzati solamente i dispositivi impostati come visibili.

3 Selezionare un dispositivo dall'elenco.
A Seguire le istruzioni visualizzate sullo schermo per effettuare l'autenticazione.

E « Questo passaggio viene saltato per i dispositivi cui & stato effettuato laccesso in
precedenza.

Invio di dati tramite Bluetooth

1 Selezionare un file.
- E possibile inviare file multimediali o contatti.

2 Toccare <& > Bluetooth.

Impostazioni 97



3 Selezionare un dispositivo di destinazione per il file.
- Ilfile viene inviato non appena viene accettato dal dispositivo di destinazione.

E « | processi di condivisione di file potrebbero differire, a seconda del file.

NFC

E possibile utilizzare il dispositivo come tessera dei trasporti o carta di credito. E
inoltre possibile condividere dati con laltro dispositivo.
1 Nella schermata delle impostazioni, toccare Dispositivi connessi > NFC.
7 Toccare () ) per attivarlo.
+ Mettere a contatto il proprio dispositivo con laltro dispositivo che supporta
NFC per consentire la condivisione di dati.

5 - L'antenna NFC potrebbe essere situata in una posizione diversa a seconda del tipo
di dispositivo. Per i dettagli relativi allarea dellantenna NFC, vedere Panoramica

delle parti.

Pannello di condivisione
E possibile condividere i contenuti delle app Galleria, Musica e File Manager con i
dispositivi nelle vicinanze. Inoltre, & possibile condividere contenuti con delle persone

specifiche nelle app che utilizzano Google Condivisione diretta.

T Nella schermata delle impostazioni, toccare Dispositivi connessi > Pannello di
condivisione.

7 Toccare @ ) per disattivare ciascuna opzione.

e possibile condividere i contenuti delle app Galleria, Musica e File Manager.

- Condivisione diretta: da unapp che supporta Google Condivisione diretta,
& possibile visualizzare un'icona che consente di condividere contenuti con

persone specifiche.
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Condivisione File

E possibile inviare e ricevere file scambiandoli tra il dispositivo e altri dispositivi o
tablet LG.

T Nella schermata delle impostazioni, toccare Dispositivi connessi >
Condivisione File.

7 Personalizzare le sequenti impostazioni:

K52: consente di modificare il nome del dispositivo.

Salva in: consente di impostare la cartella di destinazione in cui salvare i file
inviati da altri dispositivi.

Condivisione File: consente la ricezione di file inviati da altri dispositivi.

SmartShare Beam: consente di condividere file con altri dispositivi tramite
SmartShare Beam.

Guida: consente di visualizzare la guida alla condivisione dei file.

Stampa

E possibile connettere il dispositivo a una stampante Bluetooth e stampare foto o
documenti salvati sul dispositivo.

Nella schermata delle impostazioni, toccare Dispositivi connessi > Stampa.

+ Toccare Servizio di stampa predefinito per cercare le stampanti a cui e
possibile connettersi. Oppure, toccare + > Aggiungi stampante per aggiungere
manualmente una stampante.

- Toccare (+) Nuovo servizio per scaricare lapp della stampante desiderata.

5

« Questa funzione é disponibile sono quando ¢ attiva la funzione di rete mobile o
Bluetooth.

Per scaricare [app della stampante in @ Nuovo servizio, & necessario prima
accedere al proprio account Google.
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Suono

E possibile personalizzare le impostazioni relative a suono, vibrazione e notifiche.

Nella schermata delle impostazioni, toccare Suono e personalizzare le seguenti
impostazioni:

Profilo audio: consente di passare alla modalita audio Suono, Vibrazione o
Silenzioso.

Volume: consente di regolare il volume dellaudio di diversi elementi.

Suonerie: consente di selezionare una suoneria per le chiamate in arrivo. £
possibile aggiungere o eliminare suonerie.

Suono di notifica: consente di selezionare una suoneria per le notifiche. £
possibile impostare un brano musicale salvato sul dispositivo come suoneria di
notifica.

Suoneria con vibrazione: consente di impostare sul dispositivo la vibrazione e la
riproduzione di una suoneria in contemporanea.

Suoneria contatto: consente di creare una suoneria per una chiamata in arrivo
da un determinato contatto.

Allerta flash per le chiamate in arrivo:imposta il lampeggiamento secondo la
suoneria LG.

Non disturbare: consente di impostare il tempo, l'intervallo e il tipo di app per
cui ricevere messaggi di notifica. E possibile ricevere messaggi di notifica solo in
particolari giorni della settimana.

Qualita del suono ed effetti: usare la funzione per impostare la qualita e gli
effetti audio quando si riproduce una canzone o video.

Volume: consente di regolare il volume dellaudio di diversi elementi.

- Normalizza volume: Usare la funzione per normalizzare i volumi di sorgenti
audio differenti.

Equalizzatore: Usare [a funzione per regolare le impostazioni
dell'equalizzatore.

- LG 3D Sound Engine: Usare la funzione per riprodurre musica o video in un
audio tridimensionale, immersivo e vivido quando cuffie, altoparlanti, o altri
dispositivi audio esterni sono connessi. Per i dettagli, vedere, consultare la
sezione LG 3D Sound Engine.

Tipo vibrazione: consente di selezionare il tipo di vibrazione per le chiamate in
arrivo.
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+ Suono della tastiera di composizione: seleziona ['effetto sonoro del tastierino.
+ Suono touch: Selezionare un effetto sonoro per quando si tocca un elemento.

- Suoni di blocco schermo: selezionare un effetto sonoro per quando lo schermo
viene bloccato o sbloccato.

Notifiche

E possibile controllare lelenco delle app installate e configurare le impostazioni per
le notifiche.

71 Nella schermata delle impostazioni, toccare Notifiche.

7 Personalizzare le impostazioni come desiderato.

Display
E possibile personalizzare impostazioni dettagliate per ogni tipo di schermata.

Nella schermata delle impostazioni, toccare Display e personalizzare le seguenti
impostazioni:
- Sfondo: consente di personalizzare le impostazioni per la schermata Home. Per
i dettagli, vedere, consultare la sezione Impostazioni della schermata Home.

Barra di navigazione: impostare lo stile della barra d navigazione come Gesti
0 Solo pulsanti. Quando come stile della barra di navigazione si seleziona Solo
pulsanti, e possibile anche cambiare la combinazione di pulsanti. Per maggiori
dettagli, vedere Uso della barra di navigazione.

Barra di stato: consente di impostare il colore della barra di stato nella parte
superiore dello schermo, o di impostare |a visualizzazione dell'icona di notifica e
della percentuale della batteria.

Vista comfort: consente di ridurre la quantita di luce blu sullo schermo del
dispositivo per limitare ['affaticamento degli occhi.

Modalita notte: di notte & possibile applicare un tema dello schermo oscurato
per evitare ['abbagliamento.

Carattere: modificare dimensione, grassetto, o facciata.

Colore accento: consente di cambiare il colore di punta per impostazioni, menu,
finestre di notifica ecc.
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Dimensioni display: consente di impostare gli elementi presenti sullo schermo
su dimensioni facilmente visibili per [utente. Alcuni elementi potrebbero
cambiare posizione.

Schermo intero App: consente di regolare le dimensioni sullo schermo delle
app.

Luminosita: utilizzare a barra di scorrimento per modificare la luminosita dello
schermo. Per regolare automaticamente la luminosita dello schermo in base
allintensita della luce ambientale, toccare l'interruttore Automatico.

Automatico: consente di impostare la regolazione automatica della luminosita
dello schermo in base all'intensita luminosa dellambiente.

Timeout schermo: consente di disattivare automaticamente lo schermo
quando il dispositivo viene lasciato inattivo per un determinato periodo di
tempo.

Rotazione automatica: consente di ruotare automaticamente lo schermo a
seconda dellorientamento del dispositivo.

Screen saver: consente di visualizzare uno screen saver quando il dispositivo &
collegato al supporto o al caricabatteria. Selezionare un tipo di screen saver da
visualizzare.

Schermo a una mano: ridurre le dimensioni dello schermo in modo da poter
utilizzare il dispositivo con una sola mano. Trascinare il pulsante a sfioramento
Home verso 'angolo inferiore sinistro o destro dello schermo.

Sfondo & Tema

E possibile selezionare lo sfondo, il tema dello schermo, lo stile delle icone 0 AOD
(always-on display) per il dispositivo.

1 Nella schermata delle impostazioni, toccare Sfondo & Tema.

2 Toccare Sfondo o Tema per personalizzare le impostazioni.

Blocco schermo & sicurezza

E possibile personalizzare le impostazioni della schermata di blocco e della
sicurezza.

T Nella schermata delle impostazioni, toccare Blocco schermo & sicurezza.
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7 Personalizzare le impostazioni.

Google Play Protect: scansiona giornalmente il dispositivo per scoprire app
potenzialmente nocivi.

Trova il mio dispositivo: tracciare a distanza la posizione del dispositivo.
Puoi anche proteggere i tuoi dati in modo sicuro se hai smarrito il tuo
dispositivo.

Aggiornamento sicurezza: controlla gli aggiornamenti software e configura
le impostazioni di installazione automatiche.

Seleziona il blocco dello schermo: seleziona il metodo di blocco schermo
desiderato. Per i dettagli, vedere, consultare la sezione Impostazione di un
blocco schermo.

Personalizza Blocco schermo: modifica le informazioni visualizzate sullo

schermo bloccato.

Impostazioni di Blocco con sicurezza: modifica le impostsazioni di blocco

sicuro.

Impronte digitali: consente di usare limpronta digitale per sbloccare

lo schermo o il contenuto. Per i dettagli, vedere, consultare la sezione

Informazioni generali sul riconoscimento delle impronte digitali.

Blocco del contenuto: consente di impostare un tipo di blocco (password o

sequenza) per i propri file della Galleria.

Crittografia e credenziali: configura le impostazioni per la cifratura e le

credenziali della scheda SD.

- Cripta la Scheda SD: consente di crittografare la scheda di memoria per
impedire ['utilizzo su un altro dispositivo. Per i dettagli, vedere, consultare
la sezione Crittografia della scheda di memoria.

- Protezione delle credenziali: consente di visualizzare il tipo di memoria
su cui sara salvato il certificato di sicurezza.

- Credenziali di fiducia: visualizza i certificati CA root e i certificati CA
installati dall'utente del tuo sistema.

- Credenziali dell'utente: visualizza e modifica le informazioni dei
certificati sicuri conservati sul tuo dispositivo.

- Installa dalla memoria: installare un certificato sicuro da un archivio.

- Cancella archivio: cancella i certificati sicuri installati da utente e le
credenziali relative.
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Amministratori dispositivo: consente privilegi per limitare il controllo o
[utilizzo del dispositivo a determinate app.

Trust agents: consente di visualizzare e utilizzare agenti attendibili installati
sul dispositivo.

Puntina schermo: consente di fissare la schermata dellapp in modo che sia
possibile utilizzare soltanto (app attiva al momento.

Accesso all'utilizzo: consente di visualizzare i dettagli sull'utilizzo delle app
sul dispositivo.

Privacy

E possibile trovare e regolare tutte le impostazioni sulla privacy.

1 Nella schermata delle impostazioni, toccare Privacy.

2 Personalizzare le impostazioni.

Gestione autorizzazioni: Consente di controllare e cambiare le
autorizzazioni concesse alle app.

Blocco schermo: Consente di impostare le notifiche da visualizzare sul
blocco schermo.

Rendi visibili le password: attivare questa opzione per visualizzare
rapidamente ciascun carattere della password mentre si digita per vedere
cosa si sta immettendo.

Compilazione automatica Google: azionare questa opzione per inserire le
informazioni salvate nel proprio account come password, indirizzo, 0 numero
di carta di credito con un singolo tocco. E possibile anche disattivare questa
opzione, usare la funzione Google Autocomplete, oppure aggiungere un
nuovo account di servizio.

Cronologia delle posizioni Google: Consente di abilitare o disabilitare

la Cronologia delle posizioni. Quando ¢ abilitata, Google periodicamente
memorizza e utilizza i dati sulla posizione piti recenti del telefono in
connessione con laccount Google.

Nella schermata Cronologia delle posizioni, toccare ¢ per visualizzare e/o
gestire i dati sulla posizione.

Gestione attivita: Seleziona attivita e informazioni che si desidera vengano
salvate da Google.
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+ Annunci: Consente di controllare D pubblicita e impostare le pubblicita
personalizzate.

- Utilizzo e diagnostica: Abilitare questa opzione per migliorare ['esperienza
Android inviando automaticamente a Google dati diagnostici e sull'utilizzo
del dispositivo e delle app.

Posizione

E possibile controllare come vengono condivise le informazioni sulla propria
posizione e configurare l'autorizzazione per accedere alle informazioni sulla propria
posizione.

Nella schermata delle impostazioni, toccare Posizione e impostare la funzione
desiderata.

Estensioni

Smart Doctor

E possibile utilizzare Smart Doctor per esequire una diagnosi dello stato del
dispositivo e ottimizzarlo.

Nella schermata delle impostazioni, toccare Estensioni > Smart Doctor.

Gaming
E possibile configurare le impostazioni di gioco per gli strumenti, la grafica e il
risparmio energetico.
1 Nella schermata delle impostazioni, toccare Estensioni > Gaming.
7 Personalizzare le sequenti impostazioni:
- Launcher Del Gioco: Toccare () ) per usare la funzione Launcher Del Gioco.

- Strumenti di gioco: E possibile eseguire la funzione durante il gioco
toccando licona degli strumenti di gioco tra i pulsanti a sfioramento anteriori.

- Grafica di gioco: Regola la grafica di gioco.
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5 « Se si modifica la risoluzione video di alcuni giochi, le funzioni di visualizzazione dello
schermo potrebbero non funzionare correttamente.

+ Questa funzione potrebbe non essere disponibile per alcune app di gioco.

- Tempo di pausa: Riduce la luminosita dello schermo e le prestazioni, ogni
volta che si abbandona il gioco per piti di 5 minuti.

Dual App

E possibile installare app di messaqgistica duplicate nel prodotto e utilizzare due

account contemporaneamente.

71 Nella schermata delle impostazioni, toccare Estensioni > Dual App.

2 Dopo aver letto la dichiarazione di non responsabilita, toccare Conferma.

3 Nell'elenco delle app disponibili, toccare Installa per installare una copia dellapp
desiderata e sequire le istruzioni visualizzate sullo schermo.

« Sullo schermo viene visualizzato [elenco delle app duplicate disponibil.
Durante linstallazione, sulla schermata Home vengono generate le icone
delle app.

Collegamenti

E possibile utilizzare pulsanti quali accensione/blocco, volume e Assistente Google
per esequire direttamente determinate app o funzioni.

T Nella schermata delle impostazioni, toccare Estensioni > Collegamenti.

2 Personalizzare le sequenti impostazioni.

« Apri Fotocamera: premere il tasto di accensione due volte per awiare la
Fotocamera.

+ Apri Promemoria a schermo spento: quando lo schermo é bloccato o
spento, premere due volte il tasto volume su (+) per aprire promemoria off
screen.

+ Apri Fotocamera: quando lo schermo é bloccato o spento, premere due
volte il tasto volume giti (-) per awiare Fotocamera.

+ Apri Assistente Google: premere il tasto Assistente Google sul lato del
telefono.

« Parla con Assistente Google: tenere premuto il tasto Assistente Google
per parlare rapidamente con [Assistente.
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E « Assistente Google non supporta alcune lingue.

Toc Toc
Esequire un doppio tocco sullo schermo per spegnerlo o accenderlo.
Per i dettagli, vedere, consultare la sezione Toc Toc.

Applicazioni

E possibile controllare lelenco delle app installate e configurare le impostazioni per
notifiche, autorizzazioni delle app e altro ancora.

T Nella schermata delle impostazioni, toccare Applicazioni.

2 Personalizzare le impostazioni.

Batteria

E possibile visualizzare le informazioni sulla batteria corrente o attivare la modalita
risparmio energetico.

7 Nella schermata delle impostazioni, toccare Batteria.

7 Personalizzare le seguenti impostazioni:
- Utilizzo della batteria: consente di visualizzare i dettagli sull utilizzo della
batteria.
- Batteria adattiva: consente di risparmiare la batteria impedendo
lesecuzione in background delle app.

Limiti di Background: abilitare questa opzione per limitare le app in
background e risparmiare la batteria durante ['uso del dispositivo. Le app
con limitazioni per il risparmio energetico potrebbero non funzionare
correttamente o potrebbero non inviare notifiche.

- Risparmio energetico: consente di ridurre il consumo della batteria
riducendo alcune impostazioni del dispositivo, come la luminosita del display,
la velocita e lintensita della vibrazione.

Eccezioni del risparmio energetico: seleziona le app che vengono

utilizzare senza alcuna restrizione in modalita di risparmio energetico o di
ottimizzazione della batteria.
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Archiviazione

E possibile visualizzare e gestire la memoria interna sul dispositivo o lo spazio di
archiviazione della scheda di memoria.

1 Nella schermata delle impostazioni, toccare Archiviazione.

2 Personalizzare le seguenti impostazioni:

+ Archivio interno: consente di visualizzare lo spazio di archiviazione totale
e lo spazio libero nella memoria interna del dispositivo. Visualizza un elenco
delle app in uso e la capacita di archiviazione di ciascuna app.

« Scheda SD: consente di visualizzare lo spazio di archiviazione totale e lo
spazio libero nella scheda di memoria. Questa opzione compare soltanto
quando viene inserita una scheda di memoria. Per disattivare la scheda di
memoria, toccare

Account

E possibile aggiungere utenti con i quali condividere e registrare un account cloud.
1 Nella schermata delle impostazioni, toccare Account.

7 Personalizzare le impostazioni.

Benessere digitale e Controllo genitori

E possibile visualizzare il tempo di utilizzo del prodotto e impostare il timer per
ciascuna app. E possibile inoltre gestire il tempo di utilizzo del telefono cellulare
utilizzando la modalita di preparazione al sonno e la modalita di messa a fuoco.

Nella schermata delle impostazioni, selezionare Benessere digitale e Controllo
genitori e impostare la funzione desiderata.

Google

E possibile utilizzare le impostazioni di Google per gestire le proprie app e le
impostazioni dell'account di Google.

Nella schermata delle impostazioni, toccare Google.
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Sistema

Centro aggiornamenti

Puoi controllare e installare la versione pit recente dell'app o del software fornito
alG

T Nella schermata delle impostazioni, toccare Sistema > Centro aggiornamenti.

7 Personalizzare le seguenti impostazioni:
- Aggiornamento applicazione: controlla se & disponibile un aggiornamento.
Se disponibile, puoi installare ['aggiornamento.
« Aggiornamento software: controlla se e disponibile un aggiornamento
software. Se disponibile, puoi installare ['aggiornamento.

Lingua e tastiera
E possibile personalizzare le impostazioni di lingua e tastiera del dispositivo.

1 Nella schermata delle impostazioni, toccare Sistema > Lingua e tastiera.

7 Personalizzare le sequenti impostazioni:
« Lingua: consente di selezionare una lingua da applicare al dispositivo.

- Gestisci tastiere: e possibile modificare le impostazioni di base della tastiera
del prodotto, impostare gli ambienti di utilizzo per la tastiera LG o altre
tastiere installate e impostare la funzione di riconoscimento vocale per i
comandi con Google Vioice. E possibile inoltre impostare se visualizare il
pulsante della tastiera nell'area dei pulsanti a sfioramento della schermata
Home, in modo da poter passare rapidamente a un'altra tastiera.

- Tastiera fisica: selezionare per usare |a tastiera fisica, o controllare i tasti dei
collegamenti da tastiera.

- Correttore ortografico: consente di impostare varie opzioni per la il
correttore ortografico di Google.

+ Servizio Compilazione automatica: azionare questa opzione per inserire le
informazioni salvate nel proprio account come password, indirizzo, o numero
di carta di credito con un singolo tocco. Puoi anche disattivare questa
opzione, usare Google Autocomplete, 0 aggiungere un nuovo account di
servizio.

« Lettura text-to-speech: consente di configurare le impostazioni delloutput
sintesi vocale.
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+ Velocita del puntatore: consente di regolare la velocita del puntatore di un
mouse o trackpad.

« Inverti i pulsanti del mouse: consente di invertire il pulsante destro del
mouse in modo che esegua le principali azioni di manipolazione diretta.

Data e ora
E possibile personalizzare le impostazioni di data e ora del dispositivo.
T Nella schermata delle impostazioni, toccare Sistema > Data e ora.

7 Personalizzare le impostazioni.

Memoria

Consente di visualizzare la quantita media di utilizzo della memoria in un
determinato periodo di tempo e la memoria occupata da unapp.

1 Nella schermata delle impostazioni, toccare Sistema > Memoria.

2 Toccare w per impostare una fascia oraria per il recupero dei dati.

Backup
E possibile esequire il backup dei dati salvati sul dispositivo su un altro dispositivo o
account.

1 Nella schermata delle impostazioni, toccare Sistema > Backup.

7 Personalizzare le sequenti impostazioni:

+ LG Mobile Switch: consente di trasferire i dati da un vecchio dispositivo LG a
quello nuovo. Per i dettagli, vedere, consultare la sezione LG Mobile Switch.

+ Backup e ripristino: consente di eseguire il backup dei dati del dispositivo o
ripristinare i dati di un backup nel dispositivo.

A « llripristino del dispositivo potrebbe eliminare i file di backup salvati nellarchivio.
Assicurarsi di copiare e salvare i file di backup importanti nel proprio PC.

- Google Backup: modifica le impostazioni di backup di Google. E possibile

anche controllare 'account di backup attualmente usato, o aggiungere un
nuovo account di backup.
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Riavvio & Ripristino
E possibile ripristinare il dispositivo, includendo le impostazioni di rete e app.
1 Nella schermata delle impostazioni, toccare Sistema > Riavvio & Ripristino.

7 Personalizzare le sequenti impostazioni:

+ Riavvio automatico: riavvia e ottimizza automaticamente il telefono allora
impostata. Toccare () ) per attivare la funzione. Il dispositivo si riawia
automaticamente all'ora impostata e si ottimizza. Seleziona la data e l'ora
del riawvio.

E - Puoiimpostare il dispositivo affinché si riawii una volta la settimana. Il dispositivo
si riavvia automaticamente entro un'ora dall'ora impostata.

Una volta che il dispositivo si riawvia, le notifiche e i badge sono cancellati. Salvare i

dati importanti prima dell'ora preimpostata.

+ Lafunzionalita di riavvio automatico non ¢ attivata nelle seguenti situazioni.

Quando lo schermo ¢ acceso, quando il dispositivo & in uso, quando il livello della

batteria & il 30% o meno, o quando la scheda USIM ¢ bloccata.

- Aseconda del fornitore del servizio di telecomunicazione, la funzione di riawio
automatico potrebbe non essere disponibile.

Ripristino delle impostazioni della rete: consente di ripristinare Wi-Fj,
Bluetooth e altre impostazioni di rete.

Ripristina preferenze applicazione: ripristina le impostazioni dio un'app. |
dati salvati nell'app non saranno cancellati.

Ripristino dati di fabbrica: consente di ripristinare tutte le impostazioni del
dispositivo ed eliminare i dati.

E « llripristino e il riawio del dispositivo elimina tutti i dati presenti sullo stesso. Inserire
nuovamente il nome del dispositivo, laccount Google e altre informazioni iniziali.

« Dopo linizializzazione dei dati, i dati non possono pili essere recuperati.

Info sul telefono

5 possibile visualizzare informazioni sul dispositivo, come nome, stato, dettagli
software e informazioni legali.

Nella schermata delle impostazioni, toccare Sistema > Info sul telefono e
visualizzare le informazioni.
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Normative & Sicurezza

E possibile visualizzare i certificati normativi e le relative informazioni sul proprio
dispositivo.

Nella schermata delle impostazioni, toccare Sistema > Normative & Sicurezza.

Accesso facilitato

E possibile gestire i plugin di accessibilita installati sul dispositivo.

T Nella schermata delle impostazioni, toccare Accesso facilitato.

7 Personalizzare le seguenti impostazioni:

Visione > TalkBack: consente di impostare il dispositivo in modo da
notificare lo stato dello schermo o le azioni tramite voce.

Visione > Notifiche vocali:impostare sul dispositivo la lettura delle
informazioni del chiamante tramite voce.

Visione > Carattere: modificare dimensione, grassetto, o facciata.

Visione > Dimensioni display: consente di impostare gli elementi presenti
sullo schermo su dimensioni facilmente visibili per l'utente. Alcuni elementi
potrebbero cambiare posizione.

Visione > Zoom touch: consente di eseguire lo zoom avanti o indietro
toccando lo schermo tre volte.

Visione > Zoom della finestra: consente di eseguire lo zoom avanti o
indietro allinterno di una finestra e invertire il colore.

Visione > Puntatore del mouse grande: consente di ingrandire il puntatore
del mouse.

Visione > Schermo ad alto contrasto: consente di modificare il colore di
sfondo in nero per uno schermo ad alto contrasto.

Visione > Inversione del colore dello schermo: consente di aumentare il
contrasto del colore del display per le persone ipovedenti.

Visione > Regolazione del colore dello schermo: consente di regolare il
colore del display.

Visione > Monocromatico: consente di far passare lo schermo alla modalita
scala di grigi.
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« Visione >Termina le chiamate con il tasto di accensione: consente di
terminare una chiamata premendo il tasto di accensione/blocco.

+ Udito > Preferenze di didascalia: consente di attivare il servizio dei
sottotitoli durante la riproduzione di video per non udenti.

+ Udito > Flash allarme: consente di impostare il dispositivo in modo da
notificare all'utente le chiamate in arrivo, i messaggi e le sveglie con una luce
lampeggiante.

+ Udito > Disattiva tutti i suoni: consente di disattivare tutti i suoni e
abbassare il volume sul ricevitore.

+ Udito > Canale audio: consente di selezionare il tipo di audio.
+ Udito > Bilanciamento del suono: consente di regolare il bilanciamento

dell'uscita audio. Consente di utilizzare la barra di scorrimento per modificare
il bilanciamento.

+ Movimento & cognizione > Touch assistant: consente di attivare il pannello
touch per facilitare [utilizzo di pulsanti e gesti.

- Movimento & cognizione > Input tattile: consente di immettere il testo
toccando e tenendo premuto lo schermo, o di modificarlo semplicemente
toccando lo schermo.

+ Movimento & cognizione > Tastiera fisica: consente di personalizzare le
impostazioni della tastiera.

+ Movimento & cognizione > Click automatico del mouse: consente di
cliccare il puntatore del mouse automaticamente in caso di assenza di
movimento.

- Movimento & cognizione > Tocca e tieni premuto per le chiamate:
consente di rispondere o rifiutare le chiamate toccando e tenendo premuto il
pulsante di chiamata, invece di trascinarlo.

+ Movimento & cognizione > Timeout schermo: consente di disattivare
automaticamente lo schermo quando il dispositivo viene lasciato inattivo per
un determinato periodo di tempo.

+ Movimento & cognizione > Aree di controllo tattile: consente di limitare
l'area touch in modo che soltanto una determinata porzione dello schermo
possa essere controllata dall'inserimento touch.
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« Collegamento alle funzioni di accessibilita: consente di accedere
rapidamente alle funzioni di uso frequente premendo contemporaneamente
il tasto di accensione e il tasto volume su.

- Rotazione automatica: consente di cambiare automaticamente
lorientamento dello schermo a seconda della posizione fisica del dispositivo.

Seleziona per ascoltare: consente di toccare gli elementi e ricevere una
risposta vocale.

« Switch Access: consente di creare combinazioni di tasti per controllare il
dispositivo.
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Impostazioni della lingua LG

E possibile selezionare una lingua da utilizare sul dispositivo.
+ Nella schermata Home, toccare Impostazioni > Sistema > Lingua e tastiera >
Lingua > Aggiungi lingua, quindi selezionare una lingua.
- Toccare e tenere premuta = quindi trascinarla in cima allelenco delle lingue
per impostarla come lingua predefinita.

LG Bridge

Informazioni generali su LG Bridge

E possibile esequire il backup dei contatti, delle foto e di altri elementi sul computer
o0 aggiornare il software del dispositivo.

« Peridettagli, vedere la guida di LG Bridge.
« Le funzioni supportate possono variare a seconda del dispositivo.

« Il driver USB LG e un programma necessario per connettere o smartphone LG con
il computer e viene installato quando si installa LG Bridge.

Fun2|on| di LG Bridge

Consente di eseguire il backup dei dati dal dispositivo a un computer o
ripristinare i dati da un computer al dispositivo tramite un collegamento con
cavo USB.

+ Consente di aggiornare il software del dispositivo da un computer tramite un
collegamento con cavo USB.
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Installazione di LG Bridge su un computer
1 Andare sul sito wwwlg.com dal proprio computer.

7 Selezionare la regione.

3 Fare clic su Supporto > Software e firmware.

4

Immettere il nome del dispositivo.
OPPURE
Selezionare Categoria prodotto.

5 Andare a Sync PC > LG Bridge per scaricare il file di installazione.

+ Andare su Dettagli per visualizzare i requisiti minimi per l'installazione di LG
Bridge.

Aggiornamento software del telefono

Aggiornamento software del telefono LG Mobile da

Internet

Per ulteriori informazioni sull'utilizzo di questa funzione, visitare
http//wwwi.lg.com/common/index,sp, selezionare il paese e la lingua.

Questa funzione consente di aggiornare facilmente il firmware del telefono a
una versione pitl recente da Internet senza la necessita di visitare un centro

di assistenza. Questa funzione sara disponibile solo se e quando LG mette a
disposizione una nuova versione del firmware per il dispositivo.

Poiché laggiornamento del firmware del telefono cellulare richiede la massima
attenzione da parte dell'utente per tutta la durata del processo di aggiornamento,
assicurarsi di controllare tutte le istruzioni e le note visualizzate a ogni passaggio
prima di procedere. Si prega di notare che la rimozione del cavo USB durante
laggiornamento puo danneggiare gravemente il telefono cellulare.

E « LGsiriserva il diritto di rendere disponibili aggiornamenti del firmware
esclusivamente per modelli selezionati a propria discrezione e non garantisce la
disponibilita della versione piti recente del firmware per tutti i modelli di cellulari.
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Aggiornamento software del telefono LG Mobile
tramite Over-the-Air (OTA)

Questa funzione consente di aggiornare facilmente il software del telefono a una

nuova versione tramite OTA, senza collegamento di un cavo USB. Questa funzione
sara disponibile solo se e quando LG mette a disposizione una nuova versione del

firmware per il dispositivo.

Per eseguire [aggiornamento del software del telefono,

Impostazioni > Sistema > Centro aggiornamenti > Aggiornamento software >
Controlla aggiornamenti.

E « | dati personali dell'utente presenti sulla memoria interna del telefono, ivi comprese
le informazioni relative allaccount Google e qualsiasi altro account, i dati e le
impostazioni di sistema/applicazioni, le app scaricate e la licenza DRM potrebbero
andare perduti nel processo di aggiornamento del software del telefono. Pertanto,
LG consiglia di eseguire il backup dei dati personali prima di aggiornare il software
del telefono. LG non si assume alcuna responsabilita per eventuali perdite di dati
personali.

+ Questa funzione dipende dallarea e dal provider del servizio.
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Guida antifurto

Configurare il dispositivo per impedire ad altre persone di utilizzarlo se é stato
ripristinato alle impostazioni di fabbrica senza permesso. Ad esempio, in caso
di smarrimento, furto o cancellazione dei dati del dispositivo, solo qualcuno in
possesso delle informazioni sullaccount Google o delle informazioni sul blocco
schermo puo utilizzare il dispositivo.

Per assicurarsi che il dispositivo sia protetto e sufficiente:

+ Impostare un blocco schermo: Se il dispositivo viene smarrito o rubato, ma
si dispone di un blocco schermo, il dispositivo non puo essere cancellato

utilizzando il menu Impostazioni a meno che lo schermo non venga sbloccato.

Aggiungere il proprio account Google sul dispositivo: Se il dispositivo viene
cancellato, ma e presente un account Google su di esso, il dispositivo non
puo terminare il processo di configurazione fino a quando le informazioni
dellaccount Google non vengono nuovamente inserite.

Dopo aver protetto il dispositivo, & necessario sbloccare lo schermo o immettere la
password dellaccount Google, se & necessario effettuare un ripristino di fabbrica.

Questo fa si che il ripristino venga effettuato da una persona di fiducia.

E + Non dimenticare account Google e la password aggiunti al dispositivo prima
di eseguire un ripristino di fabbrica. Se non & possibile fornire le informazioni

sullaccount durante il processo di configurazione, non sara possibile utilizzare il

dispositivo dopo aver esequito il ripristino di fabbrica
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Informazioni avviso software Open
Source

Per ottenere il codice sorgente contenuto in questo prodotto secondo quanto
consentito dalle licenze GPL, LGPL, MPL e altre licenze Open Source, visitare
http://opensource.lge.com.

In aggiunta al codice sorgente, sono disponibili per il download tutti i termini di
licenza, le esclusioni di responsabilita e e relative note di copyright.

LG Electronics fornira anche il codice open source su CD-ROM su richiesta tramite
e-malil all'indirizzo opensource@I|ge.com addebitando il costo delle spese di
distribuzione (ad esempio il costo di supporti, spedizione e gestione).

Lofferta e valida per un periodo di tre anni a partire dalla nostra ultima spedizione
di questo prodotto. Lofferta e valida per gli utenti che avranno ricevuto queste
informazioni.

Informazioni sulle normative
(Numero ID normativa, etichetta
digitale ecc.)

Per informazioni sulle normative, andare in Impostazioni > Sistema > Normative
& Sicurezza.
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Marchi di fabbrica

+ Copyright ©2020 LG Electronics Inc. Tutti i diritti riservati. LG e il logo LG sono
marchi registrati del Gruppo LG e delle sue entita correlate.

+ Google, Google Maps, Gmail, YouTube, Google Duo, Google Play, Android, Chrome,
Google Photos, Google Play Protect, Google Calendar, Google Docs, Google Drive,
Google Sheets e altri marchi e logo correlati sono marchi di Google LLC.

- Bluetooth® & un marchio registrato di Bluetooth SIG, Inc. nel mondo.
- Wi-Fi® e il logo Wi-Fi sono marchi registrati di Wi-Fi Alliance.
« Tutti gli altri marchi sono di proprieta dei rispettivi titolari.

HE HEVCAdvance™

‘: Covered by Patents at patentlisthevcadvance.com
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Dichiarazione sulla sicurezza del laser

Attenzione!

Questo prodotto utilizza un sistema laser. Per garantirne un utilizzo corretto,
leggere attentamente il presente manuale dell'utente e conservarlo come
riferimento per il futuro. Se 'unita richiede manutenzione, contattare un centro di
assistenza autorizzato.

Lutilizzo di controlli e regolazioni o lesecuzione di procedure diverse da quelle
specificate puo provocare lesposizione a radiazioni pericolose.

Per evitare lesposizione diretta al fascio laser, non tentare di aprire l'involucro o
entrare in contatto diretto con il laser.

CLASS 1 LASER PRODUCT
KLASSE 1 LASER PRODUKT
LUOKAN 1 LASER LAITE

KLASS 1 LASER APPARAT

CLASSE 1 PRODUIT LASER

DICHIARAZIONE DI CONFORMITA

Con il presente documento, LG Electronics dichiara che il prodotto
LM-K520EMW e conforme ai requisiti essenziali e alle altre disposizioni della
Direttiva 2014/53/EU.

Una copia della Dichiarazione di conformita e disponibile allindirizzo
http7//wwwi.lg.com/global/declaration
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Contattare 'ufficio relativo alla
conformita del prodotto

LG Electronics European Shared Service Center BV.

Krijgsman 1, 1186 DM Amstelveen, The Netherlands

Wi-Fi (WLAN)

Labanda 5150 - 5350 MHz e limitata esclusivamente all'utilizzo domestico.
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Ulteriori informazioni

Parti in vetro temperato
Le parti in vetro temperato di questo dispositivo non sono permanenti e possono
usurarsi col passare del tempo.
+ Se silascia cadere il dispositivo su una superficie dura o lo si espone a un urto
violento, il vetro temperato potrebbe danneggiarsi.
In questi casi, interrompere immediatamente 'uso del dispositivo e contattare
un Centro di assistenza clienti LG.
+ Sul mercato sono disponibili apposite custodie per proteggere il dispositivo da
eventuali danni.
Tenere presente che tali custodie protettive non sono coperte dal servizio di
garanzia fornito da LG Electronics e non ne viene garantita la sicurezza.

Proporzioni
Questo dispositivo utilizza le proporzioni 20,59.
« Alcune app scaricate potrebbero non supportare le proporzioni 20,5:9.

In tal caso, selezionare le proporzioni dello schermo piti adatte allapp o
consultare il provider dell'app per ulteriori informazioni.

CUSTOMER CARE

c 199600044

Per conoscere gli orari di apertura e i relativi costi ti invitiamo a visitare il sito di LG
[talia wwwilg.com/it
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Guida al trasferimento dati

+ Per i dati trasferibili tra dispositivi LG e tra un dispositivo LG e un dispositivo di
parti terze, vedere lo schema seguente.

Dispositivo Ii':z:s:;“;? Dispositivo
LG . i0S
parti terze
Tipo Dettagli dell'elemento - N —
Dlspféltwo Dispositivo Dlsplt-)éltlvo
LG
Contatti, messaggi, registri
chiamate, calendario, 0 0 0
Dati registrazioni audio
i
personat Promemoria X 0
Sveglie X X
Datll - Foto, wdeq, canzoni, 0 0 0
multimediali | documenti
Impostazioni della schermata
) 0 X X
home (cartelle e widget)
dischermo Impostazioni della schermata
di blocco (impostazioni di 0 X X
blocco schermo escluse)
App scaricate 0 0
Applicazioni | i personali contenuti nelle 0 X -
app scaricate
Certificato pubblico 0 0 X
A hamate o
' f 0 X X

e notifiche, accessibilita,
batteria)

E « Alcune dati potrebbero non essere trasmessi a seconda della versione del
software, della versione delle app, del sistema operativo, e delle politiche del

produttore del dispositivo o del gestore del servizio.
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Bande di frequenza supportate Potenza in uscita trasmettitore

GSM 900 337dBm
GSM 1800 30.7dBm
WCDMA B1 25.0dBm
\WCDMA B8 25.5dBm

LTEB1 24.7 dBm
LTE B3 247 dBm
LTE B7 24.7 dBm
LTE B8 252 dBm

LTEB20 252dBm

LTE B28 252 dBm

LTEB38 24.7 dBm

BT 9.5dBm
WLAN 2.4GHz 18.5dBm
WLAN 5GHz 15.0 dBm

NFC -13 dBuA/m

Le informazioni sulladattatore da viaggio si possono trovare su
http//wwwi.lg.com/global/support/cedoc/cedoc
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Smaltimento delle apparecchiature obsolete

1. Tutte le apparecchiature elettriche ed elettroniche, contrassegnate da
questo simbolo ("bidone della spazzatura barrato da una croce”), devono
essere raccolte e smaltite separatamente rispetto agli altri rifiuti urbani
misti mediante impianti di raccolta specifici installati da enti pubblici o dalle

I autorita locali. Si ricorda che gli utenti finali domestici possono consegnare
gratuitamente le apparecchiature elettriche ed elettroniche a fine vita presso
il punto vendita all‘atto dellacquisto di una nuova apparecchiatura equivalente.
Gli utenti finali domestici possono inoltre consegnare gratuitamente
apparecchiature elettriche ed elettroniche di piccolissime dimensioni (non
eccedentii 25 cm) a fine vita direttamente presso un punto vendita a cio
abilitato, senza obbligo di acquistare una apparecchiatura nuova di tipo
equivalente. Si prega di informarsi previamente presso il punto vendita
prescelto circa tale ultima modalita di conferimento dellapparecchiatura a fine
vita.

2.1l corretto smaltimento dell'unita obsoleta contribuisce a prevenire possibili
conseguenze negative sulla salute degli individui e sullambiente. Una gestione
responsabile del fine vita delle apparecchiature elettriche ed elettroniche
da parte degli utenti contribuisce al riutilizzo, al riciclaggio ed al recupero
sostenibile dei prodotti obsoleti e dei relativi materiali.

3. Per informazioni piti dettagliate sullo smaltimento delle apparecchiature
obsolete, contattare ['ufficio del comune di residenza, il servizio di
smaltimento rifiuti o il punto vendita in cui & stato acquistato il prodotto.
(www.lg.com/global/recycling)

Smaltimento delle batterie/accumulatori

1. Questo simbolo potrebbe essere associato ai simboli chimici del mercurio (Hg),
cadmio (Cd) o piombo (Pb) se la batteria contiene piti di 0,0005% di mercurio,
0,002% di cadmio 0 0,004% di piombo.

2. Tutte le batterie e gli accumulatori devono essere smaltiti separatamente
rispetto alla raccolta differenziata municipale, mediante impianti di raccolta
specifici designati dal governo o dalle autorita locali.

3.l corretto smaltimento di batterie e accumulatori obsoleti contribuisce a
prevenire possibili conseguenze negative sullambiente, sulla salute degli
individui e su tutte le altre specie viventi.

4. Per informazioni piti dettagliate sullo smaltimento di batterie e accumulatori
obsoleti, contattare ['ufficio del comune di residenza, il servizio di smaltimento
rifiuti o il negozio in cui & stato acquistato il prodotto.
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FAQ

In questo capitolo sono descritti alcuni problemi che potrebbero verificarsi durante
l'uso del dispositivo. Alcuni problemi richiedono una chiamata al provider del
servizio, ma la maggior parte e facilmente risolvibile in autonomia.

Errore scheda SIM

Assicurarsi che la scheda SIM sia inserita correttamente.

Nessuna connessione alla rete o connessione di rete interrotta
Il segnale & debole. Spostarsi verso una finestra o in uno spazio aperto.
Sei al di fuori dellarea coperta dal fornitore di rete. Spostati e controlla la rete.

Le chiamate non sono disponibili
Nuova rete non autorizzata.

Assicurati di non avere impostato il blocco chiamate dal numero che effettua la
chiamata.

Assicurati di non avere impostato il blocco chiamate dal numero che stai
chiamando.

Non é possibile accendere il dispositivo
Quando la batteria & completamente scarica, il tuo dispositivo non si accende.
Ricaricare completamente la batteria prima di accendere il dispositivo.

Errore di caricamento

Assicurarsi che il dispositivo sia in carica a una temperatura normale.
Controllare il caricabatteria e il suo collegamento al dispositivo.
Utilizzare solo gli accessori forniti autorizzati da LG.

La batteria si scarica piu rapidamente rispetto a quando é
stata acquistata

Esponendo il dispositivo o la batteria a temperatura molto alte o molto basse, la
durata della batteria potrebbe ridursi.

Il consumo della batteria aumenta quando si usano certe app o funzionalita, come
GPS, giochi o internet.

La batteria e usurabile e la sua durata si riduce nel corso del tempo.
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Messaggi d'errore vengono visualizzati quando si avvia la
fotocamera.

Ricaricare la batteria.

Liberare memoria trasferendo i file a un computer o cancellando i file dal proprio
dispositivo.

consente di riawviare il dispositivo.

Se i problemi con app della fotocamera persistono dopo avere tentato con questi
suggerimenti, contattare il centro di assistenza LG Electronics.

La qualita delle foto & bassa.

La qualita delle foto potrebbe variare, a seconda dellambiente e delle tecniche
fotografiche usate.

Quando si realizzano foto e video, la qualita angolare standard & migliora rispetto al
grandangolo.

Realizzando foto in posti bui, di notte o interni, potrebbero essere presenti disturbi
o le immagini potrebbero essere sfocate.

In caso di problemi, azzerare le opzioni.

Lo schermo tattile risponde lentamente o in modo non
corretto

Collegando una protezione per lo schermo o accessori opzionali allo schermo tattile,
potrebbe non funzionare correttamente.

Indossando guanti, se le mani non sono pulite quando si tocca lo schermo tattile o
si sfiora lo schermo usando oggetti affilati o le punte delle dita, lo schermo tattile
potrebbe non funzionare.

Lo schermo tattile potrebbe non funzionare correttamente in condizioni di umidita
0 quando & esposto allacqua.

Riawviare lapparecchio per annullare eventuali bug del software.

Se lo schermo tattile e graffiato o danneggiato, visitare un centro di assistenza LG
Electronics.
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Chiude la chiamata o si blocca

Riavviare il dispositivo.
« Se il dispositivo si chiude la chiamata o si blocca, potrebbe essere necessario
chiudere le applicazioni o spegnere del tutto il dispositivo e riaccenderlo.

Eseguire un riavvio
- E possibile utilizzare un ripristino superficiale del dispositivo se lo schermo
si blocca oppure se i pulsanti, lo schermo a sfioramento o il dispositivo non
rispondono pill in modo corretto.
+ Per esequire un ripristino superficiale del dispositivo, tenere premuti i tasti
Volume giti e Power fino a quando il dispositivo non si riavvia.

Azzerare il dispositivo
+ Seimetodiillustrati sopra non risolvono il problema, esequire un ripristino dati
di fabbrica.
+ Nella schermata delle impostazioni, toccare Sistema > Riavvio & Ripristino >
Ripristino dati di fabbrica.
- Questo metodo consente di ripristinare tutte le impostazioni del dispositivo
ed eliminare i dati. Prima di esequire il ripristino dei dati di fabbrica, effettuare
copie di backup di tutti i dati importanti salvati nel dispositivo.

- Seil dispositivo & associato a un account Google, effettuare laccesso allo
stesso account Google dopo il ripristino.
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L'apparecchio Bluetooth non € localizzato
Assicurarsi che la funzionalita wireless Bluetooth sia attivata sul dispositivo.

Assicurarsi che la funzionalita wireless Bluetooth sia attivata sul dispositivo a cui
vuoi connetterti.

Assicurarsi che il dispositivo e altri dispositivi Bluetooth siano nellarea massima del
Bluetooth (10 m)

Se i suggerimenti indicati non ti hanno aiutato a risolvere il problema, contatta un
centro di assistenza LG Electronics.

Quando colleghi il tuo apparecchio a un computer, non viene
stabilita una connessione.
Assicurarsi che il cavo USB che stai usando sia compatibile con il tuo apparecchio.

Assicurarsi che sul proprio computer siano installati e aggiornati i driver nella
versione corretta.

Un'applicazione scaricata sta causando molti errori.
L'applicazione presenta dei problemi.
Rimuovere e reinstallare applicazione.
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EAAHNIKA
MAnpo@opieg OXETIKA UE AUTO TO

gyxepidio xpnong

Yag euxaploToUpE Tou eMAEEaTE AUTO To TTPOIOV LG. Nal Tnv ao@ali Kat owoTn
XPrion TG CUOKEUNG, TAPAKAAEIOTE va SIaBACETE MPOTEKTIKA AUTO TO EYXELPISI0
TIPWV XPNOIHOTOIOETE TN CUCKEUH yla TIPWTN QOPA.

- Na xpnotpomoleite mavtote yvriola agecoudp LG. Ta mapexopeva e§apTripata
TipoopiCoval AmOKAEIOTIKA YIal XPrioN HE AUTHY TNV GUOKEUN Kal EVOEXETaL va
unv eivat oupBatd pe AMNEG CUOKEUEC,

« Otmeplypagéc Bacifovtal oTig MpoemAeYUEVEG PUBIOELS TNG OUOKEUNG.

OL TIPOEYKATECTNHEVES EPAPLIOYEG 0T GUOKEUK UTIOKEIVTAL OE EVNUEPWOELG,
Kal 1 TTapoxT| UMOOTAPIENG VIO AUTEC TIC EQAPHOYES EVOEKETAL VA SLOKOTTE
Xwpi¢ mpoeidomoinon. Ev éxeTe EpWTHOELC OXETIKA LIE L0l EQAPLOYI TIOU
TIAPEXETAL LIE Tr) OUOKEUN), EMKOWVWVAOTE PE éva KEvTpo emokeuwv TG LG.
TXETIKA HE EQAPHOYE TIOU EXOUV EYKATAOTABEL A6 TOV XPHOTN, UMOPEITE Val
ETMIKOWWVIOETE PIE TOV APHOSIO TIAPOXO UTINPECIWV.

+ H tpomomoinon Tou A&lToupykoU GUGTAKATOC TNG CUOKEUNG 1 N EYKATAOTACN
MOyIopIKOU amo avemionpeg myég umopei va mpokahéoel BAABN oTn ouokeur
Kat va 0dnynoel o€ Kataotpo®n 1 anwAela Sedopévwvy. Tétolou gidoug
evépyelec anmoteholy mapaBiaon g adelag xpriong e LG Kat €xouv w¢
QmOTENEGHA TNV AKUPWON TG EYYUNONG 00G.

Kdmolo meplexOpeVo Kal EIKOVEC UMopE( va Sla@épouv oe axéon He TN
GUCKEUN 00C, avAAoya LE TNV TIEPLOKT, TOV TIAPOXO UTINPESIWY, TV €KSoon
TOU AOYIGUIKOU 1 TNV €KS00N TOU AEITOUPYIKOU CUOTAKATOC, KAl UMOpEi va
aMdG€ouv xwpic mpoeidomoinon.

+ To MoyIOUIKO, OL XOl, Ol TATETOAPIEC, Ol EIKOVES Kat BAAA Uéoa TTou TIapExovTal
padi pe Tn GUOKELN 0ag ouVOSEVOVTAL OO AGEL VIO TIEPIOPICUEVN XPriON.
Tuxdv e€aywyn Kat Xprion autwv Twv VMKWV Yia UTopIKoUG r AAOUG OKOTIOUG
evOEXETAL VO OLVIOTA TTAPABIcN TWV VOUWY TERT TIVEUMATIKWV SIKAUWUATWV.
Q¢ TENKOG XPAOTNG, EXETE TNV TP €UBUVN yia TUXOVV TAPAvVOuN XProN Twv
HEOWV QUTWV.

EvSéyetat va umdpyouv mpAoBeTeS XpeWTELS yia TN peaieg SeSopévwy, OTwG
Yia TIC U peoieg avTaAayng INVURATWY, T @opTwon i T Mjwn Sedopévwy,
TOV QUTOHATO CUYXPOVIOUO Kal TIG UTinpeaieg TomoBeaiag. MNa va unv
€MBOPUVEDTE Ue MPOOBETEC XPEWTELC, EMAECTE éva TpOypappa dedopévwv
TI0U VOl KAAUTITEL TIG AVAYKEG GG, ETTIKOIVWVIOTE L TOV IAPOXO UTTNPECIWV 0O
Y10 TTEPIOOOTEPEC NETTTOUEPELEG,



- To mapdv eyxelpidio xpriong éxet ouvtayBei oTig BaoikéC Y\wWooeC yia KdBe
Xwpa. Avaloya pE T YAWooa TTou XPnOLHOTIOLEITAL, TO TIEPLEXOUEVO EVEEKETAL
va Slagoporoleital.

ZUUBOVAEUTIKEG AVAKOIVWOELC

MPOEIAONMOIHZH: KataoTagoelg mou Umopei va MPOoKAaAéCOULV TPAUHATIOHO
TOU XPAOTN KAl TPITWV.

A MPOZOXH: Kataotdoelg mou pmopei va mpoKaAéaouv ENapPU TPAUHATIOHO
1 {nWa 0T GUOKEUH.

5 THMEIQZH: Avakovwoelg 1y TpdoBeTeq TANPOQOpIEC.

MAnpo@opieg OXETIKA PE AUTO TO EYXELPISIO XPrIONG
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0d6nyisg yia ac@aln Kat amoteAEGUATIKA
Xpnon

AlaBaoTe TIg mapakdtw amég odnyieg. H un tpnon autwv Twv odnyiwv pmopei va
amnofei emkivéuvn 1 mapdvopn.

Y& MePIMTWon oQAAUATOE, N GUCKELN 0ag SlaBETel éva epyaleio Aoyiopikol Tou Ba
SnuioupyroeL éva apyxeio kataypagrg o@aiuatog. To epyaleio cuMéyel Sedopéva
€151KA Y10 TO CUYKEKPIUEVO OPAAua OTIwG Ta £€AG: LoxUG onpatog, cell ID position

0€ TIEPIMTWON AmPACHEVNG AMOPPIYNG KARONG KAl EQAPHOYEG TTOU UTIAPXOULV 0T
GUOKeUN. To apXEio KATaYPAPrG XPNOIUOTIOLETAL AMTOKAEIOTIKA YI0l TOV TPOGSIOPIoHO
NG AITiag Tou OQAAUATOG. AUTA Ta OPXEQ KATAYPAPG Eival KpUTTToypag@nuéva Kat n
TIPOORacn o€ auTd gival EPIKTH POvVo amd e€0uCIoS0TNHEVA KEVTPA EMIOKEVAG TNG LG,
O€ TIEPITTTWON TIOU XPELOOTEL Va EMOTPEWETE TN OUOKEUR OAG VIO ETIIOKEVN.

'EkBeon o¢ evépyela padlocuyvotritwy

MAnPoPopieC OXETIKA HE TNV €KBETN O€ PASIOKUHATA Kall TO GUVTENEDTH EIOIKIG
amoppd@nong (XEA).

AuTH N GUOKEUN €XEl OXESIAOTEL WOTE VOl GUMUOPPWVETAL LE TIG LOXUOUOEG AMAITHOELS
aopaleiag yia tnv ékBeon og padiokupata. Ot amartioelg autég BaciCovtal og
EMOTNUOVIKEG 0dnyieg Tou ephapBavouv mepBwpLa aopaleiag yia Ty TPooTasia
OAWV TWV aTOPWY, ave€apTnTa amod TNV NAKia fj TNV KATtdoTaon TG Uyeiag Toug.

+ XTI 08nYieg OXETIKA pE TNV éKBEDN OE PASIOKUHATA XPNOIMOTIOLETA Miat HovASa
UETpNOoNG N omoia gival yvwoTh w¢ CUVTENEDTAG EISIKNG amoppoenang i XEA. Ot
é\eyyol yla 1o XEA Sie§dyovtal pe Tumomoinpéveg HeBdS0UC, e Tn GUOKEUN va
EKTTENTTEL OTO PEYIOTO TIIOTOMOINMEVO ETMESO 10XVOG O ONEG TIC {WVES CUXVOTATWY
TIOU XPNOIUOTIOLE.

« Av Kal umopei va umapyouv Sla@opég petady Twv emmédwv Tou LEA yia
S1apopa povTéNa BUOKEUWV TNG LG, OAa Ta HovTéAa €xouv oXedIOTEl WOTE Va
QVTATIOKPIVOVTaL OTIG OXETIKEG 0dNYiEG yia TV ékBeon o€ padlokupata.

« To 6pto Tou ZEA mou ouviotatat amd t Alebvr) Emtporm Mpootaciag améd  Mn
loviCouoa AktivoBoAia (ICNIRP), givat 2 W/kg pe Bdon Tov UMoAoYIoHS TG HENG
TG ya 10 ypappdpla owpatikol 10Tou.

+ HuynAotepn T tou ZEA yia autd To povTého, Omwe éxel eheyxDei yia xprion oto
auri, givat 0,555 W/kg (10 g) kat yia xprion oto owpa givai 1,310 W/kg (10 ).



« AutA n cuokeur MAnPEOI TIG MPOUTTOBETELS Yia TN ékBEaN OE PadlooUXVOTNTEG
€iTe TAV XpNolHomolETal TNV Kavovikr Béon xpriong Sima ato auri gite dtav
Bpioketal og amdoTacn TouAdxioTov 5 mm amnd to owpa. Otav xpnotpomnoleital
BrKn petagopdg, KA {wvng fi Brkn yia xprion oto owua, Sev mpémel va
mepthapBavel pETAMIKA oTolxEla Kal TTPETEL VO GUYKPATEL TO TIPOIOV G€ amdoTaon
TOUAdXI0TOV 5 mm amd To owpa oac. Na tn petadoon apyeiwv Sedopévwy iy
UNVUPATWY, N GUOKELR amaitei Tnv Umapén moloTikA¢ oUvEeonc oTo Siktuo. Xe
OPIOHEVEG TIEPITTTWOELG, N METAS00N apyeiwv SeSopEVWY 1} UNVUPATWY UMOpPEi
va kaBuoTteproel éwg 6Tou givat Slabéoiun pia Tétota ouvdeon. Beaiwbeite ott
TNPOUVTAL Ol IAPATTAVW 08NYIEG OXETIKA HIE TNV AMAOTACK AT TO CWHA UEXPL VA
olokAnpwbei n petadoon.

MAnpo@opieg oxeTIKA pe TNV €KOEDN GE PASIOCUXVOTNTES
ané tnv Opoomnovdiakn Emrpornn Emkowvwviwy twv HIMA

Tov AlyouoTo Tou 1996, n Opoomovdiakr Emtporr Emkowwviwv (FCC) Twv Hvwpévwv
MoNTewwv, pe tn Spdon tng Report and Order FCC 96-326, ui0B£tnoe éva evnuepwpévo
TPATUTIO AOPANELQG YIa TNV €KBEON TOU AVBPWTTOU OTNV NAEKTPOUAYVNTIKY EVEPYEL
padioouyvotitwy (RF) mou ekméumeTal amd MOUMOUE ot 0TToiot TEAOUV UTIO ToV
puBpIOTIKG éNeyxo TnG FCC. Ot odnyieg auTEC €ival CUVETEIG HIE TOUG KAVOVIOHOUG
acpaleiag mou eixav 1ebei 0To MapeN@OV amd Ta Siebvny Kal apepikavika mpotuma. H
oxediaon auTrg TG CUOKEURG CUMHOPPWVETAL UE TIG 0dnyieg Tng FCC kat pe autd ta
S1ebvry mpdruma.

AnAwon Part 15.19

AUTH 1 CUOKEUH} CUHHOPPWVETAL HE TO ApBpo 15 Twv Kavoviopwv T FCC. H xprion
UMOKEITal 0TI akoAouBe¢ 500 mpoUmoBEéaelc:

(1) AutA n cuokeun Sev pmopei va mpokaléoel emPBAaPeic mapepBoAEC kat

(2) auTr n ouokeun Mpémel va amodéxeTal omoladnmoTe MAPEUPOAN,
oupnepAapBavopévwy mapeUBOAWV TIOU HITOPET va IPOKAAEGOUY avemBUpnTn
Aertoupyia.

AnAwon Part 15.21

Tuxov ahayég iy TPomoTToloEI TToU GV EYKPIVOVTAL PNTA amd TOV KATAOKELAOTH
MIOPOUV VA AKUPWOOUV TO SIKaiwua xpriong Tou e§omAiopoU.
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Xpron oto cwpa

AUTH 1 OUOKEUT €XEL ENeYXDE( Y10 TUTIIKN XPriON OTO OWHA, HE TO TTOW MEPOC TNG

og anéotaon 0,39 vtowv (1 cm) amoé To oW Tou XPHOTN. [a CUPHOPPWON PE TIG
anaitrioelg g FCC yia tnv ékBeon o€ padioouyvdtnteg, mpémel va Statnpeitat eNdyiotn
anéotaon 0,39 vtowv (1 cm) avapesa To WA TOU XPROTN KAl TO THow PéEPOG TNG
OUOKEUNG.

Evééxetat va pnv pmopolv va xpnaotpomotnBouv KA otipténg oe {wvn, Brikeg kat
napepepn afeaoudp mou Slabétouv peTarika e§aptripata. Ta afecoudp yia xprion
0TO OWHa 1o Sev umopouv va Slatnpricouv amdotaocn 0,39 vtowv (1 cm) petady

TOU OWHATOG TOU XPHOTN KAl TOU TToW MEPOUG TNG CUOKEUNG Kall Ta ortoia Gev €xouv
GOKIHOOTEL yia TUTTIKEG XPROEIG 0TO OWHA, EVOEXETAL va Uy TANpolv Ta 6pia T FCC yia
Vv €kBeon o€ PadlooUXVOTNTEC Kall TIPETEL VOl AMTOPEVYOVTAL.

AfAwon Part 15.105

AUTOG 0 £EOMANIGHOG ExEL ENEYXBEL KOl CUUOPPWVETAL LIE TA OPLA VIO TIG PNPLAKES
OUOKEVEG Katnyopiag B, cuppwva pe To Part 15 twv kavoviouwv FCC. Autd ta 6pta
eival oxedlaopéva yia va Tapéxou EMAPKI TPOOTAsia évavTt eMPAABWY mMapepBoAwY
o€ OIKIaKr eykatdotaon. O €0mNOHOC QUTOG TTAPAYEL XPNOILOTOLE KAl MMTOPE( val
EKTTEUDEL EVEPYELD PASIOOUXVOTHTWY Kal, av Sev eyKaTaoTabe( Kat xpnotpomoindei
oUpPWvVa pe TIG 0dnyieg, umopei va mipokahéoel empPAapeic mapepBolég oTig
padioemkowwvieg. QaTo00, Sev uTApxEL £yyunon 6Tt Sev Ba undp&ouv mapepPoAEG
O€ M0 GUYKEKPIPEVN EYKATAOTAON. AV auTOG 0 EE0MAIOHOG TIPOKaNEDEL emPAapEic
TIAPEUPONEG OTNV TNAEOTTIKA AN, YEYOVOG TTOU UMOpPEi vat SlamoTwOei pe Thv
amevepyomoinon kai evepyomoinan Tou eE0mAIGHOU, 0 XpoTng evBappuvetal va
Sokipaoel va SlopBuwoel Tic mapepBolég Ue éva 1y eploodtepa amd Ta e§RG PETPa:

AMGETE TV TPOsaVATONOHO 1y TN Béon TG Kepaiag ARYnG.

Auénote v amdotacn petal eEomiopou Kat SkTn.

« ZuvdéaTe Tov e§0MAIOUO o€ TIPIla TTOU AVIAKEL 08 AANO KUKAWHA QO QUTO WE TO
ormoio eival ouvSeSepEvog 0 SEKTNC.

+ YUMPOUNEUTEITE TO METAMWANTH 1} évav EUTTEIPO TEXVIKO pado@uvwv/TnAedpaonc
yia Boribela.

Opovtiba kal GUVTHPNON TOU TIPOIOGVTOC
+ Naypnotporoleite povo ta e€aptripata mou mepthapBavovtal 0T CUOKEUAGia Kal ivat
eoualodotnpéva amd v LG. H LG Sev mapéxel eyyunoelg yia tuxov BAaBeg fy amotuyieg
Aettoupyiag mou ogeilovtal og e€apTripaTa GMWV KATAOKEUAOTWV.

+ Oplopéva TepLEOpEVA Kall EIKOVEC EVEEXETAL va SlagEéPouv amd Tn CUOKEUN 0aG XWPIG
npogidomnoinan.
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« Mnv anmocuvappoloyeite T povada. Otav anarrouvtal Epyacieg EMOKEUNG, MapadwoTe
NV o€ €EEIBIKEVPEVO TEXVIKO.

+ Katatn Siakprrikr euyépeta tng LG, ot eMOKeVE TOU KAAUTITOVTAL OO TNV €yyOnon
evdéxetat va mephapBdvouv Ty TomoBETon avTaMaKTIKWVY HEPWY 1 TIVAKWY (gite
KavoUPIwV €{Te EMOKEVAOHEVWVY), e TNV TPoUTOBEON OTI N AEITOUPYIKOTNTA TOUG €ival
10080Vapn E TN AETOUPYIKATNTA TWV HEPWV TTOU QVTIKATAOTABNKAV.

+ Kpatdte T GUOKEUN HaKPLA amO NAEKTPIKEG OUOKEUES OMTWG TNAEOPATELS, padIdpwva Kal
UTIOAOYIOTEG,

« H ouokeur| mpémel va QUAAOCETAL MaKPLA amd Tyég BepuoTnTaC, OTwg KAAoPIpéP
NAEKTPIKEC KouCive.

+ TMpocé€te va pnv méoeL.

+H ouokeur| dev mpémel val UOKELTAL O€ PNXAVIKEG GOVATELS f} KpadaopoU.

+ AmevepyomolEiTe Tn OUOKEULN OTIG TIEPIOKEG OTTOU amayopeUETal N XPrion TG COHPWVA E
€181koU¢ KavovIopoUG. Mo TapAdelya, pnv XENOIHOTIOIETE TN GUGKEUT) OE VOOOKOEID,
KaBWG N XPron TG UMopEi va EMNPEACEL EVAITONTO LATPIKG EEOTNIOHO.

+ Mnv mavete T cuokeun Ue Ppeypéva xépla, otav popTilel. Mmopei va mdbete
nAektpomAngia kat va mpokAnBei coBapr) BAABN otn cuokeun.

+ Mnv @oprilete 1o TNAé@wvo KovTd 08 E0PAeKTA UNKG, KaB)G evoéxeTal va BeppavBei kat
va SnpioupynBei Kivouvog mupkaylag.

« Xpnotpomolrote éva oteyvd mavi yia va kabapioeTe o mepiBAnpa TG CUOKEUNG (v
xpnotporoleite SlahUTeG 6muwg Bevdivn, SIOAUTIKOG ) OIVOTIVEUHA).

+ Mn @oprilete T cuokeur dtav PpiokeTal Mavw o€ MOAAKA uAoHaTa.

+H ouokeunr mpémel va poprtiletal o€ KaAd agpI{OpEVO XWpo.

+ Mnv a@riveTe Tn GUOKEUN O€ XWPOUG LE UTIEPBONIKO KOO 1y OKGvI.

+ Mnv TomoBeTeite T GUOKEUR Sim\a O€ MOTWTIKES KAPTEG 1} EIOITHPIA HECWV LETAPOPAG.
Mropei va emmpedoet Tig TANPOQOPIEG TTOU TIEPIEXOVTAL OTIG HAYVNTIKEC TAIVIEC.

« Mnv ytumdre v 086vn pe agunea avtikeipeva, kabwg evéxetal va mpokaléoete BAABN
0TI OUOKEUN.

+ Mnv ekBéteTe TN GUOKELN O€ LYPA 1} Lypaaia.

« Xpnotpomoleite pe mpoaoxr Ta aeaoudp, dnwg m.y. Ta akouoTikd. Mnv ayyilete dokoma
TNV Kepaia.

+ Mnv xpnotpomoleite, pnv ayyilete Kat pnv mpoomabeite va apapECETE 1 va
embI0pOWOETE OMIACHEVO, KOUMEVO ) payiopévo yuahi. H eyyunon Sev kahomtel BAdBeg
TIoU 0EINOVTaL O€ KAKH XPron TG Yudhivng 08dvng.

«H ouokeun ivat n\ektpovikr Kat mapdyet BepuOTNTA KATA Tr SIAPKELD TNG KAVOVIKNAG
Aertoupyiag, H mapatetapévn, Apeon emagr Ke 1o G€ppa 0ag UM OUVONKES AVEMAPKOUG
€€0EPIOLOL EVOEXETAI VAl EMPEPEL SUOPOPI 1} LIKPA EYKAUUATO. ZUVETILIG, XEIPIOTEITE UE
TIPOOOKT T GUOKELN) 0aG KATA TN A&IToupyia iy apéowg peTa.
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+ Av Bpayei n GUOKELN), AMOCUVOEDTE TV AUEOWG KAt OTEYVWOTE TV Kahd. Mnv
EMIYEIPNOETE VOl EMOTIEVOETE TO OTEYVWHO UE Hiat EEWTEPIKT TNy BeppotnTag, Omwg eivat
0L (pOUPVOL, 0L POUPVOL LIKPOKULATWY 1 Ol OTEYVWTHPES LAAMGWV.

+ To uypd 0N Ppeypévn oUoKeUr AMALEL TO XPWHA TNG ETIKETAG TOU TTPOIOVTOG OTO
E0WTEPIKO TNG 0UOKEUNC. H eyyUnon dev kahumtel BAAPEC TG ouokeung mou ogeilovtal
otnv ékBear Tng o€ uypa.

+ Mia @opnTri cuokeur amaitei owoTr Kukhogopia aépa yia T Sidxuon tng BeppotnTac.
H Gpeon emagn pe o Séppa Kal N QvemapKrig KUKAOQOPIa ToU aépa 0T GUOKEUN UMOpEi
va odnynoet o€ umepBéppavon} . H ouokeur} Ba mpémet va Bpioketal o€ amdotaon
TouhdyioTov 1,0 cm amd To owa Tou XprioTn.

« Epmodiote v €icodo okovng 1 aMwv Eévwv ouatwv atn B0pa Tou YopTIoTr/ToU
kahwdiou USB. EvdéxeTal va mpokAnBei umepBéppavan 1y mupkayld.

+ Amo@UYeTE TNV €KBEDN TNG CUOKEUNG OE XAUNAT) OTHOOPAIPIKY TTiETN O€ UPNAG
ueyao uPpouETpO.

+ Mnv ekBETETE TN GUOKEULN| OE TTON XAUNAR ATUOGQAIPIKA THEDN. AlOWOPETIKE,
umopei va mpokAnBei ékpnén g pmatapiag f Slappor) eVPAEKTOU LYPOU K depiou.

« OpovrioTe va unv €pBel To TPoidY Ot EMagr pe Lypd. Mnv XpnotpomolEiTe i
enavagpopTifete To mPoidv av éxel umooTei {nptd. Av To mpoidv Bpaxei, n Auxvia BAABNG
and uypd Ba aMagel xpwpa. AdPeTe umoyn oag 6Tt o€ auTiv Tv mepimwon Sev Ba
SIKAIOVOTE TIG SWPEAV UTINPETIEC EMOKEUNG TTOU KAAUTITOVTAL a6 TNV €yyonon.

Amoteleopatiki XPrion TG CUOKEUNG

HAEKTPOVIKEG CUOKEVEC
'O)EG Ot GUOKEVEG MITOpE( va G€xovTal TApEUPBONEG Tou emnpealouv Ty anddoaor Toug.
+ Mnv XPNOIUOTIOLEITE TN GUOKEUT KOVTA OE LATPIKO EE0MAIOUO XWPiG va xeTe Aafel
OXETIKN adela. ZUUBOUNEUTEITE TO yIaTPO GG yia va SIOMOTWOETE av N AeiToupyia
TNG OUOKEUNG UMOpEi va TIPOKaAéoEL TTAPEUPBONEG 0TN AelToupyia TG laTPIKAG 0ag
OUOKEUNG.
+ Ol KATOOKEVOOTEG BNUaTOS0TWY OUVITOUV ENAXIOTN amdaTaon 15 cm petagy
AMWV CUCKEUWV KAl TOU Bpatodotn, yia Ty amo@uyn moavwv mapepUBoAwy.
+ AUTHA ) GUOKEUN MITOPE( VAl TIAPAYEL EVTOVO GWG 1) GWE TOU AvaBooprvel.
+ Oplopéva BonBrpata akorg evagxeTal va PIoTAVTAL TTAPEUPONE ATTO GUOKEVEG.
« MiKpéG MapepPBONEC EVOEXETAI VOl ETNPEACOUV GUOKEVEG, OTIWG TNAEOPATELG,
PadIO@WVa, UTTOAOYIOTEG KT
+ Av eivail Suvato, XpNOIOTOIOTE T CUCKEUN O€ Beppokpacieg petagd 0 °C kat
40 °C. H €kBeon TnG 0UOKELNG O TOAU XapnAéG i uPnAég Beppokpaaieg evoéxetal
va IPOKAAEDEL (i, SuoNeIToupyia 1y aKOHa Kat EKpnEn.
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0481Kn ao@alela

ENéyE€Te TOUG VOMOUG KOl TOUG KAVOVIGHOUG YIaL Tr XPr0N OUCKEUWY OTAV OONYEITE.

+ Mnv XPNOIUOTIOLEITE TTIOTE GUOKEUN XEIPOG OTAV OSNVYE(TE.

Eotiaote OAn oag Ty mpoaooyr oty odriynon.

YTAPOTAOTE OTNV AKPEN TOU SPAOU Kal 0TABUEVOTE TO OXNKA 0ag TPV
TIPOYHOTOTOINOETE 1 AMAVTHOETE O€ M KAON, €GV TO amaitouv ol ouvBriKeg
odriynong.

+ H evépyela padloouyvoTATWY EVOEXETAL VO EMNPEAGEL OPIOUEVA NAEKTPOVIKA

GUOTAUATA 0TO OXNHA 00E, OTIWE TO PASIOPWVO TOU QUTOKIVITOU Kall TOV E§0TTANICHO
acgaleiag.

« Eav 10 0xnpa oag ivat §omAiopévo e évav 1y TIEPICOATEPOUG AEPOCAKOUCG,

unv eykabioTdte Kat Pnv tomobeteite actppato eomiiopd o onpeia omou Ba
eumodietal n Aerroupyia Tou agpooakou. Evaéxetal va mpokAnbei Suohettoupyia
TOU 0EPOOAKOU 1 00PBaPAC TPAUUATIONAE AOYw aKATAANANG anddoond.

« 'Otav akoUTe HOVOIKN eV BpiokeoTe £§w, PePaiwbeite OTi éxete pubuioel Tnv

£€vtaon og éva Aoyiko eminedo, yla va €XeTe emiyvwon Tou Tt cupBaivel yopw oag.
AUTO gival IBLAITEPA CNUAVTIKO OTAV KIVEIOTE KOVTA 08 SPOUOUC.

MpokAnon BAAPNC otnv akon cag
Ta va mpogulayteite amd mBavr) PAGPN TG akorig oag, amo@UyeTe TV
aKpdaon o€ UPNAG emimeda oL yia Peyala Xpovikd SlaoTtruarta.

Evééxetat va mpokAnBei BAGPN otnv akor) oag eav ekTiBeoTe og Suvatd fixo yia
TIAPATETAPEVO XPOVIKO SIA0TNUA. EMOPéVG, 0aG GUVIGTOUE Va NV EVEPYOTIOIEITE
1] AMEVEPYOTIOLEITE TO TNAEPWVO KOVTA 0Ta aUTId 0aG. Emiong, oag cuvioToUpe va
pUBpieTe TNV évTaon TNG HOUGIKG Kall TOU fi¥ou KAong o éva hoyikd emimedo.

« '0tav XPNOIHOTOLEITE OKOUOTIKE, VA MEIWVETE TNV €VTacon TOU XoU av Sev akoUTe

600U HINOUV YUpw 00 1} av To dTopo Tou KABeTal Sim\a o0 UMOPE va aKoUoEL
QUTO TTOU OKOUTE.

E + H umepPoNkn nNTIKr TEn amd Ta AKOUOTIKA UITOPE( va TTPOKOAEDEL

QMWAELD TNG AKONG.
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luvdhiva e§aptrpata

Oplopéva P€pn TNG CUOKEUNG 00C Eival KATAOKEUAOHEVA amd YUANL To yuai pumopei

VOl OTIAOEL AV I CUOKEUT 00 TTECEL TIAVW OE OKANPEN EM@AVELD 1) SEXTEL IOXUPOUG
Kpadaopoug. EGv omdoel kdmoto YuaAvo e€ApTNHa, KNV TO ayYIEETE Kat pnv
ETTIKEIPHOETE VA TO APAIPECETE. TAHATHOTE VO XPNOIHOTIOLEITE Tr) CUCKEUH 0ag PéXPL VA
avTikataoTaBei To Yuahi amo e0uatoSoTnuévo TTAPOYO UTTNPECIWV.

Media avativaéewv

Mnv xpnotpomolgite Tn CUOKEUN O TTEPLOXES 0oL YivovTal avaTtivaelc. Na akohouBeite
TOUG TTEPLOPIOUOUG KAl OTTOLOUG KAVOVIGHOUG 1) KAVOVEG LOXUOUV.

MepiBdaMovta 6mou umdpyel Kivduvog ekpnéewv
+ Mnv XpNOILOTOIEITE TN OUOKEUN OE ONEI QVEPOSIAGHOU KAUGTUWV.
+ Mnv XpnOIHOTOLEITE TO TNAEPWVO KOVTA OE KAUGIHA 1} XNHIKA.

« Mnv pETaQEPETE Kal Pnv amoBnKeVETE EVPAEKTA AEPLD, UyPd 1} EKPNKTIKA OTOV iS10
XWPO TOU AUTOKIVATOU 0agG OTIOU TOTOBETEITE TN GUCKEUN 1} TA a§E0OUdp TNG.

Xpnon o€ agpooKAPog
O1 00UPUATEG CUOKEVEG UMOPOUV VA TIPOKAAEGOUV TIAPEUBOAEG OTA CUOTAHATA
AEPOOKAPWV.

« MNpw empPiBaoTeite o€ AEPOOKAPOG, OTTEVEPYOTIOIOTE TN GUCKEUN).

+ ‘000 TO aEPOOKAPOG BPICKETAL OTO £50POG, UNV XPNOILOTOIEITE TO TNAEPWVO XWPIG
adeia amd o mMipwya.

MNadia

Oulagte Tn ouoKeur Og AoPANEG HéPOG, pakpla amod maudid. MepapPavel e§aptrhpata
MIKPOU pEeYEBOUG TTOU EVOEXETAI VAl TIPOKANETOUV KiVEUVO TIVIYHOU EQV AMTOOTIAOTOUV
amé 1o TNAéQwvo.

Eneiyouoec KA\oEIC

O1 emeiyouoeg KANOELG evEéxeTal va pnv ivat Slabéotpeg og OAa Ta Siktua KIvnTrg
Aepwviag, Ma to Adyo auto, Sev mpémel va Bacileate amokAEIOTIKA OE auTr TN
GUOKEUN YIa EMEIYOUTEG KANTELC. ETIKOIVWVIAOTE HIE TOV TOTTIKO TIAPOXO UTINPETIAV Yial
Va EVIUEPWOEITE OXETIKA UE AUTO TO Bépa.
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H}\npocpoplac Kal @PovTida pumataplwv
Aev ival amapaitnTo va anogopTioTel Mpw N ratapia yia va Ty
EMAVAPOPTIOETE. Z& avTiBeon pe GAa ouoTApaTa prataplwy, Sev epgavifetal 1o
QAIVOLEVO UVIALING TTOU UMTOPE VOl EMNPEACEL TNV amdS00n TNG Unatapia.

« Xpnoworoleite uovo pmatapieg kat opTioTég LG. Ot popTioTéq LG éxouv oxediaoTei
UE TPAOTO TETOI0, WOTE Va peyloTomololy Tn Sidpkela {whg TG Prmatapiod.

+ Mnv amoouvappoNoYEiTe Kat unv BPOUKUKAWVETE TV Pmatapia.

« Alotnpeite KaBapEG TIG METAANKES EMOPES TNG PmaTapiag.

« AvtikaBiotdre v pmatapia otav pelwdei onuavtika n anddoon e, H umatapia
UMOPEL VOl POPTIOTEL EKATOVTASES POPES LEXPL VA XPEIAOTE AVTIKATAOTAON.

« Edav n umatapia Sev éxel xpnotpomoindei yia moAl kaipd, popTioTe T yia va
UEYIOTOMOINOETE TN SIAPKEL XPAONG TNG.

+ Mnv a@rivete ekTeBeIpévo To PopTIoTH TG umatapiag ameubeiag otnv nAakn
QKTIVOBONIC Kall NV TOV XPNOIMOTIOLEITE OE XWPOUG HE TTOAR LYPAGia, OTTWE TO
umavio.

+ Mnv a@rivete v pratapia og Beppolc i KPUOUG XWPOUE, KaBWG evaéxeTal va
pewwbei n amdédoor e,

« Eav avtikataotiioete T pratapia pe AavBaopiévo TOmo pmatapiag, umdpyel
Kivouvog ékpnéng. H amdppudn Twv XpnotuomotnuéVWY Hmatapliv PEMEL va yiveTat
oUPPWVa PE TIG 08nyieC.

« o va amo@UyeTe TNV AOKOTIN KATAVAAWGN EVEPYELAG AMTO TO YOPTIOTH, VA TOV
QmoCUVSEETE TAVTOTE Mo TNV TPICa META TNV T PN YOPTION TNG CUCKEUNC.

H mpaypatikn Sapketa {wng Tng umatapiog e§aptdatat amoé t Slapdpewon Tou
SIKTUOU, TIG PUBHITELG TV TTPOTOVTWY, TIC CUVIBELEG XPrONG, TV MmaTapia Kat Tig
TEPIBANNOVTIKEG OUVORKEG,

« BePawwBeite mwg n prmatapia Sev EpeTal o€ EMAQN HE AIUNPA QVTIKEIPEVT, OTIWE
Sovtia {wwv 1 kap@ld. Ydpyxel Kivduvog avaphegne.

Ac@AEIQ TIPOCWTTIKWV GTOIXEIWV

+ Na TIpooTATEVETE TIAVTA TA IPOCWTTIKA GO OTOIKEID, WOTE VA EUMOSIOETE TUXOV
Slappoég Sedopévwy iy Kataxpnon evaiocdnTwv MANPOPOPILV.

+ Na énpioupyeite mavta avtiypaga ac@aleiag Twv onpavtikwv oag Sedopévwv dtav
XPnolpomoleite Tn ouokeun. H LG Sev ivat umevBuvn yia Tuxov anwheleq SeSopévwv.

« Mpwv meTd&eTe TN OUOKEUR, va SNUIOVPYATETE avTiypaga ao@aleiog OAwv Twv
Sedopévwv Kal va KAVETE EMavapopd TG CUOKEUNG WOTE Va EPMOSIOETE TUXOV
Katdypnon euaicbnTwv MANPOPOPIWV.

« 'Otav katePalete pappoyég, va SlaPalete MPOCEKTIKA TNV 006V TwV SIKAIWHUATWV.
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+ Na €ioTe MPOOEKTIKO{ OTAV XPNOILOTOLEITE EQAPLOYES TIOU €XOUV TIPOORacn oe
TIONEG AETOUPYIEG 1) OTA TIPOOWTIIKG GAG OTOIKECL.

+ Na eNéyyeTe TaKTIKG TOUG TPOOWTTIKOUE 0O AOYOPLAOHOUG. AV EVTOTIOETE TUXOV
eVOECEIC KATdYPNONG TWV TTPOCWTTIKWY GAC OTOIXEIWY, {NTHOTE amo TovV TAPOXO TNG
unnpeoiag va diaypayet ry va aMdgel Ta oTolygia Tou Aoyaplaopol oag.

« Av n ouokeun oag xabei 1y Kharei, alMagTe Tov kwdikod mpoofaocng Tou Aoyaptacpol
00G WOTE Va SI00PANCETE Ta TPOCWTTIKA 0AG OTOIXE(Q.

+ Mnv pnolUOTIOLEITE EPOPHOYES TIOU TIPOEPKOVTAL OTTO AYVWOTES TINYEG.

A Eidomoinon yia tThv avTikatdotaon TG pmatapiog
+ H pmatapia 1vtwv AiBiou eivat emkivéuvn kabwg pmopei va mpokahéoet
TPAUHOTIOO.
H avTikatdotaon g umatapiag amé Un KatapTIopEVO EmayyeAUaTia pmopel
va TPOKANEDEL (LA 0T GUOKEUN 00,
Mnv avtikaBiotdre T umatapia pévot oag. Mmopei va mpokAnBei BAARN ot
umatapia mou Ba odnyroel o unepOEpuavan Kat TPavpaTIoNd. H pmatapia
TIPEMEL VA avTIKataoTaBel amd katapTiopévo enayyeApatio. H pmatapia
TIPETTEL VA AVOKUKAWVETAL 1} VOl AMOPPITTETA EEXWPIOTA OO TA OIKIOKA
amoppippaTa.
« TNV MEPIMTWON MOV TO TPOIOV S1aBETEl EvowATWHEVN UaTapia TTou &g
umopei va agatpebei amd 1o xpriotn, n LG oag mpoteivel va ameuBuvBeite
0€ EMAYYENUATIO YIa TV AQAipEDN TNG UmaTapiag, Qv MPOKELTaL va TV
QVTIKOTOOTAOETE I Va T OTEINETE Yl aVAKUKAWON 070 TENOG TG (wiig TG,
Ma v mpoAnwn BAGRNE 0To POV, KAl yia TN ao@ANEL TOU XPROoTN,
UNV EMIXEIPHOETE VOl APAIPECETE TN prmatapia. AmeuBuvBeite otn Mpapun
BonBeiag g LG, fj o€ dA\o emayyehuaria.
+ Hagaipeon tng pmatapiag mpoumoBétel amoouvapuoAdynon
TOU TEPIBANLATOC TOU TTPOIOVTOG, AMOCUVEEDN TWV NAEKTPIKWV
KaAwSiwv/ EMaPWV, Kal TPOCEKTIK AMOPAKEUVON TNG Umatapiag
e e€e1dIkeupéva epyaleia. EQv XpeldleaTe TIG emayyEAUATIKES
odnyieg yla Tnv agaipeon g pmatapiag, emokepOeite T SievBuvon
http://www.lge.com/global/sustainability/environment/take-back-recycling.
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Aerroupyieg eyypagng nxov

Tpiodidotarog ‘Hxog Mnxavi LG

H Aerroupyia Tpiodidotatog "Hyog Mnyavr LG oag emttpémnel va akoUuTte
0TEPEOOKOTIKS Kal BEATIoTOmOINKEVO HX0. KaTd TV avamapaywyr HOUGIKAG A
Bivteo, umopeite va amoAaUoETE OTEPEOOKOTIKS Katl KABNAWTIKS X0 6av va Tov
QKOUTE OTOV XWPO.

T X0pete Tov mivaka E60MOIRGEWY TIPOC TA KATW.
7 Natiote Pubpioeig > Hyog > NMotdtnta fyou kat @€ > Tpiodiaotarog "Hyog
Mnxavi LG kat matiote () ) yia va To evepyomoIfoETE.

« Edv ouvdéoeTe e§wTEPIKN) GUOKEUN X0V OTIWE AKOUOTIKA 1} NXEia oTn
ouoKeun, pgavifetal éva avadudpevo mapabupo yia Ty evepyomoinon TN
Aertoupyiag Tpiadiaotatog *Hyog Mnyavi LG.

Google Assistant

Google Assistant Emokomnnon

H ouokeun oag €xel evowpatwpévn ™ duvatotnta Google Assistant. Bpeite
QMAVTACELC KAl KAVTE TIC SOUAEIEC 0O EKTOC OTMITIOU 1) YPOPEIOU.

E « [0 va XpnoIUOMOICETE AUTHY TV SuvVATATNTA, TPEMEL TTPWTA VA UVOEDEITE
o710 iKTuo.

Exkivnon tou Google Assistant.
T Notiote to mrjkTpo Google Assistant ot apLOTEPK| TTAEUPA TNG GUOKEUAG.

f
YUpeTe Slaywvia amo TV KATW YwVIakr akpn tng 08ovng.

7 Ayyi€te to ZEKINHETE.
3 AkohouBRoTe Tic 0dnyieg ou epgavilovral otnv 086vn.
+ H ouokeur amoBnkevel Ta wvnTika oag Sedopéva yia avayvwpion.
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A Em\é€te £dv Ba xpnotpomoinBei n Aerroupyia EEKAEIGOUATOC E TAipLAoHA
VNG
+ Edv xpnopomoleite T Aettoupyia eKAEIOWHATOG HE TAIPIAOHA QWVAC,
umopeite va EEKAEIOWOETE T CUOKEUN AKOUA Ki GTaV ) 080V TG GUGKEUNG
Sev eivat avappévn 1 av n cuokeur eoprilel, Aéyovtag “OK Google” ri “Hey
Google!.

E « Auti n SuvatdtnTa prmopei va givat mo udAwtn 600V apopd Ty acedlela,
o€ Oxéan e AMNOUG TPOTTOUG KAEIdWHATOG 086vNg, 6mw¢ To Motifo, o
Kwdikog KAeldwpatog iy 0 Kwdikog mpdopaong.
H 086vn pumopei va EekAeldwOE( Kat pe pia ewvi apdpola pe T Sk oag 1
HE TV nYoypagnuévn euwvn oag.

+ Tla va XpnolpomoloeTe auTrv T AeiToupyia, oTnv apyikr 086vn matiote
PuBpioeig> Kheibwpa 006vng & acpaleia > PuBpiceig ac@aloug
KAeIdwpatog > EEunvo KAEibwpa Kal, 0Tn GUVEXELD, XPNOIMOTIOIOTE TN
uéBodo KAeIdWuaTog 086vNG oL EXETE OPIOEL YIa VAt EEKAEIOWOETE TN
GOUOKEUH.

Av bev pmopeite va EEKAEIGWOETE TN GUOKEUN HE aVayVWPLoN ewVig, Ba
TIPEMEL VA TNV EEKAEIBWOETE XpnolpomolvTag T kaBopiopévn pébodo. Na
Aemtopépeleg, avatpé€te otny evotnTa PUBIoN KAEdwuatog 086vng.

5 Matiote Téhoc,

MpooBaon pe pwvi

T ‘Otav n apyikr 086vn eivai amevepyomoinpévn 1y KAelbwpévn, meite “OK
Google” 1| “Hey Google.".

7 Otav epgaviotei n 086vn Tou Google Assistant, Tigite i eVTONr 1} KAVTE pia
£pWTNON.

MpdaBacn amo tnv apxikn 086vn
T Noatjote to mrjktpo Google Assistant ot aploTEPK| TTAEUPA TNG GUCKEUNG.

n
Z0pete Sraywvia amd Tnv KATw ywviakn dkpn tng 006vng.

7 Meite pia evioAr f pWTNON 6TAV SETE TO * » - » 0TO KATW PEPOC TNC 00OVNC.
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E « e évamepiBahov dmou n ovvean tou acupuatou Siktvou Wi-Fi rj Tou
SIKTOOU KIVNTAG TNAEQWVIAG givat aunAiig moidtntag, n Aertoupyia Google
Assistant evoexopuévwe va meplopiletal kat 0 puBUOE TIOTHAC avayvwplong
opthiag va givat xapunAdtepoc.

« Eav n opia gival aca@ri, To PIKpd®wvo KAAUTITETAL, AEITOUPYE piat
OUOKEUN avamapaywyng péowv fj o mepiBaMwy rxocg ivat Suvatog, o
pUBHOE MOTHG avayvwpiong ophiag pmopei va givat xapnAdtepog. Otav
XPNOIUOTIOIETE TO TTPOIOV HE PWVNTIKEG EVTOAEC, ANOTE e KOAT) TTPOPOPd
0€ ouxo TEPIBANOV yia peyahUTEPN akpiBela avayvwpiong opNiag.

Avayvwpion Aaktul. Aotunwpata

Avayvwpion Aaktul. Amotunwpata - Mapouaiaon

MpoToU XPNOILOTOINCETE TN AelToupyia avayvwplong AakTuA. AMOTUTIWHATA,
TIPETIEL VO KATOXWPIOETE TA SAKTUAIKA GO AMOTUTIWHATO 0TI GUOKEUN.

Mriopeite va xpnotpomolioeTe T Aertoupyia avayvwplong Aaktul. Amotunwpata
OTIG AKONOUBEC TTEPITTTWOELC:

+ Ta Eexeibwpa tng 086vNg.

+ Tava Seite To KAEIOWEVO TIEPIEXOHEVO OTO ANPTIOU.

- Ta emPefaiwon pag ayopdg péow g oUVOEDNC O i Epappoyn i

TauTomoinang Ke To SAKTUAIKG 0a¢ amoTUNWHA.

E « Mmopeite va xpnotpomolrjoete Sedopéva AaKTUA. AMOTUTTWUATA Yial
Tautomnoinon Tou Xprotn. Yrdpxel n mbavdtnta o aiodntripag AakTul.
Anotunpata va avayvwpilel éva Sla@opeTikd ald oxebov 510 SakTUNKO
QMOTOMIWHA WG KATAXWPNHEVO SAKTUNIKO amoTunwia. Na va evioUoeTe
TNV ao@dela, cuviotdral n xpernon potiBou, PIN A kwdikou mpooBaong yia
10 EeKNeidwpia TG 006vVNG.

+ Avn ouokeun Sev avayvwpiel Ta SaxTUNKA 0ag AmOTUTIWHATA 1 av
§exAoeTe TNV KABOPIGHEVN TIUF YIO TNV KATAXWPLON, EMOKEPTEITE TO
mnotéotepo Kévtpo eunnpétnong mehatwv g LG mpookopi{ovtag
GUGOKEUN Kal TV TAUTOTNTA 0aG.
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Mpo@uldagerg yia tnv avayvwpion Aaktul. AmoTunmwpata
H akpipela avayvwpiong SAKTUNKOU QmOTUNMWUATOG UOPE( va HElwOE yia
S1apopoug Aoyouc. Na va peytotomolnBei n akpifela tng avayvwplong, eNéyéte Ta
aKoouba TPV XPNOIOTIONOETE TN GUOKEUN.

+ Kétw Kat 010 KEVTPO TNG 086vNG TOU TPOIBVTOC, UTIAIPXEL £EVOC EVOWHATWHEVOG

aleOnTrpag mou avayvwpilel SaKTUAKE amotunwpata. MPOCEXETE WOTE
va pnv ypatouvioeTe 1) mpokaléoete pBopd oTov alodntripa AaKTuA.
ATOTUNIWHOTA PE METAMIKA QVTIKEIUEVA OTTWE KEPHATA 1) KAELDIA.

- Edv umdpyouv {éveg ouaieg (16pwtag, Aootdv, vepo, okovn, Nirn, K.d.) oTov

aeOntipa Aaktul. Amotunwpata ry oto 8dyTulo mou Ba TomoBetnBei oTov
aednTpa, n avayvwplon AakTul. ATOTUTWHATA EVOEKETAL VA UNV AEITOUPYEI
OWOTA. KOUTIOTE ToV aloBNnTripa Kat To SAXTUNO Kal apatpéote KABE ixvog
vypaaiag mptv TomoBeTroeTe To dAYTUAO OTOV AlEBNTAPA.

+ Edv n em@dveia tou SaxtOMou gival okAnpr emeldn €xel OUAEG 1 €xel {apwoel

amo 1o vePd, 0 ALoONTAPAG EVOEXETAI VA PNV UITOPE( VA aVayVWPIOoEL TO
SaKTUAIKS amoTUMWHA. Z€ TETOLA TIEPITTTWON, KATAXWPIOTE éva GANO SAKTUAIKS
amoTuTIWHA.

+ Edv huyilete o SAKTUAG 0OG 1) XPNOIUOTIOLEITE POVO TNV AKPN TOU SAKTUNOU

00, To SAKTUAIKO amOTUMWHA 0aG EVOEXETAI VA LNV avayvwploTel. BeBalwbeite
OT1 70 SAKTUNG GaG KAAUTTTEL OAOKAN PN TNV EMIPAVELD TOU aloBnTAPpa AaKTUA.
AmoTunpaTa.

YapwoTe Povo €va AKTUMO Yia KEBe kataxwplon. H cdpwon mepIocoTepwv
SaKTUAWV PMTOpPED va €xel EMMTWOELG TN Sladikacia Kataxwplong Kat
EYYPaPAG.

+ H ouokeur evdéxetat va Snpoupyei oTaTIKO NAEKTPLOO € TEPIMTWOn ou

Aertoupyei o€ mepIBaNov pe Enpd aépa. EGv o mepiBdMwv aépag ivat Enpadc,
amo@UYETE TN 0dpwaon Tou SAKTUAIKOU 0ag AmOTUMWHATOC 1 ayyi€Tte éva
UETANIKO QVTIKEIEVO, OTIWE EVal VOUIOHA 1) €va KAEWST, TTplV TN 0dpwon Tou
SAKTUAKOU OTOTUTTWLATOG YIa VO EE0USETEPWOETE TOV GTATIKG NAEKTPIOMO.
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Kataywpion Aaktul. Amotunwpata
Mmopeite va kataywpioeTe Kat va amoBnKeUoeTe To SAKTUNIKO 0ag amoTunwua

0TI OUOKEUN Y10 VOl TO XPNOIHOTIOLEITE HE TNV avayvwplon AakTul. ATOTUNIUATA.

T Zmv apxikr 086vn, matiote Pubpioeig > Kheidwua 006vng & ac@dheia >
AakTul AoTUTTWHOTA..

E « [la va Pmopeite va XpnolpomolroeTe auTriv Tn Aetoupyia, Ba mpémel va
0pLOTOLV Ot PUBKICELS KAEIBWHATOC TNG 006VNG.
« Edv 1o KAeidwpa 086vng Sev gival evepyomolnpévo, SIapoPPWOTE TIG
pubuioelg KAebwpaTog 006vng akoAouBwvTag Tig 0dnyieg tng 08vne. MNa
AemTopépeleg, avaTpé€Te 0TV evotnta PUBLIoN KAIdwuaTog 08ovng.

7 TomoBetriote 10 SAKTUNG GaG 0TOV AOBNTHPAG SAKTUNKWY OMOTUMIWHATWY
0T GUOKEUN Kal puBLioTE Tov otyd-otyd.

5 « TMathote eAagpd o MKTPo AloBNnTripag AaKTUA. ATOTUNTWUATA WOTE O
aleOnTAPAG va avayvwpioel 1o SOKTUNKO 00 AmoTUNWHA.

« BePaiwBeite 6T T0 SAKTUNG 0ag KAAUTTTEL OAOKAN PN TNV EMPAVELD TOU
aebNnTrPa AMOTUMIWHATOG.

@1 AL

3 AkohouBrote Tic 0dnyieg mou epgaviloval otnv 086vn.
+ Méxpt va ohokAnpwBei n kataywpLon Tou GAKTUAKOU AmOTUTTWHATOG,
KoOuvnoTe ENaQPWE TO i810 8dyTUNO TIAvw OToV ALoBNTAPA.

+ TomoBetrote 10 SdxTulo oTov alebnTpa. Otav Ba vikoete pa ddvnon,
apalpéoTe To SAyTUNO amo Tov AloBNTAPa.

E181kég Aertoupyieg
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/' 'Otav n Kataywplon Tou SAKTUNKOU amoTun@uatog ohokAnpwBei, matriote

OK.

+ Matjote Npoabnkn emmA. yia va kataywpioete AN SAKTUAIKS
amotunwya. Emeldr) 1o mooooTo emituyiag otnv avayvwplon SaKTUNKWY
AMOTUTIWHATWY EEPTATAL ATTO TNV KATACTAGCN TOU SAKTUNIKOU
AMOTUTIWHATOG TTOU EXETE KATAXWPIOEL, GUVIOTATAL N KATAXWPLON APKETWV
S10POPETIKWY SAKTUNKWY AMOTUTTWHATWV.

Awayeipion AakTtul. Amotunwpata

Mriopeite va enefepyaoTeite 1y va SlaypaPeTe Kataxwplopéva SAKTUAKA
QMOTUNTWHATA.

1 Zmv apxikn 086vn, matfiote PuBpioeig > Kheibwpa 006vng & ac@daheia >
AakTul ATOTUTTWHOTA..
7 ZekAelWoTE OUMPWVA HE TNV KaBopIopévn uéBodo KAeIGUATOC.

3 An6 ™ Nota Twv AakTul. ATIOTUTIOUATA, TTATHOTE TTAVW O€ £val SAKTUAIKO
amoTUTWUA YA VA TO PETOVOUACETE. MNa va To StaypdyeTe, TATHOTE TO KOUT{

1.

ZekAeibwpa TN 006vNng pe xprion dakTuMikol

AMOTUTTWHATOG

Mrmiopeite va Eekheldwoete TNV 006vn 1 va Seite To KAEIGWEVO TIEPIEXOHEVO

XPnotpomolvTag To SaKTuAkd cag amotunwiua. Evepyomoinon emOupuntrig

Aertoupyiac:

T Tt apxikr 086vn, matriote Pubpioeig > KAeidwpa 006vng & acgdheia >
AaKTul AOTUTTWHATA..

7 ZekAeldWoTE OUMPWVA HE TNV KaBopIopévn UéBodo KAeIGUaTOC.

3 v 0B6vn pubpicewv AaKTUN. ATOTUTIOHATO, EVEPYOTIOIOTE TNV EMOUNTA
Aertoupyia:

+ K\eidwpa 080vng: Zekheidwpia TG 086vNG Ue Xprion SaKTUNKoU
QMOTUTIWHOTOC.

+ Kheibwpa mepieyopévou: yia va EEKAEISWVETE TO TIEPIEXOLIEVO HIE XPrioN
SaKTUAIKOU amoTunmwpaTog. Ma va 1o kdvete autd, BePaiwdeite 0T éxel
£QapHOOTE( KAWL TEPIEXOUEVOU.

- Zek\eibwpa 006vng 6tav n 086vn ivat ofnoTh : ZekAeldWoTe TV 086vn
KON Kal 0tav autr ivat ofnotr Bdlovtag o SakTuAd 6ag 0To MARKTPO
Tpopodoaiag.
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Aertoupyia moAudigpyaciag

006vn MpoécPaTWV XPoEWY
TUPETE TO APXIKO KOUTTi — TPOG T TTAVW Kall KPATHOTE TO yla va Ogite To
TIPAOPATO IOTOPIKO XPHONG.

Avaduopevo mapdbupo

Mmopeite va avoifete TOMEC eQapuoyég oTnv 006vn Kat va eVAAAICOETTE VKON
QVAUEDA TOUG O€ KAOE OTIYU.
1 Z0pete MPOC Ta MAVW 0TO — A6 TO KATW MEPOC TNG 006vVNG.
7 TNatAoTe To EIKOVIBIO TNE EQAPHOYRC OTNV EMAVW apIoTEPH Ywvia T 086vng
NG EQappoyng kat emAé§Te Avaduopevo mapabupo.
+ AV TIATAOETE TO €1IKOVISI0 TNG EQAPUOYNG, EUPavi(ovTal ol EMAOYEC
MAnpogopieg epappoyrig, MoAamd mapdbupa, Avaduopevo mapdbupo
Kat Kapegito. epap.

3 Hegpapuoyn epgaviletal ue T pop@r avadudpevou mapabipou otnv 086vn.

E + Autij n uvatdtnTa evééxetal va pnv gival S100€01pn O OPIopEVES
EQAPHOYEC I 0BSVEC.
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Xprion Twv avadudpevwy mapadipwv
- —:Ehayiotomolei To avaduopevo mapabupo. To avadudpevo mapdBupo
€NAIOTOTIOLEITAL OTO AUWPOULEVO EIKOVISIO EQAPOYAC 0TV 086VnN, TO omoio
umopei va petakivndei omoudrimote BéAeTe.

roa
Loa

: Emexteivel v e@appoyr| oe mijpn 084vn.

« X :Kheivernv epappoyn.

5

+ Mmopeite va avoi€eTe £wg 5 EPUPHOYEC XPNOIUOTIOIWVTAG TA AVASUOHEVA
mapabupa.

« [0 va eMAECETE ia EQApPLIOYT Ao TIC AVOIXTEG EQAPUOYEC, TTATHOTE O
€va amo ta avaduopeva mapdBupa. To emeypévo avaduopevo mapdbupo
£PXETAL OTO TIPOOKNVIO.

+ Taavadudpeva mapdabupa Sev pmopolv va PETaKIvBoUv oTn ypapun
Katdotaong i otnv meploxr TG lpapur morynon.

Xprion Tou @akéNou e@appoywv yia avaduopeva mapdbupa

Av matrioete — 010 avaduoduevo mapdbupo, To avadudpevo mapddupo
e\ayloTOTOLEITAL OTO EIKOVISIO TNG EQAPHOYNG.

Mmopeite va PETaKIVATETE To €lkovidlo epappoyric omoudrmote BéNeTe, GUPOVTAC

TO.

Edv ehaytotomoinBouv 6uo 1y mepioodTepa avadudpeva mapdBupa, dnuoupyeitat
0 QAKENOC EQAPUOYWV IO VO TIEQIEXEL TA EIKOVISIA EPAPHOYWV.

5

« To €IKoviblo TNG EQapUOyNG TIOU Xpnatpomolifnke mpooeata
XPNnotpoTolEiTal wg To EIKOVISI0 Tou PakéNou epappoywv. Edv matrioete oto
€lkovidlo, 6Aa Ta elkovidla yia Ta eAayloTomoinpéva avaduodpeva mapdbupa
eppavifovTal 0To PAKENO EPAPHOYWV.

« Eav matrioete mapatetapéva Tov QAKeNo EQapUoywV yia avaduoueva
mapdBupa Kal CUPETE ToV PAKENO EQappoywv oy emioyr Alaypagn, o
@AaKeNog epappoywv Ba Slaypagei.

+ Tava Slaypdyete pia amo TiG EQAPHOYES ammd TO PAKENO EQAPLOYWY,
QVOIETE TOV (PAKENO EQAPHOYWY KAl CUPETE TO EIKOVISIO TNG EPAPHOYIG
EKTOC TOU POAKENOU EQAPHOYWV.
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MoA\amAd mapdBupa

‘Otav XpnOIPOTOIEITE TAOIYNON HE XEPOVORIES

1 Z0pete MPOC TA MAVW 0TO — OO TO KATW MEPOC TG 006VNC.

+ Epgavifovtal ol mpdo@ata XpnolUOTIOINUEVES EPAPUOYEC.

+ AV TIOTAOETE TO €1KOVISI0 TNG EQAPUOYNG, EPPavilovTal ol EMAOYEC
MAnpogopieg epappoyrig, MoAamd mapdbupa, Avaduopevo mapdbupo
kat Kapegito. epap.

7 MatioTe T0 £IKOVIBI0 TS EPAPUOYAC OTNY EMAVW APIOTEPR Ywvia TG
€(pappoyng mpog mpoRolr) oe moMamAd mapdBupa kat emAéETe MoAamAa
mapddupa.

+ HemMeypévn epappoyn Ba epeavioTei 0To mavw Wiod g 08évng.

3 MatAote 0TV AAn epappioyr) o BéAeTe va eugaviletal ota oA\
mapdbupa.

+ HemAeypévn epappoyn Ba peavioTei 0To KATW oo TG 08dvnc.

‘Otav xpnotponolgite morjynan pe Movo Koupmad
1 Natote [ oty yoapun morynonc.

+ Epgavifovtal ol Ipdo@ata XpNnOILOTIOINUEVEG EQAPHOYEG.

AV TIOTAOETE TO €1KOVIBIO TNG EPAPHOYNAE, ERpavifovTal oL EMAOYEC
MAnpogopieg epappoynig, MoAamd mapabupa, Avaduopevo mapdbupo
kal Kapeito. epap.

7 NatroTe To €IKOVIBIO TNC EQAPHOYNC OTNV EMAVW APICTEPY Ywvia TN
£@appoyn¢ mpog mpoPoAr oe ToMam\a napdBupa kat eniééte =,

+ HemMeypévn epappoyn Ba eppavioTei 0To mavw piod tng 0Bévng.

3 Matiote oty G\ gpappoyn mou Béete va epaviletat ota moAMamd
mapdbupa.

E « [0 va TpooapUOOETE To pPéyeBOG Twv TUNUATWY 0Tn Slaywplopévn 086vn,
OUPETE TN YPAUMR 0TO KEVTPO TNG 08dvNg.
« [la va amevepyorolroete Tn Aerroupyia moAMam\wv mapaBupwy, GUPETE TV
KEVTPIKI YR TTPOG Ta TIAVW 1 KATW WG TO TENOG TG 086vVNC.
+ H duvatétnta moMamwv mapabipwy Sev umooTtnpileTal amé oplopéveg
£QappOYEC LG 1y amod epappoyEg mou kateBadete amo To Play Store.
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E€aptiparta kat a§eocovdp Tou mpoiovtog
Ta mapakdtw otolyeia mepNapBdvovTal 0Tn GUOKEUH GO,

+ ZUoKeun + QopTioTAG
- Kahwdio USB + 08nyo¢ vpriyopng ekkivnong
+ Kapeitoa e€aywyng

A + Ta oTOIXEIO TTOU TIEPIYPAPOVTAL TTO TTAVW UTITOPE( VAl EiVal TTPOAIPETIKA.

Ta oTolKEl0 TOL TTAPEXOVTAL UE TN CUOKELN Kat TuXov SlaBéotpia agecoudp

umopei va SlapéPouy, avaloya UE TV TTEPLOXT KA TOV TIAPOXO UTTNPECIWV.

Na xpnotporoleite mavtote yviola ageooudp LG Electronics. H xprion

a&eooudp ANWVY KATAOKEUAOTWY EVOEXETAI VOl ETTNPEACEL TNV amoS00n

TwV KAOEWV 0TN OUOKEUN 00 1} va TIPOKAAETEL TIPOPAfaTA KATA TN

Aertoupyia. H emokeur) evog Tétolou mpoBAHaTOg EVOEXETAL VA PV

KAAUTITETAL QMO TNV UTINPEDIA EMOKEVWY TG LG.

+ MepIKd amo Tal PEPN TNG CUOKEUNG £XOUV KATAOKEUAOTE( OO EVIOUUEVO
YUoi. EGv n cuokeur| oag méoel mavw G€ pia okANpr emM@Avela i
TIPOOKPOUGEL KATTOU e SUvapn, umopei va mpokAnBei {nwud oto
OKANPUHEVO YUONL. Z€ QUTHV TV TTEPITTTWOT, SIAKOYTE AUECWGE TN XProN TNG
OUOKEUNG KAl EMKOWVWVAOTE e éva Kévtpo e§umnpétnong mehatwv tne LG.

E « Edv Aeimel omolodrmote amd autd Ta BaCIKA OTOIXEID, ETMKOIVWVIOTE UE TOV
aVTITPOOWTIO Amd TOV OTI0I0 AYOPACATE TN CUCKEUH.
« Tava ayopdoete mpooBeta oToIKElD, EMKOIVWVAOTE pE éva KEvipo
e§unnpétnong mehatwv Tne LG.
+ Oplopéva atolxeia mou mepIAapBavovTal TN GUOKEUAGIO TOU TIPOIOVTOG
evoExeTal va aMd&ouv xwpig mpogidomoinon.
H gpgpavion Kat ol mpodiaypagEg TG CUOKEUNG 0ag evoéxetat va aldgouv
Xwpig mpogidomoinon pe oTox0 TN BEATILGCN TOU TTPOIOVTOG.
O1mpodiaypa@ég TG GUCKEUNG EVOEXETaL va Sla@épouy, avdhoya pe TV,
TIEPIOXN 1) TOV TTAPOXO UTINPECIWV.
AQQIPEDTE TNV IPOCTATEUTIKK LEUBPAVN amd Tov aiobntripa AaKTUA.
ATIOTUTIWHATA TIPOTOU XPNCIHOTOICETE TN AEITOUpYia avayvwpiong
AakTtul. AoTuniwpaTa.
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Emokoénnon otoygiwv

AkouaoTIKO

Lo

Dakdg PTTPOCTIVIG
KAUEPAG

MAAKTPa €viaong
fixou (+/-)

MARkTpo Google Assistant —

AiobnTrpag
eyyuTnTag/ewTiopoU
TrepIBGAAovVTOg

*— [MAAkTpO
EVEPYOTTOINONG/KAEIBWHAT
oG (a1eOnTAPag AaKTUA.
AToTUTIWHATA)

0B6vn agrig

YTT030XI) OTEPEOPWVIKWV
QAKOUOTIKWV

Oupa @opTioTr/KaAwdiou
usB

s Mikpéowvo

?
Dakoi Tiow kapepag ©)
0O
Phag -

pa—

J

Bdon kaprag Nano-SIM

— NFC

Hyegio ——
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A MHN emiyelprioeTe va a@alpEGETE POVOL 0AG TO TTOW KAAUHAL.

e Sl0pOoPETIK TIEPITTWON, EVOEXETAL va UTTOCTEL GoBapr| {NId n umatapia
Kal | CUGKEUT TIoU MMTOpE( val 08Ny o€l o€ umepBEppavan, TupKayld
Kal Tpaupatiopd. To Tiow KAAUPA Kal N Hratapia auTrig TnG OUOKEUNG
Sev mpémel va agatpouvTal fj va avtikabiotavtal and pn KatapTIopévo
emayyehuaria.

+ To Aé@uwvo oag ival pia NAEKTPOVIKY) GUCKELN TTou TTapayel BeppdtnTa
Katd tn SIGPKELD TNG KAVOVIKAG Aettoupyiag tng. H dpeon emagr pe 1o
S€ppa yla eEAIPETIKA PEYANa XPOVIKE SlaoTrhpaTa, ENEIPEL EMAPKOUG
€€aepIopoU, umopei va odnyroel o Sucopia fj ykavpaTa mPWTou
Babpov. Zuvenwg, va xelpileoTe To TNAEQWVO HE MPOTOXT) TOGO KATA TN
XPON TWV AEITOUPYILV TOU GO0 Kal AUECWG HETA.

+ Alobntrpag eyyutnTac/@wtiopou mepiBaNhovTog

- AoBnTtApag eyyutntag: Katd tn Sidpkela piag KAong, o aiodntripag
€YYUTNTAC amevepyoTolel Tnv 086vn Kat T SuvatdtnTa agng, otav
1 ouokeun Bpioketal o€ piKpr amdoTaon armd To OWHA ToU XPAOTH.
Evepyorolei Eavd tnv 066vn Kat Tn SuvatdtnTa g OTav n GUCKEUN
Bpioketat €€w amd pia ouyKekpIpEvn EPPENeLa.
AloONTHPAC PWTICHOU TTEPIBANOVTOC: 0 AICONTHPAC PWTICHOU
mePIRAAOVTOG avVaAUEL TNV £VTAoN TOU QwTIoHOU TEPIBAAovTOG dTav gival
EVEPYOTIOINUEVN N AEITOUPYIa AUTOHATOU EAEYXOU QWTEIVOTNTAG.
+ MAAKTpa évtaong xou

- Mmopeite va mpooapudoeTe TV EvTaon Twv YWV KAONG, Twv KAoEwv i
TwV €I60TOIOEWV.
Evw xpnotuomoleite Tnv KApePa, TATAOTE AmaAd KATOLo amé Ta MARKTpa
€vTaong Nxou yia va Tpapnéete pia pwtoypagia. Na ouveyeic Muelc, ayyicte
Kall KOATAOTE TO TMARKTPO €VTaong fxou.

- Tla va eKKIVAOETE TNV e@appoyn Kapepa dtav n 086vn eival KAeldwpévn i
QTTEVEPYOTIOINEVN, TIOTAOTE TO MAKTPO HEiwong TG évtaong fxou 6uo
@opéc. Na va ekKIvAoETe TV epappoyn Capture+, TATAOTE TO TARKTPO
avénong tng évtaong rixou SU0 YopEC.

+ lox0¢/MARKTPO KAESWHATOG

- Matiote ouvtopa 1o MAAKTPO GTav BENETE Va EVEPYOTIOINOETE 1 Va
QMEVEPYOTIOINTETE TNV 0B4VN.

- Matiote T0 MARKTPO TAPATETAMEVA OTAV BENETE Va EVEPYOTIOIOETE A
emAoyn e\éyxou Aettoupyiag.
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« T\ijktpo Google Assistant
- Mrmopeite va 1o MaTHOETE GUVTOHA pial POpA yla va eKTENéETE TO Google
Assistant. Mmopeite va T TATHOETE TOPATETAWEVA YIA VO EKTENECETE TO
Google Assistant kat émelta va a@rioeTe 1o SAXTUAO amd To KOUpT yia va
EKTENEOETE TN AEITOUPYID PWVNTIKAG EVIOAAG.
- NegTo Google Assistant yla NeTTOPEPELEC.
+ AloOnTpag SaKTUNKWY amoTunwpdTwy
- EvepyomoioTe tn Aettoupyia avayvipiong AakTul. ATOTUTIWHATA Yia Val
amhormoinoete tn Sladikaoia EeKAeldwpaTog TNG 006vnG. Mo AemTopépeleg,
avatpé€te otnv evotnta Avayvwplon Aaktul. Aoturwpiata - [lapouvaiaon .

E + Oplopéveg Aettoupyieg pmopei va meplopifovTal, avaloya HE TV TIEPIOX Kal
TIG TTPOSIAYPAPES TOU TIPOIBVTOG ammd Sl0QOPETIKOUG TTAPOXOUG UTINPECIWV

TNAEMKOIVWVIWV.

Yndpxel evowpatwpévo toim NFC oto miow uépog Tou mpoidvTog.

TPOCEXETE WOTE VA PNV KATACTPEWPETE 1 KAAUTTTETE TO Toum NFC.

Mnv tomoBeteite Bapld QVTIKEIPEVA TIAVW 0T GUOKEUN 1} pnv KABeoTe Mavw

0€ QUTHV. Z€ avTiBeTn mepimtwon, pmopei va mpokAnOei PAGRN otnv 086vn

agic.

+ Hxprion mpootateuTikig MepPpdvng 086vng iy agecoudp evdéxetal va
TipoKaéoouv apeUBOAEG aTov alobnTripa eyyoTnTag.

+ Edv n ouokeun oag gival bypr 1 XpnOIUOTIOLEITAL O€ UEPOG E Uypasia, N
086vn 1} Ta Koupmd agrg evoéxetal va unv Aeitoupyolv owoTd.
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3T0 TPOIOV EVOWHATWVOVTAL SUO UIKPOPWVA. MPOCEKETE WOTE VA NV KAAUTITETE
Ta HIKpOYwva. Evw pihdte 0To TNAEQWVO, PNV KAAUTITETE TO HIKPOGWVO LE TNV
moAdun fy Ta SAXTUAG oag,

Mnv xpnotpomoteite Orkn TNAEPwvoU Tou Sev gival Yoo TTPOIOV Kal pnv
KOAOTITETE TO UIKPOPWVO HE aeooudp, Tawvia, K.A.

Kpatdte 1o mpoidv owoTd 4Tav To XPNOIUOTIOIETE, OTIWG UTOSEIKVUETAL OTNY
€lkova.

Mikpdpwvo Mnv KaAUTITETE TO HIKPOPWVO
1

Op ¢X
O

Mikpopwvo Mnv KaAUTITETE TO PHIKPOPWVO
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Evepyomnoinon 1) anevepyonoinon

Evepyonoinon
‘OTav n OUCKEUN Eival ATIEVEPYOTTOLNEVN, TIATAOTE TTAPATETAUEV TO TTARKTPO
evepyomoinon/KAEIOWHATOG.

5 + 'Otav n oUOKEUR evepyomolLEiTal YIa TTPWTN POoPA, TTPAYUATOTOLETAL N

apxikn Slapopewon. H mpwtn ekkivnon tou smartphone evééxetal va
Sl0PKETEL TTEPIOOOTEPN WPA ATTO O,TL CUVIHBWG.

Amnevepyomoinon
MotAoTe mapaTeTapéva To MARKTPO AEIToupyiag/KAEISWHATOC Kat EMAEETE
Anevepyonoinon.

Emavekkivnon tng 6UoKeURG
‘Otav n cuokeur 6ev AeITOUPYE OWOTA ) GV AVTATIOKPIVETAL, EMAVEKKIVAOTE TV
aKoAoUBWVTAC TIG TAPAKATW 08nyieC.

1

MoTAoTE Kat KPATHOTE TATNUEVO TO TTARKTPO EVEPYOTTOINONG/KAEIOWHATOG
KOl TO MARKTPO HEIONG TNG £VTOONG X0V TAUTOXPOVA LEXPL N GUCKEUN Val
amevepyomolnOei.

7 ‘Otav n ouokeun emavekkivnBei, aprioTe Ta MAAKTPA.

EmMoyéc eAéyxou Aettoupyiag
MatAoTe MapaTETAUEVA TO TARKTPO AeIToupyiag/KAESWUATOC Kal eMAEETE, 0N
GUVEXELQ, EVEPYOTIOINOTE LI ETMAOYH.

- Amevepyomoinon: ATievepYOTTOLEl T CUOKEUN.

+ Amevepyomoinon Kat EMaveKKivnon: EMaVeKKIVEL T OUOKEUH.
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TonoBétnon tn¢ kaptag SIM

TomoBetriote tnv kdpta SIM (Subscriber Identity Module) mou oag éxet
TIPOUNOEVGEL 0 TAPOXOC UTNPETIAV YIa VA EEKIVIOETE VA XPNOILOTOLEITE TN
OUOKEUN 00,

+ Na €i0Te TPOOEKTIKOI KATA TOV XEIPIOHO TNG KAPPITaaC §aywyng KaBuwg éxel
aunen akpn.

E « Ta va givat n OUOKELT 00C AMOTENEGUATIKA TTPOOTATEVLEVN aTtd TO VEPD Kal
Tn oKovn, Ba mpémel va TomoBeTeital owoTd n Brikn KApTag,

T TomoBetiote TV akiba otnv omr Tg BrKNG KAPTAG Kal TATHOTE Ty akiba,
émerta tpapri€te tn Orikn kdptag mpog Ta €w.

7 EuBuypappiote Tig kapteg Nano-SIM otn Brjkn KEPTag Kat TatAoTE TV KApTa
TIPOG TNV KaTeUBUVON TOU BENOUG OTIWG PAIVETAL OTNV EIKOVA.
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E .

Autr n ouokeur umooTnpilel povo Kapteg Nano SIM.

Nano Micro Kavovikn

o @

« Ta amedoon Xwpig MPoBAATA, CUVICTATAL VA XPNOILOTIOLEITE TN

OUOKEUN e ToV owaoTo TUMO TG KdpTag SIM. Na xpnaotuomoleite mavta tnv
£PYOOTAOIOAKIG KATAOKEUNG KapTa SIM TTou mapéxeTat amd Tov mdpoyo.

+ Mnv xdoete v kapta SIM. H LG Sev pépel kapia euBovn yia PAABES kat

AaMa ripoBArjuata mou mpokaAouVTaL aré TV anwAELd 1 T petaBifaon tng
Kaptag SIM.

Katd tnv eloaywyn A tnv agaipeon tng kaptag SIM mpénel va iote
TIPOCEKTIKOI yla val Unv mpokAnBei {nuid.

'Otav eloaydyete v kdpta SIM A TNV KapTa PvApnG, TomoBETAOTE TNV
0woTd oTn Brikn kdpTac,

'Otav eloaydyete T OrKkn kdptag avd otn cuokeur, TomoBeTHoTE

v op1lévTia PG TV KateuBuvaon tou BéNoug, driwg amelkoviletal.
BeBaiwBeite oTi n kdpta mou €xel TomoOeTnBel 0T Brikn KapTag dev éxel
@UyeL am6 T Béon TG

+ TomoBetriote TV kApTa SIM PE TIG XPUOEC EMAPEC OTPAUHEVES TTPOG Tal

KATW.

+ BePaiwBeite 6Tt dtav Tonmobeteite TV kdpta SIM 0Tn GUOKELN, akoAouBeite

TIG 08nyieg 0To eyxEIPISIO XPrioNnG.

« ‘Otav TomoBeTeite 1 apalpeite T OrKn KAPTAG AMd TN GUCKEUT, TPEMEL Val

TIPOGEXETE VA PNV TIEPACEL VEPO 1} AN LYPA Péoa aTnv umodoyn KapTag.
Eav n Brikn Kaptag 1 n kapta mou Ba TomoBEeTHOETE 0T GUOKEUH €ivat uypr),
TOTE eVEXETAL VA TTPOKANBEL (LA 0T GUOKEUN GG,

+ HKapta pvApng gival TPOAIPETIKT.

H ouxvi eyypaen Kat dlaypa@ri Se5opévwv pmopei va UEoEL Tn SlapKELa
QWG TNG KAPTAG UVRAHNG.

OpIOPEVEG KAPTEG LVAKING MITOPET VAl LNV €ival TARPWE CUMBOTES ME TN
ouokeur. H xprion piag pn cupBatrg Kaptag umopei mpokahéoel BAARN g
GUOKEUNG i} TG KAPTAG pvApNG, 1 va KataoTpéPel Ta dedopéva mou gival
amoBnKeupéva o€ AUTHV.
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TonoBétnon tng Kaptag PvMNG

TomoBeTAOTE TNV KAPTA UVIUING 0T GUOKEUN 00C.

H ouokeun pmopei va umootnpiet kdpta microSD éw¢ 2 TB. Avdhoya e Tov
KOTOOKEVOOTH KAl TOV TUTTO TNG KAPTAG PVHNG, KATIOLEG KAPTESG MVARING MMTOPE( va
unV gival CUMPBATEC e TN GUOKEUN GO,

T TomoBetiote TV Kap@itoa e€aywyr oTn omr Tiou Bpioketal oTnv urodoxK
NG KAPTAG.

TpaPnére mpog ta é§w v umodoxn TG kdpTag.

TomoBETAOTE TNV KAPTA MVIUNG OTNV UTIOS0XT TNG KAPTAC LE TIG XPUTES
EMAPEC OTPAUMEVEG TIPOG TA KATW.

w N

Kapra pvipng )
(TTwAEiTal EEXWPIOTA, TTPOAIPETIKA)

Képra SIM

/A Emotpéyte Ty umodoxn TG KAPTag otnv apyIkn g B£on.

A + OPIOPEVEC KAPTEC VNG UITOPE( va NV gival TAMPWS OUPPBATEC UE TN
ouokeun. H xprion piag pn oupBartic kaptag pmopei mpokaléoel BAGBN te
OUOKEUNG f} TNG KAPTAC PVARNG, i va KaTaoTpéPel Ta Sedopéva mou gival
amoBnKeupéva o€ AUTHV.

E «H ouyvn eyypaon kai Siaypa@n Sedopévwv Umopei va pelnoel T SIdpKela
CWNG TG KAPTAG UVAUNG.
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A@aipgon TG KAPTAG UVIUNG

la AOyouc ao@aleiag, amevepyomoloTe TV KAPTA UVAKING, TIPV TNV AQAIPEDETE.

T Zmv apxikr 066vn, matiote Pubpioeig > AoBNKeUTIKOG XWPOg >

7 TomoBetriote T kap@itoa e€aywync otnv omr mou Bpioketal oTnv umodoxn
NG KApTag Kat émetta TPAPAETE TN BrKN TG KAPTAC TTPOE Ta £§W.

3 AQaIpéoTe TV KAPTA PVAUNG amoé Tn Brkn KApTag.

/A Emotpéyte Ty umodoxn TG KAPTag otnv apyIkr g B£on.

A + Mnv agaipeite TV KAPTA PVARNG, EVW N CUOKEUN HETAPEPEL 1} XPNOIHOTIOLE!
Sedopéva. Mmopei va mpokAnBei amwAela iy KataoTtpogr dedopévawy, i
BAGPN TG KApTAG PVAHING 1 TG ouokeunc. H LG dev euBuvetar yia amwAeleg
TIOU €ival amOTENEGHA KAKNAG ) AKATAANANG XPONG TWV KAPTWV UVAKNG,
oupmeptAapBavopévng tng anwAelag SeSopEvwy.

Mnatapia

Odption TN prarapiag
TPtV XPNOILOTOIOETE TN GUOKEUN, POPTIOTE APWE TNV UraTtapia.
Oopriote T ouokeun e To Kahwdio USB tumou C.

= Akpodékng Kahwdiou ddptiong
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Baoikég Aertoupyieg

« Eav umdpyet uypacia otnv umodoxn POpTIoNG, o€ ANEG EKTEDEIIEVEG
UTOSOKEC, 0TO KAAWSIO POPTIONG, GTOV TTPOCAPHOYEA POPTIONG KATT,,
MNV XPNOLUOTIOLEITE I PopTI(ETE TO MPOIGV. To MPOIGV EVEKETAL Val
mapouatalel Suohermoupyia iy va éxel ahdoel 1) pOapei Kat umapxel Kivouvog
TpaupaTIopoL amd nAektpomAnéia, wtid, umepBéppavan, ékpnén, K.a. Eav
TIAPATNPHOETE LYPATIA O€ TETOLA ONpiEia, SIOKOYTE TN Xprion i T eopTIoN
TOU TIPOIOVTOG APECWG KOl AITOUAKPUVETE TIApWG TV UYPaoia.

« Mnv a@aipeite To KAAUpPaA NG pratapiag.
AuTO TO TIPOIOV XPNCIHOTOLEL PN apatpoUpevn pmatapia. Mnv agatpeite ry
uNV avTIKaBloTATE To KAAUUHA umatapiag 1 Thv pmatapia. EGv apaipéoete
I QVTIKOTAOTIOETE TO KAAUPHA prmaTapiag iy T patapia, umdpyel
mOavotnta PAAPNG, umepBEppavang i €Kpnéng Tou mPOIdVTOG.

« Xpnotgomoleite povo 1o kahwdio USB Kal Tov TposapHoyéa 9OPTIONG TTOU

TIOPEXETAL IE TO TIPOIOV.

H ouokeun oag Slabétel eowTepikn emavagopTi{dpevn pmatapia. Ma Sikr

00G AOPANELD, LNV APAIPEITE TNV EVOWUATWHEVN PmaTapia.

Y€ TEPIMTWON XPrONG TG OUOKEUNG VW auTr YopTilel, evoéxeTal va

mipokAnBei n\ektpomAnéia. MNa va XpnOIHOTOIOETE TN GUOKEUT, OTAHOTHAOTE

N POpTION.

AQaipéaTe Tov PopTioTH amd Ty mpila apol ohokAnpwbei n épTIoN TG
OUOKEUNG. ETOL amoTpémeTal N AOKOTTN KATavaAwan VEPYELQG.

‘Evag AMog TpOTIOC yia va QopTiOETE Ty umatapia ivat va ouvdéoete

éva kaAwd1o USB petal Tng ouokeung Kat evog emrpamédiou fi gopntol
umohoyloTn. H evépyela auTr| Umopei va ival EpIocoTePO XpovoRdpa amo
TN QOPTION TNG Pmatapiag o€ emroixia mpila.

Mn @opriCete Tnv pmatapia xpnotpomolwvtag USB hub mou dev

Suvarat va Slatnpriogt aTabepr| TNV ovopaoTIKh Tdon. Evoéxetat va unv
mipaypatomoinBei ¢opTion 1 va Slakorei.

« 'OtV EMOKEMTEDTE TO KEVTPO EMOKEUWV YIal KATTOL0 TPOBANUa 0TV
umatapia, mpémel va €xeTe padi 0ag To MPOIOV Kal ToV pOPTIOTH TIOU
XpPnolpomoleite. Emeidn n pumatapia ivat avaAwotpo mpoiov, n Siapkela
(WNG TG MIMOPE( VOl LEIWVETAL UE TO TIEPATHA TOU XPOVOU.
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I'Ipo<pu)\a££|c Kot m Xpnon e O'UOKEUT]C
- BeBawBeite ot ypnopomoleite To mapexdpevo Kahwdio USB. Mnv
xpnotpomoteite kahwdia USB 1} @OPTIOTEC TPITWV KATAOKEUAOTWV JE TN
OUOKeLN 060G, H meplopiopévn eyyunon e LG Sev KahUmTel T xprion
a€e00VAP TPITWV KATAOKEUAOTWV.

Tuxdv aduvapia Thpnong Twv odnylwv mou mepthapBdvovTal oTo mapdv
€YXEIPIBI0 Xpriong Kat n akatdAANAN Xprion EVEEXETAL VA £XOLV WG ATTOTENECHA
v mpdkAnon BAAPNG 0Tn GUOKEUH.

E « Avn Beppokpaacia tng umatapiag unepPei 1o kaBoplopévo 6plo Katd Tn

SIAPKELD TNG POPTIONG, N POPTION EVEEXETAL VA OTAUATHOEL.

+ Av 070 TTioW PEPOG TNG CUOKEUNG £XOUV TTPOCAPTNOE MayVNTIKG, METOANKA
1 GA\a ay@yIUa OTOIXEID, ) TPOOTATEUTIKY BriKn, TOTE N GUOKEUN EVOEXETAL
Va Unv @opTiCeTal KAVOVIKA.

+ HLG Electronics dev @épet kapia uBOvn yia mpoPAfjpata mou oxetiCovat
ue ageooudp ANwv etatpelv. Na tétola Bépata, aneubuvbeite otov
KOTAOKEVAOTH TOU QVTIOTOLXOU TIPOIOVTOG.

Amnoteleopatiki Xprion Tng pmatapiog
H Sidpketa {wng TnG Umatapiag Umopei va UelwBel Gv 0Tn GUOKEUR eKTENOLVTAL
TIOMNEG EQAPLOYEG KOl AEITOUPYIEG TAUTOXPOVA KAl OUVEXWG.
Ma va avgroete n Slapketa {wiig TG Umatapiag, TEPUATIOTE TIC AEITOUpYiEC TTOU
EKTENOUVTAL OTO TIAPACKAVIO.
Mo va ENaKIOTOTOINOETE TNV KATAVAAWON TNG LOXVOG TG Uratapiag, akohoubnote
TIC TAPAKATW CUUBOUAEG:
- Na anevepyoroleite Tn Suvatotnta Bluetooth® ry Siktuou Wi-Fi dtav ev Tig
XPNOILOTIOLEITE.
+ PuBpiote 1o Xpovikd 6plo TnG 086vng oTN HikpdTEPN SuvaTh TIn.
+ PuBpiote T QwtevotTa TG 006vng 010 EAAXIOTO.
- Evepyomotiote 1o kAeidwpa TG 006vng 6Tav Sev XpnOILOMOILETal N GUOKEUR.
+ ENéyETe TN 0TABUN pmaTapiag evw XPNOLUOTIOIETE EQAPOYES TTOU EXETE
KateBaceL
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006vn agn¢

Mriopeite va e§oikelwBeite Pe TOV ENeYXO TNG CUOKEUAC GAG XPNOILOTIOIWVTAG TIG

KIVOELG TIOU UTTOPEITE VOl KAVETE e Ta SAKTUAG 0ag oTnv 006vn aQng.

Matnpa
Mathote eENa@pd To SAKTUNS GaC yia va KAVETE pia emhoyn fj va emAEEETE kat va
EKTENEDETE IO EPAPHOYH.

Mapatetapévo matnua
M0 VO EUPAVIOTEL TO EVOU e TIC SIaBETIUES EMAOYEC, ) EVEPYELD TIOU AMAITELTAL
€{val To dyylypa Kat TO KPATNUA Yio OPKETA GEUTEPONENTAL.

Baoikég Aertoupyieg
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A6 matnua
MatAoTe ypriyopa SU0 GOPEC yia Vo LeyEOUVETE 1} va OUIKPUVETE Jia LlOTOoEAISA 1y
£vav xaptn.

Metakivnon

Ayyi€Te Kot KpaTioTe éva OToIXEID, AT pia epappioyn 1 éva widget kat, 0T ouvéeLa,
peTakIVAOTE To G TUNS 00 oe GANO onpieio akoAouBwvTag pia eNeyxOpevn kivnon.
Mnopeite va xpnoILOMOIOETE AUTAY TNV Kivnon Yio val UETAKIVACETE £va OTOIXE(D.

KaBetn kOhion

Ayyi€te TNV 086vn pe To SAXTUAO 0aG Kat HETAKIVAOTE TO YPYopa XWPIG Kapia
mavon. Mmopeite va XpnoILOTOIOETE QUTH TNV Kivnon yla va UETaKIVNOEeiTe Ot pia
NioTa, pia 1oTooeNiba, TIC WTOYPAPiE, TIC 0BOVES Kat GANaL
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Avotypa Kat KA€io1p0 Twv SakTUAWV

KAeioTe Ta U0 SAKTUAG 0aG YIa va GUYETE amo Wi EQAPOYH, OTIWG Yid
TapAdelypa amd pia pwtoypagia fy évav xaptn. MNa va peyeBovete Kamolo oTolxeio,
avoite ta SAKTUAA oag.

A « Mnv ekbétete TV 006vn agrig og umepBolika Suvatolg Kpadaopoug.
Mmopei va mpokAnBei BAGBN otov aloOntrpa agic.

E « XemepImwon XPriong TG CUCKEUNG KOVTA OE HAyVNTIKO, METAANIKO 1y
QywyLpo UAIKS, n 086vn a@rig VEEXETAL VA UNV AMOKPIVETAL.

Y& MePIMTWON XPriong TNG CUOKEUNG KATW A6 £VTOVO PWTIOHO, OTIWG TO
Apeco NNaKoO Gug, n 086vn pmopei va pnv givat opatr, avaloya pe T Béon
0aG. XpnOIHOTIOLEITE TN CUOKELN OF pial OKIEPH TomoBeaia r pia TomoBecia
E HETPIO QWTIONO, OE EVTOAON TIOU APKEL yia TNV avdyvwon evog BiBAiou.

« Mnv matdre mdvw oty 006vn pe umepPoNikr Suvaun.

« TotAote amald pe To SAKTUNG oag TV emAoyr TTou BENETE.

O éNeyx0G aPrC EVOEXETAL VO LNV AEITOUPYATEL CWOTA OE TIEPITTWON TTOU

(POPATE YAVTIA I} TTATATE IE TO AKPO TOU VUXIOU Ga.

0 é\eyxoc aQriG eVOEXETAL VA NV AEITOUPYHOEL OWOTA Qv 0TV 086VN €xel

OXNMATIOTE( bypacia.

« HoB6vn agrig evdéxeTal va pnv AEIToupyei GwoTd £V 0T OUOKEUN €XEL
TonoBetnOei mpootateuTikn pepBpdavn i aecoudp mou mpopunBeutrikate
amnd TpiTo KataoTna.

+ H eupavion piag oTaTiKG EIKOVAG Yia TTOPATETAMEVA XPOVIKG SlaoTrpaTa
umopei va 08nynoel otn Snpioupyia HETEIKAOHATOG 1 EI6WAOL 0TV 086V,
AmevepyorolioTte Tnv 086vn 1) ano@uyete Thv mPoBoAr| Tne idlag ikdvag
yiat peydho Sldotnpa otav Gev XpnGILOTIOIETE Tr) CUOKEUN.
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Apxikn 086vn

Emokonnon apxikrig 086vng

H apykr) 08évn gival To onpeio ekkivnong yia tnv mpoopaocn o S1apopeg
AEITOUPYIEC KOl EQAPUOYEC OTN CUOKEUN 0OC. ZUPETE TO SAKTUNO amd TO KATW
pépog omotadnmote 08dvng yia va petapeite aneubeiag otnv apxikri 00ovn.
Mmopeite va SlaKeIPIOTEITE ONEG TIG EQAPUOYEC Kal Ta widget aTnv apyikr 0Bovn.
YUpeTe T0 HAKTUNG 0ag 0TV 086VN TIPOC Ta aploTePd 1y Pog Ta Se€1d yia va Seite
ONEG TIG EYKATETTNHEVES EQAPHOYEG E HIOL HOTIA.

Aidtagn apxikng 066vng
Mmopeite va Seite ONeG TIC EQAPHOYEG KAl Va 0pYaVWOETE Ta widget Kat Toug
(aKENOUC 0TV apxIKr 006vn.

pappn kardotaong

Widget kaipol

Avalntnong Google

DékeAog —- Alnl o

Eikovidio ogAidag

| @ +— Nepioxn vprivopng
TpdoBacng

Tpappr TAorynang

E « Hapyikr 086vn evoéxetal va Slapépel avaAoya pe TV TTONITIKF TOU
KOTOOKELAOTH, TIG PUBUITELC XPrioTN, TV €K500N TOU AOYIOMIKOU 1 TOV
TIGPOXO UTINPETIWV.
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- Tpappn katdotaong: eppavilel eikovidla KaTdoTaong, TNV WEA Kal Tn oTAdun

NG pmatapiag.

Widget KatpoU: egavion mMnpo@opiiv Kalpol Kat XpOVOoU Yio GUYKEKPIHEVN

TIEPLOXN.

- Tpagiko atoiyeio Avalritnong Google: Aaktuhoypdgnae iy pika yia va
avoielg v Avadrtnon Google.

+ Odakelog: Mmopeite va Snpioupyeite pakéNoug yla va TomoBeTeite Tnv
€pappoyn pe Baon ta emBupnTd KpiTipla.

« Eikoviblo oghidag: ppavion Tou ouvolikou aplBuou Twv KapBddwv otnv
apxIkn 086vn. Mmopeite va ayyi&ete To emBupnTo elkovidio oehidag yia va
petapeite otn oehida TG emAoync oac. Oa emonuavOei o ekovidlo mou
eppaviCel Toug KapPBASEC EKEVNG TG OTLYUNG.

- Meproxn ypriyopng mpdaBaong: TomoBeTrioTe PACIKES EQAPHOYEC OTO KATW
Uépog TG 086vN¢ yia va gival Suvath n mpdoRaon oe AUTEC amd omolovanmoTe
KOPBA TG apxIkrg 006vNnc.

« Tpappn morynong: Mmopeite va petapeite otnv mponyoUpevn 08évn f tnv
apyIKr} 006vn v XPNOILOTOLETE TNV EQAPOYR Kat va eEAéyEeTe TN NioTa Twv
EQPAPHOYWV TTOU XPNOIUOTIOICATE TPOoPATA.

Xprion ¢ Fpappric morynong
AkolouBei 0 08NnYA¢ XelpovopIwY yia Tov ENeyxo TG lpapur morynon.

- Ta va petapeite otnv Apyikr 086vn, GUPETE TPOG TA TAVW ad TV KATW Ywvia
NG o0ovng.

[0 va emMoTPEPETE 0TNV TTPONYOUpEVN 08OVN, GUPETE TTPOG TA éCA amo TV
aptotepn f Tv Se€1d dkpn ¢ 08dvNc.

Mo va petafeite otnv 086vn EMoKOMNong, CUPETE TPOE Ta TAVW KAl KPATAOTE
amd TV KAtw MAEUPA TG 086vNC.

Mo ypriyopn evallayn HETa Twv EQappoYwy, CUPETE TPOG Ta Sedid amd To
KATW PEPOG TNG 086VNG yla va LETAREITE OTIC EQAPHOYEC TIOU XPNOILOTION0ATE
TIPONYOUUEVWG,

5 + O1 Xelpovoplieg ival n mpoemAoyr yla T ypappr morjynong. Ma va to
aMaéete oe Mévo koupma <]/ ) /[ omv apxki 086vn, matiote
PuBpiogic> MpoPoAr > Mpapun monynang, otn cuvéxela emAéEte Movo
Koupmd.
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Ewkovidia katdotaong

Otav umdpyel pia idomoinon yia éva adidaoTo privuua, éva cuppav
nuepoloyiou 1 umvntripy, N ypappn katdotaong epgaviel To avtiotolyo
elkoviblo eidomoinong. EAéy&Te TNV KaTAoTaon TNG GUOKEUAG 0OC UECW TWV
elkoviSiwv e1domoinong mou eppavifovtal 0T ypauur Katdotaong.

Z Aev undpyel oripa

H petadoon Sedopévwv mpaypatomoteital péow SIkTiou

PR

‘Exel pubpiotei unvntrpt

n] ‘Exel evepyomoinBei n Aerroupyia dévnong

3 ‘Exet evepyoroinOei 1o Bluetooth

YUvdeon pe umohoyloTh péow USB

Y140un unatapiog

AerToupyia TTACNG EvepyoToinuévn

Avamdvnteg KAAOELG

‘Exet ouvdebei To Wi-Fi

‘Exel evepyomoindei n Aerroupyia aiyaong

Q ‘Exel evepyoroinei 1o GPS

(0] ‘Exel evepyoroinei To popnTto onueio mpdopaong

N Agv undpyel kdpta SIM

m H Aerroupyia NFC givat evepyomoinuévn

E « Oplopéva amo autd ta eikovibla evoéxetal va epgavifovtat S10@opeTiKa iy
va pnv eggavifovtat kaBoAou, avaloya pe TNV KATAoTaon TG GUOKEUNG.
AlaBaote v meplypagn Twv ikoviSiwv avaloya pe To mEPIBANOV Kat TV
TIEPIOXT) OTTOU XPNOILOTIOIETE TN GUOKEUN KOl TOV TIAPOXO UTTNPETIWV.

« Ta ekovibla mou pgavifovtal voéxetal va Slagépouv avaloya He Thv
TIEPLOXI) KOl TOV TIAPOXO UTINPECIWV KIVNTHG TNAEPWVIAC.
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Mivakag eidomoloewv
Mriopeite va avoieTe Tov mivaka EI50MOICEWV GUPOVTAG TN YPAUUN KATAGTAONS
TIPOG Ta KATW 0TNV KUpla 08dvn.

« Mmopeite va oUpEeTE MPOE T KATW TO APdBupo E160MOICEWVY 1 VO TIATAOETE
T0 €IKovidlo BENoug yia va avoifete T AioTa pe Ta elkovibia ypriyopwv
pubuioswv.

+ Mnopeite va matroete /2 yia va MpOOBETETE, SlaYPAPETE 1 TAKTOTOWOETE Ta
elkovibla 0To mapabupo eI8OTOICEWV.

- Edv matioete mapatetapéva To eikoviblo, Ba epgavioTe n 08évn pubpicewv
yla TV avtioTolyn AtToupyia.

E « Mmopeite va XpnoILOTOICETE TOV TivaKa EI60TOICEWY aKOUa Kal dTav
n 086vn eivat KAelSwpévn. ZUPETE ToV Tivaka EI50MOIRCEWVY VW N 086vN
eivat KAeldwuévn, yla va amoKTHoETE ypriyopn mpooRacn oTig SuvatotnTeg
TIou BéNeTe.
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Evalayn otov mpocavatoAoué g o0dévng

Mriopeite va opioete va aAAalel auTOpaTa 0 TPOCAVATONOMOC TG 086vNng
QVANOYQ [IE TOV UOIKO TIPOCAVOTONGHO TNG CUCKEUNG.

2oV mivaka eidomotjogwy, emAEETe Mepiotpo@n amd tn Aiota Twv elkoviSiwv
ypryopnc mpoéofaong.

Mriopeite emiong va matriote PuBpioeig > MpoPoAn kat vepyomoiioTe Tnv
Autopatn meploTpoPr 086vNG oTNV apXIKr 08N,

Ene€epyacia tng apxikng 00ovng

TNV Apxikr) 086vn, ayyi€Te Kal KpATAOTE O€ éva KEVO ONKEIO KA, OTN GUVEXELD,

€MAEETE TNV EMBUUINTI EVEPYELD OO TIC TIOPOKATW.

- Ta va aMagete ™ didtaén Twv kapPddwv otnv apxikr 086vn, matioTe

TaPATETAPEVA TAVW OF évav KAUBA Kal CUPETE Tov O€ pia AN Béon.

la va mpooBéoete éva widget atnv Apxikry 006vn, ayyi€te €va kevo onueio TG

ApxIKG 086vng kal kpatroTe To emiéyovtag Widgets.

Mo va aMa&eTe Tametoapieg kat Bépata, matoTe mapaTeTapéva o€ éva Kevod

onueio otnv Apxikr 086vn Kat emAé€te PovTo & Oépa.

Mmopeite emiong va matrioete PuBpioeig > Oovto & Oépa otnv apyxikr 086vn

Kall, 0Tn OULVEXELQ, va eMAEEETE TameToapieg kat Bépata mou Ba epapuooeTe

OTN OUOKEUN.

+ T va aAagete To MAéypa, TIOTAOTE TAPATETAUEVA OF €Val KEVO ONUEIO TNG
ApyxIkric 086vnc Ka, oTn cuvéxela, emAéEte MAEypa. Matrhote To emBuunto
m\éypa, katdmy matiote Epappoyn.
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+ Tiava SlapopPWOETE TiG puBHIoEI; TNG ApXIKiG 08V, ayyi&Te éva kevo
onueio TG ApXIKiG 006vNG KAl KPATAOTE TO EMAEYOVTAG OTN CUVEXELD
PuBpioeig apyikrig 006vng. Mo Aemtopépeleg, avatpé€te oTnv evotnTta
PuBioeic apyikric 08ovng .

Mo va Seite 1 va eykataotioeTe Eavd TIC LN EYKATEOTNUEVEC EQAPMOYEC,
ayyi€te éva kevo onpeio TG ApxIKing 086vNng Kal KPATAOTE TO EMAEYOVTAG
Zkoumibia epappoy. Ma AeMTOUEPELES, AVATPECTE OTNV EVOTNTA ZKoUTTidIa
EQAPLIOY. .

Mo va aAa&eTe Ty mpoemiheypévn 006vn, ayyi€Te Kal KOATAOTE HIa KEVH

meploxn TNG ApXIKNG 006vng, peTakivnBeite otnv emBupnTr 086vn, ayyi€te To

koupi 1Y, Kal 0N ouvéxela ayyi€Te TRy 086vn yia AN Wia Gopd.

MpoetmiAeypévn 0B6vn
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MpoBoAn Tou Bépatog povTou
H mpoBoAi TG EIKGVAC POVTOU €ivat SuvaTr LOVO e TNV amdKpuyn Twv
€QAPUOYWV Kal Twv widget otnv apxikri 086vn.
Am\woTe Ta U0 SAKTUNG oag 0TV apyxIKn 0Bvn.
- o va emoTpéPeTe oTnV apyIkr 006V HE TIC EPappoYEC Kat Ta widget, evwoTe
70 SAKTUAG 0aG EVW) T OKOUPTTIATE 0TV APKIKI 086VN 1 GUPETE TTIPOG TA TIAVW
— amé TV KATw AKpn TG 080vng.

Metakivnon epappoywv aTnv apxikn 086vn
3TNV apxikn 006V, TaTHOTE MAPATETAUEVA TTAVW GE L0l EQAPHIOYT KOl CUPETE TV
O€ Hla GNn Béon.

+ [0 va KOPPITOWOETE TIG EQAPHOYEG TTOU XPNOIOTIOIOVVTAL CUXVA OTO KATW
UEPOG TNG APXIKHG 08OVNG, TTATAOTE MAPATETAUEVA TIAVW OF MIa EQAPMOYH, Kt
GUPETE TNV 0TNV TEPILOXT| YPIYOPNE MPOGRaoNG 0To KATw PEPOG TNG 006VNG.

- NMava apaipéoete éva gikovidlo amod v meptoxn ypriyopng mpoofaong, oUpete
0 €1KOVibIo 0TV apyIkr} 086vn.
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Xprion @akéAwv amd Tnv apyIikni 086vn
Anuovpyia akélwv

TNV apxIKf 006vn, TATHOTE MAPATETAUEVA TTIAVW OF MOl EQAPHOYI KOl CUPETE TV
TIAVW OE [t GAAN EQAPHOYN.
+ Anuioupyeital évag vEog PAKeNOG KAl Ol EQAPHOYEC TPOOTIOEVTAL OTOV PAKENO.

Ene€epyacia pakélwv

TNV apxIKf 006vn, ayyi€te £vav GAKENO Kal, EMEITA, EKTENEDTE pia amd TIG

OKONOUOEG EVEPYELEG.

« T va ene§epyaoTeite 10 GVopa YaKENOU, TATAOTE OTO AVOA YAKENOU.

Mo va eme€epyaoTEiTe TO XPWLA, TATHOTE 0ToV eMAVW Se€i KUKNO.

« [0 va mpooBEoeTe EQAPHOYES, ayYIETE Kal KPATAOTE TO EIKOVIOIO HIAG
E(QAPLOYNG, CUPETE TO TIAVW ATTO TO PAKENO Kal, 0T GUVEXELD, AQHOTE TO.

+ [0 va aQaIPECETE JIa EPAPHOYR ammd TOV QAKENO, TATAOTE TAPATETAPEVA
TIAVW 0NV EQAPHOYN Kal CUPETE TNV £§w amod Tov PakeMo. EGv n katapynBeioa
€pappoyn givat n Hovadikn epappoyr oTo QAkeNo, o pdakehog Ba KatapynBei
autdépata.

- Emiong, pmopeite va mpooBECETe 1 va apaipéoete eQappoyég matovtag ().

E + Aev pmopeite va aMAEETE TO XPWHA TOU PAKEAOU GTAV XPNOIUOTIOIEITE
Kamolo Bépa mou €xete KATeRATEL
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PuBpioeic apxikiig 086vng

Mmopeite va TPOCAPHOOETE TIG PUBICELS TNG apXIKAG 086vNG.

T Zmv apxikr 086vn, matiote Pubpioeig > MpoBor > Apxikr 086vn.

2 MpocappooTe TIG TapaKATw pubpicel:
- EmAé€re Apyikn oghiba: emAECTE Wi Aettoupyia amo Ty apxikr 086vn.
+ OAvto: aMdETe TV TameToapia YOVTOU TG apxIKNG 086vne.

+ E@é 006vng: emAé€Te 1o £@é mou Ba epappoletal Katd Tnv evalayn kappa

0TV apyIKr 086vn.
Ixnparta eikovidiwv: emAEETe edv BéNeTe Ta Elkovidia va Exouv
TETPAYWVIOUEVEC 1] OTPOYYUNEEVEC AKPEG.

+ Por Google: ppdvion ota aplotepd The Kuplag ApxIkrg 08évne.
+ Ta&ivopnon epappoywv avd: Seite pe molov Tpomo TagivopouvTal ot

EQAPLOYES OTNV aPXIKT 0BVN.

ANOKpUYN EQAPHOYWV: EMAEETE TIC EQAPHOYEC TIOU BENETE VA AMOKPUYETE
amoé v apxikr 08ovn.

Na emrpénerat KUKAIKN emavainyn ApXIKWV 00ovwv: EVEPYOTTOIOTE
AUTAY TNV EMAOYN Y10 va EMTPEPETE TN OLVEXH KUAION 0TV apX Ik 086vn
(emoTpéPTE HéOW BPOXOU OTNV MPWTN 006V PETA TNV TEAeUTaia 006vN).
TUpPETE MPOG Ta KATw 010 ApXIKN 006VN: Evepyomolrote v avalritnon
£QAPUOYWV 1 TIEPLEXOMEVOU ) TIPOPBANAETE EI8OTIOINTEIG GEPVOVTAG TTPOG TA
KATW 0TNV apyIKr) 006vn.

K\eidwpa Apyikri 006vn: EvepyomoloTe To yia va uny yivetat avadidtagn
1 amoudKpUVOn Eappoywv kat widget.

Baoikég Aertoupyieg 49



KA&idwpa 006vng

Mapouaciaon kAeibwparog 00ovng

H 086vn tn¢ oUOKEURG 0aG AmEVEPYOTIOLEITAL KAl KAEIOWVEL AUTOUATA OV TIOTHOETE
70 M\AKTPO Aettoupyiag/kheldwpatoc, To iSlo oupPaivel emiong kail 6tav n GUoKeUH
Tapapeivel o adpavela yia éva kaBoplopévo Xpovikd Sldotnua.

Eav matroete 10 MAKTPO evepyomoinonc/KAEIOWHATOS XwpiG val €XEL
evepyoroinOei To KAeibwua 006vng, Ba epgavioTei autopata n apyikr oddévn.

MNa va e€ao@aNioeTe TNV A0PAAEIA TNG CUCKEUNG KAl VO AMTOTPEWETE avemOUUINTN
TPOGRAON O AUTH, EvEPYOTTOINOTE TO KAEIdwHa 086vNG.

E + To KAeibwua 006vNG AMOTPEMEL TNV TIEPITTH EI0AYWYI| EVIOADV AQRG OTN
GUOKEUH KAl MEIWVEL TNV KATAVAAWON 10XU0G TNG PmaTapiag. Zuviotatal
V0l EVEPYOTIOIOETE TO KAEISWHa TG 006vNG 6Tav SV XPNOILOTOIETE TN
OUOKEUN.

PUBuIoN KAe1dwpaTog 006vNng
AlaTiBevTal ApKETEC EMAOYEC Yia TN SIAUOPPWON TwV PUOLIcEWY KAEISWUATOC TNG
obovng.
T Zmv apxir 086vn, matiote Pubpioeig > KAeidwpa 006vng & ao@aleia
> AloAé€te KAeidwpa 080vNG Kal, 0T OUVEXELD, EMAEETE TN PEBOSO TTou
TIPOTIMATE.
2 MpocappooTe TIG TapaKATw pubpicelc:
- Kavéva: amevepyomoinon Aetrtoupyiag KAeldwpatog 08évng.
+ ZUPETE: COPWOTE 0TNV 006VN yia va EeKNEIBWOETE TV 086vn.
+ Morifo: oxediaote éva potifo yla va EekheldwveTe Tnv 086vn.
+ Kwdikog kKAaldwpatog;: eloaydyete évav aplBuntikd kwdikéd mpdoBaong yla
va ekAeldwoeTe TV 0B6vn.
Kwd1kog mpooPaong: eloaydyete évav aApaplOpnTIko Kwdiké mpooRaong
yla va EEKAEIOWOETE TV 0B0vn.

+ AakTtul Amotunwpata: EEKAEISWOTE TV 006V XPNOIUOTIOIWVTAG TO
SaKTUNKG 0O amoTUMWA.

Baoikég Aertoupyieg 50



Mapapetpomoinon KAedwpatog 006vng KAEIdwATOG
Mriopeite va TposapHOCETE TV 006V KAEISWUATOG.
T Tt apxikr 086vn, matiote Pubpioeig > KAeidwpa 006vng & acgdheia >

Mapapetpomnoinon KAWOwuatog 08ovng.

7 Em\é€te wia Aerroupyia mou BéNete va puBpioeTe.

+ MOVTO: Zag EMTPEMEL VA OPIOETE TO PAVTO Yia TV 086V KAEWSWHATOG 00IC.

+ PolOt: Zag emtpémel va opioeTe moU va ToMoBETHOETE TO POAOL 0TV 086vN
KAEWBWUATOG,

+ JUVTOMEVOEIC: Zag EMTPEMEL va EMAEEETE TNV EQappoyn Tou Ba exteheoTel
oTnv 006vNn KAEWBWUOTOG oac. AuTH N pUBHION gival 0paTr LOVO OTav éxel
oploTei To KAeidwua 08évne.

« ZTolKEl0 EMAPNG OTNV TTEPITTTWON AMWAELAG TOU TNAEPWVOU: Zag Sivel
n SuvatdtnTa va opiceTe Keipevo oTnv 086vn KAEWSWATOC Yia vat
TIPOOSIOPICETE TOV KATOXO TOU TNAEQWVOU.

PuBuioeig ao@alol¢ KAEIbwHATOC

Mrmiopeite va opioete aopaleig pubpioelc KAeldWpaTog,

T Zmv apxikr 086vn, matiote Pubpioeig > KAeidwpa 006vng & acgaleiag
ao@dMeia > PuBpioeig acpaloig KAeldwuatog.

7 Em\é€te wa Nerroupyia mou BéNete va puBpioeTe.

+ Na @aivovtat ta potifa (eppavietal povo otav to Motifo éxel oploTei wg
KAeidwpa 086vNc): Evepyomoiote yia va KAveTe To poTio opato.

+ XpovodiakomTng KAEISWHATOG: Xag eMTPEMEL val pUBUI(ETE TO XPOVIKO
S1a0TNUa TTPIV TO QUTOUATO KAEIBWa TNG 080VNG agou KAEIOETE TOV
omioB10 PWTIoUO (xPoVIKS 6plo Adyw adpdvelag).

« To koupmi tpo@odooiag kKAeWdwvel oTtypiaia: Evepyomoliote autr v
emoyn yla va KAESWOETE apéowg Tnv 006vn 6Tav TECETE TO KOUKTI
gvepyomoinong / KAEWdwpaTtog. AuTr n puBUION umePIOoXVEL TNG pUBIONG
XPOVOSIAKOTTN KAEIOWHATOC A0PaAEiag.

Epgavion emhoynr¢ KAeISWHaToC (Ep@avileTal Hovo 6Tav éxel OpLoTEl
KAeidwpa 086vng): Evepyomoiriote autry Tnv emAoyn yia va epeaviletal
TO €IKOVISI0 KAEISWUATOG GTAV KPATATE TTATNHEVO TO IAMKTPO loxvog/
KAetdwpatog. MatroTe To 1Koviblo KAEIGWHOTOG YIa Va ATIEVEPYOTIOIOETE
70 €€unvo KAEIdwHa, To BIOMETPIKS EeKAEIdWHA KAl TIC EIGOTIOINCEIG 0TV
006vn KAeldwpaTog,
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+ Smart Lock: Za¢ Sivel Tn Suvatotnta va opiceTe aIOMOTn GUOKELN,
TomoBeoia, pwvr kat / i avixveuon 0To cwpia Tou Ba emTpéPel 0TO
TNAEPWVO 0ag va mapapével EEKAeISwuévo.

+ O18100é01ueg emMoyEg pevol evdéxeTal va Slapépouv avaloya pe Thv
emAeypévn péBodo 006vNG KAEISWUATOG.

Evepyomoinon 006vn¢
MropeiTe va EVEPYOTIOINOETE I VA ATTEVEPYOTIOINOETE TNV 006vVN pe SIMAG matnpa
mavw TG,

E « Auti n emoyn eivat Slabéoiun pdvo atnv apxikr 086vn e LG. Aev
Aertoupyei owoTd o€ Kamola e18IKN EQapuoyn EKKIVNoNG 1) 0TV apxIKn
086vn mou éxel eykataoTabei amd Tov Xprotn.

+ Ta va matroete v 086vn agrig, xpnotpomolrote To SAKTUAS oag. Mnv
XPNOILOTIOLEITE TO VUYL 0OC.

« Tlava xpnotpomolroete tn Aeitoupyia Evepyomoinon 08ovng, PePaiwbeite
oT1 0 ALoBNTAPAG EYYUTNTAC/PWTIOHOU Sev epmodileTal amod kdmolo
QUTOKONANTO 1 GAAN évn ouaia.

Evepyomoinon 086vng
MatrioTe pe 1o SAKTUNG oag 800 Popég 0Tn Péon Tng 0BdvNg.
- EQv matAoeTe 0T0 EMAVW 1} 0TO KATW PEPOC TNG 006vNE, 0 Babudc avayvwplong
NG Kivnong evaEKeTal va NV €ival EMOPKAG.

Amnevepyomnoinon 006vng

Ayyi€te pe 1o SAKTUNS 0aG SU0 PoPEC TTAVW OF €val KEVO Onueio oTnv ApXIKH
066vn kat otnv K\etdwpévn 0Bovn.

EvaakTikd, matriote S00 popég o€ évav Kevo XWPO OTN YPauur KATtdoTaong.

Anevepyonoinon Evepyomoinon 086vng

Eav 6ev BéNete va xpnotpomoleite T Aertoupyia Evepyoroinon 086vng, kavte Ta
ednc

v apxikn 086vn, matriote PuBpioeig > Emektaoeig > Evepyomoinon 086vng kat
OUPETE YI0 VO ATTEVEPYOTIOIOETE TN AEITOLPYIAL.

Baoikég Aertoupyieg 52



Kpumrtoypdgnon kaptag pvAaung
Mmopeite va KpUTTOYPAPHOETE Kall VA TTPOOTATEVCETE Ta SedOEVA TTOU
amoBnKevovTal 0TV KAPTA MVAKNG. Agv givat Suvatr n mpooBacn amo AMn
GUOKEUN 0T KPUTTToypa@npéva Sedopéva otV KAPTa Pvipne.
T Zmv apxikr 066vn, matiote Pubpioeig > KAeidwua 006vng & ac@pdheia >
Kpumrtoypdgnon & diamateutripia > Kpumrtoypdgnon kaptag SD.
7 AlaBAaoTe TV mapousiacn yia Ty KpUItoypaenon TS KAPTAg UvAipng mou
eu@aviCetal oTnv 086vn Kal TatroTe ZUVEXELD YIa VA GUVEXIOETE.
3 Evepyomotjote pia emoyn kat ayyifte Kpunrtoypagnon:
+ Kpumnrtoypd@nan véou apyeiou: yia va KPUTTOYPOPHOETE HOVO
Ta Sedopéva mou amoBnKeUTNKAV 0TV KAPTA PVAHING HETA TV
KpurToypagnon.
+ MAPNE KPUTTTOYPAPNON: VL0 VA KPUTTTOYPAproeTe OAa Ta Sedopéva Tou
lval amoBnKeupéva oTnV KAPTA VNG T SeSopévn OTIyUN.
- E€aipean apyeiwv MOANUPESWV: yia Va KPUTTTOYPAPHOETE OAa Ta apKeia,
EKTOC AMO APXEIN TTONUPESWVY, OTIWG APXEIQ LOUOIKNAE, PUTOYPAPIWY KAl
Bivteo.

E « Mg Eexvrioel n KpumToypdgnon TG KAETAG VNG, OPIOUEVEG
\ertoupyieg kaBiotavral un Stabéotpeg.

« Edv n ouokeun amevepyomnoinBei evw n kpumtoypagnon Ppioketat
o€ e€ENIEN, n Sladikaoia kpurtoypd@nong Ba amotUxel kat evoéxeTal
va KataoTtpagouv oplopéva dedopéva. MNa autd, mptv EEKIVACETE TNV
KPUTTTOypa@non, ENéyETe Katd mooov n oTabun The umatapiag givat
EMAPKNAG.

« Ta KpumToypa@nUEVa apxeia gival TPOoRAaIHa LOVO amd Tn CUOKEUR OThV
omoia £YIVE N KPUTITOYPAPNOT) TOUG.

+ H kpuntoypagnuévn Kapta pvipng dev pumopei va xpnatpomoinbei oe
AMn ouokeun LG. Ma va xpnotoToloETE TNV KPUITTOypa@npévn Kapta
MVIAUNG O€ KATola AN GUCKEUN KIVNTOU TNAEPWVOU, TIPETTEL VOl EKTENEDETE
pop@omoinon TG KApTac.

+ Mmopeite va evepyoTOICETE TNV KPUTTTOYPAPNON TNG KEPTAG PVANG
AKOUA KI OTaV SEV UTIAPXEL KAPTA UVAKING OTN GUOKEUT. KABe KdpTa puviung
iou Ba TomoBeTnBei peTd TV KpuTToypAPnon Ba KpunToypageiTal
autépara.
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AQYn oTiypiotunwy

Mmopeite va SnpioupynoeTe oTtyidTuma TG 006vng mou PAEMETE.

Méow ouvtopguong
MaTAOTE MAPATETAUEVA TO TARKTPO EVEPYOTIOINONG/KAEISWATOC KL TO TIARKTPO
MEILONG TNG £VTAONC X0V TAUTOXPOVA Yia ToUAdxioTov SUo SeutepolemTa.
+ Mropeite va Seite Ta oTiypidtuna 08évng mou éxete Tpapnéel otov GAkero
Screenshots 010 pevoy AApmoup.

Méow ZTiypiotumou 00dvng
Evw Bpiokeote otnv 086vn To oTiypidTumo TG omoiag BéNeTe va TpaPngeTe,
OUPETE TN YPAUMH KATAOTAONG TTPOG Ta KATW Kal TATHOTE Q

E « o Nemrtopépeleg, avatpé€te 0N evotnTta Anuioupyia ONUEIDOEWY OF va
oTlypIéTumo o0ovng.

Kotvn xprion mepiexopévou

Avanapaywyn meplexopévou amoé dAAn cuckeun

Mmopeite va IpayHaTomoINOETE avamapaywyr uToypalwy, BIVIEO 1 LOUCIKNAE

TIOU €XOUV AMOBNKEUTE! 0T GUGKEU O pia TNAEGPAON.

T Zuvbéote v tn\edpaon kat T cuokeur oTo iblo Siktuo Wi-Fi.

7 Katd v mpoBoAi Twv oToixeiwv 0To ANUITOUK 1 TN e@apuoyr) MOUGIKKG,
natote : > Avamapaywyr 0 GAAn GUOKEUR.

3 Emé€re v TNAedpaoh otnv omoia BéNeTe va ouvSeDsite.

« Ta xprion pe ouokeury Chromecast, ot urnpecieg Google Play mpémet va givat
EVNUEPWHEVEG.
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MpoBoAn eplEXOUEVOU AMIO KOVTIVEC GUOKEVEC
Mmopeite va Seite TepIEKOHEVO amd SIAQOPEG CUOKEVEG, TX. UTIONOYIOTH), CUOKEUN
NAS 1 popnTH GUGKEUT, XPNOIHOTIOIWVTAS TIG EQAPHOYEG AMUTIOUN 1} MOUGIKH).

ZUVOEON TWV GUOKEUWV

YUVOEOTE TN GUOKEUH GaG Kall Hitat GANAn CUOKEUT TTou umooTnpilel Tnv urnpeaia
DLNA o7o0 i610 acUpparto Siktuo.

E + BePawBeite 611 n Aertoupyia kowng xpriong apxeiwv (DLNA) ivat
€VEPYOTTOINUEVN Kall 0TN SIKK) 0AG GUCKEUN Kl 0T GUVSESEPEV CUOKEUN.

Avaltnon KovTIVWV GUCKEUWV

Mmopeite va Seite pa Aiota pe Tic ouokeuég DLNA mou ival ouvedepéve oto
{610 SikTUO EMAEYOVTAG TO peVOU = > KovTIVEG GUCKEUEG OE KABE EQapLOYY).
XpnotpomolioTe To MEPLEXOUEVO AMO TIG KOVTIVEG GUOKEVEC Omw¢ Ba To
XPnotpomolovoate v BpLokdTav oTn SIKH 0aG CUCKEUN.

Anootoli N AjYn apxeiwv
Mrmopeite va KAVETE Kowvn xprion apxeiwv LETA&Y TG OUOKEUNG 0aC Kal AMNNG
OUOKELNG LG 1 evdg tablet.

AmooToAn apyeiwv
An6 to Ahuroup 1y ané GAn epappioyn, tatiote + > Kown xprion 1 «< kat
€MAECETE 10 CUOKELN amo TN NOTa KOWVIG XProNG apxEiov.

AAqYn apyeinv

ZUPETE TN YPOAUU KATAOTAONG TPOG Ta KATW Kal TaTHoTe To Koupri Kowvi Xprion
Apxeiou.

Eav n ouokeun oag Sev umootnpilel TV Kowvr Xprion apxeiwy, oTnv apxikr
0606vn, matrjote Pubpioeig > Tuvdedepéveg ouokeuég > Koviy Xprion Apyeiou >
SmartShare Beam

«+ BePawBeite 611 n cuokeur| oag eivat cuvdedepévn 0To 610 aclppaTo
S{KTUO WE TN OUOKEUT TIPOOPIGHOU YIa T HETAPOPA TWV APXEIWV.

« BePawBeite 6L n Aertoupyia Koy Xprion Apxeiou givat evepyomoinuévn
Kall 0TIC 5U0 GUOKEUVEC,
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Mnv evoxAeite
Mmopeite va TepLopIOETE ) va ameVEQYOTTOINOETE TIC EGOTTOIATEIS YIA VA NV 0ag
€VOXAOUV Y10 €VOl GUYKEKPIUEVO XPOVIKO SIdoTnua.
SV apxikr 086vn, matriote PuBpioelg > 'Hyog > Mnv evoyAeite.
- Aerroupyia kat emAEETe T Aertoupyia mou BéeTe:
- Mdvo nmpotepatotnTa: mpaypatonoteitat Ajyn idomotrioewy Ke fxo i
86vNnon yia TIG EMAEYUEVES EQAPUOYEC. AKON Ki GTaV €ival evepyomoinuévn
n emoyr Mdvo mpotepaldtnTa, e§akohouBolv va nxouv ei50moINCELG.
- Zuvolikd aBo6pufo: amevepyorolei Kal Tov o Kat Tn dovnon.
- Emoyn mpotepatotritwv: AdBeTe £160mOINTELC Kal TIG EI5OTOINTELS YIa TIC
EMAEYHEVEC EQAPHOYEC,
- K\ijoeig amo: Pubpiote pia oglpd eidomomrioewv Katd T Agn KAogwv.

E « Emavalappavopevn KAjon: Méoa oe 15 Aemtd, n Sevtepn kKAon amd tov
{510 kahoUvTa Sev gival olwmnEn.

- Mnvopara ané: PuBpiote pia oglpd eidomoroewy Katd T Ajpn UnNvUpATwy.
+ Xprion Mnv evoyAeite: Evepyomoinote tn Aettoupyia Mnv evoxAeite.
+ Ynvog: OpioTe To MPAYPAUUA Yia TO oTToio BENETE va EvEPYOTTOIOETE TN
Aettoupyia Mnv evoyAeite.
- BonBeia: MpoPohn T forBeiag yia ™ Aettoupyia Mnv evoyAeite.
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Xpnoipeg
EPAPHOYEG



Eykatdaotaon Kal aneykataotacn
EPUPHOYWV

Eykatdotaon epapuoywv
Mrieite o€ éva KATAoTNHA EQAPHOYWV Yia va avalnTAOETE KAl Va KATERAOETE
EQAPHOYEG.
« Mropeite va xpnotporotfjoete 1o SmartWorld, To Play Store fj To katdotnpa
EQAPHOYWV TOU TIAPOXOU UTINPECIWV.

E + [lo opIopEVa KATAOTHHATA EQAPHOYWY EVEEXKETAL VA AmaITETaAL N

Snuioupyia Aoyaptacpou Kat n o0vSEan O QUTOV.

+ Tl0 OPIOPEVEG EQOPHOYEG EVOEXETAL VA UTIAPXEL XPEWDT.

« Edv xpnotpomoleite Sedopéva Kivntrg TNAepwviag, pmopei va emPBapuvBeite
E XPEWOELG Yia TN Xprion Sedopévwy, avaloya HE To TPOYPAUMA XPEWTEWY
TIOU €XETE EMMEEEL

+ HAerroupyia SmartWorld evééxetat va pnv umootnpietat avaloya pe Thv
TIEPLOXN 1 TOV TTAPOXO UTTNPECIWV.

Katdpynon eyKatdotaong eQappoywv
Katapynote amo Tn OUOKEUN 0ag TNV EYKATACTAC EQAPHOYWV TIoU Sev
XPNOUOTOLOUVTAL TIAEOV.

AMEYKATAOTOON PE MAPATETAMEVO AT A
MoTAoTE TAPATETAMEVA OF HI0L KEVE TIEPLOXT) OTNV 08OV KAl 0TN OUVEXELD TIOTAOTE
10 € TG £Qappoyn¢ o BéAeTe va SlaypayeTe.

Ameykatdotaon He XPron Tou pevol pubpicewv
SV apxikn 086vn, matriote PuBpioelg > Epappoyég > MAnpogopieg papuoyng,
€MAEETE Lla eappoyn Kat matriote Katdpynon eykatdotaong.

E « Aev gival Suvatr n KATAPYNON OPLOUEVWY EGAPOYWV OO TOUG XPHOTEG.
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Katdpynon eykatdotaong epappoywy amd 1o Katdotnpa
EQAPHOYWV

Mo va KaTapyHOETE TNV EYKATACTACN HIAG EQAPHOYAG, UMEITE OTO KATAOTNHA
EQAPHOYWV ATTO TO OTTO{0 KATEBACATE TNV EQAPHOYN KAl KATAPYAOTE TV
€yKATAoTAOH TNC.

Eykatdotaon Kat Katapynon eyKataotaong EQapUoywyv
KaTd T pLOuIon

‘OTaV EVEPYOTTIOIEITE T GUOKEUN IO TIPWTN YOPJ, UMOPE(TE va KATERAOETE TIG
TIPOTEIVOUEVEC EQAPOYEC.

Mmopeite va TapaKAUYETE AUTO TO BrKA KAl VA TIPOXWPNOETE OTO EMOUEVO XWPIG
V0l EXETE OAOKANPWOEL TNV EYKATACTACH.

Zkoumibia epappoy.
Mriopeite va Seite TIC epapuoyég ou €xouv ameykataoTtabei. Emiong, pmopeite va
EMAVEYKATOAOTHOETE TIC EQAPLOYES TTOU £XOUV aMEYKATAOTABE! TIC TEAEUTaES 24
WPEG.
T Zmv 0bovn apykn, matiote Alayeipion > Zkouridia pappoy..
Mmopeite akopa va ayyi€eTe pia Kevr TIEPLOXH 0TNV apxIKr) 086vn Kat va thv
Kpatroete ayyi(ovtag To Kouuni Zkoumidia epappoy.
7 Evepyoroinon emBuuntric Aertoupyiag:
+ Emavagopd: emaveykataotaon eMAEyUEVNG EQAPOYAC.
- {II] : KATAPYNOTE MOVIPIA TIG OMEYKATETTNLEVES EQAPUOYEC ATTO TN GUOKEUN.

E + Ol ameyKaTeEOTNUEVEG EQAPHOYEG KATAPYOUVTAL QUTOUOTA OO T CUCKEUN
24 MPEC UETA TNV ameyKaTdoTaor) Toug. Edv BéAeTe va eykataoTroete Eava
TIC AITEYKATEOTNHEVES EQApPLOYEC, Ba mpémel va Ti¢ katefdoete Eava amod To
KOTAOTNUO EQOPHOYWV.

+ Auti n Aettoupyia givat evepyomoinpévn HOVO 0TV MPOEMAEYHEVN APXIK

006vn. Edv ameykabloTdte eQappoyEG Katd tn xprion tng 08évng EasyHome
1) GANOU TTPOYPANHOTOG EKKIVNONG, AUTEG KATAPYOUVTAL ad T GUCKEUN
QMEOWG KA HOVIPAL.
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ZUVTOUEUCELG EQAPHOYWV
TNV apxIkr 086vn, ayyi€Te Kat KpATHOTE MATNHEVO £val €IKOVISIO EQaPHOYNG,
onw¢ Ta eikovidia KAron, Mrivupa, Kapepa, ANumouy, PUBICELG, yia va eavioTei
70 avTioTolyo Hevou ypriyopng mpdoPaong. Kavte mo 0koAn T xprion
EQAPUOYWV A€IOTIOIWVTAC TIC CUVTOEVUTELS EQAPUOYWV.

+ NatAote &) yia va pubuioete Ta widget yia Ty epappoyn.

+ Matiote (§) yia va Seite TIg TANPOPOpiES TG EQAPHOYAG.

E + Autij n Suvatdtnta eivat S1aB€otIHN MOVO Yia GUYKEKPILEVES EQOPHOYEG.
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TnAépwvo

OwvnTikn KAjon

MpaypatomoloeTe TNAEQWVIKY KAON XENOILOTTOIWVTAG KATTOLA OO TIG
Slabéoipeg peBddoug, Gmwg TNV MNKTPOAOYNoN Tou aplBoU TNAEPWVOU HE TO
XEPL, Kat emAéyovTag pia emagr amd tn Aiota enagwv 1 T Aiota mpdo@atwy
KA OEWV.

Mpayuatomoinon KAGng amo 1o MANKTPoAGylo
T Zmv apxiki 086vn, matiiote (B > KAfjon.
7 MpaypatonolfoTte pia KAon xpnotpomolovTag t uébodo e emhoyrg oag:
« TAnktpoloyaTe évav apiBud TAe@wvou kai matiote To koupri (®.
« Ayyi€te Kat kpatoTe €vav apiBpd taxeiag KAong.
+ AvalnTAOTE Hia EMOQH TTATWVTAG TO APXIKO YPALA TOU OVOUATOG TG
EMAQPNE 0TN NOTA EMAPWY, KAl TIATAOTE TO KOUTT Q

E « [la va eloaydyete 1o oUPPOMO «+» OTav mpaypatomoleite SieBveic KAOELS,
TIOTAOTE MAPATETAPEVA TOV APIOPO 0.

« BA. [lpoafikn ema@wv yio NemTOUEPELEG OXETIKA LE TOV TPATIO TPOOBRKNG
apIBuWV TNAEPWVOL GTN NioTa HE TIG Taxeieg KAOELC.

Mpayparomoinon KAoEwVY amo emagEg

1 v apxii 086vn, matote (B> Enagéc,

7 A@oU emAéEeTe Tov apIBPO TIoU BENETE val KAONEDETE a6 TN AioTa EMOPQY,
natiote &..
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Amndavtnon o€ KA\fjon

M0l VOl amaVTAOETE O€ Jia KAON, CUPETE TO KOUWTTE Q 0NV 006VN EL0EPXOUEVNG
Khnonc

‘Otav gival ouvSedepéva Ta OTEPEOPWVIKA AKOUOTIKE, UMTOPEITE va
TIPAYHATOTOIEITE KAOEIG XPNOUOTIOIWVTAG TO KOUTT KAYONG/TEPHATIOHOU
0TO OKOUOTIKG.

Mo va TeppatioeTe pia KAon xwpig va k\eioete Tv 08vn, matrote Sladoxika
PuBpiogig > Aiktuo & internet > PuBpiceic kK\jogswv > Amavtnon Kat
TEPUATIOHOG KAJOEWV Kall, 0TN CUVEXELD, EVEPYOTTOIOTE TN SuvaTtotnTa
Teppatiopdg KAjoNnG pe To mMAKTpo Tpopodoaiag.

E « Xnv apxikr 086vn, matrote PuBpioelg > Aiktuo & internet > PuBpioeig
KAOEWV > ATAVTNON KAl TEPUATIONOG KARGEWV > TEPUATIONOG
KAjoNnG pe To MARKTPO Tpogodoaiag kal Ba umopeite va Teppatioste
ot KAjon mativTag To MARKTPO KAEIGWHATOG/evepyomoinong 600 &ival
evepyomoinuévn n 08évn kKA\ong o€ EENEN.

Anéppupn KArjong
Mo va amoppiPete pia el0epXOMEVN KAON, CUPETE TO KOUTT ° otnv 0Bovn
E€10EPKOHEVNG KAONG.
Mo va oteilete éva privupa amdppiyng, CUPETE TV EMAOYH PNVOHOTOG
anoppltl)nc o€ OAn TNV 086vN.

+ Ta v mpoaoBrkn i eme€epyacia evog unNVOHATOC amdpEIYNG, OTNV APXIKH
066vn matriote PuBpioeig > Aiktuo & internet > KAfjon > ATokAEIopOG
KAong & Amoppiyn pe privupa.

+ Katd tnv eloepyopevn KAon, MAtoTe To MARKTPO alénong Tng évtaong
X0V, TO MAKTPO HEIWONG TNG €VTAONE HXOU 1) TO MARKTPO evepyomoinong/
KAEISWUATOG Yial Giyaon Tou HXou KARoNg f Tng 6vnong 1 yia 6éon tng kAfong
o€ avapovh.

'EAeyxo¢ E10€pXOMEVNG KANGNG EVW N e@appoyn BpiokeTal
o€ Aertoupyia

OTav €XETE 0 EI0EPXOUEVN KAON EVW XPNOILOTIOLEITE Hia Epappoyr, Ba
EUPAVIOTEL i avaduopievn €160moinon 0To EMAvw PEPOC TG 006vng. Mmopeite
va SeTElTe TNV KAON, VAl TV amoppieTe 1 va OTENETE purivupa amd Ty
avaduopevn 00ovn.
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5 « TtV apxiki 086vn, matrote > Pubuicei Aiktuo & internet > Pubpiceig
kAjoewv > Mp6aBeteg pubpioeig > MAaicio avaduong l0EpXOUEVNG
KAong kat mMAEETE Tov TPOTTO TIou BEAETE val eppavileTal n El0EpKOHEVN
KA|on 6TV XPNOIUOTIOIEITE UIa EQAPHOYY].

MpoBoAr avamavinTwv KAoEWV

Eav undpyel avamavintn KAon, n YPAUr Kataotacng 0To EMavw HEPOG TG
086vn¢ eppaviCer v €voeign X,

lNa va Seite oTolXEl YIa TIC AVATTAVTNTEG KA OELG, CUPETE TN YPAUUK KATAGTAONS
TPoG Ta katw. Mmopeite emiong va matroete (§ > Apxeia katayp. KAfo. oTnv
apxikrj 08ovn.

MpooBdoipeg Aertoupyieg katd tn Sidpkeia KARong
Kata tn Sidpketa piag kKAjong, pmopeite va éxete mpdofaon oe 0o
AEITOUPYIWV TTATWVTAG TA KOUUTIA TToU gpgaviovtal otnv 086vn:
Emagéc: Seite T Niota emaguwv katd T Stdpkela piag KAjone.
Avapovny: Balet tnv Tpéxouca KAON O avapovn.
MANKTP: yla va eUQavioeTe 1 va KPUYETE TO TANKTPOAGYIO KAONG.
Hxeio: yia va evepyomoiioete Tn Aettoupyia nyeiwv.
Ziyaon: yla va TpayuaTomoIoeTe olyacn 0To HIKPO@wVE 0ag €101 WOTE N
QWVN} 00C VA LNV OKOUYETAL OTOV CUVOUIANTH 0ag.
Bluetooth: mpowBroTe Tnv kKAron o€ Wia ouleuypévn kat ouvdedepévn
ouokeun Bluetooth.
. ° 1yl0 VO TEQUATIOETE TNV KAjon.

: :mip6opaon oe MPOBeTeC eMAOYEC KAFONG.

E - Ta 8l0Béoipa otolyeia pubpicewv evdéxetal va Siagépouv avaloya pe Ty
TIEPIOXN 1) TOV TTAPOXO UTINPECIWV.
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Mpayuaromoinon TpiUePoUE KARONG
Mriopeite va mpayUaTomoIoETe KAMON G€ AN EMAQR Katd T SIGEKELD oG
KAjong mou Bpioketat o€ eEENEN.
T Katén 8idpketa piag kAfong, matfote to kouprni : > Mpoodrikn kKAjong.
2 Mnktpohoynote évav apiBpd TAepwvou kat athote To koupri .

+ O16vo K\joelg eppavifovtal oTny 086vn TauToXPOVa Kal N TPWTN KAjon

Umaivel o€ avapovn.

3 Tiava EekivAoeTe pia kAo ouvSIdokePng, ayyi€te Zuyxwveuon.

E « Ta kaBe KArjon evdExeTal va IoXVEL XpEwan. MNa TIEPIOOOTEPEG TANPOYOPIES,
OUMPBOUNEUTEITE TOV TAPOXO UTINPECIWV.

MpofBoAn apxeiwv KAfoEWV
Mo v mpoBoAr) Twv apxeiwv MPAoPaTWV KAGEWY, 0TNV apxIKf 006vn TaTHoTE
> Apxeia katayp. KAAo.. Emerta, Pmopeite va XpnolOTOIOETE TIG TOPAKATW
\ertoupyieg:

- Tava dlaypdvete apyeia K\joewy, matiote = > Alaypa@n.

E + H &1dpkeia kArjong mou epgavietar evoéxetal va Slagépel amd tn didpkela
L0l TNV OTT0ia XPEWVEDTE. Ma TIEPIOOATEPES TTANPOYOPIES, CUMBOUNEUTEITE
TOV TIAPOYO UTTNPEDIWV.
Agv gival Suvatrj n amoKatdoTaon Tou S1ayPaUUEVOU IGTOPIKOU KAOEWV.
« [0 va IPOCapPUOCETE TO péYEDOG YPAUOTOOEIPAG TwV NUEPOOYiwV
KAOEWV 1} TV EMAQWV, TETTE pe SUo SayTula fj am\woTe Ta SaxTUNG oag.

Alapopewaon Twv emAoywv KAong

Mrmopeite va puBuioeTe TIg SIAPOPEC eMAOYEC KAONG.

T Zmv apxikr 086vn, matiote (B > Khjon 1y Apxeia katayp. KARG..

7 Natiote o koupri & > PuBpioei KANOEWV Kay, EMerta, SIapopewoTe TG
EMAOYEC CUUPWVA IE TIG TIPOTIUINCELG 0QG.
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Mivupa

AmooToA pnvUpaTog

Mriopeite va SnIoupynoETe Kal va OTEINETE UNVUKATA OTIC EMAPES 0O
XPNOILOTIOIWVTAG TV £Qappoyn «Mnvopata.

E « [0 TV amooToA UNVULATWY 0TO EEWTEPIKO EVOEXETAL VA LIOXUOLY EMTMAEOV
XPEWOELG, M0l TEPIOOOTEPES TANPOPOPIES, CUMPBOUNEUTEITE TOV IAPOXO
UTTNPECLWV.

1 Zmv apxikn 066vn, matriote ).
2 Natiote 1o koupni Cham-
3 Opiote mapaAATTTN Kat SNUIOUPYHOTE £val VLA,
+ T va XpNOIHOTIOAOETE TI EMAOYEC TONUHEOWY, TIATHOTE ().
+ [0l va amoKTrioeTe MPOGPaoN O TPOALPETIKA OTOIKEID LEVOU, TTATHOTE TO
Koupi «.
/A EmAéEte To B> (AMooTOM) yia va OTEINETE T urivupa.

Avayvwon pnvopatog

Mriopeite va Seite T pnvupaTa ou €XeTe AVTAANAEEL avA ETOQN.
1 Zmv apxikn 066vn, matriote ).

7 Em\é€te wa emagr armo tn \ioTa pnvupatwy.

Alopép@waon Twv pUOUICEWY PNVUUATWY

Mropeite va aMdeTe Tig puBpioELC avTOMAYRG UNVUHATWY £TCL WOTE Va
QVTAMOKPIVOVTAL OTIG TIPOTIUNTELG.

T v apxii 086vn, matiote ).

7 Natiote 1o koupri = > PuBpioeig and m ANiota unvupdtwy.

E + Mmopeite va em\é€ete pubpioelg yia To mapdBupo eidomoioewy, Tov
amoKAEIOS KAOEWY, TNV EI80TT0INON KATAGTPOPNG, T HNvUKATA
TIONUPEOWV, KATT.
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Kapepa

Ekkivnon ¢ kapepag

Mriopeite va TpaPriete pwtoypagia ry va eyypalete Bivieo yia va anabavartioete
OMEG TIG a€€XQOTEC OTIYUEG OQG.

TV apyikr 066vn, matriote ().

5

« Tl amd T AqPn HIag pwtoypapiag 1 Tnv eyypaer evog Bivieo, okoumioTe

TOV QOKO TNG KAUEPAG HE Eva amalo mavi.

+ TPpocéTe va pnv AeKIAOETE TOV QAKO TNG KAHEPAG HE Ta SAXTUAG oag 1) GNn

&évn ouoia.

« Ot IK6veg ou mepIAapBavovTal G€ auTd To EYXEPIBIO XPrioNG MITopE( va

Sla@éPouV amoé TNV MPAYHATIK) GUOKEUN).

« Mmopeite va mpoBANETE Kal va EMEEEPYAOTEITE TIG YWTOYPAPIEG KA TAL

Bivteo péow Tou ANUmoU. ol AeTOPEPELES, VOTPEETE 0TV EVOTNTA
Emokdmnon epappoyn¢ AAumouy .

+ MnV XpnOIMOTOIE(TE AUTO TO TTPOIOV Y10l OKOTIOUG TIOU EVOEXOHEVWG

mapaptalouy To ISIWTIKO andpEnTo 1 Ta SiKatwpata GAAwV.
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Aqn ewtoypapiog
Mriopeite va TpaPrEeTe QTOYPAPIES HE TV KALEPA GTO TIPOIOV.
1 NatAote (5) kat e0Tidote 070 Bépa oag.
« Mmopeite va ayyi&ete T 086vn 0To B€pa yia va £0TIAOETE € QUTO.
+ Mmopeite va avoiete 1 va evwoete Vo ddyTula yla peyébuvon f
opikpuvon.
7 Matote  yia va BydheTe pia pwrtoypagia.
+ Mmopeite emiong va matroeTe To MAKTPO avénong TG EVtaong fxou 1y 1o
TIANAKTPO HEiwong TG évtaong fXoU yia va TPaPHEETE pia wToypapia.
+ Mnopeite va TparEeTe pia wToypagia eVw YPAPETE BivTEO TATWVTAC TO
© otnv 08dvn.

Ot emhoyég mou epgaviovtal otnv 086vn AjPng evdéxetat va Slapépouv
avahoya e TV EMAEYUEVN KAPEPA (UMPOOTIV 1) TTHOW) Kal TN A&ttoupyia
Kduepag.

+ Hkdpepa Ba amevepyomoinOei autopata av Sev Ty XpnoIHOTOIOETE yia
Niyo HETA TNV eKTENEDN TNG EPappoyic Kapepa.

EkkivioTE TO
Google Lens.
EvaMayry

EPTTPOG/TTIoW

KapEPaAg

EmiAoyn puBpiong
XPOVOUETPOU

i

Emidoyr) puBpiong g _’ -
PAag

Egappoyr e@é¢ —3 o — \1) WTOYPAPILV
ovt <ot ﬁlﬂ fiyn Qwroypap

PUBuion avaloyiog —) Apoemokémmon

086vng Kauepag
PUBuIon Kauepag —
Tpéxouoa
AeiToupyia kKGuEPAg

Emhoyn
peyéBuvong
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5 + Mmopeite va eKTENETETE TNV EQapUOYH KAUEPAG TTATWVTAG Ypryopa SUo
(QOPEG TO TIAKTPO TPOYodoaiag. ETnv apyikr 08ovn matrote Pubpiceig
> EmeKTao€1g > ZUVTONEVOEIG Kall, 0T OUVEXELD, TATHOTE Avolypa
Qwtoypa@ikiig MnXaviig yia va Ty EVEPYOTIOIOETE.

+ ‘Otav n 086vn €ivat amevepyomolnuévn 1 KANESwEVN, HOpE(Te va
EKKIVIOETE TNV KAUEPA TTATWVTAG SU0 POPEG TO TMARKTPO MEIWONG TNG

€vtaonge.

TV apxiki 006vn, matrotePubpioelg > EMEKTATELG > ZUVTOUEVTELC Kal,
07T ouvéxela, matriote Avotypa Owtoypaikic Mnxavrc @ ) yava v
EVEPYOTIOINOETE.

Mpocappoyn Twv eMAOYWV TG KAUEPAS
Mriopeite va TpocappoceTe MANBOC EMAOYWV KAUEPAS AVANOYA HIE TIC

TIPOTIUACELG 0OC.

Ayyi&te To koupmi §83 otnv 086vn.

« O18100é01pec emMoyég Slapépouv avaloya Ke TV EMAeYpEVN (UMPooTvA iy
Tow) KAUEPa Kal TV emMAeypévn AelToupyia KapePag.

MéyeBog
puroypagiag

Emm\éyel Ti¢ Tiuég Tou Adyou SlaoTdoewv kal To péyebog yia
MUn ewToypaPIDV.

HDR

TpaBda pwtoypaieg pe {wnpd xpwuata Kat Snpioupyei 9
QVTIOTABIONG OKOUA KI 6TAV Ol pwToypapies tpaiodvtat
UE KOVTPA @WC. AUTEC Ol AEITOUpYIEC TTapéxovTal amod Tnv
Texvohoyia uPnAou Suvapikou vpoug (HDR) e v omoia
eivat e§omAiopévn n kapepa.

MAéypa

Epgaviote otnv 006vn kaBodnynTikd miéypata yia An
QWTOYPAPIWV 1} Eyypa®n Bivieo Bacel Twv opt{ovTiwy Kat
KOTOKOPUPWY YPOUHWY aVaPopdG.

E@appoyn 'Cheese'

Yag Sivel Tn duvatoTnTa va TPABAEETE pia pwToypagia
Aéyovtag ‘Cheese; 'Smile, 'Whiskey; ‘Kimchi'f ‘LG

TomoBsaia eTIKéTAC

AmoBnkevel Ty elkova elodyovtag Ta dedopéva tomobeaiag GPS.

AmnoBrikeuon

Emé€te edv BENeTE va amoBnKeVETE TIC PWTOYPAPIEC KL
1a Bivteo atov Eowtep. amoB. xwpog 1y otnv Kapta SD.
(AlatiBetal otav €xel TOMOOETN el KAPTA UVAUNG).
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Bonfsta

Mapéxel BorBela yia kdBe pevou T KApEPAG.

MpdoBOeteg emAoyég 0TV PMPOCTIV KApEPQ

Amnobrkeuon ATIOBNKEVEL TIG EIKOVEC WG AVECTPAUUEVEC KATA TV AN
avaoTPOYNG uiag selfie.
Selfie TpaPrée pia selfie emAéyovtag eite AjPn pe xelpovopia

XEPLOU €ite Autopatn Ajyn.

E « Mmopeite va epapuooeTe To £9€ pakiylad otav tpafdre pia selfie
XPNOIHOTIOIWVTAG TN MMPOOTIVA KAUEPQ.
+ HARYN pe xeipovopia XEPIOU EKTENEITAL UE AVAYVWPLON TOU OXAHOTOG EVOG
XEPLOU Kal n Autopatn Ajn YiveTal Pe avayvwplon EVOG TPOCWTTOU.

EmAoyn Aetroupyiag

Mmopeite va emAéyete e0koAa TN Aettoupyia Tou BéNeTe amo TG Aertoupyieg ou
epgavifovtal otnv 08vn, ot omoieg EMAEyoVTal GUUPWVA HE TO TTEPIBANOV

Munc.

MNatrote () kat 0UPETE TIC Nertoupyieg TG Kapepag aploTepd A 861 1 oUpeTe TV
086vn aplotepd 1y 5e€1d yia va emAECeTe pia AerToupyia KAPEPAG.

AeIToupyieg KAPEPAG
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Xprion Aertoupylwv Kapepag
Eyypaon Bivieo

1 Natiote (2) kat emé€te Bivieo o0povTag TG AerToupyieg g Kapepac.
7 Matiote e yiava eyypdpete éva Bivieo.

PuBpion kapepag —9 e —— ETiAoyn pUBuiong gAag

PuBpion avaiuong Bivieo Epappoyn e@é piAtpou

M o —— ETTIAOYI pEYVEOUVONG

MPOETTIOKOTINGT — et o ® e —— EvaAhayr) egtrpog/

I THow KApePag

Eyypaen Bivreo

+ Ta va TpaPnéete pia puToypagia Katd Ty eyypaen Bivieo, matiote To
Koupri © .

- Tiava Slak6Yete Mpoowpvd v eyypagr Bivieo, matioTe 1o Koupmi (11).
la va ouveyioeTe TV eyypagn Pivieo, MATHOTE TO Kouui (e .

+ Katd tnv eyypagn evog Bivteo, pmopeite va Teviwoete f va mdoete Vo
Saytula yia peyéBuvon 1 opikpuvon.

Katd v eyypaen Bivteo, pmopeite va ayyi€ete Tnv emBuuntr meploxr yia
va puBpioete T wteVOTNTA.
3 TMaTAoTE TO KOUUT | ) yia va TEPUATIOETE TNV eyypagn Pivteo.
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Myn pwtoypaepiag

Natiote (=) kat emhé§te PwTtoypagia GUPOVTAC TIG AEITOUPYIEC TNG KAUEPAG,

BA. Arjn gwtoypagiac ylo epIooOTEPEG AEMTOEPELEC.
NqYn ewtoypagiag pe ™ Aettoupyia Al

Katd tn Myn piag wrtoypagiag, n Aettoupyia Al avayvwpilet éva Bépa kat
XPNOOTOLE TO KATAMNAOTEPO EQE OTN PUTOYPAPIaL.

E « Matrote ’ Y10l VOl QTTEVEPYOTTOINOETE TN Agttoupyia Al.

Xprion mpocOeTwv AeITOUPYIWV KAUEPAC

Natote (&) kat emhége MeproodTepa 6UPOVTAG TIC AETOUPYiES TNG KAPEPAC.

Makpogwtoypagia

Mrmiopeite va BYANETE KOVTIVEG QWTOYPAPIES EVOG BEUATOG.

1 Natote O > (&) kai, 0T cuvéxela, matrote Mepiocotepa> &,
7 Matiote | yia va ByaheTe pia pwtoypagia.

XpriolpeG papuoyeg
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Mavépapa
Mropeite va SnUIoUPYNCETE pLd TTAVOPAMIKE QWTOYPAPIa METOKIVWVTAG TNV

KAUEPQ TTPOG piat KATEVOBUVON YIa AP PWTOYPAPIWV KAl CUPPAPH TWV CUVEXWY

MUewv piag evpuywviag MPoBoAng.

1 Natiote (5) kat emé€te NeproodTepa 00POVTAG TIG NerToupYieg TG KAUEPQC.

7 Natiote o Koupmi B3,
- EmAé€te pey£Buvon 1y opikpuvon amd €9 / @).

3 TatAOoTE To KoUK Kal, £MENTQ, JETAKIVHOTE TV KAWEPQ TIPOC i
KatevBuvon,.

/A Ayyi&te to kouuni @ yia va S1a0kOYETE TV TTAVOPAIKA AjYN.

Pubpion kapepag —OEI

5 + Otav PETaKIVEITE TV KAPEPA TTPOC ia KatevBuvon, Befaiwbeite 6Tin
086vn atnv omoia Kavete TV Ayn Sev Bpioketal EKTOC TG YPOUUAG
kaBodrynong.

XpriolpeG papuoyeg

72



Tpriyopo pAag
Ot pwtoypaieg mou AapBAvovTal o€ KavoviKo S1A0TnHa amoBnKevovTal we
apxeia GIF.
1 Natiote (&) kay, 0T cuvéxela, matiote Meploodtepa > R,
7 Matote . yia va BydheTe pia pwtoypagia.
+ O1pwtoypagiec A\appavovtal kabe 3 SeutepdAemTa kal amoOnKeLoVTAL WG
apyeio GIF.

« Ayyi€te [T v 086vn yia va emMEEeTe TOV apIBUS TWV PUTOYPOPIV TTIOU
Béhete va Tpapntete.

« Kata m Mjyn ewtoypagiav, atrote @ yia va Snpiovpyroste apyeia GIF
e QuTOYPaPieC TTOU €xeTe TPaBREel 0TO MAPENBOV.

E « To (Aag eVEPYOTTOLEITAL AUTOMATA YIa VA AEITOUPYIOEL WG XPOVOUETPO.

+ Auth givat n Mjyn Kat 0 6uVoNIKOG aptBPOG Twv APewv mou epgavifovtat
Katw amd v 0Bdvn.

+ ‘O)eg o1 e1KOVEG oL €xouv AnpBei amoBnkevovTal povo we apyeia GIF.
« Aev pmopeite va aAa&ete T Taxutnta GIF oUTe T OElpd EIKOVWV.

YouTube Live

Mriopeite va kataypAyeTe éva Bivieo kal va To amooTeileTe ameubeiog oTo
YouTube.

Mo va XpnotomooeTe auTh TRV SuvatoTnTa, MEEMEL VA TTANPEITE TIC
nipoumobécelg emhe§ipotnTag. Emkovwviote pe 1o YouTube yia Ti¢ mpoimoBéaeic.
1 v apyxikr 086vn, matrote (2).

7 Emé€te Neproodtepa aldlovtag Aertoupyieg TG KAUEPAG KAl TIATAOTE (o).

E « To YouTube Live givai SiaBéotpo povo 6Tav n GUCKELN 0ag ival
ouvdedepévn ato Sladiktuo. Edv xpnotpomoleite Sedopéva Kivntig
TNAEQWVIaC, UMopei va eMPBaPUVOELTE [E XPEWTELS yia TN XPrion Sedopévawy,
QVANOYQ E TO TIPOYPAUMA XQEWOEWV TTOU EXETE EMAECEL.
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XpNolua XapaKTNPIOTIKA KAEPOG

Google Lens

Mmopeic va MBeig meploodtepeg mMAnpogopieg 1y va avaldpelc Spdon oe
avTIKeipeva xpnotpomolwvtag Google Lens, dmwg opdonpa, agioeg, pevol
eoTiaTopiwy, {Wa, AouhoUdia, 1 YPAUUOKWOIKES, KAaTEUBEIQV 0T GUOKELH GOU.

KAeidwpa autopatng ékBeong/autépatng eotiaong

Mriopeite va mpooappooeTe T0 Tpéxov eminedo ékBeong kat Tn B¢on eotiaong
TIOTWVTOC TAPATETAUEVA TIAVW 0TV 086vn oTnv Autdpatn Asrtoupyia. MNa va
amevepyoroloeTe TN AerToupyia, ayyi&Te pia Kevr TepLoxr TG 086vNng.

KAgidwpa

- autépaTng
£kBeang/auTtopar
ng €aTiaong

E «+ AutA n duvatotnta gival SlaBéotun POVO O CUYKEKPIUEVES AEITOUPYIEC.

XpriolpeG papuoyeg
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EvaAhayn petadi Kapepwv
Mriopeite va evaANAooETe T Aettoupyia HeTady TG EPMPAC Kall TTow KAUEPAG yia
va Taipladel oto mepIBANov AMjung.
+ Ta evalayn} peTay NG PMPOGTIVAG Kall TNG TToW KAUEPAS, OUPETE TV 086vn
mévw A Katw otnv 086vn APng otnv epappoyn Kauepa.

E + XPNOIUOTIOIROTE TV MITPOOTIV KApePa yia va tpaBrigete selfie. Ma
AemTopépeleg, avaTtpé€te oty evotnta Selfie.

MeyéBuvon 1 opikpuvon
Mriopeite va avoiete 1 va evwoete U0 ddyTula yla peyéBuvon i opikpuvon 6tav
NapBdvete pwtoypaeieg i Bivteo.

E « H\erroupyia peyéBuvonc/opikpuvong dev givat Stabéaipn otn Aertoupyia

selfie (umpooTiv kApePa).
« Auti n Aertoupyia Sev umooTnpileTal o€ APKETEG KATAOTAOEIG AEIToUpYiag.
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Xpnon e Aetroupyiag MoAamhi Aqyn
Mriopeite va TpaPr&ete GUVEXOLEVEC PUITOYPAPIEC Kall VAl TIG SEITE WG KIVOUUEVES
€IKOVEC 0TO AAUTIOUp.
1 Natiote (5) kat emééte Owtoypaeia.
7 Matiote maparetapéva 1o
+ Evw) kpatate matnpévo 1o - AapBdavovtal TOANEC, ouvexOpEVEC
PWTOYPAPIES.

NAYnN pe xerpovopia xeptov
Mmopeite va tpapriéete selfie ivovtag eVTONEG pe AMAEG KIVIOELG TWV XEPIWV OO,
Avoi€Te TNV TOAGPN 060G OTPAUUEVN TIPOG TNV UITPOCTIVH KAKEPA Kal, EMELTA,
KAeioTe Ta SAKTUNG oag o€ ypoBid.
Mrmopeite akopn va kAeioeTe Ta SAXTUAG 0ag o YpoBid Kal va Ta avoi€eTe mpog Tn
UTTPOCTIV KApEPQ.

- YeTpia SeuTEPONEMTA MPAYUATOTIOLETAL AN PWTOYPAPIAG.

o

W

"

E « [la va xpnolpomoloeTe autrv T Aettoupyia, Uetapeite otn Aertoupyia
HITPOOTIVIG KAPEPQG KA, OTN GUVEXELD, ayYiETe Sladoxika §63 > Selfie >
AN pE XELPOVOpia XePLOU.
+ BeBaiwbeite o1t n maAdun oag Kat n ypobid oag Bpiokovtal eviog tng
YPOUUNAG QVaQOPA YIal VO UTTOPEL N KAPEPA VA TIG AVaYVWPIOEL
+ Auti n Aertoupyia evoéxetat va punv gival S1aB€otpn 6Tav xpnotpomolEite
OPIOEVES amtd TIG AEITOUPYiES TG KAUEPAG.
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Autépatn Aqyn

Mmopeite va XpnOILOTIOINCETE TN AEITOUPYIC AVIXVEUONG TIPOCWITOU VIO VAL
Tpapri&ete selfie ypriyopa ki e0koAa. Mmopeite va puBICETE T GUOKEUN £TOL
WOTE, OTAV KOITATE TNV 086VN, N UMPOCTIVH KAUEPQ AVIXVEVEL TO TIPOOWTTO 0aG Kalt
Tpafdel autopata pia selfie.

MOAIC N UTTPOOTIV KAUEPA QVIXVEVOEL TO TTIPOOWTO A, EPPavileTal éva
Aeuko mhaiotlo-08nyoe. Edv To Béua evtog Tou maiciou-o08nyol otapaTroel
Val KIVELTal, TO XpWwHa Tou TAALG{oU-08nyoU YiveTal KiTpIvo, Kat TOTE N Kauepa
Tpapdel pwToypaia.

E « Ayyi€te Sladoxika £03 > Selfie > Autépatn Ajyn yia va evepyorotioeTe
Aerroupyia «Autopatn Aqpn».

MeooSiaotnua AqPng
Mriopeite va tpaPriéete selfie pe xpovikn amoéotaon uetagy Touc.
EVW XPNOILOTIOIETE TV UIMPOCTIVA KAEPQ, AVOIETE TNV TTAAALN 0OG OTNV KAWEPA
Kay, émerta, KAeioTe Ta GAKTUNG 6a¢ ypriyopa o€ ypoBid emavalapBavovtag Ty
id1a kivnon dvo popéc.
+ ©a AneOolv TéooePIC wTOYPAPiEC S1adoyIKA HETA amd KaBuoTEPNON TPIWV
OeuTEPONEMTWVY Yol KaBepiaL.

AmoBrikeuon avacTpoPig
Mpw TPaPrEETE pia QuTOoypagia LE TNV UTPOOTIVA KApEPQ, ayYIETE TO Koupmi §53 >
AnoBrikeuon avasTpo@nc. H eikova avaotpépetal og opt{ovTio afova.

E + Katam xprion TG HmpoaTivig KAUEPAG, HMopEiTe va aAEEETE Tov TPOTIO
Mng Twv selfie oTig emMoyég Kapepag. MNa AemTopépeleg, avatpé€te oty
evotnta lMpooappoyr) Twv EmAoywv ¢ KAUEPAG .

Selfie
Mriopeite va XpnOIUOTIOICETE TV UMPOOTIVH KAUEPA Yia Vol S€iTe TO IPOoWTS
oag otnv 08dvn kai va tpaPriéete selfie.
1 Natiote (5) ka emé€re Dwtoypagia c0PoOVTAG TIG Nertoupyieg TG KAUEPAC.
7 Natiote {0} yia evalayr 0TV UmpooTIVA KAUEPQ.
3 MNatfote | yiava tpapréete pwtoypagia.

- NMatfote §) yia va epapudoeTe S1apopa GHOPPa EPE.

XPAOIUEG EPAPHOYEC 77



AApmoup

Emokonnon epappoyng ANumoup
M TI¢ pwToypapieg Kat Ta Bivieo mou €xouv amoBnKeUTEN 0T GUOKEUH Gag
napéxovTal SuvatotnTeg mPoBoAig Kat SIaxeipIong Toug.

MpofoAr pwTtoypaPIwV
Mrmiopeite va SeiTe TIC pTOypaPieS TTOU EXOUV AMOBNKEUTEL TO TTPOIOV.
1 Natiote € kat emé€te Tov emBupntod @akero.
7 Matiote oty emBupNTA QwToypaPia.
+ O @dakehog Ahumoup mepiéxel Ta Qwtoypagia, AApmoup, Avapvioelg Kat
Avanap.

EmoTpopA othy —¢

{5 — MNpoéoBaon oe dAAeg
TTponyoUpevn 0Boévn. 3

€TMIAOYEG.

s — [poeTmokoTnon dAuToUuN

Mpoaobrkn ) katdpynon

Alaypagr) eIkOVwy
aTré Ta ayaTnUéVa

Koivr) xprion €Ikovwy
Eme€epyaaia eikévwy

E « To pevol emtopepeldv epgaviletal dtav ayyilete eha@pwg v 086vn. Av
ayyi€ete Tnv 086vn akopa pia gopd, To pevou Ba e§apavioTei.
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Avamnapaywyn Bivteo
Mmopeite va Seite Ta Bivieo mou éouv amobnKeuTel 0TO MPOIOV.

e— lMpoéoBaon ot

EmoTtpogr) oTnv —&2
GAAeg eTTIAOYEG

TrponyoUpevn 08dvn

Ma00N | — e
avatapaywyn
Bivreo

s | |POETTIOKOTINOT GAUTIOUM

Mpoobrkn A katdpynon

Alaypagn eikévwv
aTrod Ta ayaTTnUEvVa ==

I— Koivr) xprion eikévwv

_-T_l

E + Tlava puBpioete TV évtaon tou nxov, TpaPrte T 6eid meupd oty
006vn evog Bivteo TPOG Ta KATW 1 TTPOE Tal TAVW.
« [0 va pUBHICETE TN PWTEVETNTA TNG 006VNG, CUPETE TNV APLOTEPT) TTAEUPA
0TV 086vn PG Ta ENAVW 1 TTPOG Tl KATW.
« Av oUpete v 086vn mpog Ta aploTtepd atnv 066vn avanapaywyrg Bivieo,
7o Bivteo Kiveital mpog Ta miow (REW) kat av cUpete mpog Ta Se€1a, umopeite
Val KIVAOETE TO BivTeo Pog Ta EUMPOG Kat ypriyopa (FF).

Emegepyaoia eikévwy
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Awaypagn apxeiwv
Mmopeite va SiaypAaeTe apxeia XpNOILOTOIWVTAC Ui ard TIG TAPAKATW EMAOYEG:
- Matiote mopatetapéva mavw o€ éva apxeio amd T NioTa apxeiwv kay, émetta,
emA\éCTe Alaypaepr.

Ta Slaypappéva apxeia petagépovial autdpata otov + >Kado

AMOPPIUHATWY KAl LTOPOUV Va avaKTNOoUV eMOTPEPOVTAC 0TO ANUTTIOUL
EVTOG 7 NUEPWV.

- MatAote 1o koupri [x] yia va Slaypdete udvipa ta apyeia. L& autiv v
TEPImTwon, Ta apxeia dev umopolv va avaktnBolv.

Koivij xprion apxeiwv

Mmopeite va KOIVOTIOICETE £val APXEIO XPNOILOTOIWVTAG Hia ammd TIG MapaKaTw

EMAOYEC:

- Evi) BAénete pia wtoypagia fj Bivieo, matioTe To Koupri < yia va
KOIVOTIOIOETE TO APXEIO XPNOIpoTOIWVTAG T HEB0SO Tou BéNETE.

5

« Edv tpaBnéete ouwtoypaoiss 1y Bivieo apou matoete (€) > £63 > TomoBesia

etikétac @ ), Snpioupyeital QUTOUATA TO GAUTTOUH QVAUVHOEWY
OUYKEKPIEVNG TOMOBEGIOG UETA amo €va OPIOHEVO XPOVIKO SIAoTNHA 0TV
KapTéAa AVAUVICELG TOU ANUTTOU.

+ OpIOPEVEG LOPPEG apXEiwV EVEEXETAL va pnv umtooTnpiovTal avaloya HE To

EYKATEOTNUEVO AOYIOUIKO.

« Evdéxetat va pnv ivat Suvatd to dvotyua oplopévwy apyeiwv e§artiog tg

KwSIKomoinarg Toug.

« Apyeia mou umepPaivouv To EMTPEMOUEVO Oplo peyEBoUG evdéxeTal va

TIPOKAAETOUV GQANUATA.
Mpémel va evepyomolroete Tn Aettoupyia GPS yia va dnuioupyrioete éva
GAUTTOUK pVApNG.
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Anuovpyia Tawvieg

Mriopeite va SnpioupynoeTe pia véa Tatvia cuvdualovTag eikOve kat Bivteo.

1 Natiote @ katemAé€te + > Anpioupyia Tawieg,

7 Em\é€te TiC eikdveg 1 Ta Bivieo mou BéAete va oupmep\aBeTe oty Tawia oag
Kat matrjote Anpiouvpyia Tawvieg.

3 EmeepyaoTeite TIC £IKGVEG Kal Ta BIVTED TIOU £XETe EMAECEL KAl TIATHOTE
AnoBrkeuon.

& —— ETravagopd apxeiwv

—— [poobrikn apxeiwv

E « ot Anpioupyia Tawieg, pmopeite va xpnotpomnolrnoete £wg 50 Bivteo.
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Anovpyia GIF

Mmopeite ebkoha va SnuoupynoeTe éva apyeio GIF xpnotpomolwvag
nxoypagnuévo Bivteo.

Natiote (Y kat em\é€te ¢ > Anpioupyia GIF.

Anuovpyia Bivteo
T Tn otypr mou Ba emé€ete otV apyr TS MPoBoi¢ evéc Bivteo, matioTe @),
7 Em\é€te 1o prikog Tou GIF miou OéAeTe va SnuioupynoeTe.
+ To GIF dnuioupyeitat yia o Xpovikd S1dotnpa mou éxel emAeYei amé To
KaBoPIoPEVO XPOVIKO ONpEio Evapéng.
« Na Bivteo pe Sidpkela Aiydtepo amo 5 SeutepoAemta, ot ikoveg GIF
SnoupyouvTal QUTOHATA YIa TV UTIOAOITTN WPa.

Anpovpyia pwrtoypagiwv GIF

T Zm Nota wtoypagiiv ot cuMoyr, matote - > Anwoupyia GIF.

7 Em\EETe pia eKOVa Yia va TN HETATPEYETE O wToypagia GIF kat émerta
natriote Anpioupyia GIF.

+ Mmopeite va mpooBéoeTe/SlaypAPeTe pia pwToypapia, Vo TPOCAPHOCETE
TNV TaxUTnNTa 1 Tov Adyo 08vng Kat va 0pIoETE TN OELPA TWV QWTOYPAPIWV.

E + Hénpioupyia pwtoypagiwv GIF givat pia AerToupyia ou mapéxetal yla Tov
XPOTN WOTE VO UMOPEL va TIAPAYEL SNUIOUPYIKES lKOVES. H mapaiaon
SIKalwPATWY OTIWG To SIKaiwpa TVEVHATIKAG IGloKTnaiag fi n SlafoAr
NG PANG GANOU ATOLIOU XPNOIUOTIOWWVTAS TN AetToupyia Snpoupyiag
pwtoypaplwv GIF evdéxetal va mPoKaAEGEL AOTIKI 1 TTOWVIKK Siwén
OUMQWVA JE TOUG LOXUOVTEG VOpOUG. Mnv avTypdpeTe i petadidete To £pyo
AaMou atdpou xwpic mponyoupevn eovatodétnon. H LG Electronics dev
@épel Kapia uBuvnN yla TETOIEG EVEPYELEG ATTO TOUG XPHOTEG.

+ Mmopeite va emMé€eTe éwg 100 pwToypapies OTav SNUIOUPYEITE pia EIKOVA
GIF.
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Emagég

Enagéc - Mapouoiaon
Mriopeite va amoBnKeVoETe Kal va SIAXEIPIOTEITE TIC EMOAPES.
SV apxikn 086vn, matrjote Ta amapaitnta > Emagéc.

MpocOnkn emagwv

MpooBnkn véwv emapwv
T Zv 0B6vn e Niotag Mgy, mathoTe To KOUUTT—-.
+ Oa gppaviotei éva avadudpevo mapdBupo yia va emiéEete T Béon
amoBriKeuong yla va Tnv Kovorolroete. EmAEETe Tn B€on mou BéheTe.

7 Eloaydyete ta otolyeia enmkowwviag kai matote AmoBrikevon.

Eicaywyn emagpwv

Mmopeite va eloayayeTe emagég amo i GAAn GUOKEUN amoBrikeuonc.

T Zmv 0B6vn e Niotag emagawy, ayyite Sladoyika ¢ > Maxeipion emagwv >
Ewcaywyn.

7 Em)\é€te TIc TomoBeaieC poEAELONC Kal TTPOOPICHOU Yia TV EMAQH TV
mipoopiletal yla elcaywyn kai matriote OK.

3 EmMé€te TIc emagéc kat ayyi€te Eloaywyn.

MpocBrikn ema@wv otn Aiota Taysiag KAjong

T Zmv 086vn e Niotag emagav, TatioTe 1o koupni ¢+ > Tayeia KAjon.
7 Ayyi€te NMpoaBrkn ema@ic and évav apiBuoé Tayeiag KAonc.

3 Em\é€te pua emagn.

« ‘Otav mpooBETeTe pia KavoUpyla emagn, TaTHoTE (57 yia va mpooBéoete
évav aplBuo tayeiag KAong.
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Avalfitnon emagwv
Mmopeite va mpaypatomoloete avadtnon MA@V XpNOOToLWVTag pia amd Tig
TOPAKATW EMAOYEG:

+ MotAoTe T ypaupr avaditnong oto endvw PéPog tng 08évng Emagwv kat
EI0AYETE TNV EMAPH ) TOV APIBUO TNAEPWVOU Yia Ta omoial BENETE va KAVETE
avalrtnon.

Mpaypatomnotiote KUAIoN TG NOTAC EMAQWV TIPOE Ta TIAVW 1 TTPOG TA KATW.
« A6 10 EUPETAPIO GTNV 006VN TNG NOTAG EMAPWY, EMAECTE TO APXIKS YpAppa
yia pia eman.

E « Eav matrioete ot ypappn avaditnong oto emdvw uépog tng 08ovng
Emagwv Kat elodyeTe pia emagn 1 évav aplbuo epwvou, Ba eupaviotov
Ta anoteNéopata avalfitnong amd To (0TopIkd KAoEWV Kal T AioTa
EMAPWV TTOU €ival AmOBNKEVUEVN OTN GUOKELN.

Niota ema@wv

Ene€epyacia emagpuwv

1 Zv 086vn e NoTag ema@wy, eMAEETE pia emagn.

7 v 0B6vn Twv OTOIKEIWV WAG EMAPRC, TATAGTE TO KoupTi /7 Kat
€MECEPYAOTEITE Ta OTOIYED.

3 MNatAote AmoBAKELON yia va anoBnKeUoeTe TIC AANAQYEC.

Awaypa@n emagwv
Mriopeite va SlaypAaYeTe EMAPES XPNOILOTIOIWVTAG Mot artd TIG TAPAKATW
emAoyéc:
+ 2TV 006vn TG NioTag emaguwy, ayyiTe Kat KpatioTe TV emagr| mou BéNeTe va
SlaypayeTe Ka, 0T OLVEKELD, ayYiETe ],
- Ayyi€te Siadoxika : > Alaypagn mou Bpioketat atnv 086vn Notag enagav.

E Ol amOMAKPUOHEVEG ETTAPES EVOEXETAL VA NV AITOKATACTABOUV.
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Mpocbrikn ayammpévwv

Mmopeite va KATaxWPICETE TIG EMAPES TTOU XPNOLUOTIOLEITE GUXVA WG AYATTNEVEG.
71 Zmv 006vn e NoTag ema@wy, emMAEETE pia emagn.

7 v 086vn Twv OTOIXEIWV WOG EMAQAC, IATAGTE TO KOUTT 1.

Anpiovpyia Opadag

T T Nota tg opadag enagiv, natiote —-.

2 MAnktpoloyroTe éva véo dvopa yia Ty opdda.

3 NatAote MpooBikn pehwv, em\éEte emagéc kat matrote NMpooBRkn.
/' Natfiote AmoBrikeuon yia va anoBnkeVoeTe T véa opdda.

QuickMemo+

Mapouaiaon TG e@appoyng QuickMemo+

Mriopeite va @TIAEETE SNUIOUPYIKES ONUEIWOELS XPNOILOTIOIWVTAG TV YKAUA
emAoywv mou S1aBETEL AUTA N TIPoNYUEVN SuVATOTNTA TOU ONUEIWHATAPIOU, OTTWG
n Siaxeipion ekévwv Kat otiypdtunwy. Ot emioyé auté Sev umootnpilovtat amd
TO GUUPBATIKO ONUEWUATAPLO.

AuTh n ouokeur) umooTnpilel To Evepyd oTuhd AES2.0 (Active ElectroStatic -
Evepyo HAektpoOTaTIKO).

Anuoupyia onpeiwong
T Zmv apxikr 066vn, matiote Ta anapaitnta > QuickMemo-+.
7 Natote 1o koupri @ yia va SnuoUpyACETE Wia onpeiwon.
- @ : anobrikeuon onpeiwong.
+ < : Avaipeon tng mponyoUHEVNG evEpYeLlag eme€epyaciac.
7 : EmavéAnyn twv mo mpoo@atwy vepyelwv SlaypaprG.
+ (T :el0aywyr OUEIWONG XPNOIHOTOIWVTAC TO TANKTPOASYIO.
- 9 : AIOBNKEVOTE TOUG ayannpévoug 6ag TUTIOUC OTUAD.
+ /1 Snpioupyia XepOYPaPWY CNUEIWTEWV.
& : 51ypagn XEPOYPAPWY ONUEIDITEWV.
- ¢ :TpdoPaon o GMeC eMAOYEG.
3 Natiote 1o kouuni @ yia va anobnkeloete T onpeiwon.
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Anoupyia CNUEIWCEWV G€ £va OTIYIOTUTIO 006VNG
T Katdmv mpoBoAr Tng 086vng mou BENETE va amOTUNIWOETE, GUPETE TN YPAUUN
KATAOTaONG TPOG Tal KATW Kall, 0TN GUVEXELD, ayyi€Te To koupr @).
+ H 0B86vn amotunwvetat kat ppavifetal we Likpoypagia 0to Se&16 KaTw
UéPOgG TG 0B6vNG.
7 Tiava YpAyete onuewoel; atny 066vn, Tatriote (&7
3 TpAYTe ONUEIDTELS XPNOILOTIOIOVTAG Ta epyaleia.
- 19 : Kavete peyéBuvon 1y opikpuvon 1y mpooappdoTe Ty meplox Mung.
/- dnuoupyia XepOYpaQWY ONUEIWOEWV.
& : Blaypagn XepOYPAPWY ONUEIDTEWV.
+ €51 Avaipeon g mponyoUpevng evépyelag eneéepyaoiac.
« (: EmavaAnyn Twv mo mpoo@atwy eVepyelv Slaypagrc.
+ (35 :Mepik6Wte v 080VN CUPPWVA KE TIC ATAITHTELG 00,
4 Natiote \/ Kat anoBnKeVOTE TG ONUEIWTEL.
+ Mmopeite va Seite TIC ONUEWOELS TToU anmoBnKeVoate 0To ANMTOUL.

MpdcOeta XapaKTNEIGTIKA META TN ARPN OTIYIOTUTIOU 000VNG

MarroTe yia va
QTTOTUTTWOETE OAOKANPN
v 086vn
XPNOIHOTIOIWVTAG TN
Suvarétnta KUAIONG.

MarroTe yia va

avatapaydyeTe 10

QATTOTUTTWHEVO OTIYHIOTUTIO
: 086vng.

MarroTe yia va ypdyeTe 7, fie—————— [latioTe yia va diaypayeTte
ONUEIWOEIG OTO ¥ . TO QTTOTUTTIWHEVO

QATTOTUTTWHEVO OTIYHIGTUTIO - OTIYMIOTUTIO 086VNG.
oBdvng.
MaTAOTE yia va PoIpaoTEiTe

TO ATTOTUTTWHEVO
OTIYMIOTUTIO 086VNG.
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5

« Mmopeite va amotunwoete 0OAOKAnEN Ty 086vN XPNOIHOTIOIWVTAG TN

SuvatdtnTa KUNONG.

+ Katan xprion piag epappoyng, dmwg ot Messaging kat Chrome, oUpete

T0 TAQ{O10 EISOTIONGEWV TIPOG TAL KATW KAl KATOTIY TTATHOTE o ‘Enerta,
TIATAOTE |, YId VO aMOTUhoeTe ONOKAN PN TN 086V Tiou BAEMETe ekeivn
TN OTIyHr WE €va Povo apxeio.

+ Autij n Suvatdtnta eivat S1aB€otn MOV Yia OPICHEVEG EQAPHOYEG TTOU

umootnpiouv T SuvatdtnTta KUNONG.

« Midote 6Uo SdyTula 1y amioTe Ta SAxTUAG oag yia va aAagete T diataén

TWV Onyeiwv.

PolAot

Agunvion

Mriopeite va opioete va xtummoet To unvntript pia kaBopiopévn wpa.

T Zmv apxikr 066vn, matiote Ta anapaitnta > PoA6L > A@imvion.

7 Natote 1o koupni—}- yia va mpooBéoete éva kawoUpylo EumvnTApL.
3 Aapop@woTe TIG pUBICEIC aUMVIONG Kat TIaTroTe ATTOBAKEUON.

5

« Edv em\é€eTe pia kataywpion apumviong mou gixe pUBUIOTE] 0T TAPENBOY,

UMOPEITE va EMEEEPYAOTEITE Ta OTOIXEIA TNG.

+ Tava Slaypayete pia emhoyn agUmviong, TOTAGTE TO KO +

> Aaypa@n. 0To eMavw uépog TG 086vng. EVAMAKTIKG, ToTrioTe
TIAPOTETAPEVA TNV APUTIVION.

Maykoaouo poAdt

Mriopeite va Seite TNV TPEXOUTA WPA OTIG TIOAELG OE OAO TOV KOGHO.

1 Zmv apxikn 086vn, matijote Ta anmapaitnta > PoASt > MayKoopio poAoL.
7 Natote o koupni -} Kat TpooBéaTe pia mOAN.

XpriolpeG papuoyeg
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Avtiotp. Xpovop.

Mmopeite va opioeTe va XTummoel To EunvnTript PETd amo éva kaboplopévo
XPOVIKO SidoTtnua.

T Zmv apxikr 066vn, matiote Ta anapaitnta > PoA6L > AvioTp. Xpovo.
7 Pubuiote Tnv wpa kai matiote Evapén.

+ Na avaoToAr Tou xpovodiakdmn, matriote Maven. la cuvéyion Tou
XPOVOSIOKOTTN, TIATAOTE ZUVEKELD.

3 MartAote AlakomH yia va SIOKOYETE TOV XPOVOSIOKOTTH.

Xpovopetpo
Mmopeite va XpnOIOTIOIOETE TO XPOVOUETPO YIa VA LETPHOETE TOV XPOVO yla
€vav yopo.
T Zmv apxikr 006vn, matiote Ta anapaitnta > PoAdL > XpovopeTpo.
7 Matiote 1o Kouuri Evapé&n yia va EEKIVHOEL TO XPOVOUETPO.
+ Tova PETPAOETE TOV XPOVO yia €vav YUpo, TatoTe Lap.
3 MNatfote Mavon yia va avacTe\eTe TO XPOVOUETPO.
+ [0l va OUVEXiOEL TO XPOVOUETPO, TATAOTE ZUVEXELQ.

+ T va dlaypdpete ONeC TIG EYYPAPES KAl VA EEKIVITETE TO XPOVOUETPO OO
v apxn, ayyite Emavagopd.

ApiOpopnxavn
Mriopeite va xpnotpomnolroete U0 TUTOUG UTOAOYIOTWV: TO AMTAG KOUTIOUTEPAKI
KOl TN MNXAVIKK aplOpopNXavh.
T Zmv apxikr 066vn, matiote Ta anapaitnta > ApiBuopnxavi.
7 XpnoomotioTe 1o MNKTPOAOYIO YIa VA KAVETE £VaV UTTONOYIGHO.
« Edv Bé\ete va yivel véog umohoyiopdc, matroTe mapartetapéva o {XJ.

Movuoikn

Mmopeite va akoUOETE Kat va SIaxELPIOTEITE TpayoUdia 1) LOUGIKA AAUTTOU.
T Zmv apxikr 086vn, matiote Ta anapaitnta > MouGIKN.

7 Em\é€te wia katnyopia.

3 EmAé€Te éva apyeio MOUOIKAC.
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EmoTpogr oTnv —
TIponyoupevn 0Bévn.

MoatoTe yia avamapaywyl —
aTT6 TV apXI| TOU TPEXOVTOG
apxeiou / MatoTe dUo @opég
yia avatapaywyr Tou
TIponyoUpEvoU apyeiou /
MatioTe TapaTteTapéva yia

.

it

—

e

Avoige/Kheioe 10 Dwg PAag.
PUBUION NXNTIKWY EQE.
— MMpdopacn oe GAAeG eTTIAOYEG.

— [avon A avamapaywyr.

— MarioTe yia avamapaywyn
TOU €TTOMEVOU apyeiou /
MotoTe TTapaTeTapéva yia

Mpooappoyn g éviaong
fxou.

MpooBnkn A diaypagr oo Ta

5

XpriolpeG papuoyeg

ETMIOTPOP ATNV aAPXH. Ypfiyopn Tpoiénor
E R | I T
Avamapaywyr og TUXGI"G —1 r Emioyn Aermoupyiag
oeipd. emavaAnyng.
—
—h % = MetdBaon otn Aiota

Avamapaywyng ot eGENgN.

]

OpIOPEVEC LOPPEC apxEiwV evOEXETal va Unv urtooTtnpilovTat avdhoya pe To
EYKATEOTNUEVO AOYIGUIKO.

Apyeia mou umepBaivouy To EMTPEMOPEVO OplO HeEYEBOUG EVOEXETAI VA
TIPOKAAEGOUV GPANUATA.

Ta apyeia Houolkrg evoéxeTal va mpooTatevovTal amo SIEBVEIC KaToxoug
TIVEUUOTIKWV SIKAWUATWY 1} TOUG VOHOUG TTEQT TIVEUUATIKWV SIKAUWUATWV.
Mo va avTypApeTe KAmolo apxeio MOUGIKNG, UMOPE( va XpelaoTel va AapeTe
vopipn adela. Na va mpayatomnoloete AN f avtypagr evog apyeiou
MOUGIKNG, ENéYETE TPWTA TN VOUOBEDIA TTEPi IVEUUATIKWV SIKAIWUATWY 0T
XWpa 6mmou BpioKeoTe.

AuTo To povTéNo umoaTnpilel avamapaywyn fxou Hi-Fi. Ta apyeia rixou Hi-Fi
epgavifovtal pe o ekovidio Hi-Fi.

Edv evepyomotrjoete o gAag, Ba avaBooPrivel CUMQWVA PE T LOUGCIK TIOU
avamapdyetat.

ayaTmnuéva.
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ThinQ

Mmopeite va cuvdéoeTe EUKONA TO TIPOIOV e GUOKEUVEG l0T yia va TIG
TIOPAKOAOUBEITE Kall val TIG XPNOIUOTIOIETE e AveEoN.
v apxikr 086vn, matriote Ta amapaitnta > ThinQ.

E + Mmopeite va KataywpioeTe MUVTHPIO POUXWY, CTEYVWTHPLO, CUCTNHA
@povTidag evéupdtwv styler, MAuVTHpLO MAETWY, GOUPVO Kal GKOUTIA POMTTIOT
oTaV TO TIPOIOV BPIOKETAL OE KATAOTOON AVALOVAG.

+ Avalntiiote To orjpa ThinQ oto mpoidv yia va kataAdBete av pmopei va
ouvdeDei e v epappoyr ThinQ.

« MNatjote = yia va udbeTe MePIOTOTEPA Yia SIAPOPES AEITOUPYIEG TG
gpapuoyrig ThinQ.

Eyypaen nyou

Mriopeite va nXoypa@roETe Kal va anoBnKeVOETE T Qwvh 6ag 1 TN Gwvr) AAwY
and onpavtika cuppavta. Emerta, Umopeite va mpayHaTomolETE avamapaywyn
1] KOWVOTIOINGN TWV GWVNTIKWY AUTWV APXEIWV.

T Zmv apxikr 006vn, matiote Ta anapaitnta > Eyypa@n fxou.
2 Natrote 1o koupri @.
- Tiava SlakoPeTe mpoowpvd Ty nxoypdenon, matfote 1o koupri @.
3 Natiote @ yia va TEPUATIOETE TV EYYPOQH.
- To apyeio amoBnkeveTal autopata kat eugaviletat n 006vn pe Ta apyeia
IOV €X0ULV NXoyPaPnOei.
4 NatAote 1o koupri @ yia avamapaywyr TG NXOyPaPNHEVNG QWVIC.

« Matiote =0 yia mpoBolr| Twv apxeiwv mou £xouv nyoypagnBei. Mmopeite
Va TIPAYHOTOTIOIOETE avamapaywyr eVag apxeiou nxoypaenuévng ewvig
amn6 ™ Niota.
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Mpoypappa Exkiv. Mayvid.

Mriopeite va emAé€ete av Ba xpnotpomoteital To Mpoypappa Ekkiv. Mayvid. dmou
umopeite va Seite T AioTa pe Ta maixvibia mou éxouv eykatacTabei oTo mpoiov
Kol va emAéyeTe pubuicelC yia Ta matgvidla, dmwg amevepyomoinon Tou RXOU Twv
TIOAUHECWVY, TIEPLOPIOO EIGOTOICEWY, KNI,

T Zmv apxikr 086vn, matiote Npdypappa Ekkiv. Magvis..

7 EmAé€te v emdoyry ou BéAeTe.

Smart Doctor

Mrmopeite va xpnotpomnolroete 1o Smart Doctor yia va SlayVwoeTe Ty KataoTtaon
TNG GUOKEUNG Kat va TN BENTIOTOMOIOETE.

Snv 086vn apyikn, matrjote Alaxeipion > Smart Doctor.

LG Mobile Switch

Méow tou LG Mobile Switch petagépete elkola Sedopéva amod Uia PETOXELPIOHEVN
GUOKEUN O€ IO VEQ GUOKEUN).
T Zmv apxikr 086vn, matiote Alayeipion > LG Mobile Switch.
Mmopeite emiong va matrioete PuBpioelg > Zuotnpa > Avtiypa@o ac@aleiag
> LG Mobile Switch.
+ EdQv n epappoyn Sev éxel eykataotabei oto mpoidv, AaBete Kat
€YKATAOTAOTE TNV €Qappoyn LG Mobile Switch amé to Google Play Store.
7 Akoloubriote i 08nyieg Tn¢ 006vng yia va emié€ete T emBupunt pébodo
UETAPOPAC.

E « Aev Ba SnuoupynBouv avtiypaga aopaleiag yia ta dedopéva o Evav
Moyaptaopd Google. Otav cuyxpovilelg Tov Aoyaplaoud cou ato Google, ot
epappoyéc Google, ot emagég Google, To Huepohdyio Google, Ta Sedopéva
NG EPapHOYNG onpelwpdTwy Google Kal ot EpapHOoyEG TTou KateRaivouv
am6 To Play Store amoBnkevovtal otnv epappoyr Drive autépata.

« QopTioTe MARPWG TNV Pmatapia mpiv amd Tn PETapopd Twv Sedopévwy yia
Va amo@eUBEi N AOKOTTN amevePyomoinon TNG CUOKEUNG KaTtd T SlapKela
¢ Sadikaciag.

XPAOIUEG EPAPHOYEC 91



Ikoumidia epappoy.

Mriopeite va Seite pia NioTa pe Slaypappéves EQAPUOYEG 0TV apxIKr 086ovn.
MmopeiTe va QVOKTAOETE A EQappoyr Tou SlaypdpnKe TiC TEAEUTAIES 24 WPEC,
Znv 086vn apxikn, matriote Alaxeipion > Zkoumibia epappoy..

Mo mePIoodTEPEC AETTTOUEPELES, AVATPEETE OTO S KOUTTIOIa EQAPLIOY..

RemoteCall Service

Mropei va yivel amopakpuopévn S1ayvwon TG CUOKEURG 0aE yla TV emAucn
Twv mpoPAnpatwv. Apxikd, kahéoTe 1o Kévtpo e§unnpétnong meatwv T LG
aKOAOUBWVTAC T MAPAKATW BripaTa:

E « [la va XpnoIHOMOICETE aUTHV T AEIToUpYia, TPEMEL TTPWTA Val
OUMQWVIOETE LE TOUG OPOUE XPrONG TG Aettoupyiag.
« Edv xpnotpomoleite Sedopéva Kivntrg TNAepwviag, pmopei va emPBapuvBeite
E XPEWOELG Y1a TN XPrion SeSopévwy, avaloya e TO TPOYPAUUA XPEWOEWY
TIOU €XETE EMAEEEL

T Zmv apxikr 086vn, matiote Ynnpeaieg > RemoteCall Service.
7 Mpaypatomoifote kKAjon mpog To Kévtpo e€unnpétnong mehativ tne LG.
3 Otav amavtnBei n kAo, akoAoubroTe TIC 08NyieC TOU CLVEPYATN EMOKEVWY
yla va loayayete évav eEapriglo aplopo.
« ExTeAeiTal amopakpuopévn 6UVEEDN 0T GUOKEUN 0ag Kal EeKIVeL n
QMOHOKPUOHEVN UTTOOTHPIEN.

Exmopnn KupéAng

Mriopeite va SeiTe TIC EKTTOPTTE KEIPEVOU O TIPAYHATIKO XPOVO OE KATAOTACEIG
€KTOKTNG QVAYKNG, OTIWG TUQWVES, TANUUUPEG KAl GEIGHOUC.

TV apxikr 006vn, matriote Yanpeaieg > Ekmounn KuYéng.
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Epappoyéc Google

Mriopeite va xpnotpomoljoste epappoyég Google opilovtag éva Aoyaplaoud
Google. Otav xpnotuomoleite pia epappoyr Google yia mpwtn @opd, eppavifetal
éva mapabupo kataxwplong Aoyaplacpou Google. Edv Sev éxete Aoyaplaopd
Google, SnpioupynoTe évav amoé Tn CUOKEUN 0ag. Ma AEMTOUEPEIEG OXETIKA ME TN
XPrion Hiag epappoyng, oupBouleuteite Tn BorBela otnv idia v epappoyn.

+ Oplopéveg pappoyEG evaExeTal va pnv Aettoupyolv, avaloya HE Thv
TIEPLOXN 1 TOV TTAPOXO UTTNPECIWV.

Huepoldylo

H epappoyr Huepoldylo cag emtpénel va mapakoloubeiTe To Mpoypauua
oupPavtwy oag (mou eoeic Snuioupyroate), opyavwpévo avd Huépa, ava 3
Huépec, ERSopdda i Mrva.

Chrome
‘Evag ypriyopog, am\og, KL ac@alrg mepinynTig, @TIayUEVOC yia TOV GUYXPOVO (0TO.

Eyypaga

To Docs gival éva cuNoyIkd epyaleio emeepyaciag KelpEvou Tou eVIoXVEL
TNV MapaywytkodTnTa. Xpnotpomolrote to Docs yia va dnuoupyrnoeTe, va
€MECEPYOOTEITE KAl VO GUVEPYOOTEITE OE TTPAYMATIKO XPOVO.

Google Drive

To Drive gival wpog amoBrKeuonc apxeiwv Kat KOV G EQAPHOYNG TToU O€
S1EUKONUVEL VA BPELG, Va MOLPACTEIG KAl OUVEPYAOTEIG O projects SOUAEIAG amo
mavtou, dpeoa.

Gmail

To Gmail eival pia eUkoAn 0T xprion pappoyr email mou Siatnpei Ta pnvopatd
00¢ A0QaAr, KAVEL TO ypaupaToKIBwTid oag §umvoTtepo kai oag fonBdel va iote
OPYAVWHEVOL.
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Google

H epappoyr Google o€ KpaTdel EVALEPO Y10 T TIPAYHATA TIOU OE EVOIAPEPOUV.
Bpeite ypriyopeg amavtioelg, €epeuviioTe Ta evolapépovTd oag, Kal udbete
IOTOPIEG KA TIAPTE EVNEPWOELS Yia BEATA TTOU 0O EVOIAPEPOUV.

Xdpteg

MNdte kamov; MnyaiveTe pe Toug XAPTES, N EPAPUOYH 0TV OTOoial PUMOPE(TE
va BOoIOTEITE Yio TAOAYNON O TIPAYHATIKS XPAVO, yia Thv KukAogopia, Tn
GUYKOWVWVIQ, Kl YIol NETTTOPEPELEC VIOl EKATOUUUPIA EPN, OTIWG KPITIKEC Kall
SNUOPIEIC WPEC.

Owroypagieg
To omitt yla OAEC TIC QWTOYPAPIES KAl TA BIVTES 0AE, AUTOUATA OPYAVWUEVA ETOL
WOTE VO UMOPE(TE va LolpAleaTe Kal va amoBnKeVETe 6,T1 éxel onuacia.

Touvieg kat TV Play
XpnotpomotjoTe Tov Aoyaplacpé oag Google yia evoikiaon r ayopd Taviwv.
Mmopeite va ayopAoeTe TEPIEXOUEVO Yia avamapaywyr mavtou.

YT Music

Mia véa umnpeaia streaming pouoikrg amod to YouTube.

YnoAoyloTIKA QUANG

To Sheets givai éva cuMoYIkO epyaleio eme§epyaciog UMONOYIOTIKWY GUANAWY
TIOU EVIOXVEL TNV TTAPAYWYIKOTNTA. Xpnolpomoljote To Sheets yia va el0AyeTe, va
OPYOVWOETE Kalt va avaAUoETE MANPOPOpieS Hali 0€ MPAyUATIKO XPOVO.

Mapouaidoeig

To Google Slides givat éva cuMoyIko epyaleio Snpioupyiag mapouoiaong mou
€VIOXVEL TNV TTapaywylKotnTa. Xpnotporotjote to Slides yia va opyavwoete
TIANPOPOPIEC, VO IOPOUCIACETE AMOTEAEGHATA, Kall VO TTAPVETE anmopacelg pali oe
TIPAYHATIKO XPOVO.

YouTube

MapakoAouBnoe Ta ayarmnpéva 6ou Kavahia, GKOUOE Tr LOUCIKH TTou ayarmdg, Kat
avéBaoe PIVTEOD yia VA LOIPACTEIC e avOpWmoug amd OAO ToV KOGHO.
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Bon0dg

H ouokeun oag €xel Tov BonB6 Google evowpatwpévo. Bpeite amavtroeig Kat Kave
nipdypata otny mopeia. MNa va Eekvioelg, amd mdta 1o kAeSi BonBog Google otnv
TINEUPA TOU TNAEPWVOU 1 AYYIEE Kl KOATA TO APXIKO KOUMTTi TOU TNAEQWVOU.

E « O BonBd¢ Google dev gival S1aBEGIHOG OE GUYKEKPILEVEG YAWOOES Kal
XWPEC.

Files
Mmopeite va mpoBaleTe kall va SIOXEIPIOTEITE Ta apXEia TTOU €KOLV amOBNKeUTE]
0T GUOKEUN 00C.
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PuBpiosig

Mmopeite va TpooapUAOETE TIC PUOUITELS TNG CUOKEURC CUUPWVA HE TIC
TIPOTIUNCEIG 0QG.

SV apxikr 086vn, matrjote PuBpioeic.

E « Edv ei0ayete Mé€n kheidi oto mapdbupo avaditnong 0To enavw pépog
NG 006VNG, UMOPEITE va EKTENECETE TTO EUKOAA TOL OTOIXEID TIOU TIPETTEL VOl
puBuioTOLV.

Aixtuo & Internet

AR kdpta SIM

Mriopeite va Slapop@waoeTe TIC puBioel SImAng KapTag SIM.

T Ztnv 086vn Pubpioeic, matrote Aiktuo & Internet > Aumhr képta SIM.
7 Mmopeite va TpoCapHOCETE TIG IAPAKATW AEITOUPYIEC:

+ Kdpta SIM 1: Mmopeite va aAAEETE TO GVOpa Kall TO EIKOVIBIO TG KAPTAC
SIM 1.

Kapta SIM 2: Mmopeite va aMAEeTe To dvopa Kal To €IKoViSIo TG KApTag
SIM 2.

+ Xpwpa Béparog kaptag SIM: ANGETE Ta XpwHOTIKA BEUATa Yia TIG KAPTES
SIM.

Nertoupyia e€oikovopnong: EvepyomolroTe 1 anevepyomoloTe T
Aertoupyia e§oikovopnonc. Lt Aettoupyia ££01KOVOUNONG, AV KAAECETE
Hia emagr) oTnv omoia £XEl AVTIOTOIXIOTEL A OUYKEKPIWEVN KapTa SIM,
Ba xpnotpomoinOei autr n SIM yia Ty KAjon akopa Kt av givat evepyn n
NN SIM ekeivn T oTtyr (emeldn m.x. xpnotpomole Ta Sedopéva KivnTrg
epuviag).

Agdopéva KivnTrig TNAewviag: Mmopeite va emAé€ete Tnv kdpta SIM
0L Bt XPNOIMOTIOLELTE Yia TV UTTNPEGia GEG0UEVWY KIVNTHAG TNAEQWVIOC.
Mropeite emiong va amevepyomoroeTe auTryv T AerToupyia.

Meplaywyn 6edopévwv: OpioTe aUTHV TV EMAOYN YO VO EMTPENETE OTN
OUOKEU 00¢ va Xpnolporolei ta Sedopéva Kivntrig TNAepuviag dtav
BpiokeoTe o MEPIAYWYI EKTOC TOU KAVOVIKOU 0aC SIKTUOU.
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- Agdopéva KIvnTHG TNAEPWViag Katd th Sidpkela TG KARoNG: ATIOKTHOETE
npoowpIva mpooBacn oe dedopéva KIvNTAG TNAEQWVIAS XPNOIUOTIOIWVTAG
Hia pn mpoemAeypévn Kapta SIM Sedopévwy Katd tn SlapKeLa piag
@wvNTIKAG KAjong HD pe v idia kapta.

Wi-Fi

Mrmopeite va uvOEDEITE pie KOVTIVEG OUOKEVEC PEow SikTuou Wi-Fi.

Tuvdeon oe diktuo Wi-Fi
T Zmv 066vn pubuicewy, matriote Aiktuo & Internet > Wi-Fi.
7 Natote To Kouuni yla evepyormoinon.
+ Ta diaBéotpa diktua Wi-Fi epgpavifovtal autdpata.
3 EmAéETe éva Siktuo.
+ Mmopei va xpelaoTei va eloaydyeTe Tov Kwdiko mpooaong Tou SIKTuou
Wi-Fi.
+ H ovokeun mapaleinel autrv T dadikacia ya diktua WI-Fl ota omoia
elye ouvdeDei oTo MaPeNBOV. Av Sev BéNelg va ouvdeDeic autdpata pe éva
oplopévo Siktuo Wi-Fi, méta 1o Siktuo Kat petd mdta Ataypaen.

PuBpioeg Siktoou Wi-Fi
3V 086vn pubpioswy, matrote Aiktuo & Internet > Wi-Fi.

« Metafaon o€ Siktuo KivnTAg TNAEPwViag: dv n Aertoupyia TG olvoeong
Sedopévwv KIvNTAG TNAEQuVIAE ival evepyomoinpévn, aAAd | CUOKEUN
Sev pmopei va ouvdebei oo Internet péow g olvdeonc Wi-Fi, n cuokeun
ouvdEeTal autopata oo Internet péow tng ovvEeong Sedopévwy KIvNTAG
TAepwviag.

E + Autij n Suvatdtnta e€aptdTal amod ToV TAPOXO UTINPECILV.

+ :MpooappooTe TIC PuBicES Tou Sikthou Wi-Fi.

Wi-Fi Direct

Mriopeite va GUVOEDETE T GUOKEUN 0aG 0 GANEG OUOKEUEC TIoL UmooTnpilouv
Wi-Fi Direct yia ameuBeiag ko xprion Sedopévwy Ue autég. Agv gival anapaitntn
n xperion onueiov mpdoPaonc. Mmopeite va cuvdebeite e meploodtepeg amd SUo
OUOKEVEG xpnotpomolwvtag Wi-Fi Direct.
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T Zmv 0B6vn pubpicewy, matriote Aiktuo & Internet > Wi-Fi> & > Wi-Fiyia
nipoxwpnuévoug > Wi-Fi Direct.
+ Ot kovTIvéG ouoKeUEC Tou umoatnpiouv Wi-Fi Direct epgavifovtat
autopata.

7 Em\é€te o oUoKeUN.
+ YUvdeon mpaypatomoleital dtav n cuokeur amodexTel To aitnpa ouvdeong.

E + Hpmatapia evdéxetat va e§avtAnBei ypnyopotepa dtav xpnoluomoleitat
Wi-Fi Direct.

Agdopéva KivnTAG ThAEQWviag

Mmopeite va evepyomoleite Kal va amevepyoroleite Ta SeSopéva KIvnTig
Aepwviag. Mmopeite emiong va SlaxelploTeite Tn xprion dedopévwv KIvnTrg
TAeQwviag.

Evepyomoinon 6edopévwv KIvnti¢ ThRAEQwviag

1 Zmv 0B6vn pubuicewy, matfjote Aiktuo & Internet > AsSopéva KIvNTHG
TAepwviag.

2 Matrote 1o Koupmi yla evepyomoinaon.

Mpocappoyn Twv pubpicewv dedopévwv KIvnTAG TNAEPWViag
1 Zmv 086vn pubuicswy, matfjote Aiktuo & Internet > AsSopéva KIvNTHG
TAgpwviag.
7 MpocappooTe TIG TaPaKATW PUBpIcEL:
+ Aedopéva KivnTrig TNAEPwviag: pUBpIoN yia xprion cuvdéoewv dedopévwv
o€ KivnTd SikTua.

Meplopiopdg xpriong petdadoong dedopévwv: Béate éva dplo yia T xprion
Sedopévwy KIvNTAE TNAEPWVIAC, Y€ TIEPIMTWON TTOU PTACETE AUTO TO OPIO,
Sev Oa emtpémetat MAéov n xprion Sedopévwy KIvnTAG TNAEQWVIAC,

+ 1 :TIPOCAPUOYH TwV PUBHICEWV SeBOpEVWY KIVATAG TNAEPWVIAG,
0 dykog xpriong Sedopévwy umoloyiletal pe BAon To mMPoidv Kat 0 dyKog
10U UTTOAOYI{EL 0 TIAPOXOG 0agG EVOEKETAL VO SIAPEPEL
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PuBpioceic KAjoswv
Mriopeite va TIPOGAPHOCETE TIC PUBHITEIS KAOEWY, OTIWE Y10 TIC QWVNTIKEG
KANOELG Kal TIG EMAOYEC S1EBVWY KAOEWV.

+ Oplopéveg Aettoupyieg evdéxetal va unv umootnpifovtal, avahoya HE TV
TIEQLOXN 1 TOV TTAPOXO UTINPECIWV.

T Zmv 066vn pubuicewy, natfiote Aiktuo & Internet > PuBpioeic KAjogwv.
2 MpocappooTe TIg pUBKIoELC.

Tethering

Z0vbeon Péow KIVNTIG OUOKEVNRC e USB

Mriopeite va ouvOEDETE T GUOKEUN 0€ AMN cuokeun péow USB yia kovi xprion

Sedopévwv KIvnTiG TNAEPWVIag.

T Zuvbéote T cUOKeUR 0aG Ue ANNEG CUOKEVEG Uéow Karwdiou USB.

7 Tnv 0B6vn puBpioswy, motiote Aiktuo & Internet > ZUvSeon péow KvnTAg
OUOKEUNG > ZUVEEoN HEOW KIVNTAG CUOKEVNG pe USB kat 0Tn ouvéyela
TatAoTe To Koupri () ) yla evepyomoinon.

E + T autrv Ty emAoyn xpnotpomolovvratl dedopéva KIvnTriG TNAEQWVIag
Kal Umopei va emBapuvOEiTe pe XpEWOELS yia TN Xprion Sedopévwy,
avaoya HE TO TIPOYPAHHA XPEWOEWV TTOU EXETE EMAECEL M TIEPIOOOTEPE
TIANPOYOPIES, CULBOUNEUTEITE TOV TTIAPOYO UTINPETLWV.

« [l oUvdeon og umoAoyIoTH, KATERAOTE TO TTPOYpauua odrynong USB amd
TNV TomoBecia Www.lg.com Kat YKATAOTAOTE TO GTOV UTIOAOYIOTH.

« Aev givat Suvatr n amoatolr 1 N AYn apxeiwv PeTagld Tng CUOKEUNG
0ag Kal vog umooyloTr dtav gival evepyomoinuévn n ovvdeon USB.
Amevepyorotjote T ouvdeon USB yia tnv amootoAr i Aiin apxeiwv.

+ Ta AerToupyIk@ GUCTHAHATA TTOU UTTOOTNPI(OVV AUTOV ToV TUTIO CUVOEDNG
eivar ta Windows XP | petayevéatepn ékdoon, fj To Linux.
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®opnto onpeio mpooBaong Wi-Fi
Mriopeite va 0piOETE TN GUOKEUN WG AOUPHATO SPOPONOYNTH, £T01 WOTE Ol ANNEG
GUOKEVEG va pumopolv va ouvdeBoulv oo Internet xpnotpomolwvtag ta dedopéva
KIVNTAG TNAEQVIag TG CUOKEUNG 0ag.
T Zmv 0B6vn puBpicewy, matiote Aiktuo & Internet > Tethering > ®opntd
onpeio mpdaBaong Wi-Fi kal émeta matriote yla evepyomoinaon.
Ayyi€te PUBHion popntou onpeiov mpooPacng Wi-Fi kat kataywpiote 10
QAVayVWPIOTIKO Katl Tov Kwdikd mpdoBaong tou Ovopa Wi-Fi (SSID).

2
3 Evepyomotfjote to Wi-Fi 0TtV G\ 0UOKEUR Kat EMAEETE TO Gvopa ToU SIKTUOU
NG ouokeung otn Aiota Wi-Fi.
/A MAnktpoloyrote Tov Kwdikd mpdoBacnc SIKThou.
E « [a autv Ty emdoyn xpnotpomolobvtal Sedopéva KIvnTrig TNAEQWVIag
Kal Umopei va mBapuvoeiTe pe XPEWOELS yia TN Xprion Sedopévwy,
QVANOYQ LIE TO TIPOYPAUMA XPEWOEWV TTOU EXETE EMAEEEL M TEPIOTATEPES
TIANPOPOPIES, CULBOUAEVTEITE TOV TTIAPOYO UTTNPETIWV.
« Mmopeite va Bpeite mepIoodTEPES TANPOPOPIES OE AUTOV TOV LOTATOTIO:
http://www.android.com/tether#wifi

Xpovodiakdmtng amevepyomoinong gopntol anpeiov mpooBaong Wi-Fi

‘Otav 1o onpeio mpooRaong Wi-Fi Sev éxel xpnotpomolinei yia oplopévn mepiodo,
amevepyoroleital autdpata. Mmopeite va opioeTe Ty wpa o BEAETE va
EKTENEOTEL AUTOMATN AMOCUVOEDN.

Bluetooth tethering

Mia ouvdedepiévn e Bluetooth cuokeun pmopei va cuvdebei oto Internet

XPnotpomolvtag ta Sedopéva KivnTrg TNAEPWVIAG TG CUOKEUNG 0aG.

1 Zmv 086vn pubuicswy, matfjote Aiktuo & Internet > ZUv8eon péow KIVNTAG
ouokeung > Bluetooth tethering kat otn cuvéyela matriote To koupmi yla
gvepyormoinon.

7 Evepyorolfote To Bluetooth kai 0TIC 500 GUOKEUEC, Kal TIPAYUATOTIONOTE
Cevén.
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5 « Ta autv Ty emoyn xpnotpomolobvtal Sedopéva KIvnTHiG TNAEQwVIag
Kal propei va emPBapuvBEeiTe Pe XPEWOELS yia Tn xprion dedopévay,
QVANOYQ HE TO TIPOYPAUMA XPEWOEWV TTOU £XETE EMAEEEL M TEPIOTATEPES
TIANPOPOPIEC, CUMBOUAEUTEITE TOV TAPOXO UTINPECIWV.

« Mmopeite va Bpeite mepIoodTEPES TTANPOPOPIE OE AUTOV TOV LOTATOTIO:
http://www.android.com/tether#Bluetooth_tethering

BonBsia
Mriopeite va mpoBahete T BoriBeta oxeTIKA pe TN Xprion cuvdéoewv kat hotspot.
SV 086vn pubuiogwy, matrjote Aiktuo & Internet > Tethering > Borjfeia.

Nertoupyia mtRong

Mriopeite va amevepyomnoloeTe TG Aettoupyieg KAjong kat SeSopévawv Kivntrig
Agpwviac. Otav autr n Aertoupyia gival vepyoroinpévn, ot AEIToupyieg ou
Sev amartolv T xprion Sedopévwy, OTwg matkvidia Kat avamapaywyr LOUCIKAG,
Tapapévouy SlaBEoIpEC.

1 Zmv 0Bovn pubuicewy, matiote Aiktuo & Internet > Aertoupyia mTriong.

7 Matiote 1o Koupni yla evepyomoinaon.

Aiktua KIvNTAG TNAEPWViag
Mriopeite va TPOGAPHOCETE TIG PUBHITELG SIKTUWV KIVNTAC TNAEQWVIAG.
1 Zmv 006vn pubuicewy, matfjote Aiktuo & Internet > Aiktua Kivn TG

TAgpwviag.

2 MpocappooTe TIG TapaKATW PUBpIcEL:

+ Aertoupyia Siktvou: EmAéEte TUMO SikTUOUL.

+ Ovopata onpeiov mpooPaong: Na epedavion rj alayr Tou onpeiov
TIPOOaONG Yia TN XPron UMnEeatwv SeSopéVwY KIVNTAG TNAEQviac. Na
va aMGEeTe To onpeio mpooBaong, emAégTe éva atolyeio amd tn Aiota
onueiwv mpooBaong.

Etaupeieg Sitoou: Ma avalritnon mapdxwv SIKTUOU Kat autopath cuveon
o€ Kamolo SikTuo.

PuBuioeig 102



VPN

Mmopeite va ouvdebeite o€ éva ao@aNég eIKOVIKO SiKTUO, TIX. O EVa ECWTEPIKO
€TAPIKO SiKTUO. MMTOpE(TE £MONG Vol SIOKEIPIOTEITE TA GUVSESEPEVA EIKOVIKA
1SlwTiKa SikTua.

Mpoaodnkn VPN
1 Zmv oBovn pubuicewy, matfjote Aiktuo & Internet > VPN.
7 Matiote To koupmi -

5 + Auti n Aertoupyia givat StaBaotun Lovo epdoov gival evepyomoinuévn n
Aermoupyia Kheldwpatog 006vne. Edv n Aertoupyia kAeldwpatog 006vng
eival amevepyomoinuévn, eppavifetal pia 086vn eidomoinong. Ltnv 066vn
eldomnolrioewv matriote ANayn Yl va EVEPYOTIOICETE TN AerToupyia

KAELBWHATOG 000VNG. MNa AEMTOPEPELE, AVATPEETE OTNV EVATNTA PUBLION
KAglbwpatog 066vng.

3 Ewaydyete ta otoixeia tg ouvdeong VPN kat matriote AmoBrkeuon.

Aapdépewon Twv pubpicswv VPN
T Tt Aota VPNS, emAé€te éva VPN.
7 Ewoaydyete Ta otolyeia Moyapiacpou xprotn VPN kat matriote Zovéeon.

- [a va anoBnkeVoETe Ta oTOIXEIQ TOU Aoyaplacpoy, mAEETe To MAaiolo
ehéyyou AmoBrikeuan aTolxeiwv Aoyaplacuov.

I61wTtikd DNS

Mriopeite va Slapop@woeTe TiG emhoyég IS1wTikoy DNS (Domain Name System).
1 Zmv 086vn pubuicswy, matfote Aiktuo & Internet > I81wtikd DNS.

7 Kavte v emhoyr mou Bé\ete kai motriote AmoBrikevon.
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Tuvdedepéveg CUOKEVEG

Bluetooth

Mriopeite va GUVOEDETE T GUOKEUN GOG O€ KOVTIVEG CUOKEUEG TIou umtooTnpilouv
Bluetooth yia avtaMayr SeSopévwv e QUTEC. ZUVOEDTE T GUOKELN 00 O éva
OKOUOTIKS Kat éva MANKTPOAOGYI0 He Suvatdtnta Bluetooth. Etot o éNeyxog Tng
OUOKELNC Bal gival EUKONOTEPOC,

Z0Ceuén pe AN cuokeun
1 Zmv 0B6vn pubuicewy, matiote Zuvdedepéveg ouokevéc > Bluetooth.
7 Matiote 1o Koupmi yla evepyomoinaon.

+ O18100¢01pEC OUOKEVEC ppavifovTal auTopaTa.

- Tava avaveqoete  Nota ouokeuwy, atfote ().

E + Movo 01 GUOKEUEG TTOU €XOULV OPIOTE! WG 0paTEC EPaviCovTal ot AioTa.

3 EmAé€Te pia ouokeur amd tn Aiota.

/I AkohouBroTe TIC 08nyie¢ Tou pgavifovtal atny 006vN yia va
TIPOYHOTOTIOIOETE EAEYXO TAUTOTNTOC.

E + Autd T0 Bripa TAPCAAEITETAL YIa CUOKEVEG OTIG OTIOIEG EXEL UTTAPEEL
TP6oPaon oTo MaPeNBoV.

Anootoln edopévwy péow Bluetooth
T EmAé€te éva apyeio.
« Mmopeite va oteilete apyeia MOAUPESWY 1) OTOIXEIQ EMAPWV.
7 Natiote < > Bluetooth.
3 EmAEETE ot GUOKELK TIPOOPIGHOU VLA TO apXEiD.
+ To apyeio amooTENETAL LONIG YiVeEL AOSEKTO A Tr CUOKEUK TTPOOPICHOU.

E «+ O181ad1Kacieg Kovrg xpriong apxeiwv evoéxetat va Slapépouv avahoya e
TO apxeio.
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NFC
Mriopeite va XpnOIOTIOINCETE TN GUOKEUH WG HIa KAPTA Yia Ta Péoa MadiKng
HETOAQOPAG 1 WG MOTWTIKA KApTa. Emiong, umopeite va kovomoiroete Sedopéva
0& AN\EC CUOKEVEC.
1 Zmv 0Bo6vn pubuicewy, matiote Zuvdedepévec ouokeuég > NFC.
7 Natiote 1o Koupmi yla evepyomoinaon.

« Ayyi&te T ouokeun oag pue AN cuokeur ou umooTtnpilet NFC yia

avtohayr dedopévwv.

E « Hkepaia NFC umopei va Bpioketat o€ S1aQopeTIKS onueio avaloya Ue Tov
TUMO GUOKEUNG. Mol AETTTOEPELEG OXETIKA ME TV TIEPLOXT TG Kepaiag NFC,
avatpé€te 0TV evotnta Emokomnnon otolxeiwv.

Mivakag kolvomoioewv

MmopeiTe va KOIVOTIOINOETE TIEPLEXOUEVO aTd TO AAUTTOUY, TN MOUGIKY Kat T

Alayeipion apyeiwv 0ag og KOVTIVEG OUOKEVEC. Mmopeite emiong va KovoroloeTe

TO TIEPIEXOUEVO OE GUYKEKPILEVA ATOMA OE EQAPHOYEG TTOU uTooTnpiouv T

Suvardtnta dueong kotvomoinong tng Google (Google Direct Share).

1 Zmv 086vn pubuicswy, matfote Tuvdedepéve ouokevéC > Mivakag
KOIVOTIOINCEWV.

7 Anevepyornomjote kGO emoyn xpnotponotwvtag 1o puduoTikd @ .

+ Kovtivég ouokevég: Mmopeite va EPPaVIOETE TIC KOVTIVEG CUOKEUEG HE TIG
OTIOEC UMOPEITE VA LIOIPAOTEITE TIEPIEXOHEVO QMO TIG EPAPHOYEC ANUTTOUY,
Mouaikn kat Alaygipion apxeiwy,

+ Apeon Kowvomoinon: Amd pia pappoyr mou umoatnpilel tn duvatdtnta
Apeong kowvomoinon tng Google (Google Direct Share), umopeite va
EUPAVIOETE €Al EIKOVISIO TIOU GAG EMTPETEL VA POIPACEDTE TIEPIEXOEVO LIE
OUYKEKPIUEVOUG avOpWIouG.

Kown Xprion Apxeiou

Mriopeite va oteilete 1 va AAPETE apyeia avauesa 0Tn GUOKEUH 0ag Kal € ANAN

ouokeun 1 tablet tng LG.

T Zmnv 086vn pubuicewy, matriote Zuvbedepéveg ouoKeLEG > Kowr Xprion
Apxeiou.

7 Mpooapp6oTe TIC TapaKATw puBpIcEIC:

PuBuioeig 105



K52: yia va aAAEETE TO GVOpa TNG OUOKEUNG.

- AmoBNKeuoN GE: 0PIOTE TOV PAKENO TIPOOPIOHOU YIa TNV AMTOBKKEVCN TWV
apyxeiwv mou amooTéNovTal amd AANEG GUOKEUEC.

+ Kown Xprion Apxeiou: yia va emtpéPete T Ajn apyeiwv mou
amootéAovTal and AANEC CUOKEUVEC.

+ SmartShare Beam: yia va HolpaoTeiTe apyeia e AANNEG CUOKEUVEG HECW TOU

SmartShare Beam.

- BonBeia: umopeite va Seite T BoriBeta yia TV kovomoinon apxeiwv.

Extunwon

Mriopeite va GUVOEDETE T GUOKEUN 0O O€ évav ekTumwTtr Bluetooth kat va
EKTUTTWOETE TIG WTOYPAPIES 1} TA EYYPOPA TIOU £XOUV ATOONKEUTEL 0TI GUOKEUN).
Ztnv 08vn pubpicswy, matiote Zuvdedepéveq ouokevE > EkTOmwon.

- Matriote NpoemAeypévn UNINPEGia EKTUMWONG Yia va yivel avaltnon
EKTUTIWTQV LE TOUG OTT0{0UG popeite va ouvdeBeite. H matiote + >
MpooBKn EKTUMWTWV yia va TPOCBECETE XEIPOKIVNTA évav EKTUNTWTH.

- Natfote (+) NMpoobrikn unnpeoiag yia va ANaPete TV eappoyr ToU EKTUNWTA
Tou BéNeTE.

5 + Auti n duvatdtnta eivat Slabéoiun uévo dtav To Siktua KIVNTrG
Aeguwviag A n Aerroupyia Bluetooth givar evepyomoinuévn.

+ Tava AdBete Tv epappoyn ektunwtr oto (+) Mpoadiikn umnpeaiag, Ba
TIpEMeL TPWTa va ouvSebeite aTov Aoyaplaopo oag Google.

'Hyog

Mriopeite va TpooapHOCETE TIC PUBITELS fixou, SGvnong kal eidomoroewv.

TNV 086vn pubpioswy, matrote HYog Kal TPOCGAPHOOTE TIG TAPAKATW PUOLICELC:

+ Hxntikd mpo@il: aA\a&te T Aertoupyia xou o€ ‘Hyog, Movo dvnon, 1y

Ziyaon.

‘Evtaon;: puBpion tng évtaong fxou yia ta Sldgopa oTolyEia.

+ 'Hxoc¢ kAfjong: EmAéCte évav o KAjong yia loepyopeve KARoelS. Mpocbéote
1} Slaypayte Xoug KAong.

- 'Hxog e18omotfjoewv: EmAECTE évav ryo eidomoinong. Opiote éva Louoiko
KOMMATL TTOU £XEl AmOONKEUTEL 0T OUOKEUN WG X0 1domoinang.
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+ 'Hxog kAjong pe d6vnon: Pubuiote Tn ouokeur yia §6vnon Kat avamapaywyn

X0V KAONG TauTdXpova.

Ringtone ID: dnuioupyei évav 1o KAong yia Lia ElgpXOpeVn KAon amo pia

OUYKEKPIUEVN EMTAQN.

- To @Aag avdPel dtav umapyel eloepxopevn Khijon: Pubpiote va avaBooprvel
TO QAAG CUUPWVA PE TOV X0 KAong TG LG.

+ Mnv evoyAeite: OpioTe TNV wpa, T SIAPKELD Kal ToV TUTTO EQAPHOYAG Yia Ta

omoia 6a AapBavete unvopata eidomoinong. Mmopeite va AapBavete unvopata

€160TIOIOEWV OVO OE CUYKEKPIUEVEC NUEPEC TNC ERSopddag.

MoétnTa AXOU Kal EQE: XpnoomooTe Tn A&ltoupyia yia va pubuiceTe Tnv

TOIOTNTA YOV Kall Ta EPE KATA TNV avamapaywyr vog Tpayoudiou i Biveo.

- 'Evtaon: pubuion TngG €vtaong rxou yia ta Sldgopa oTolxeia.

- Kavovikomoinon évtaong: Xpnolomolote Tn Aeltoupyia yla va

OAMNOTIOINOETE TNV TOCOTNTA SIAPOPETIKWV TINYWV HXOU.

loooTaBuo TG XpNoIomoIoTE TN AElToupyid Yia VA TIPOCAPHAOCETE TIG

pUBioEL l00OTABUIOTH.

Tpiodiaotarog "Hyog Mnxavn LG: Xpnotpomoinoe Ty Aeitoupyia yia va

mai€elg ouoikn iy Bivteo oe TpLodidoTaro, ePPUBIOTIKO Kat {wvtavd fixo

OTAV AKOUOTIKA, NXEIO 1} GANEG EEWTEPIKEG CUOKEVEC fiXou Eival oUVOESEUEVAL

Mo Aemrtopépeleg, avatpédte otnv evotnta Tpiodidotaroc ‘Hyoc Mnyavii LG.

Tunog 86vnong: pmopeite va emAé€ete Tov TUMo Sdvnong mou Ba

EVEQYOTIOLETAL KOTA TN AYN KAOEWV.

"Hxo¢ mAnktpoloyiou kAjogwv: EMAEETE To NYNTIKO £ yia TO MANKTPOAGYLO.

+ 'Hoc apr¢: EmMAEETE éva €€ fixou yla 6Tav TATATE O€ éva OTOIXE(O.

"Hxo¢ kKAeldwpatog 080vng: EMAEETE €va epé rxou yia oTav KAEISwVeL 1

Eekheldwvel n 0Bovn.
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1bomoinoeig

Mmopeite va Seite pa NioTa eyKaTaoTnHéEVWY EQAPUOYWVY KAl VA SIAHOPYWOETE

TG
1
2

pUBpIoELC Yia ldomoINTELC.
YV 08dvn pubuicswy, matrote Eldomoioeic.
ANGETE TIC pUBUICEIG CUMEWVA LE TIG ATTAITAOELS OOG,

MpofoAn

Mriopeite va TpooapHOCETE AeMTOpEPEIG PUBLITELC yia KABE TUTO 086VNG.

Ztnv 086vn pubpicswy, matrote MpoBoAr Kal TPOCAPHOOTE TIC TAPAKATW

pu

Buioeig:
ApxiKr 080vn: TPooapUOOTE TIC PUBUITELS yla TV apxikr 08vn. Na
AenmTopépeleg, avatpéSTe oTnv evdtnTa PUBLIoEIC apyiknc 086vNG.

« Tpapun mhonynong: Opiote To oTul TG Mpappr} mMoriynon o Xelpovopieg iy

Mévo koupmid. Mmopeite emiong va aAAgeTe 1o GUVEUAGHO KoUMWV 6Tav
opioete Movo koupumid we 0Tul NG Mpappr mMorynon. Na Aemrtopépeleg BAéme
Xprion ¢ lpappric morynong

Fpappn katdotaong: PuBioTe To Xpwa TG YPAUKNG KATAGTAONG OTO EMAVW
Ué€POC TNG 086vVNC iy pubpioTe TV TPORoAN Tou glkovidiou eldomoloewv Kat
TNV TPOBOAN TOU TOGOGTOU UMATAPIAG.

« Avetn mpoBoAn: pUBUIOTE TN CUOKEUN €TOL WOTE VA LEIWOETE TNV TOOOTNTA

TOU MIMAE QWTAC 0TNV 086V Kall VO TIEPIOPIOETE TNV KATATTOVNGN TWV HOTIGV.

« Nerroupyia vuxTag: Mmopeite va QapUOCETE éva ayxvo Béua 08évng yia va

amoUYETE TNV €vtovn Adpyn tng 08évng katd T SidpKela TG VOXTOC,

« Tpappatooelpd: ANGETE TO péyeBog TNG YPAUUATOOEIPAC, TNV €VTaon TN

YPAQAG 1} TN YPAHHATOCEIPA.

+ XpwHaTIKAG TOVoG: ANAETE TO XpwUa yia TIG pUBLICELS, Ta pevoy, Ta

mapdBupa E160MOICEWY, KNI,

MéyeBo¢ 066vng: OpioTe To péyeBog Twv oTolXEIWV 0TV 006VN OTTWE GG
Bolevel Kamola otolyeia evdéxetal va ald€ouv Béon.

MARPNG 080V EQapPUOYEG : TPOCAPUOOTE TO HEYEBOG 006VNG TWV EQAPLIOYWV.

- QutavotnTa: XpnolpomooTe T ypappr KUMonG yia va aAG&eTe T

QWTEVOTNTA TN 080VNG TG ouoKeunG. MNa va puBpioeTe autdpata
QWTEVOTNTA TNG 08SVNE avAAoya e TV £VTACH TOU QWTIOHOU TIEPIBANOVTOC,
ayyi€te v emoyr} Autopato.
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+ Autdparto: puBIOTE TN CUOKEUN T0L WOTE N PWTEIVOTNTA TNG 086VNG va

puBpieTal auTOHOTA CUPPWVA LUE TNV EVTACT GWTOE TOU TTEPIBANOVTOC.

Aiién xpovikou opiou 006vNG: ATevepyoToILETal AUTOMATA N GUCKEUN OTav

Tapapével og adpAvela yia éva kaBoplopévo Xpoviko Sidotnpa.

+ Autdpatn meplotpon 080vng: Meplotpépetal autdpata n 08évn avaloya pe
TOV TPOGAVATONGHO TNG CUCKEUNC.

+ Mpo@UuAagn 086vne: EpgpaviCetat mpo@UAagn 08évng 6Tav n OUCKEUR €xel

ouvdebei otn Bdon ry Tov @opTioTr. EmAEETE Tov TUMO MPOPUAAENG 006VNG

mou BéAete va epgpaviletal.

006vn pe 1o éva xépt: MikpUveTe To péyeBog TG 08dvng, £T01 WOTE va

UTOPEITE VOl XPNOIUOTIOLELTE Tr) GUCKEUN LIE TO €Vl XEPL ZUPETE TO TMANKTPO

APNG APXIKNG 08AVNE 0TO KATW PEPOC TNG 086VNG TPOG Ta aploTepd 1y Se€id.

Dovro & Oépa

Mnopeite va emAé€ete povTo, Bépa 086vng, oTul eikovidiwv i} AOD (Always-on
Display) yia tn cuokeun oag.

T Zmv 086vn puBpicewy, matiote évto & Oépa.

2 Matote ®6vTo 1} O€pa yia va TPOGAPHOCETE TIG PUBICELG.

KAeidwpa 006vng & acpaleia
Mriopeite va TPOGAPHOCETE TI PUBHIOELG TG 08OVNG KAEIGWHATOC KAl TNG
AoQAAELOC.
T Zmv 0B6vn pubuicewy, matriote KAeidwpa 086vng & acpdleia.
2 MpooappooTe TG pUOKIoELC.
- Google Play Protect: ZapwoTe Tn 6UoKeUR 060G KaBnpepvd yia moavwg
BhaBepec epapoyé.

- EUpeon ouokeunq : MapakoloubroTe Tnv Tomobeaia TG GUOKEUNG
QmOpOKPUOHEVA. MTTOPE(TE £MMIONG VA TIPOOTATEWETE HE AOPANELD TA
Sedopéva 0ag Qv XAOATE Tr) GUOKELN GG,

+ Evnpépwaon ac@dleiag: EAeyxXoq yia evnpépwaon AoyIopIKOU Kal
Slapopewon pubHicEWY AUTOUATNG EYKATAGTAONG.

Atohé€te kAeidwpa 080vng: EmAEETe T uéBodo Khelbwpatog 08dvng mou
Oéhete. MNa Aemtopépeleg, avatpé&te otnv evotnta PUBLION KAEIbWaTOC
oBovng.
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+ Mapapetpomoinon KAEWWHATOG 000vNn¢ KA WHaTOg: ANy Twv
TIANPOPOPIWY TTOU ppavifovtal oTnv KAEWGwpEVN 006vn.

« PuBpiogic ac@aloug kAeWdwpatog: ANAETE TIG publioeg KAeSwuUaTog
QA0QaAEiag.

+ AAGKTUA ATTOTUTTWHATA: XPNOILOTOIOTE TO SAKTUNKG 0ag amoTUMwia yia
va EeKNeIOWOETE TNV 080vN 1y To TTEPLEXOEVO. [1a AenTopépELeg, avaTpéSTe
otnv evotnta Avayvwpion Aaktul. Amotunwparta - lMapouvoiaon .

+ Kheibwpa mepieyopévou: ag MTpEmel va 0pioeTE TUTTO KAEWOWHATOG
(kwd1kd mpdoPaonc i poTiBo) yia Ta apxeia oag ZuAoyic.

Kpuntoypagnon & Siamoteutrpia: Alapop@uoTe TiG pUBLIoELS yia TV
KPUTTTOYpA®non Kai Ta SlamoTeuTrpla TG kdptag SD.

Kpunrtoypdenon kaptag SD: Kpuntoypa@rioTe TV KAPTa MVARNG yla va
AMOTPEPETE TN XPNON TNG 0€ AN cuokeun. MNa AemTopépeleg, avatpéfTe
OTNV EVOTNTA KpUTToypdgnon KApTag LVIUNG .

- Npootagia StamoTteutnpiou: Mool TUTOU Tou XwPEou amobrKeuong
6mou Ba amoBnKeUTE( TO MOTOMOINTIKG AGPANEIQG.

AgiomaoTta Siamotevtipia: MpoBol Twv pilikwv motomoinTikwy CA
TOU GUGTAHOTOG 00G Kall Twv ToTomolnTiKwv CA mou €xouv eyKataoTtadei
amnd 1o xprotn.

- MamoTteutipia xprot: Mpofoli kat aAayn Twv aceaiv
TANPOYOPIWV TIOTOTOINTIKOU TTOU Eivall amoBNKEVUEVES OTN CUOKEUN
oag.

Eykatdotacn amd tov amoOnkeutiké Xwpo: Eykatdotaon evog
A0@QANOUE TOTOTIOINTIKOU Ao ia Povada amobrKeuonc.

ExkaBdpion Siamoteutnpiwv: Alaypapr doQAAWY TMOTOTOINTIKWY TTOU
£X€EL EYKATAOTHOEL 0 XPOTN KOl TV OXETIKWY SIOMOTEUTNPiwV.

AlOXEIPIOTEG GUOKELWV: EKYWPNOTE SIKAIWUATA YA VO TTEPIOPICETE TOV
€NeyxO0 N} TN XPON TNG OUOKEUNG OE GUYKEKPIUEVEG EQAPUOYEG.

+ Trust agents: EugpavioTe Kat xpnotpomoote Ta trust agent mou €xouv
€yKATaoTaOEl 0T OUOKELN).

Kapgitaa 006vng: Pubuiote Tv 006vn epappoywy €101 WOTE va gival
Suvatr HOvo N xPron TNG EGAaPUOYNE TToU €ival evepyn TNV eKAOTOTE
otiyun.

- TpoaoBacn xpnong: Seite \eMTOPEPELEG OXETIKA HE TN XPHON EQAPHOYWV
0T GUOKEUN.
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Anoppnto

Mmopeite va Bpeite kat va aANd&eTe OAeC TIC pUBUioEIC amopprToL oag.
T Zv 0bovn pubuicewy, matjote AméppnTo.
7 MpooappooTe Tig pUBKIoELC.
« SlaxelplotigAdeta: ag emrtpémel va deite kat va aMdeTe Ta Sikaiwpota

TIOU €XETE SWOEL OTIC EQAPHOYEG.
KAeidwpévn 080vn: Zag emtpémel va opioeTe TIG e160molroelc Tou Ba
eppaviCovtal otnv 086vn KAeldwpaTog.

+ Na @aivovtat ot kwdikoi mpécPacng: Evepyomoiote authv v emoyn

yia va eugaviletat yia oUVTopo SIAoTNHa KABE XapakTipag Tou KwdIkou
TIPOORaonG KaBwG Tov MANKTPONOYEITE WOTE va BAETETE TL EIOAYETE.

Aut. ZupmAfpwon am6 v Google : Evepyomolote autriyv Ty emioyn
Yia va YIVETAL EI0YWYH TwV TANPOQOPLWY TTOU Eival amoBnKEUUEVEC

070 Aoyaplacpé oag, omuwg kwdiko mpdoPaong, Sievbuvon ry

apIBpOoL TMOTWTIKAG KAPTAC HE éva Povo mdtnua. Mmopeite emiong va
QITEVEQPYOTIOIOETE QUTHY TNV EMAOYH, VA XPNOILOTIOICETE TN A&lToupyia
Autopatng cupmiipwong tng Google iy va mpooBéoete éva véo
Noyaptaoud urnpeciac.

- lotopiko TomoBeoiag Google: Tag emtpénel va evepyomoIoeTe iy va

amevepyomoloeTe To loTopiko TomoBeaiwv. Otav €xel evepyoroinBei, n
Google amoBnkevel MePLOSIKA Kall XpNOIoTIOLE! Ta TTo TTPdo@ata Sedopéva
TonoBeaiag Tou TNAEQWVOU 0ag og GUVEUAGHO LE TO Aoyaplaopd oag
Google.

TtV 066vn loTopIKG TomoBeCIwY, TATAOTE * yia va Seite Kau va
Slayelploteite Ta Sedopéva TomobeSIV 0.

Ttolxeia ehéyxou Spaotnpiotntag: EmAéETe Tic SpaoTnpIoTNTES KAl TIC
TANPoopieC Tou BéNeTe va amobnkevel n Google.

+ Ala@nuiceIg: Zag eMTPEMeL va EITE TO AVAYVWPIOTIKO Sla@nUicEwV Kal va

0pioeTE EEATOUIKEUpEVES SlaPNUITELC,.

+ Xprion kat SlayvwoTikd: Evepyomolrote autiv Ty emoyn yia va

ouvteNéoete 0Tn BeATiwon TG epmelpiag Tou Android péow Tng autopaTng
amooToN G SlayvwoTIKwv Sedopévwy, SeSopévwv GUOKEUNG Kal Xpriong
£pappoywv otn Google.
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TonmoBeoia

Mmopeite va eENéyEETe TOV TPOTIO TTOU KOVOTIOIOUVTAL Ot TTANPOYOpiES TomoBeaiag
00 KAl VO pUBHICETE Ta SIKAIWHATA TPOGRACNE OTIC TANPOPOpIES TOMOBETIAG
oag,

3TNV 086vn pubpicswy, matrote TomoBeaia kal puBpioTe Tn Aetoupyia mou
Béhete.

Enextaosig

Smart Doctor

Mriopeite va xpnotpomolrjoete 1o Smart Doctor yia va SlayvwoeTe Ty KatdoTtaon
TNG GUOKEUNG Kall VAl TN BENTIOTOTIONOETE.

TV 086vn puBpicswy, matrote Emektdoelg > Smart Doctor.

Mauyvidt
Mriopeite va Sl0HopQWOETE TIG PUBLICELS yia EpyaNEia Kat yPaPIKA TTaXVISIwy,
KaBw¢ Kal yia T SuvatdtnTa e€0IKovOUNoNG Umatapio.
T Zmv 086vn pubuicewy, matriote Enektaoeig > Mayvibt.
7 MpooappooTE TIC TAPaKATW PUBIcEIC:
« Mpoypappa Ekkiv. Nawvid.: Mathote Y10 VOl XPNOILOTIOIOETE TO
Mpdypapua Ekkiv. Natgvid..

- Epyaleia maixvidio0: Mmopeite va ektehéoete Tn Aettoupyia otav mailete
navidia matwvTag Ta epyaleia maxviSlol amod Ta KOUPTIA apric TG
apXIKNG 086vNG
Tpa@ikd maiyvidiov: Pubuiote Ta ypagikd Tou maxviSiov.

E « Edv aMd€ete v avaluon oe opiopéva matyvidia, n duvatdtnta mpoBoAng
000vng evEXETal Va PNV AEITOUPYET CWOTA.

« Auti n Aertoupyia evoéxetat va unv gival SLaB€oIpn O EQAPHOYES
TAKVISIWV.

+ Adhelppa: Melwote T QuTevoTnTa TG 006VNG Kat Ty amodoon Kabe
OPA TTOU SIOKOTITETE TO ALY VIOL Yia TIEPIOCATEPO AMO 5 NeMTd.
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AwmAA E@appoyi

Mriopeite va eyKaTaoTAOETE SU0 POPEC A EPAPHOYH AVTAAAAYAG UNVURATWY

07O TIPOIOV Kal va XpnotpoToleite SU0 AoyaplacpoUg Tautdxpova.

1 Zmv 086vn pubuicswy, matote Enektdoeig > A EQappioyn.

7 Metd v avdyvwon ¢ SA\wong amoroinong, natote EmpPefaiwon.

3 2 Nota Siabéoipwv epappoywy, matiote Eykatdotaon yia va
EYKATAOTAOETE éva aVTiypagpo TG EQappoyng Kat akoAoubnoTe Tic odnyieg
mou epgaviovtal otnv 0Bdvn.

+ XV 08dvn gpgavietal n Niota Twv Slabéoipwv Stmwv epappoywv. Katd
N SIAPKEL TN EYKATACTAONG, OTNV apXIKr 080vn mpooTiBevTal ekovibla
TWV EQOPHOYWV.

ZUVTOMEVCEIG
Mriopeite va XpnoIOTIOLEITE KOUUTIA GTIWG TO KOUpTT evepyomoinong /
KAEISWUATOC, TO KOUTTE évTaong rXou kai To Google Assistant yla ApEC KTENETN
GUYKEKPILEVWY EQAPHOYWV 1) AEITOUPYIWV.
T Zmv 066vn pubuicswy, matriote EMeKTAOEL > ZUVTOUEUOELC,
7 NpooapudoTe TIC Tapakdtw pubpiceIC.

« Avoiypa Owtoypagiking Mnxaviig: Matote 500 Popég To MARKTPO

EVEPYOTTOINONG YIa VA AVOIETE TNV KApEPQ.

Avolypa Inueiwon ofnotrig 006vng: Matrote U0 PopE To MARKTPO
avgnong TN €vtaong HXOU Yia va avoi&eTe Tn Asttoupyia Inueiwong
006vng, tav n 086vn givat KAEWGwpEVN 1y ammevepyoToINUéVN.

+ Avotypa Qwtoypagikrig Mnxavig: Matiote 1o miiktpo Meiwong évtaong
S00 Popéc yia va avoiete Tn Asttoupyia Kapepa dtav to kAedi eivat
KAELBWHEVO 1) QTTEVEPYOTIOINKEVO.

+ Avolypa Google Bon04g¢: Matriote To mAKtpo Tou Google Assistant oto
TINGL TOU TNAEPWVOU.

- Miijote oto Google Bon8og: Kpatriote matnuévo 1o miriktpo Tou Google

Assistant yia va WIAAoETe ypriyopa e Tov Bon0o oag.

E + To Google Assistant dev umootnpiCel OAEG TIG YAWOOEG.
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Evepyomoinan 00dvng

Kdvte StmAo mdtnpa ot 006vn yia Vo VEQYOTIOIOETE 1) VOl AMTEVEQYOTTIOIOETE
v oBovn.

Mo AemTopéPELES, avaTPELTE 0TV evoTnTa Evepyoroinon 08ovng.

Epappoyéc

Mriopeite va Seite pia NioTa yKATAoTNHEVWY EQAPHOYWY KAl VA SIAHOPQWOETE
TIC PUOUIOELS YO E160TTOINTEIC, SIKAUWUATWY EQAPHOYWV Kat GANCL.

1 Zmv 0Bovn pubuicewy, matiote EQappoyéc.

7 Mpooapp6oTe TG pUOKITELC.

Mnatapia

Mrmiopeite va Seite TIC TPEXOUTEC TANPOYOPIES YA TNV prmaTapia 1 va
€EVEPYOTIOINOETE TN AEITOUPYia EE0IKOVOUNONG EVEPYELQG.
1 Zmv 08dvn pubuicswy, mathote Mmatapia.
7 MpooappooTe TIC TapaKATW PUBIcEIC:
+ Xprion pmatapiog; G&ite AeMTOPEPELEG YIa TN XPON TNG UMATApI.
+ PuBpi{opevn pmatapia: Emtpémnel e§olkovopunon evépyelag SIoKOMTovTag
N AEITOUPYia EQAPHOYWY OTO TTAPATKHAVIO.
- Neplopiopoi govtou: Evepyomoliote autry TV EMAOYA Yia Va TIEPLOPIoETE
TNV EKTENEON EPAPHOYWVY OTO TTAPACKIVIO YIat EE0IKOVOUNCN EVEPYELQG
Katd T Xprion T cuokeuns. Ot epappoyEg mou meplopilovTat yia Adyoug
£€0IKOVOUNONG EVEPYELAG EVEEXETAL VA NV AEITOUPYOUV OWOTA 1 va NV
00¢ OTEAVOUV EIGOTIOINCEL.
- E§oikovopnon evépyelag: MeioTe T katavaAwan 1ox00¢ TG pmatapiog
emAéyovTag XaunAOTePN TIUN O€ OPIOPEVES PUBITELS TG CUOKEUNG, OTTIWG
TN QWTEIVOTNTA TNG 08VNE, TV TAXUTNTA TOU AEITOUPYIKOU CUGTIHATOG
Kat tnv évtaon tng 6évnonge.
- E§aupéoeig e§oikovopunong evépyelag: EmAECTE TIC eQappoyEég Tou
B€NeTE Va XPNOILOTIOLEITE XWPIG KaVEVAV AEITOUPYIKO TIEPIOPIOHO TIOPA TN
Aertoupyia e§oikovdpnang Loxvog 1y BeAtioTomoinong pmatapiag.
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AnoOnkevon

Mriopeite va mpoBAAeTe Kall va SLOXEIPIOTEITE TOV ECWTEPIKO XWPO ATOONKEUONG
0TI OUOKEUN 1} TOV OMOBNKEUTIKS XWPO 0NV KAPTA UVAMNG.

T Zmv 066vn pubpicewy, matriote AMOBNKEUTIKOG XWPOC,

7 MpooappooTE TIC TaPaKATW PUBIcEIC:

+ EowTePIKAG amoOnKEVTIKOG XWPOG: AEITE TOV GUVOAIKO XWPO
amoBKeVONG Kal ToV ENEVOEPO XWPO OTOV ECWTEPIKS XWPO amoBrikeuong
TNG OUOKEUNG. Agite pia NoTa e TIC EQapUOYEC TIOU XPNCIoToLoUVTaL Kall
TOV XWPO amoBrKeuong mou KatavaAwvel n kabepia.

+ Kapta SD: Agite Tov GUVOAIKO XWPO amoBriKeuong Kat Tov eAeVBepo
XWPO OTNV KAPTA PviuNG. AUTr n emhoyn eppavietal ovo oTav €xel
TomoBeTnBei kApTA PvARNG. Ma Va ameEVEPYOTTOICETE TNV KAPTA PVAKING,
TIATAOTE

Noyapracpoi

Mriopeite va mpocBEoeTe PrOTEC HE TOUG omoioug Ba XPnOIHOTIOLEITE O KOlVoU
TN GUOKEUN Kat va SnptoupynoeTe va hoyaplacud oto cloud.

T Zmv obovn pubuicswy, matriote Aoyaplacuoi.

7 MpooappooTe TIC PUBKITELC.

Digital Wellbeing kot yovikoi é\eyyot

Mropeite va Seite Tov Xpdvo Xpriong Tou mpoidvTog Kat va pubpiceTe 1o
XPOVOUETPO Yia KABe epappoyr. Mmopeite emiong va SIaxeLpIOTEITE TOV XpOVo
XPioNG TOU KIvNTOU TRAEPWVOU XPNOILOTOIWVTACG TN Aettoupyia MpogToipacia
Umvou kai tn Aettoupyia Eotiaon.

EmAé€te Digital Wellbeing kat yovikoi é\eyxot otnv 086vn pubuiogwv kat
puBpiote Tn Aertoupyia mou BéeTe.
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Google

Mriopeite va xpnotpomoloeTe TG pubpioeLl; Tou Google yia va SIaxeIPIOTEITE TIG
€pappoyéc Google Kal Tig puBLIcELS Tou AoyapLaopou.

SV 086vn puBpioswy, matiote Google.

Zuothua

Kévtpo evnpépwaong

Mriopeite va TpoBANETE Kall VOl YKATAOTAHOETE TNV TEAeUTaia €KSoon TG
€(QapUoyNG 1 Tou AoyIopIKoU Tiou mapéxel n LG.

1 Zmv 086vn pubuicswy, matfote ZOoTnpa > KEvtpo evnuépwonc.

7 Mpooapp6oTe TIC TapaKATW pUBIcEIC:

+ Evnuépwon pappoyng: EAeyxog edv undpyel SlaBéotpn evnuépwon
£QApHOYNG. EQv umdipxel, UMOpEiTe va EYKATAOTHOETE TNV EVNUEPWHEVN
ékdoon.

+ Evnpépwaon AoyiopikoU: Eheyxog eGv umdpyel S1abéoipn evnuépwon
Noytopikou. Edv umdipyel, UTOPE(TE Va EyKATAOTAOETE TV EVNHEPWUEVN
£kdoon.

Mwooa & mAnktpoAdylo

Mmopeite va mpooapudoETe TIC pUBUITELS YA\WOOAC Kat TANKTPOAOYIOU yia T
OUOKEUN 00,

T Zmv 0bovn pubuicgwy, matrote Zuotnpa > NAWooa & TANKTPOAGYIO.

7 MpooappooTE TIC TAPaKATW PUBIcEIC:

- M\waooa: EmAéETe Y\wooa yia T GUOKEU.

- Aayeipion minktpoloyiwv: Mmopeite va aAagete T pubuion yia 1o
Baotko MANKTPOASGYLO TOU TIPOIOVTOC, Va pUBIcETE Ta EPIBANOVTA
XPoNC yia To MANKTPOAGYI0 LG 1} GANa eyKATESTNUEVA TTANKTPOAOYIA KAl VOl
puBpioeTe TN Asrtoupyia avayvwpiong opthiag yia €ioodo pe Ty epappoyn
Google Voice. Mmopeite emiong va emAéEeTe av To Koupmi MAnKTpoloyiou
Ba eppavifeTal 0TV MEPIOX TWV KOUUMWY aPriG 0NV apxIkr 086vn, wote
Va UMOPE(Te va PETaBeiTe ypriyopa o€ AN TANKTPOAGYLO.

+ Mpaypatiké MAnKTpoAoyto: EMAECTE yia va XpnOIUOTIOIGETE TO KAVOVIKO
TIANKTPOAOYIO 1 yia va TTPOBAANETE TG GUVTOEVTELG TTANKTPOAOYIOU.
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+ OpBoypa@ikdg ENeyX0G: Lag eMTPEMEL va opioeTe SApopeS pUBITEIS yia
N Aertoupyia opBoypagikou eAéyxou Google Spell Checker.

+ Ymnpeoia autopatng cupmAnpwong: Evepyomoote autriv Ty emioyn
yia va yivetal eloaywyn Twv MANPOQoPLWV TV €ival amoBnKEUUEVEG
070 Aoyaplacpé oag, omwg kwdiko mpdoPaong, Sievbuvon ry
ap1BpoL MOTWTIKAG KAPTAC UE éva Povo mdtnua. Mmopeite emiong va
QITEVEQYOTIOIOETE AUTHY TNV EMAOYK, VA XPNOILOTOICETE TNV AUTOHATN
ouumAnpwon tn¢ Google fj va mpocBéoete éva véo Aoyaplaopd umnpeciog.

+ Metatpomnn Kelpévou o€ pwvn: AlapopPWOTE TIC PUBLICELS YA HETATPOTTH
KEIEVOU O OUINIQL

+ Tayutnta Tou Seiktn: PubpioTe v TayUtnTa Tou S&iKTN TOL TOVTIKIOU 1)
Tou trackpad.

AVTIOTPO®N TTARKTPWV GTO TTOVTIKL: avTIOTPEWTE TO Se€i Koupi Tou
TIOVTIKIOU Y10 Va EKTEAEL PAOIKEG EVEPYELES ALIETOU XEIPIOHOU.

Hpepopnvia & wpa

Mriopeite va TPOOAPUOCETE TIC PUBHIOELG NHEPOUNVIAG KAt WPAG YL TN CUCKEUN
oag.

T Zmnv 06ovn pubuicswy, natote ZuoTnpa > Hpepopnvia & wpa.

2 MpocappooTe TIg pUBKIoELC.

Mvripn

Mmopeite va Seite évav Péco o yia TNV KATAVAAWON MVAKNG Yia éva

GUYKEKPILEVO XPOVIKO SIA0TNHA, KABWGE KAl TNV TOGATNTA UVANG TTOU

KOTOVOAWVEL L0l EQOAPHOYT.

1 Zv 0Bdvn pubuicewy, matiote ZooTnpa > MvAun.

7 TMatioTe To KOUTT w yia va opioEeTe wia XpovoBupida yia avaktnon
Sebopévv.
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Avtiypago ac@aleiog

Mriopeite va SnpioupynoeTe avtiypaga acpaleiag yia Sedopéva mou eivat
anoBnkeupéva 0Tn CUOKEUN 0ag O pia GAAN GuoKeLr 1} Aoyaplacpo.

1 Zmv 006vn pubuicswy, matote Zootnpa > Avtiypago ac@aleiac.

7 MpooappéoTe TIC TapaKATW puBpIcEIC:

+ LG Mobile Switch: Zag emtpémel va petagépete Sedopéva amo pia malid
OUOKeUN LG o€ pia véa ouokeun LG. MNa Aemtopépeleg, avatpé€te otnv
evotnta LG Mobile Switch.

+ Anpioupyia avtlypd@wv ac@aleiag Kat emava@opd: Snploupynote
avtiypaga ao@aleiog Twv GES0HEVWY TNG CUCKEVNG 1 EMAVAQEPETE
Sedopéva 0Tn GUOKEL 0ag amd KAToLo avTiypa@o acaleiag.

A + Me tnv emava@opd Tng oUOKEUNG evEéxeTal va Slaypagpouv apyeia
avTIypa@wv acpaleiag mou €xouv amobnKeUTEl oTOV XWPO amoBrKEUONG.
BeBaiwBeite 61 éxete avtypdel kat amoBnKeLOEL GTOV UTTOAOYIOTH 0aG Ta
avtiypagpa ao@aAEiag Twv OnUAvVTIKWV apxeiwv oag.

« Avtiypago acp. Google: ANayr Twv pubuicewv avtypd@ou acealeiog
Tou Google drive. Mmopeite emiong va mpoBaNeTe Tov Aoyaplacpd
Snuioupyiag avtypdewv ao®aleiag o xpnolpomoleital i va mpooBéoete
€vav véo Aoyaplacpo dnuioupyiag avtlypdewv ac@aleiag.

Enavekkivnon & Emavagopa
Mriopeite va KAveTe EMavaQopdA TG GUOKEUNG TEPAApBavOUEVWY Twv PUBHIcEWY
SIKTUOU Kal EQAPHOYWV.
T Zmv 086vn pubpicewy, matriote Zuotnua > Emavekkivnon & Emavagopd.
7 NpooapudoTe TIC Tapakdtw pubpiceIC:
+ Autdpatn emavekKivnon: AUTOUATN EMAVEKKIVNON Kal Tpooapuoyn
TOU TNAEPWVOU OE KaBOPIOUEVO XpOvo. MaTAoTE TO Ko ylava
£VEPYOTIOINOETE AUTH TN A&lToupyia. H GUOKEUT EMAVEKKIVETAL AUTOHATA
o€ KaBoplopévo xpdvo kai BeAtioTomoteitat autdpata. EmAéSte Ty
NUEPOUNVia KAl TNV WPA yia TO Bloypa@ikd onueiwpa.
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E « Mmopeite va pubuioete T ouokeun va Eekivd Eavd pia popd tv eBdoudda.
H GuoKer EMaVeKKIVETal AUTOPATA O picl wpa amod TV POKABopPIoHEVN
wpa.

« MeTd TV emavekkivnon TnG CUGKEUNG, Ol EI60TTOINTELS Kat T EMPBAHaTa
Katapyouvtal. AmoBnkeloTe onpavtikd Sedopéva mptv amd tnv
mpokaBoplopévn wpa.

« HAeroupyia autopatng emavekkivnong Sev eivat evepyri 0TI akOAoUBeG
nepumtwoelg: Otav n 086vn eival evepyomoinuévn, dtav n CUCKEUN ivat og
Xprion, 6tav n otadun tng pumatapiag givat 30% ri Ayotepo 1 6tav n Kapta
USIM eivat kKAeildwpévn.

- Avdloya e Tov TTAPOYO UTINPEDIWV TNAETIKOIVWVIQY, N AElToupyia
QUTOHOTNG EMAVEKKIVNONG EVOEXETAL VA LNV gival SlaBéatun.

- Emava@opd Twv pubpicewv SIKTUoU: emavagépel Ti¢ pubpioelg Wi-Fi,
Bluetooth kat d\\eg pubpioeig Siktuou.

+ Mnbeviopdg mpoTiunoewv epappoyng: Emavaeopd twv pubpicswy yia pia

epappoyn. Aev Ba Siaypagouv ta dedopéva mou eivat amobnkeupéva otny

£pappoyN.

Emava@opd epyooTaciakwV SES0PEVWV: EMAVAPEPEL ONEC TIG PUBLIOELG

yla T ouokeun Kat Staypdgel ta dedopiéval.

E + H emavekkivnon Kat n emava@opd TnG CUCKEUHG 00U Slaypael OAEG
Ta Sedopéva mavw 6" auTrv. BANTE To Gvoua TG OUOKEUNG 0ag, TOV
Noyaplacpé Google Kat GANeG apxIKéG TANpo@opieg ava.
« Metd v apyomoinon twv Sedopévwy, Sev gival duvatr n Emavagopd
TOUG.

ZXETIKA KE TO TNAEQWVO

Mriopeite va Seite MANPOQOPIES OXETIKA LIE TN OUCKEUT 0ag, OTIWG TO OVoud TG,
TNV KTAoTaoN, TA OTOIXEIX VL0 TO AOYIGHIKO KOl VOLIKEG TTANPOQOPIEC.

YV 086vn pubuiogwy, matiote ZUOTNHA > IXETIKA ME TO TNAEPWVO Kal SeiTe TIG
TIANPOYOPIEC TTOU 0AG EVOLAPEPOLV.

PuBuioTiké mhaioto & Ao@alela

Mriopeite va Seite TIC PUBMIOTIKEC ETIKETEG TIG OXETIKEG TANPOYOPIEG TN CUCKEUN
oag.

TV 086vn pubpicswy, matrote Z0otnpa > PubpioTiko mhaioto & AogpdAela.
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Mpoofacipotnta
Mriopeite va SlaxelploTeite TI TPOOONKES TPOOaCIUATNTAG TTOU £XOUV
€yKataoTabel 0T OUOKEUN 0aG,

1
2

Ynv 08dvn pubuicewy, matriote NpooPacipétnra.

MPoCaPHOOTE TIC TAPAKATW PUOLICELS:

‘Opaon > TalkBack: PuBpiote tn cuokeur| va oag ei8omolel péow Guvng yla

TNV KATAOTAoN TNG 006VNG 1) V1o EVEPYELEC.

+ 'Opacn > Owvnrikég eldomomoeig: Pubpiote T ouokeur va SlaBalet ta
OTOIXEID EI0EPKOUEVNG KAONG HEOW QWVIG.

- 'Opaon > lpappatocelpd: AANAETE To PéyeBoC TNG YPAUUATOOELPAS, TV

£VTaon NG YPAPAG N TN YPAUUATOOEIPA.

‘Opaon > MéyeBog 006vng: Opiote 1o péyebog Twv oTolxeiwv atnv 086vn

omwg oag BoAevel. Kdmota atolyeia evdéxetal va aMda&ouv Béon.

+ 'Opaon > MeyéBuvon a@nig: yla peyéBuvon i opikpuvon maTwvTag oty
0006vN TPEIC POPEC.

‘Opaon > Mey£Buvan mapabupou: mpaypatonolnote peyébuvon 1
OikpLVON EVTOE TOU TaPABUPOU Kal AVTIOTPEWTE TO XPWHA.

+ 'Opaon > Meydahog Seiktng movTikioU: peyeBuvete Tov Seiktn Tou
TIOVTIKIOU.

+ 'Opacn > 006vn uPnAig avTiBeang: OKOUPUVETE TO XPWHA YOVTOU Yia

006vn uPnAng avtiBeonc.

‘Opaon > AvTIoTpo®r XpwHATWY 006vNnG: AunoTe Tnv avtifeon

XPWHUATWY TNG 086VNG 1o ATOMA PE TIEPIOPIOHEVN Opach.

+ 'Opaon > PUBoN xpwpdtwv 080vng: MpooapudoTe To XpWHa TG
0Bovng.

+ 'Opaon > Movoypwpn: aMaEte Tn Aeitoupyia tng 006vng o KAipaka Tou

YKPL

‘Opaon > Teppaniopog KAong pe To MARKTPO Tpo@odosiag: TEpHaTIoTe

Mo KAon e To TATNA TOU TTARKTPOU EVEPYOTIOINCNG/KAEISWHATOC.

+ Akon > Mpotipnoeig Ae(avtag: Evepyomoirote Ty unnpecia umoTitAwv
KOTd TV avamapaywyn Biveo yia dtopa pe mpoBARHaTa akong.

Akon > Eidomolfoeig @Aag: pubLioTE TN GUOKEUN VA 0OG EVNUEPWVEL e
QWG IOV avaBooPrVEL Yia EICEPXOUEVES KAOELS, UNVUUATO KAl AQUTTVIOELG.
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+ Akor} > ATopOVWGN AWV TWV AXWV: AITOHOVWOT OAWV TwV AXWV Kal
XOpNAGTEPN 0TABUN évTaong fixou otov SékTn.

+ Akon} > KavaAt fou: emAEETe TOV TUTTO fXOU.

« Akor} > loopporia fyou: TPocapUOoTE TV IooppoTia d8ou fou.
XPNOWOTOINOTE TN VPO KOMONG Yia va aANAEETE TNV L0OPPOTTIL.

Kivnuikétnta kat yvwan > Touch assistant: evepyomnotrjote Tov mivaka
APNG YIa EVKOAGTEQN XPHON TWV KOUUTIWV KAl TWV KIVGEWV.

+ Kwntikétnta kau yvwon > Eloaywyn a@ig: KataxwproTe Keiuevo
TIOTWVTOC TTAPATETAMEVA TNV 080VN 1| TPOTIOTOIOTE TO MATWVTAC AN TV
00ovn.

Kivntikotnta kat yvwon > Mpaypatikd mAnKTpoASylo: mpooapuOoTe TIC
puBUioelC Tou MANKTPOAOYIOU.

+ Kivnikdtnta kot yvwon > Autdpato KAIK movTtikoU: Snuioupyriote
auTOpaTa KNIK Tou G€iKTn TOU TTOVTIKIOU O€ TEPIMTWON anmouciag kivnong.

Kivntikotnta Kat yvwon > Ayyi€te mapatetapéva yia va KAvete KAfjon:
AmavTAOTE ) AmoPPIYTE KANOELG TATWVTAC TAPATETAPEV TO KOUMTT
KAoNG, Kat OX1 ME GApWOT) Tou.

+ Kivnuikétnta kot yvwon > Afjén xpovikol opiov 086vng: va
QITEVEQYOTIOLETAL AUTOMATA 1) GUOKEUN OTaV Mapapével og adpdvela yia éva
KaBoPIoPEVO XPOVIKG SIdoTNua.

+ Kivntikétnta kat yvwaon > Meployri eAéyXou apng: mepLopioTe TNV TIEPLOKT
APNG £TOL WOTE 0 ENEYXOG APG Va Eival SuVATOG IOVO OE VA GUYKEKPIUEVO
TUAHA TG 006vNG.

+ Zuvtopeuon A&rroupylwv mpooPactpdtntag: MpoomedoTe ypriyopa Hia
GUXVA XPNOILOTIOIOUHEVN AEITOUPYIa TATWVTAG TAUTOXPOVA TO TARKTPO
Tpogodoaiag kai o MikTpo AUENONG évtaong nyou.

+ Autopatn meplotpo@r) 086vng: aAAlel aUTOHATA O TTPOCAVATONGHOG TG
006vng avaloya e ToV TPOsavATONOUO TNG CUOKEUAC,

- EmAé€Te yia ekpuvnon: Zag eMTPEMEL va TATATE OPIOHEVA GTOIYEID YIa VOl

NapBAvete TPOYOPIKN avatpo®odoTnon.

MpooBaon pe S1akdm: Anuioupyrnote 6uvSUACKOUS TARKTPWY Yia val
ENEYXETE TN GUOKELN 0OG.
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PuOpiosic y\wooag LG
Em\é€te Y\OOA yla TN GUOKEU.
« XV apyikn 08ovn, matriote Pubpioei > Luotnpa > Nwooa & MAnKTpoAoyio
> MNwoaoa > MpocOrikn yYAwooag kat mAEETE pia YAwooa.
- Ayyi€Te Kal KPATAOTE TO KOUMTTI == Kal GUPETE TO OTO EMAVW PEPOG TNG
NoTaG Y\wOoOoWV Yia Vo TO 0PIOETE WG T YAWOOoa POEMAOYNG.

LG Bridge

LG Bridge - Mapouaiaon

Mrmiopeite va SnIoUpYHOETE QVTiyPaQa AOPANEIRS TWV EMAPWY, TWV
QWTOYPAPIWV KAt GAWV OTOIKEIWV OTOV UTTONOYIOTH 1} VO EVNUEPWOETE TO
MOYIOUIKO TNC OUOKEUNG.

E « [la mepLoooTePEG MAnpogopie BorBelag, avatpé€te oty evotnta LG
Bridge.
Ot umootnpI{OuEeVeC AerToupyieg eVOEXETaL va Sla@éPOouV avAaloya HE TN
OUOKEUN.
« To mpoypappa odrynong USB LG gival amapaitnto yia va ouvSéoeTe To
smartphone LG pie Tov umoAoyloTr Kat ykabiotartal Katd Ty eyKataotacn
Tou LG Bridge.

Netroupyieg Tng e@appoyng LG Bridge
+ AnpoupynoTe avtiypaga ao@aleiag Twv SeSopévwy amod T GUOKEUH Ot évav
umohoyloTh 1} emava@épete Ta Sedopéva amd évav UMOAOYIOTH OTN GUCKEUN
péow ouvdeong kawdiov USB.
+ Evnuépwan AoyiopikoU TnG GUOKEUNE amd évav UMOAOYLOTH Héow oUvEeon(
kaAwdiou USB.
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Eykatdotaon epappoync LG Bridge og umoloyloth

T MetaBeite otn SiebBuvon www.lg.com amé Tov umoAoyIoTH 0aG.

7 Em\é€te v mepioxn oac.

3 MatAote YIooTthpi€n > AOYIOUIKO Kat UNIKOAOYIGMIKO.

/' TANKTPONOYAOTE TO OVOUA TNG GUOKEUNC 0ag.
H
EmAé€te TV katnyopia mpoiovToc.

5 Tava kateBdoete 1o apyeio puBiong, emAéCte Zuyxpoviopog PC> LG Bridge.
« EmAé€Te Aemropépeleg yia va Seite TIG ENAXIOTES OMAITATELS Yia TV

£yKaTAoTaON TNG EPapHoy¢ LG Bridge.

Evnuépwon AoylGHIKOU THAEQWVOU

Evnuépwan Aoylopikou Kivitol TnAepwvou LG amnéd 1o
Internet

M0 TEPIOOATEPES TANPOPOPIES OXETIKA HE TN XPr0N QUTAG TG AelToupyiag,
emokepOeite ™ Sievbuvon http://www.lg.com/common/index.jsp Kat emAEETE T
XWpa Kal T yA\wooad 6.

Me autrjv T Aertoupyia pmopeite EDKOAA VA EVNUEPWVETE PéOw Internet To
UANIKONOYIOMIKO OTO TNAEQWVO 0aG OF L0t TTIO TIPOGQATN €KS00N XWPIC val
XpeldleTal va emokePOeite KATTOL0 KEVTPO EMOKEVWV. AUTH N Aettoupyia

Ba eival Slabéotun edv kat 6tav n LG Slabéoel otny ayopd veotepn ékdoon
UNIKOAOYIGMIKOU Y1 Tn) GUCKEUH 0.

Eme16n n evnuépwaon Tou UANIKOAOYIGHIKOU TOU TNAEQWVOU TPoUTOBETEL

TNV €0TIAOEVN TIPOCOYXT TOU XPHoTN KAaBAAN TN Sldpkela Tne Sladikaoiog
evnuépwong, PePatwbdeite 6T SraBalete MPooeXTIKA ONEC TIG 0ONYiES KAt TIC
ONUEWOELS TIoU ep@avifovTal og KABE Bripa TIPIV TPOXWPENOETE OTNV EKTENEDT
Tou. AdPete umoYn 6T €dv aatpéoete To kahwdio USB katd tn Sidpkela tng
Sladikaoiag avapaduiong, evoéxetat va mpokAnBouv coBapd mpoBAfuata oTo
AEQWVO 0ac.

E « HLG em@uldooetal Tou SIKaipatog va Slabétel, Katd T Slakpitikni
TNG EVXEPELD, TIG EVNUEPWOELG TOU UNKOAOYIGHIKOU MOVO Yia EMAEYUéVA
povTéha kat Sev eyyudtal T S1aBeoIpoTnTa TNG VEOTEPNG EKEOONG
UAIKOAOYIGHIKOU Y10l OAG TOl LOVTEAD TNAEPWVWV.
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Evnuépwan Aoylopikou Kivntol ThAe@uwvou LG péow
Over-the-Air (OTA)

AuTH N AeToupyia 0AG EMTPETEL VA EVNUEPWVETE EVKOAA TO AOYIOMIKS TOU
TNAEPWVOU 0ag o€ pia o mPooath ékdoon péow OTA, xwpic ouvdeon Kahwbdiou
USB. Auth n Aertoupyia Ba givat StaBéoiun eav kat 6tav n LG diabéoel otnv ayopd
VEOTEPN €KOOGT UNKONOYIOHIKOU YL TN GUCKEUN 0OC,

M0 Vol EKTENEOETE EVNUEPWOT TOU AOYIGHIKOU TOU TNAEQWVOU, aKOAOUBAOTE TV
€€nc Sladpoun:

PuBpioeig > Z0otnua > Kévipo evnuépwong > Evnuépwon Aoyiopikou >
EAeyxog evnpépwaong Aoyiopikou.

5 + Katd  1ad1kaoia evnpépwong Tou AOYIGHIKOU TOU TNAEQWVOU Gag
evdéxeTal va xaBolv Ta poowmika oag SeSopéva amo Tov ECWTEPIKO
XWPO amobrjKELONG TOU TNAEPWVOU, OTIWG YIal TAPASEIYUA, OL TTANPOPOPIES
OXETIKA UE TOV TIPOOWTTIKO 0ag Aoyaplacpd Google Kat GANoug
Aoyaplaopoug, Ta Sedopéva Kat ot PUBHICEIC TOU CUCTAKATOC KAl TWV
EQAPHOYWV 0aG, Ol amoBnNKEUpEVES EQappoyEC amo To Internet kai n ddeia
xprionc DRM. Emopéviwg, n LG 0dg ouviotd va dnpioupyeite avtiypapa
ao@aleiag Twv MPOCWTIKWY 6ag SeS0HEVWV TIPIV aTtd TV EVNUEPWON TOU
MoyiopikoU Tou ThAEpwvou oag. H LG ev pépel euBuvn yia evdexdpevn
QMWAELD TIPOCWTTIKWY SESOpEVWV.

« Auti n Aertoupyia eaptatal amd v mEPLOKT 1) TOV TAPOXO UTINPECIAV.
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06nyo¢ kata NG KAOmNG

PuBpiote Tn ouokeun oag va Pnv eMTPEMEL TN XEroN amd dANa ATopa £4v Exel
TIPAYHATOTOINOEL EMAVAPOPA EPYOCTACIOKWY PUBHICEWV XWwpig TV Adeld oag. MNa
TaPASELYHa, EQV N OUOKELR oa¢ xabei i KAamei, 1 edv Slaypagpolv ta dedopéva
NG, HOVO KATolog ke Aoyaplaopo Google fy Minpogopieg yia To KAEidwua Tng
086vn¢ Ba pmopei va xpnoIUOTOIOEL TN GUCKEUH.
To povo mou ypetdletat va Kavete yia va Befatwbeite 61 n cuokeur oag gival
TIPOCTOTEVPEVN €ival Ta E§1G:

+ Na opioete KAeibwpa 086vnc: dv n cuokeur oag xabei fy kKharmei, al\d éxete
opioel kAeidwpa 086vng, Sev gival duvatn n Slaypaer Twv dedopévwy
TIou BpIOKOVTAI OTN CUOKEUT HEOW TOU pevoU pubpioewv mapd pévo v
EekheldwOei n 0Bovn.

Na mpooBéate Tov Aoyaplacpd oag oto Google 0T cuoKeLr 0ag: £Gv Ta
Sedopiéva TG UOKEUNG oag Slaypapoly alAd ExeTe opioel Aoyaplaopo
Google, n cuokeur gv umopei va oAokANpwael Tn Sladikacia pUBUIONG UEXPL
va gloayBouv avd ta oTolxgia Tou Aoyaplacpou oag oto Google.
A@OU TIAPETE TA AMOPAITNTA HETPA VIO TV TIPOOTAGHA TNG CUOKEUNG 0ag, £4v
XPELOOTE VO TIPAYMATOTIOIOETE EMAVAPOPA TNG OTIC EPYOOTACIAKEC PUBicELS, Oa
Tipémel va EeKAEIOWOETE TV 086vN 0ag ) va EloaydyeTe Tov KwdIKO TpooBaong
yia Tov Aoyaplaopd oag 0to Google. Me autév tov Tpdmo Siacpahiletal 6T n
EMAVOPOPA UTTOPE( VO EKTENETTEI IOVO QMO KATTOIOV TTOU EUMIOTEVEDTE.

E « Tpwv ekteNéoETe EMaVaPOPd TwV EpYOoTaCIaKwY pubpicewy, Befaiwbeite
6T BupdoTe Tov Aoyaplacpo oag oto Google Kat Tov KwdIKo mpooBaong
TIoU éXETE MPOOBETEL OTr GUOKELN 0ag, EQv Sev Umopeite va mapéxete autd
Ta oTolkEia Aoyaplacpou katd T Sladikacia puBpiong, Sev Ba umopeite
VOl XPNOILOTIONOETE T CUOKEUT KaBONOU HETE amd TNV eKTENEON TNG
ENAVAPOPAG EPYOCTACIAKWY PUBHICEWV.

Mapdptnua 126



MAnpo@opisg onueiwong yia to
AOYIGHIKO AVOIKTOU KWOIKA

MNa ™ AN Tou mnyaiou kwSika mou Siémetat amd TG adeleg xpriong GPL, LGPL,
MPL kat GAeG adeteg xpriong avolytou Kwdika, o omoiog mepthapBavetat 6To
Tipoidv, emoKeTeite Tn SlelBuvon http://opensource.lge.com.

Ext0¢ amo Tov mnyaio Kwdika, Slatibevtat mpog An 6Aot ot avapepdpevol 6pot adelmv
XPONG, Ol AMOTOICEIG EYYUOEWV KAl Ol ONPEIGELG TIVEUHATIKWV SIKAWHATWV.

H LG Electronics Ba oag mapéxel emiong Tov Kwka avolx g mnyng o poperi CD-
ROM évavtt xpéwaong mou Ba kaAumTel Ta €€06a TG Slavopnic (OMwe To KHOTOC Twv
TIOAUHECWVY, TNG AIMOOTOAG Kalt TNG SLayeiplong), KATomy artuatog Yéow email
otn SievBuvaon opensource@lge.com.

H mpoopopd 1oxUEL yia TEPInS0 TPIWV ETWV amd TNV TEAEUTAIN LA ATOCTOAN
auTou To TTPOIGVTOG. H poo@opd 1oXVEL yia GAOUG TOUG TTAPAAATITES AUTHG TG
TIANPOYOpIaC.

MAnpo@opieg OXETIKA UE TOUG
KaVOVIOHOUG (ApIOROC avayvwploTIKOU
KAVOVIOMOU, NAEKTPOVIKEG ETIKETEC KAL)

Mol NeTTTOPEPELEC OXETIKA LE TOUG KAVOVIOpOUG, emAEETe Sladoyikda PuBpioeig >
Y0oTnua > PubpioTiko maicio & Ac@alela.
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Epmopikd ojpara

+ Mveupartikd Sikawpara ©2020 LG Electronics Inc. ONa ta Sikaiwpota
npooTtatevovTal. H emwvupia LG kat o Aoyotumo LG eival oripata katateBévia
Tou Opilou LG Kal Twv OXETIKWY OVTOTATWY TOU.

Ta Google, Google Maps, Gmail, YouTube, Google Duo, Google Play, Android,
Chrome, Owtoypagiec Google, Google Play Protect, Huepohdylo Google,
Google Docs, Google Drive, Google Sheets kit GAMa OXeTIKA orjpaTa Kal
Noydtuma givat epmopikd orjpata g Google LLC.

To Bluetooth® amotelei ofjua katateBév Tng Bluetooth SIG, Inc. maykoopiwg.
H enwvupia Wi-Fi® kai to Aoystuno Wi-Fi eival ofjuata katateBévta g Wi-Fi
Electronics.

‘O Ta UTIGNOITTAL EPTTOPIKA CUATA KAt TIVEUHATIKG SIKaIwUaTa anmoTtehoiv
1I510KTN G0 TWV AVTIOTOIWV KATOXWY TOUG.

HE HEVC \dvance”

Covered by Patents at patentlisthevcadvance.com
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AnAwon acpaleiag Aélep
Mpoooxn!

Auto To Tpoidv xpnaoiuomolei cloTnpa Aéilep. MNa va BePaiwbeite mwg
XPNOlHoToLEiTe KATANNAa AUTO To TTPOTOY, SIaBAOTE MPOTEKTIKA TO EYXEIPISIO
XPOTN Kat QUAGETE TO yia HENOVTIKH ava@opd. Ze mepimTwaon mou n povada
XPEIOOTE GUVTAPNON, EMKOIVWVACTE PE E§0UCIOSOTNHEVO KEVTPO ETIOKEVWV.
H xprion otolxeiwv eAéyxou, pubpicewv r n ektéAeon Sladikaotwy mou dev
TIEPYPAPOVTAL 0TO TTAPOV EVOEXETAL VA EMPEPOLV eMmKivouvN €kBeon o
padievépyela.

Mo va amo@UYeTe Tnv dpeon €kBeon otnv aktiva Aéilep, unv mpoomabroeTe va
avoiete To mePiBAnUa fy va ExETeE APEDN EMAQN Ue TO AéIlep.

CLASS 1 LASER PRODUCT
KLASSE 1 LASER PRODUKT
LUOKAN 1 LASER LAITE

KLASS 1 LASER APPARAT
CLASSE 1 PRODUIT LASER

AHAQZH ZYMMOPOQXHX

Meé 1o mapdv, n LG Electronics Sn\wvel ot to mpoiov LM-K520EMW
GUUMOPQWVETAL E TIC BACIKES AMAITACELS KAl LIE TIG UTONOUTEG OXETIKEC SlATAEIG
NG Odnyiag 2014/53/EU.

‘Eva avtiypago tng Afdwong Zuppdpewong SatiBetal otn Sievbuvon
http://www.lg.com/global/declaration
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AevOuvon evnpépwong yia Oépata
GUHHOPPWONE WG TTPOC TN XPHON TOU
TPOIOVTOG

LG Electronics European Shared Service Center B.V.

Krijgsman 1, 1186 DM Amstelveen, The Netherlands

Wi-Fi (WLAN)

H ouyxvétnta 5150 - 5350 MHz mpoopileTat amoKAEIOTIKA yia Xprion O
EOWTEPIKOUG XWPOUG.

AT |BE |BG|CH|CY|CZ|DE|DK|EE|EL|ES|FI|FR
QHR HU[IE | IS|IT| L |LT|LU|LV|MT|NL|NO|PL

PT|RO|[SE | SI [ SK|UK|AL|ME|RS [MK]|TR |BA]|XK
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Meproootepeg MAnpoopicg

E€aptipara and okAnpupévo yuai

Ta e§aptripata auTrig TG CUOKEURG ammd OKANPUEVO Yuai Sev xouv SIdpKela ¢’

6pou {wrig, CUVETWC, EvOEXETAL Va BAPOUV e TNV TTdPodo Tou xpdvou.

+ Edv n ouokeun oag méoel TAvw O€ pia OKANPN EMEAVELD 1) TPOOKPOUGTEL KATTOU
e Svvapn, wmopei va mpokAnBei {nptd 6To oKANPUHEVO YUaA.
Ye QuTAv TV TePImTwan, SIaKOYTE APESWE TN XPHON TNG CUCKEUNG Kall
EMKOWVWVAOTE PE éva Kévtpo e§umnpétnong mehatwv tng LG.

TNV ayopd KUKANOQOPOUV TIPOOTATEVTIKEG BIKEC TTOU UMTOPEITE Va
TIPOUNOEUTEITE YIa VA TTPOOTATEVOETE Tr) GUOKELN 0ag amd Tn {npid.
N&Bete umOYN OTL AUTEC OL TTPOOTATEUTIKES Brikeg Sev KaAUTTOVTAL amd TV
€yyunon ¢ LG Electronics kat 6ev eyyuwvTal Tnv ao@alela.

Noyo¢ Slaotdoewv
AuTA n ouoKeun €xel Adyo Slaotacewv 20,5:9.

« Evéxeta kdmoteg \n@Oeioeg epappoyég va pnv umootnpifouv tov Adyo
Slaotdoswy 20,5:9.

Ye autrv TV mepimwon, emAEETe TI¢ BEATIOTEG avahoyieg 006vng yia v
gpappoyn 1 anotabeite oTov MAPOYKO TNG EPAPHOYAG Y10l TIEPIOTATEPES
TIANPOPOPIEC.

TNa mep1ocoTEPEG MANPOPOPIEC

mAepwviiote oto: 801 11 200 900

i and Kwnto oto: 210 4800564
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06nydc yia petagopd dedopévwv
+ Ta Sedopéva mou Pmopouy va LETaPepBouv PETay cuokevwy LG iy petay
Uiag ouokeung LG Kal piog GUOKEUNG TPITOU KATAOKEUAOTH, GUUBOUAEUTEITE

Tov mapakdTw mivaka.
ZuoKeur Tpitou
SUOKEUH LG KatooKeuaoT ZugKeun
e AerToupyIko i0S
Tumog Nemtopépeleg oTOIXEIOU — Android .
Zuokevn LG - Zuokeun LG
Tuokeu LG
Emagéc, unvopata, apxeia
KAOEWV, NUEPOAOYIO, @) O O
Mpocwmka PWVNTIKEG EYYPAPES
Sedoptva 2nUEWUATAPIO X O
Zunvntipla X X
Agdopéva | Dwroypagieg, Pivteo, o o o
mohupéowv | Tpayoudia, éyypaga
PU’QHIOEIC apiknc 066vng o X X
(pakehot kat widget)
PU?““’E'C PUBpioEIC KAEIS(PATOC
086vng ¢ 086vNC (e€apouvTat o X X
ol puBpioelC KAeldwuatog
006vng)
An@Beioec epappoyég @) e)
Egappoyéc Mpoowmika dedopéva yia .
. . @) X
™ An@Beioa epappoyn
Anpdoto moTtomoNTIKd O @) X
PuBpioeig (Wi-Fi,
ANa Bluetooth, kAroelig,
X0 Kat E80TTONCELG, @) X X
mpooBacipotnta,
umatapia)
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E « Evdéxetal va pnv ivat QIKTr N HETAQopd oplopévwy dedopévwy avaloya
ME TV €KE0ON AOYIOUIKOU Kal EQAPOYNE, TO AEITOUPYIKO 0UOTNA, TOV
KATAOKEVAOTH 1) TNV TTONTIKY) TOU TIAPAXOU UTTNPECIAV.

Ymootnpi{opeveg {WVEG CUXVOTHTWV loxug e€680u mopmou
GSM 900 33.7dBm
GSM 1800 30.7 dBm
WCDMA B1 25.0dBm
WCDMA B8 25.5dBm
LTEB1 24.7 dBm
LTEB3 24.7 dBm
LTEB7 24.7 dBm
LTE B8 25.2dBm
LTE B20 25.2dBm
LTE B28 25.2dBm
LTE B38 24.7 dBm
BT 9.5dBm
WLAN 2.4GHz 18.5dBm
WLAN 5GHz 15.0dBm

NFC -13 dBuA/m

Mriopeite va Bpeite MAnpo@opieg yia 1o goptioth Tagidiou otn Siebuvon
http.//www.lg.com/global/support/cedoc/cedoc
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Anoppudn tng maAidic cag GUOKEVNG

1. AuTo o Slaypappévo oUPBOAO TOU TPOXOPOPOU KASOU UTTOSEIKVUEL OTL
Ta amoBANTA NAEKTPIKWV Kat NAEKTPOVIKWY TTpoiovTwy (AHHE) mpémetva
amopP{MTOVTAl XWPIOTA OO Ta YEVIKA OIKIAKA AmoppipuaTa.

B 2 TanaNd NAeKTPIKA TPOIGVTa UMOPE( va TIEPIEXOUV EMIKIVOUVEG
0UOIEC KAl WG EK TOUTOU N 0WOTH AmoppiPn TG MaNAG 0ag GUOKEUNG
QMOTPEMEL EVEEKOUEVEC APVNTIKEG CUVETTELEG Yiat TO TIEPIBANOV
Kat v avBpwmivn uyeia. H maAid 6ag GUOKEUR PMOPE( va TIEPIEKEL
EMAVOXPNCIUOTIOOIA AVTAMAKTIKE TTou Ba pmopouoav va
XPnotpomonBouy yia Ty MoKeur GAwV TPoIOVTwWY, KaBWE Kat GMa
UAIKA a&iag mou umopouv va avakukAwBoLv yia e§oikovopunon Twv
TIEPIOPIOUEVWY PUOIKWVY TIOPWV.

3. Mmopeite va TTATE TN CUOKEUR 00, iTE 0TO KATAOTNO amd TO
0TI0i{0 AyOPACATE TO TIPOIGV, I} Va EMKOIVWVAOETE TO TOTIKS YpaPEio
AMOPPIUUATWV Yia AETTOPEPELEC OXETIKA HE TO TTANCLETTEPO EYKEKPILEVO
onueio ouloync AHHE (AnépAnTa HAektpikwv kat HAEKTpOVIKWV
JUOKEUWV). M0 TIG TTIO TPOOPATES TTANPOPOPIES YIA TN XWPA 0AG
emokepOeite T SievBuvon www.lg.com/global/recycling

AmoppPn TWV XPNOIUOTTOINMEVWY prrataplwv/
CUCCWPEUTWY

1.To oOpBolo autd pmopei va cuvdualetal pe Ta XnUikd cupBoAa yia
Tov udpdpyupo (Hg), To kadpo (Cd) rj To pdAuBso (Pb), av n pmatapia
TIEPIEXEL TOOOTNTEG PEYaNUTEPES a6 0,0005% udpdapyupo, 0,002%
Kadpio 1} 0,004% poAupso.

2. H améppun OAwv Twv PIaTaplwv/CUCoWPEUTWY TTPEMEL vVal
YIVETOL XWPIOTA A0 TA YEVIKA OIKIAKA AMOPIpaTa, HEow EISIKWY
EYKATAOTACEWY CUNOYIG AOPPIUHATWY TTou €xouv kaBoploTei amd v
KUB£€PVNON 1 amo TIG TOTTIKEG APXEC.

3. H owotr andppipn Twv maNwy HmaTapiwv/cCUCowPEUTWY AITOTPETEL
EVOEXOUEVES OPVNTIKEG CUVETTELEC VIO TO TIEPIBANOV, KABWE Kal yia Thv
uyeia Twv {Wwv Kal Twv avBpwmwv.

4. Na Mo avaAUTIKEG TTANPOPOPIES OXETIKA LE TNV amoppIPn Twv MV
UMTOTAPIWV/CUCOWPEUTWY, EMKOIVWVAOTE WE TO TOTIKO YPaQEio, TNV
apuodia umnpeaia SIGBETNC OIKIOKWY AMOPPIMUATWY 1} TO KATAoTNHA
amné to omoio ayopdoate To TPoidv.
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LUXVEG EPWTIOELG

370 KEQAAILO QUTS avaPEPOVTAL OPLopEVA TIPOPBAUATA TTOU EVOEXETAL Va
QVTILETWTTIOETE KATA TN XPrioN TNG OUOKEUNG 0aC. Na optopéva mpoPAruata Oa
XPELOOTE VOl EMKOWWVHOETE LIE TOV TTAPOYKO UTNPECLWV 0ag, AANG Ta TTEPIOCOTEPA
pmopeite va Ta S1opBwoETe Kal HOvol 0.

Z@ahpa kaptag SIM

BeBaiwOeite 6T n kdpta SIM gival owoTa TomoBeTnpévn.

Agv uniapyel ouvdeon SiktUou 1 undpxel anwAela SIKTUOU
XapnAd orjua. MetakivnBeite kovtd og mapabupo 1y o€ avoiyxTd Xwpo.

Eiote extog TG meploxng kahung diktuou tou médpoyou. ANAETe Béon kat eNéyEte
70 SikTuo.

Aev givan S1a0£o1peg ol KAAoEIg

To véo iktuo Sev eival e§ouaiodotnpévo.

S 1lyOUpEUTEITE TIWG SV EXETE OPIOEL PPayr KNOEWV yIa TOV EI0EPKOHEVO aPIOUO.
S1youpeuTEiTe WG Sev EXeTe OpioEl Ppayr KAOEWV yia TOV apIBUO TTOU KOAEITE.

Aev givat Suvatn n evepyomnoinon TG CUOKEVNG

Otav n pmatapia €xel amo@optioet Mpw¢, Sev Ba givat Suvatr n evepyomoinon
TNG GUOKEUNG 00,
DopTtiote MAMPWG TN UMATAPIA TIPLV VA EVEPYOTTOI\OETE TN GUCKEUH.

ZPAaApa eopTiong

BeBauwbeite 61 n cuokeur @optiletal o€ KavoVIKr Beppokpacia.

ENéy€Te TOV QOPTIOTH Kalt TN GUVOEDT) TOU OTN GUOKELN).

Na xpnotuomoleite pdvo ta e§aptripata mou mepIAapBAvovTal 0T CUCKEVAGIA Kal
eivat e€ovotodotnuéva amd v LG.
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H pmatapia teAewwvel mo ypriyopa o€ oxéon pe 6tav aydpaca
OPXIKA TN CUCKEUN

'Otav ekTiBETAL N GUCKELN 1 N Umatapia og TOA) UYNAEG 1 xapnAég Bepuokpaaieg,
evdéyetal va pelwbei n Sidpketa (wng NG pmatapiag.

H katavéAwon pmatapiog a au§nbei dtav xpnotoToLETE OPIoHEVES
XOPOKTNPLOTIKA 1 EQAPHOYEC, OTwE To GPS, maikvidia i 1o Internet.

H pmatapia ivat avaAwotpo kat n {wn tg pmatapiog 6a petvetal pe tnv mapodo
Tou Xpdvou.

Epgavi{ovtal pnvopota 6AAHaTog Katd T KKivnon tng
KAMEPG

Oopriote TV umatapia.

AmeNeuBEPWOTE VAN LETAPEPOVTAC apxEia O Evav uTToAoyloTh f Staypdgovtag
apyxeia amd T ouokeun oag.

ETOVEKKIVE( TN GUOKEUN.

Eav e€akohouBeite va avtipetwmifete mpdBAnUa Ke TNV QapOoYR TG KAUEPAS
0QOTOU AKONOUBNOETE AUTEC TIC GUUBOUAEG, EMKOIVWVHOTE e €va Kévtpo Z€pPIg
NG LG Electronics.

H moiétnta tn¢ pwtoypagiag givat Kakn

H mo1dtnTa Twv QuToypagiwy 0ag VOEXETAI VA TIOIKIAEL avahoya pe Tov
TEPIBAANOVTA XWPO KAl TNV TEXVIKI GUTOYPAPNONG TTOU XPNOILOTOIE(TE.
'Otav Bydlete pwtoypagieg kal Bivteo, n molotnTa anod otabepr ywvia givat
KOAUTEPN OE OXEON HE TNV QVTIOTOIYN QMO EUPEIA ywvia.

Edv Bydlete putoypaieg o€ OKOTEVA PEPN, TO BPASU 1 O€ ECWTEPIKO XWPO,
evdeyetal va umdpyel 00puBog oTIC pwToypagieg i va givat Boléc.

Edv avtipetwnilete mpoBAUOTa, KAVTE EMAVAPOPA TWV EMAOYWV.
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H 00dvn agng avtamokpivetat apyd i AavOaopéva

Edv TomoBetrioeTe mpooTaTeuTIKO 006VNG 1 TPOAIPETIKA €€APTARATA OTNY 08dVN
AQPAG, AUTH EVOEXETAL VO NV AEITOUPYEL OWOTA.

Eav @opare yavtia, €dv Ta xépla oag Sev eival kaBapd 6tav ayyilete Tnv 08ovn
ARG A €av ayyigete Tnv 006vN PE aiUnEA AVTIKEILEVA 1) L Ta akpoSAKTUAG oag,
QUTH EVOEXETAL VA NV AEITOUPYNOEL GWOTA.

H 0086vn agn¢ evoéxeTal va unv Aerroupyrogl owoTd og ouvBrKeg uYNARiG
uypaoiag ry étav ektedei oe vepo.

EmavekKIVOTE T 6UOKEUN 060G yla va §lopBwBolv Tuxov mpoowptva mpoBArata
Aoylopikou.

Edv n 086vn agrq éxel ypatoouvioTei ) umooTel {Nd, EMOKePTEiTE éva Kévtpo
Y£€pPig TG LG Electronics.

KaBuotepei i) koAdel

EmavekKivijoTe T oUOKEUR
+ Av n ouokeun oag KoMdeL i kaBuoTepei, pmopei va XpelaoTei va kheioete
KATTOLEG EQAPHOYEG 1) VO ATIEVEQYOTTOIOETE T GUOKEUN Kal Vol ThV
evepyoroloete {ava.

EKKIVAOTE TN OUOKEUR
- Hemavagopd umopei va xpnotpomolndei av n 086vn maywael, 1) av Ta Koupmd,
n 086vn agnic fi n ouokeun Sev avtamokpivovTal Tma.
- [l va EnavagépETe T GUOKELN 0G, TATAOTE TAUTOXPOVA T TIARKTPA HEiwoNg
£VTOONG X0V Kal AEITOUPYIaG LEXPL N CUCKEU Vol EMAVEKKIVNOEL.

Emavagopd tng cUoKeung
+ Edv n xprion twv mapandvw pefodwv Sev amokataotrioel To mpoBAnua,

EKTENEDTE EMAVAPOPE EQYOOTACIAKWY SESOUEVWV.

+ XV 08dvn pubpicewv, ayyi€te Sladoxikd Zuotnua > Emavekkivnon &

Emavagopd > Emavagopd epyooTtaclakwv Sedopévuwv.

- Emavagépet ONeg TIG pUBLIoELC yia TN ouokeun Kat Slaypdgel Ta Sedopéva.
Mpwv MPOXWPNOETE 0NV EMava@opd epyooTactakwv Sedopévwy, Bupnbeite
va SnuoupynoeTe avtiypapo ac@aleiag yia 0Aa ta onuavtika dedopéva
TIOU €XETE AmOONKEVPEVA OTN GUOKEUN.

- Av Kataywpnoeg évav hoyaplaopo Google 0T OUOKEUN, TTPEMEL v KAVEL
€i0060 pe Tov (610 Moyapiaoud Google LETA TV EMAVAPOPA TNG CUOKEUNG.
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Agv BpéBnke ouokeur Bluetooth
Y1youpeuTeite mwg n Aertoupyia Bluetooth €xel evepyomoinBei otn cuokeur oag.

TlyoupeuTeite wg n Aettoupyia Bluetooth €xel evepyomoinBei otn cuokeun pe T
omoia BéAete va ouvdeDeite.

BePaiwbeite 611 n cuokeur) oag kat n dAAn ouokeun Bluetooth gival vtog tng
péylotng epPéhelag Bluetooth (10 m).

Edv ot mapamdvw oupBoulég Sev Augouv To IPARANUA GaG, EMKOIVWVACTE HE éva
Kévtpo ZépPig ¢ LG Electronics.

Aev mpaypatomoleital o0vOEon OTav CUVOEETE TN GUCKEUN O
évav umohoyloTh

Y1youpeuTeite mwg to KaAwdio USB mou xpnotuomoleite givatl oupBato pe
OUOKEUN 00,

S IYOUPEUTEITE TIWG EiVal EYKATAOTNEVO Kall £XEL EVNUEPWOEL TO KATAANAO
TIPOYPALLA 08ryNONG GUCKEUNG OTOV UTTOAOYIOTH GOIC.

H e@appoyn mou Aj@Onke mpokalei moANd o@aApata
H epappoyn mapouatalel mpoPAfuata.
AQaIPEOTE KAl EYKATAOTAOTE EaVA TNV EQAPUOYH.
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ENGLISH

About this user guide

Thank you for choosing this LG product. Please carefully read this user
quide before using the device for the first time to ensure safe and proper
use.
+ Always use genuine LG accessories. The supplied items are designed
only for this device and may not be compatible with other devices.

+ Descriptions are based on the device default settings.

- Default apps on the device are subject to updates, and support for
these apps may be withdrawn without prior notice. If you have any
questions about an app provided with the device, please contact an
LG Service Centre. For user-installed apps, please contact the relevant
service provider.

- Modifying the device's operating system or installing software from
unofficial sources may damage the device and lead to data corruption
or data loss. Such actions will violate your LG licence agreement and
void your warranty.

- Some content and illustrations may differ from your device, depending
on the area, service provider, software version, or OS version, and are
subject to change without prior notice.

- Software, audio, wallpaper, images, and other media supplied with
your device are licenced for limited use. If you extract and use these
materials for commercial or other purposes, you may be infringing
copyright laws. As a user, you are fully responsible for the illegal use of
media.

+ Additional charges may incur for data services, such as messaging,
uploading, downloading, auto-syncing and location services. To avoid
additional charges, select a data plan suitable to your needs. Contact
your service provider to obtain additional details.

- This user guide is written in major languages for each country.
Depending on the language used, content may partly differ.



Instructional notices

A WARNING: Situations that could cause injury to the user and third
parties.

A CAUTION: Situations that may cause minor injury or damage to the
device.

E NOTE: Notices or additional information.

About this user guide
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Guidelines for safe and efficient use

Please read these simple guidelines. Not following these guidelines may be
dangerous or illegal.

Should a fault occur, a software tool is built into your device that will gather a
fault log. This tool gathers only data specific to the fault, such as signal strength,
cell ID position in sudden call drop and applications loaded. The log is used only to
help determine the cause of the fault. These logs are encrypted and can only be
accessed by an authorised LG Repair centre should you need to return your device
for repair.

Exposure to radio frequency energy
Radio wave exposure and Specific Absorption Rate (SAR) information.

This device has been designed to comply with applicable safety requirements for
exposure to radio waves. These requirements are based on scientific guidelines that
include safety margins designed to assure the safety of all persons, regardless of
age and health.

+ The radio wave exposure guidelines employ a unit of measurement known
as the Specific Absorption Rate, or SAR. Tests for SAR are conducted using
standardised methods with the device transmitting at its highest certified
power level in all used frequency bands.

+ While there may be differences between the SAR levels of various LG device
models, they are all designed to meet the relevant guidelines for exposure to
radio waves.

+ The SAR limit recommended by the International Commission on Non-lonizing
Radiation Protection (ICNIRP) is 2 W/kg averaged over 10 g of tissue.

+ The highest SAR value for this model tested for use at the ear is 0.555 W/kg
(10 g) and when worn on the body is 1.310 W/kg (10 g).

+ This device meets RF exposure guidelines when used either in the normal use
position against the ear or when positioned at least 5 mm away from the body.
When a carry case, belt clip or holder is used for body-worn operation, it should
not contain metal and should position the product at least 5 mm away from
your body. In order to transmit data files or messages, this device requires a
quality connection to the network. In some cases, transmission of data files
or messages may be delayed until such a connection is available. Ensure the
above separation distance instructions are followed until the transmission is
completed.



Information about the RF exposure from FCC

In August 1996, the Federal Communications Commission (FCC) of the United
States, with its action in Report and Order FCC 96-326, adopted an updated safety
standard for human exposure to radio frequency (RF) electromagnetic energy
emitted by FCC regulated transmitters. Those guidelines are consistent with the
safety standard previously set by both international and US. standards. The design
of this device complies with FCC guidelines and these international standards.

Part 15.19 statement

This device complies with part 15 of the FCC Rules. Operation is subject to the
following two conditions:

(1) This device may not cause harmful interference, and

(2) this device must accept any interference received, including interference that
may cause undesired operation.

Part 15.21 Statement

Changes or modifications not expressly approved by the manufacturer could void
the user's authority to operate the equipment.

Guidelines for safe and efficient use 7



Body-worn Operation

This device was tested for typical bodyworn operations with the back of the device
kept 0.39 inches (1cm) between the user’s body and the back of the device. To
comply with FCC RF exposure requirements, a minimum separation distance of
0.39 inches (1cm) must be maintained between the user's body and the back of
the device.

Any beltclips, holsters, and similar accessories containing metallic components
may not be used. Body-worn accessories that cannot maintain 0.39 inches (1cm)
separation distance between the user’s body and the back of the device, and have
not been tested for typical body-worn operations may not comply with FCC RF
exposure limits and should be avoided.

Part 15.105 Statement

This equipment has been tested and found to comply with the limits for a class

B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed
to provide reasonable protection against harmful interference in a residential
installation. This equipment generates uses and can radiate radio frequency energy
and, if not installed and used in accordance with the instructions, may cause
harmful interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment does cause
harmful interference or television reception, which can be determined by turning
the equipment off and on, the user is encouraged to try to correct the interference
by one or more of the following measures:

+ Reorient or relocate the receiving antenna.

+ Increase the separation between the equipment and receiver.

+ Connect the equipment into an outlet on a circuit different from that to which
the receiver is connected.

+ Consult the dealer or an experienced radio/TV technician for help.

Product care and maintenance

+ Use only in-box accessories which are authorised by LG. LG does not guarantee
any damage or failure which is caused by third party accessories.

+ Some contents and illustrations may differ from your device without prior
notice.

- Do not disassemble this unit. Take it to a qualified service technician when repair
work is required.

Guidelines for safe and efficient use 8



Repairs under warranty, at LG's discretion, may include replacement parts
or boards that are either new or reconditioned, provided that they have
functionality equal to that of the parts being replaced.

Keep away from electrical appliances such as TVs, radios and personal
computers.

The unit should be kept away from heat sources such as radiators or cookers.

Do not drop.

Do not subject this unit to mechanical vibration or shock.

Switch off the device in any area where you are required to by special
regulations. For example, do not use your device in hospitals as it may affect
sensitive medical equipment.

Do not handle the device with wet hands while it is being charged. It may cause
an electric shock and can seriously damage your device.

Do not charge a handset near flammable material as the handset can become
hot and create a fire hazard.

Use a dry cloth to clean the exterior of the unit (do not use solvents such as
benzene, thinner or alcohol).

Do not charge the device when it is on soft furnishings.

The device should be charged in a well ventilated area.

Do not subject this unit to excessive smoke or dust.

Do not keep the device next to credit cards or transport tickets; it can affect the
information on the magnetic strips.

Do not tap the screen with a sharp object as it may damage the device.

Do not expose the device to liquid or moisture.

Use accessories like earphones cautiously. Do not touch the antenna
unnecessarily.

Do not use, touch or attempt to remove or fix broken, chipped or cracked glass.
Damage to the glass display due to abuse or misuse is not covered under the
warranty.

Your device is an electronic device that generates heat during normal operation.
Extremely prolonged, direct skin contact in the absence of adequate ventilation

may result in discomfort or minor burns. Therefore, use care when handling your
device during or immediately after operation.

Guidelines for safe and efficient use 9



+ If your device gets wet, immediately unplug it to dry off completely. Do not
attempt to accelerate the drying process with an external heating source, such
as an oven, microwave or hair dryer.

+ The liquid in your wet device, changes the colour of the product label inside your
device. Damage to your device as a result of exposure to liquid is not covered
under your warranty.

A mobile device requires proper air circulation in order to dissipate heat. Direct
skin contact and inadequate circulation of air flow to the device may cause the
device to overheat. The device must be at least 1.0cm from between the user's
body.

+ Prevent dust of any other foreign substances from getting into the Charger/
USB cable port. It may cause heat or fire.

+ Avoid exposing the device to low air pressure at high altitude.

+ Do not expose the device to extremely low air pressure. Otherwise, it can cause
explosion of the battery or leakage of flammable liquid or gas.

+ Please ensure that the product does not get in contact with liquid. Do not
use or recharge the product if it is wet. Once the product becomes wet, the
liquid damage indicator changes color. Please note that this will limit you from
receiving any free-of-charge repair services provided under warranty.

Efficient device operation

Electronics devices
All devices may receive interference, which could affect performance.

+ Do not use your device near medical equipment without requesting permission.
Please consult your doctor to determine if operation of your device may
interfere with the operation of your medical device.

+ Pacemaker manufacturers recommend that you leave at least 15 cm of space
between other devices and a pacemaker to avoid potential interference with the
pacemaker.

+ This device may produce a bright or flashing light.
+ Some hearing aids might be disturbed by devices.
+ Minor interference may affect TVs, radios, PCs etc.

+ Use your device in temperatures between 0 °C and 40 °C, if possible. Exposing
your device to extremely low or high temperatures may result in damage,
malfunction, or even explosion.
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Road safety

Check the laws and regulations on the use of devices in the area when you drive.
+ Do not use a hand-held device while driving.
- Give full attention to driving.

+ Pull off the road and park before making or answering a call if driving conditions
SO require.

+ RF energy may affect some electronic systems in your vehicle such as car
stereos and safety equipment.

+ When your vehicle is equipped with an air bag, do not obstruct with installed
or portable wireless equipment. It can cause the air bag to fail or cause serious
injury due to improper performance.

If you are listening to music whilst out and about, please ensure that the volume
is at a reasonable level so that you are aware of your surroundings. This is of
particular importance when near roads.

Avoid damage to your hearing

To prevent possible hearing damage, do not listen at high volume
levels for long periods.

Damage to your hearing can occur if you are exposed to loud sound for long
periods of time. We therefore recommend that you do not turn on or off the
handset close to your ear. We also recommend that music and call volumes are set
to a reasonable level.

+ When using headphones, turn the volume down if you cannot hear the people
speaking near you, or if the person sitting next to you can hear what you are
listening to.

E + Excessive sound pressure from earphones and headphones can cause
hearing loss.
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Glass Parts

Some parts of your device are made of glass. This glass could break if your device is
dropped on a hard surface or receives a substantial impact. If the glass breaks, do
not touch or attempt to remove it. Stop using your device until the glass is replaced
by an authorised service provider.

Blasting area

Do not use the device where blasting is in progress. Observe restrictions and follow
any regulations or rules.

Potentlally explosive atmospheres
Do not use your device at a refueling point.
+ Do not use near fuel or chemicals.

+ Do not transport or store flammable gas, liquid or explosives in the same
compartment of your vehicle as your device or accessories.

In aircraft
Wireless devices can cause interference in aircraft.
+ Turn your device off before boarding any aircraft.

+ Do not use it on the ground without permission from the crew.

Children

Keep the device in a safe place out of the reach of small children. It includes small
parts which may cause a choking hazard if detached.

Emergency calls

Emergency calls may not be available on all mobile networks. Therefore you should
never depend solely on your device for emergency calls. Check with your local
service provider.
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Battery information and care

+ You do not need to completely discharge the battery before recharging. Unlike
other battery systems, there is no memory effect that could compromise the
battery's performance.

+ Use only LG batteries and chargers. LG chargers are designed to maximise the
battery life.

+ Do not disassemble or short-circuit the battery.

+ Keep the metal contacts of the battery clean.

Replace the battery when it no longer provides acceptable performance. The
battery pack may be recharged hundreds of times before it needs replacing.

Recharge the battery if it has not been used for a long time to maximise
usability.

Do not expose the battery charger to direct sunlight or use it in high humidity,
such as in the bathroom.

Do not leave the battery in hot or cold places, as this may deteriorate battery
performance.

+ Risk of explosion if battery is replaced by an incorrect type. Dispose of used
batteries according to the instructions.

+ Always unplug the charger from the wall socket after the device is fully charged
to save unnecessary power consumption of the charger.

+ Actual battery life will depend on network configuration, product settings,
usage patterns, battery and environmental conditions.

+ Make sure that no sharp-edged items such as animal's teeth or claws, come
into contact with the battery. This could cause a fire.

Securing personal information

+ Make sure to protect your personal information to prevent data leakage or
misuse of sensitive information.

+ Always back up important data while using the device. LG is not responsible for
any data loss.

+ Make sure to back up all data and reset the device when disposing of the device
to prevent any misuse of sensitive information.

+ Read the permission screen carefully while downloading applications.
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+ Be cautious using the applications that have access to multiple functions or to
your personal information.

Check your personal accounts regularly. If you find any sign of misuse of your
personal information, ask your service provider to delete or change your account
information.

« If your device is lost or stolen, change the password of your account to secure
your personal information.

+ Do not use applications from unknown sources.

A Notice for Battery replacement
Li-lon Battery is a hazardous component which can cause injury.

.

.

Battery replacement by a non-qualified professional can cause damage
to your device.

Do not replace the battery by yourself. The battery can be damaged,
which can cause overheat and injury. The battery must be replaced by
a qualified professional. The battery should be recycled or disposed
separately from household waste.

.

In case this product contains a battery incorporated within the product
which cannot be readily removed by end-users, LG recommends that
only qualified professionals remove the battery, either for replacement
or for recycling at the end of this product’s working life. To prevent
damage to the product, and for their own safety, users should not
attempt to remove the battery and should contact LG Service Helpline,
or other independent service providers for advice.

.

Removal of the battery will involve dismantling of the product case,
disconnection of the electrical cables/ contacts, and careful extraction of
the battery cell using specialised tools. If you need the instructions for
qualified professionals on how to remove the battery safely, please visit
http7/wwwi.ge.com/global/sustainability/environment/take-back-recycling.
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Features



Audio recording features
LG 3D Sound Engine

LG 3D Sound Engine feature allows you to hear stereoscopic and
optimised sound. When playing music or video, you can enjoy stereoscopic
and immersive sound as if you were listening in the field.

1 Drag the notifications panel downwards.
7 Tap Settings > Sound > Sound quality and effects > LG 3D Sound
Engine and tap (0 to activate it.

E - If you connect an external audio device such as an earphone or speaker
to the product, a pop-up appears to turn on the LG 3D Sound Engine
feature.

Google Assistant

Google Assistant overview

Your device has the built-in Google Assistant feature. Find answers and
get things done while on-the-go.

E « To use this feature, first connect to the network.

Launching Google Assistant

1 Press the Google Assistant key on the left side of the device.
or
Swipe diagonally from a bottom edge corner of the screen.

2 Tap GET STARTED.

3 Follow the on-screen instructions.
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« The device saves your voice data for recognition.

/ Set whether to use the voice match unlock function.
« If you use the voice match unlock function, you can unlock the
device even when the device screen is turned off or the device is
charging by saying “OK Google"” or “Hey Google”.

E « This feature may be more vulnerable to security than the other screen
locks, such as Pattern, PIN, and Password.
\When a similar voice or your recorded voice is used, the screen may be
unlocked.

« To use this feature, on the home screen, tap Settings > Lock screen
& security > Secure lock settings > Smart Lock, and then use the
screen lock method you set to unlock the device.

« You need to unlock the device by using the specified method if you fail to
unlock the device with voice recognition. See Setting a screen lock for details.

5 Tap Finish.

Accessing by Voice

T When the home screen is turned off or locked, say “OK Google” or
“Hey Google”.

2 When the Google Assistant screen appears, say a command or ask a
question.

Accessing from Home Screen

1 Press the Google Assistant key on the left side of the device.
or
Swipe diagonally from a bottom edge corner of the screen.

2 Say a command or question when you see «« -« on the bottom of the
screen.
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E .

In an environment where Wi-Fi or mobile data connection is poor, the
Google Assistant function may be restricted and the speech recognition
accuracy rate may be lowered.

If the speech is ambiguous, the microphone is covered, a media player is
playing, or the surrounding is loud, the speech recognition accuracy rate
may be lowered. \When you are using the product via voice commands,
say with accurate pronunciation in a quite environment for better
speech recognition accuracy.

Fingerprint recognition

Fingerprint recognition overview

You must register your fingerprint on your device first before using the
fingerprint recognition function.

You can use the fingerprint recognition function in the following cases:
+ To unlock the screen.

- Toview the locked content in the Gallery.

- Confirm a purchase by signing into an app or identifying yourself with
your fingerprint.

E .

.

You can use fingerprint data for user authentication. There is a
possibility that the fingerprint sensor might recognise a different but
very similar fingerprint as the same registered fingerprint. To strengthen
security, it is recommended that you use the pattern, PIN, or password
method for unlocking the screen.

If the device cannot detect your fingerprint or you forgot the value
specified for registration, visit the nearest LG Customer Service Centre
with your device and ID card.
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Precautions for fingerprint recognition

Fingerprint recognition accuracy may decrease due to a number of
reasons. To maximise the recognition accuracy, check the following before
using the device.

At the bottom centre of the product’s screen, there is a built-in sensor
that recognises fingerprints. Be careful not to scratch or damage the
fingerprint sensor with metal objects such as coins or keys.

If there are foreign substances (sweat, lotion, water, dirt, grease, etc.)
on the fingerprint sensor or on the finger to be put on the sensor,
fingerprint recognition may not work properly. Wipe the sensor and the
finger clean and remove all moisture before putting the finger on the
sensor.

If the finger's surface is rough due to it being scarred or pruney from
water, the sensor may not be able to recognise the fingerprint. In such
a case, register another fingerprint.

If you bend your finger or use the fingertip only, your fingerprint may
not be recognised. Make sure that your finger covers the entire surface
of the fingerprint sensor.

Scan only one finger for each registration. Scanning more than one
finger may affect fingerprint registration and recognition.

+ The device may generate static electricity if the surrounding air is dry.
If the surrounding air is dry, avoid scanning fingerprints, or touch a
metallic object such as a coin or a key before scanning fingerprints to
remove static electricity.
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Registering fingerprints
You can register and save your fingerprint on the device to use fingerprint
identification.

7 Onthe home screen, tap Settings > Lock screen & security >
Fingerprints.

« Alock screen must be set in order to be able to use this feature.

+ If the screen lock is not active, configure the lock screen by following the
on-screen instructions. See Setting a screen lock for details.

7 Place your finger on the fingerprint sensor on the device and adjust it
little by little.

E - Gently press the fingerprint sensor so that the sensor can recognise
your fingerprint.

« Ensure that your finger covers the entire surface of the fingerprint
sensor.

@1 AL

3 Follow the on-screen instructions.

- Until the fingerprint registration is completed, move the same finger
around on the sensor little by little.

- Put the finger on the sensor. When you feel a vibration, remove the
finger from the sensor.
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4 When the fingerprint registration is done, tap OK.

- Tap Add more to register another fingerprint. Since the fingerprint
recognition success rate depends on the condition of the registered
fingerprint, it is recommended that you register several different
fingerprints.

Managing fingerprints

You can edit or delete registered fingerprints.

7 On the home screen, tap Settings > Lock screen & security >
Fingerprints.

2 Unlock according to the specified lock method.

3 From the fingerprint list, tap a fingerprint to rename it. To delete it, tap
[}

Unlocking the screen with a fingerprint

You can unlock the screen or view the locked content by using your

fingerprint. Activate the desired function:

1 On the home screen, tap Settings > Lock screen & security >
Fingerprints.

2 Unlock according to the specified lock method.

3 On the fingerprint settings screen, activate the desired function:
+ Screen lock: Unlock screen with a fingerprint.

+ Content lock: Unlock content with a fingerprint. To do this, make
sure that the content lock is set.

- Screen unlock when screen is off : Unlock screen even when the
screen is off by placing your finger on the Power key.
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Multi-tasking feature

Recent Uses Screen

Swipe the Home button — upward and hold to view the recent use
history.

Pop-up window
You can open multiple apps on the screen and easily switch between
them at any time.

1 Swipe up on — from the bottom of the screen.

2 Tap the app icon on the top left of the app screen and select Pop-up
window.

« If you tap the app icon, the App info, Multi window, Pop-up
window and Pin app options appear.

3 The app appears in the form of a pop-up window on the screen.

np

E « This feature may not be available in some apps or screens.
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Using the pop-up windows

+ — :Minimises the pop-up window. The pop-up window is minimised
into the app icon floating on the screen, which can be moved anywhere
you want.

U :Expands the app to full screen.
+ X :Closes the app.

+ You can open up to 5 apps using the pop-up windows.

+ To select an app from the opened apps, tap one of the pop-up windows.
The selected pop-up window comes to the front.

+ Pop-up windows cannot be moved to the status bar or navigation bar
area.

Using the app folder for pop-up windows

If you tap — on the pop-up window, the pop-up window is minimised into
the app icon.

You can move the app icon anywhere you want by dragging it.

If two or more pop-up windows are minimised, the app folder is created to
contain the app icons.

E « The recently-used app icon is used as the app folder icon. If you tab the
icon, all the icons for the minimised pop-up windows appear in the app
folder:

+ If you touch and hold the app folder for pop-up windows and drag the
app folder into Remove, the app folder will be removed.

« To remove one of the apps from the app folder;, open the app folder and
drag the app icon out of the app folder:
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Multi window

When using gesture navigation

1 Swipe up on — from the bottom of the screen.
+ Recently-used apps appear.
- If you tap the app icon, the App info, Multi window, Pop-up
window and Pin app options appear.
2 Tap the app icon on the top left of the app to be displayed in the
multiwindow and select Multi window.
+ The selected app appears at the top half of the screen.

3 Tap the other app to be displayed in the multi window.
+ The selected app appears at the bottom half of the screen.

When using Buttons only navigation

1 Tap[Jon the navigation bar.
+ Recently-used apps appear.
- If you tap the app icon, the App info, Multi window, Pop-up
window and Pin app options appear.
2 Tap the app icon on the top left of the app to be displayed in the
multiwindow and select =,
+ The selected app appears at the top half of the screen.

3 Tap the other app to be displayed in the multi window.

E - To adjust the size of the split screen, drag the bar on the centre of the
screen.

+ To deactivate the multi window feature, drag the centre bar up or down
to the end of the screen.

+ The multi window feature is not supported in some LG apps or apps
downloaded from the Play Store.
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Product components and
accessories

The following items are included with your device.

+ Device + Charger
- USB cable - Quick Start Guide
+ Ejection pin

A .

« The items supplied with the device and any available accessories may

Basic Functions

The items described above may be optional.

vary depending on the area and service provider.

Always use genuine LG Electronics accessories. Using accessories made
by other manufacturers may affect your device's call performance or
cause malfunctions. This may not be covered by LG's repair service.

« Some of the device parts are made of tempered glass. If you drop your

device on a hard surface or subject it to severe impact, the tempered
glass may be damaged. If this happens, stop using your device
immediately and contact an LG Customer Service Centre.

If any of these basic items are missing, contact the dealer from which
you purchased your device.

« To purchase additional items, contact an LG Customer Service Centre.

Some items in the product box are subject to change without notice.

- The appearance and specifications of your device are subject to change

without prior notice for product improvement.
Device specifications may vary depending on the area or service provider.

Remove the protective film from the Fingerprint sensor before using the
fingerprint recognition feature.
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Parts overview

Earpiece
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Front camera lens

Volume keys (+/-) —I:

Google Assistant key —e

Proximity/Ambient light
sensor

~— Power/Lock key
/Fingerprint sensor

Touch screen

Stereo headset jack

Rear camera lenses

Flash

Speaker ———*
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A Do NOT attempt to remove the back cover by yourself.

+ Doing so may severely damage the battery and device, which could
cause overheating, fire, and injury. This device's back cover and battery
are not to be removed or replaced by a non-qualified professional.

+ Your phone is an electronic device that generates heat during normal
operation. Extremely prolonged, direct skin contact in the absence of
adequate ventilation may result in discomfort or minor burns. Therefore,
use care when handling your phone during or immediately after
operation.

+ Proximity/Ambient light sensor

- Proximity sensor: During a call, the proximity sensor turns off the
screen and disables touch functionality when the device is in close
proximity to the human body. It turns the screen back on and enables
touch functionality when the device is outside a specific range.

- Ambient light sensor. The ambient light sensor analyses the ambient
light intensity when the auto-brightness control mode is turned on.

- Volume keys
- Adjust the volume for ringtones, calls or notifications.

- While using the Camera, gently press a Volume key to take a photo.
To take continuous photos, press and hold the Volume key.

- Press the Volume Down key twice to launch the Camera app when
the screen is locked or turned off. Press the Volume Up key twice to
launch Capture+.

+ Power/Lock key
- Briefly press the key when you want to turn the screen on or off.

- Press and hold the key when you want to select a power control
option.
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+ Google Assistant key

- You can short-press it once to run Google Assistant. You can press
and hold it to run Google Assistant and then release the finger from
the key to run the voice command function.

- See the Google Assistant for details.

+ Fingerprint sensor

- Turn on the fingerprint recognition feature to simplify the process
of unlocking the screen. See Fingerprint recognition overview for
details.

E .

.

Some functions may be restricted depending on the region and product
specifications of different telecommunications providers.

There is the NFC chip built into the rear part of the product. Be careful
not to damage or cover the NFC chip.

Do not put heavy objects on the device or sit on it. Failure to do so may
damage the touch screen.

Screen-protective film or accessories may interfere with the proximity
sensor.

If your device is wet or is being used in a humid place, the touch screen
or keys may not function properly.
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There are two microphones built into this product. Be careful not to cover
the microphones. \While you are talking on the phone, do not cover the
microphone with your hand or fingers.

Do not use a phone case that is not a genuine product or cover the
microphone with accessories, tape, etc.

Hold the product correctly as shown in the image when you are using it.

Microphone Do not cover the microphone.
1

Microphone Do not cover the microphone
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Turning the power on or off

Turning the power on
When the power is turned off, press and hold the Power/Lock key.

E + When the device is turned on for the first time, initial configuration
takes place. The first booting time for the smart phone may be longer
than usual

Turning the power off
Press and hold the Power/Lock key, then select Power off.

Restarting the device

When the device is not working properly or does not respond, restart it by
following the instructions below.

1 Press and hold the Power/Lock key and the Volume Down key at the
same time until the power is turned off.

2 When the device is restarted, release the key.

Power control options

Press and hold the Power/Lock key, then select an option.
« Power off: Turn the device off.

- Power off and restart: Restart the device.
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Installing the SIM card

Insert the SIM (Subscriber Identity Module) card provided by your service
provider to start using your device.

A + Be careful with the ejection pin since it has a sharp edge.

« In order for the water-resistant and dust-resistant features to work
effectively, the card tray must be inserted correctly.

7 Insert the pin into the hole of the card tray and press the pin, and then
pull the card tray out of the product.

2 Align the Nano-SIM cards on the card tray and press the card in the
direction of the arrow as shown in the figure.

l_ Nano-SIM card 2
N Nano-SIM card 1
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This device supports only Nano SIM cards.

Nano Micro Standard

e @

For problem-free performance, it is recommended that you use the
device with the correct type of SIM card. Always use a factory-made
SIM card supplied by the operator.

Do not lose your SIM card. LG is not responsible for damage and other
issues caused by loss or transfer of a SIM card.

Be careful not to damage the SIM card when you insert or remove it.
When you insert the SIM card or memory card, place it on the card tray
correctly.

\When you insert the card tray back into the device, insert it horizontally
in the direction of arrow as shown in the figure. Make sure that the card
placed on the card tray does not move out of its position.

Insert the SIM card with the gold-coloured contacts facing downwards.
Be sure to insert the SIM card into the device by following the
instructions in the user manual.

If you insert or remove the card tray from the device, be careful not to
let water or other liquids enter into the card tray. If a wet card tray or
card is inserted into the device, your device may get damaged.

Memory card is an optional item.

Frequent writing and erasing of data may shorten the memory card
lifespan.

Some memory cards may not be fully compatible with the device. If you
use an incompatible card, it may damage the device or the memory card,
or corrupt the data stored in it.
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Inserting the memory card

Insert the memory card into your device.

The device can support up to a 2 TB microSD card. Depending on the
memory card manufacturer and type, some memory card may not be
compatible with your device.

1 Insert the ejection pin into the hole on the card tray.
2 Pull out the card tray.

3 Put the memory card on the card tray with the gold-coloured contacts
facing downwards.

Memory card
(optional-sold separately)

SIM card

4 Insert the card tray back into the slot.
A + Some memory cards may not be fully compatible with the device. If you

use an incompatible card, it may damage the device or the memory card,
or corrupt the data stored in it.

E « Frequent writing and erasing of data may shorten the memory card
lifespan.
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Removing the memory card
Unmount the memory card before removing it for safety.
7 On the home screen, tap Settings > Storage > /..

2 Insert the ejection pin into the hole in the card tray and then pull out
the card tray from the device.

3 Remove the memory card from the card tray.
4 Insert the card tray back into the slot.
A + Do not remove the memory card while the device is transferring or
accessing information. This may cause data to be lost or corrupted, or
may damage the memory card or the device. LG is not responsible for

losses that result from the abuse or improper use of memory cards,
including the loss of data.

Battery
Charging the battery

Before using the device, fully charge the battery.
Charge the device with the USB Type-C cable.

Charging cable terminal
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If there is moisture on the charging port, exposed terminals, charging
cable, charging adapter, etc, do not use or charge the product. The
product may malfunction or get broken or damaged, and there is risk
of injury caused by electric shock, fire, overheating, explosion, etc. If
you find moisture on such areas, stop using or charging the product
immediately and completely remove the moisture.

Do not separate the battery cover.

This product uses a non-removable battery. Do not remove or replace
the battery cover or the battery. If you remove or replace the battery
cover or the battery, the product may be damaged, overheated or
explode.

Only use the USB cable and charging adapter provided with the product
as basic components.

Your device has an internal rechargeable battery. For your safety, do not
remove the embedded battery.

Using the device when it is charging may cause electric shock. To use the
device, stop charging it.

Remove the charger from the power socket after the device is fully
charged. This prevents unnecessary power consumption.

Another way to charge the battery is by connecting a USB cable
between the device and a desktop or laptop computer. This may take
longer than plugging the adapter to a wall outlet.

Do not charge the battery by using a USB hub that is unable to maintain
the rated voltage. Charging may fail or unintentionally stop.

When you are visiting the Service Centre with a battery issue, bring the
product and the charger with you Since the battery is a consumable, the
battery life may be shortened as times goes by.
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Precautions when using the device

+ Make sure to use the USB cable provided; do not use third party USB
cables or chargers with your device. The LG limited warranty does not
cover the use of third party accessories.

- Failure to follow the instructions in this quide and improper use may
damage the device.

E - If the battery temperature exceeds a certain level while charging the
device, charging may be stopped.

- If magnetic, metallic or conductive materials are attached on the back
of the device or a protective case is inserted, the device may not charge
properly.

+ LG Electronics is not responsible for any issues concerning accessories
of other brands. For such issues, contact the manufacturer of the
accessory product.

Using the battery efficiently

Battery lifespan may decrease if you keep many apps and functions
running simultaneously and continuously.

Cancel background operations to increase battery life.
To minimise battery consumption, follow these tips:

« Turn off the Bluetooth® or Wi-Fi network function when not using
them.

- Set the screen timeout to as short a time as possible.

+ Minimise the screen brightness.

- Set a screen lock when the device is not used.

+ Check the battery level while using any downloaded apps.
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Touch screen

You can familiarise yourself with how to control your device by using
touch screen gestures.

Tapping

Lightly tap with your fingertip to select or run an app or option.

Touching and holding

Touch and hold for several seconds to display a menu with available
options.

Basic Functions
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Double-tapping

Tap twice quickly to zoom in or out on a web page or map.

Dragging

Touch and hold an item, such as an app or widget, then move your finger
to another location in a controlled motion. You can use this gesture to
move an item.

Swiping

Touch the screen with your finger and move it quickly without pausing.
You can use this gesture to scroll through a list, a web page, photos,
screens, and more.
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Pinching and spreading
Pinch two fingers to zoom out such as on a photo or map. To zoom in,
spread your fingers apart.

.

.

.

.

S

/,'

« Do not expose the touch screen to excessive physical shock. You might

damage the touch sensor.

« A touch screen failure may occur if you use the device near a magnetic,

metallic or conductive material.

If you use the device under bright lights, such as direct sunlight, the
screen may not be visible, depending on your position. Use the device

in a shady location or a location with an ambient light that is not too
bright and bright enough to read books.

Do not press the screen with excessive force.

Gently tap with your fingertip on the option you want.

Touch control may not work properly if you tap while wearing a glove or
by using the tip of your fingernail.

« Touch control may not work properly if the screen is moist or wet.

« The touch screen may not function properly if a screen-protective film

or accessory purchased from a third party store is attached to the
device.

Displaying a static image for extended periods of time may result in
after-images or screen burn-in. Turn off the screen or avoid displaying
the same image for a long time when you do not use the device.
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Home screen

Home screen overview
The Home screen is the starting point for accessing various functions and
apps on your device. Swipe up from the bottom edge of any screen to
directly go to the Home screen.

You can manage all apps and widgets on the Home screen. Swipe the
screen left or right to view all installed apps at a glance.

Home screen layout
You can view all apps and organise widgets and folders on the Home

screen.

E

Status bar — T

Weather widget —)

*=— Google Search widget

(== Page icon
8 ) [5) »| @ »— Quickaccess area
Navigation bar ————e]

settings, software version or service provider.

Basic Functions
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Status bar: View status icons, the time and the battery level

Weather widget: View the information of weather and time for a
specific area.

Google Search widget: Type or speak to pull open Google Search.

Folder: You can create folders to classify the app based on desired
criteria.

+ Page icon: Display the total number of Home screen canvases. You

can tap the desired page icon to go to the page you selected. The icon
reflecting the current canvas will be highlighted.

Quick access area: Fix main apps at the bottom of the screen so that
they can be accessed from any Home screen canvas.

Navigation bar: You can go to the previous screen or home screen
while using the app, and check the list of apps you used recently.

Using Navigation bar
Here is the gestures guide to control the Navigation bar.

To go to Home screen, swipe up from the bottom edge of the screen.
To go back to the previous screen, swipe in from the left or right edge
of the screen.

To go to Overview screen, swipe up and hold from the bottom edge of
the screen.

To quickly switch between apps, swipe right at the bottom edge of the
screen to go to previously used apps.

- Gestures is the default for the Navigation bar. To change it to Buttons
only<]/Q/ [:] , on the home screen, tap Settings > Display >
Navigation bar, then select Buttons only.
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Status icons

When there is a notification for an unread message, calendar event or
alarm, the status bar displays the corresponding notification icon. Check
your device's status by viewing notification icons displayed on the status

bar.
A No signal
Data is being transmitted over the network
[C) Alarm is set
e Vibrate mode is on

Bluetooth is on

& Connected to a computer via USB
[ ] Battery level
4+ Airplane mode is on
A Missed calls
= Wi-Fiis connected
X Mute mode is on
Q GPSison
3 Hotspot is on
N No SIM card
m The NFC mode is on

+ Some of these icons may appear differently or may not appear at all,
depending on the device's status. Refer to the icons according to the
actual environment and area in which you are using the device and your
service provider.

- Displayed icons may vary, depending on the area or service provider.
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Notifications panel
You can open the notifications panel by dragging the status bar
downward on the main screen.
+ You can drag down the notice window or tap the arrow icon to open
the list of quick setting icons.

- You can tap ~® to add, delete or arrange icons in the notice window.

- If you touch and hold the icon, the settings screen for the
corresponding function appears.

+ You can use the notifications panel even on the lock screen. Drag the
notifications panel while the screen is locked to quickly access the
desired features.
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Switching the screen orientation

You can set the screen orientation to automatically switch according to
the device’s physical orientation.

On the notification panel, tap Rotation from the quick access icon list.

You can also tap Settings > Display and activate Auto-rotate screen on
the home screen.

Editing the Home screen

On the Home screen, touch and hold on an empty space, then select the

desired action from below.

- Torearrange the Home screen canvases, touch and hold on a canvas,
then drag it to another location.

- To add a widget to the Home screen, touch and hold on a blank area of
the Home screen, then select Widgets.

- To change wallpapers and themes, touch and hold on a blank area of
the Home screen, then select Wallpaper & theme.
You can also tap Settings > Wallpaper & theme on the home screen,
then select wallpapers and themes to apply to the device.
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- To change the grid, touch and hold on a blank area of the Home screen,
then select Grid. Tap the desired grid, then tap Apply.

- To configure the Home screen settings, touch and hold on a blank area
of the Home screen, then select Home screen settings. See Home
screen settings for details.

- Toview or reinstall the uninstalled apps, touch and hold on a blank area
of the Home screen, then select App trash. See App trash for details.

+ To change the default screen, touch and hold on a blank area of the

Home screen, move to desired screen, tap £}, then tap the screen once
more.

Sl — Default screen
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Viewing the background theme

You can view only the background image by hiding the apps and widgets
on the Home screen.
Spread two fingers apart on the Home screen.

- Toreturn to the original screen, which displays apps and widgets, pinch
your fingers on the Home screen or drag up — from the bottom edge
of the screen.

Moving apps on the Home screen

On the Home screen, touch and hold an app, then drag it to another
location.

« To keep frequently used apps at the bottom of the Home screen, touch
and hold an app, then drag it to the quick access area at the bottom.

+ To remove an icon from the quick access area, drag the icon to the
Home screen.
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Using folders from the Home screen

Creating folders
On the Home screen, touch and hold an app, then drag it over another
app.

A new folder is created and the apps are added to the folder.

Editing folders

On the Home screen, tap a folder and do one of the following actions.
- To edit the folder name tap the folder name.
- To edit the colour, tap the right upper circle.

- To add apps, touch and hold an app, then drag it over the folder and
release it.

- To remove an app from the folder; touch and hold the app and drag it to
outside the folder If the removed app is the only one app that existed
in the folder, the folder is removed automatically.

+ You can also add or remove apps after tapping ().

E + You cannot change the folder colour while using downloaded theme.
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Home screen settings
You can customise the Home screen settings.
1 On the home screen, tap Settings > Display > Home screen.
2 Customise the following settings:
+ Select Home: Select a Home screen mode.
- Wallpaper: Change the Home screen background wallpaper.

- Screen swipe effect: Select an effect to apply when the Home
screen canvas switches.

+ lcon shape: Choose if you want icons to have square or rounded
corners.

- Google feed: Show to the left of the main Home screen.
- Sort apps by: Set how apps are sorted on the Home screen.

+ Hide apps: Select which apps you want to hide from the Home
screen.

+ Loop Home screen: Enable to allow continuous Home screen
scrolling (loop back to first screen after the last screen).

- Swipe down on the Home screen: Enable to search apps or
contents, or view natifications by swiping down on the home
screen.

- Home screen lock: Enable to prevent apps and widgets from being
rearranged or removed.
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Screen lock

Screen lock overview

Your device's screen turns off and locks itself if you press the Power/Lock
key. This also happens after the device is left idle for a specified period of
time.

If you press the Power/Lock key when a screen lock is not set, the Home
screen appears immediately.

To ensure security and prevent unwanted access to your device, set a
screen lock.

E « A screen lock prevents unnecessary touch input on the device screen
and reduces battery consumption. \We recommend that you activate the
screen lock while not using the device.

Setting a screen lock
There are several options available for configuring the screen lock settings.

7 Onthe home screen, tap Settings > Lock screen & security > Select
screen lock and then select the method you prefer.

2 Customise the following settings:
+ None: Deactivate the screen lock function.
- Swipe: Swipe on the screen to unlock the screen.
- Pattern: Draw a pattern to unlock the screen.
+ PIN: Enter a numeric password to unlock the screen.
+ Password: Enter an alphanumeric password to unlock the screen.

Fingerprints: Unlock the screen by using your fingerprint.
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Customise Lock screen

You can customise lock screen.

1 On the home screen, tap Settings > Lock screen & security >
Customize Lock screen.

2 Select a function you want to set.
- Wallpaper: Allow you to set the background for your Lock screen.

+ Clock: Allow you to set where to position the clock on the Lock
screen.

+ Shortcuts: Allow you to choose apps to run on your Lock screen.
This setting appears only when a screen lock is set.

- Contact info for lost phone: Allow you to set text to be displayed
on the Lock screen to identify the phone's owner.

Secure lock settings
You can set secure lock settings.

7 Onthe home screen, tap Settings > Lock screen & security > Secure
lock settings.

2 Select a function you want to set.

- Make pattern visible (shown only when Pattern is set as a screen
lock): Turn on to make pattern visible.

- Lock timer: Allow you to set the amount of time before the screen
automatically locks after the backlight turns off (time-out due to
inactivity).

- Power key instantly locks: Enable this option to instantly lock the
screen when the Power/Lock key is pressed. This setting overrides
the Security Lock timer setting.

+ Show lockdown option (shown only when a screen lock is set):
Enable this option to display the Lockdown icon when you press
and hold the Power/Lock button. Tap the Lockdown icon to turn
off Smart Lock, biometric unlocking, and notifications on the lock
screen.
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+ Smart Lock: Allow you to set trusted devices, places, voice, and/or
on-body detection that will allow your phone to remain unlocked.

E + Available menu options may vary depending on the lock screen method
selected.

KnockON

You can turn the screen on or off by double-tapping the screen.

5 « This option is available only on the Home screen provided by LG. It may
not function properly on a custom launcher or on the Home screen
installed by the user.

+ When tapping the screen, use your fingertip. Do not use a fingernail.

+ To use the KnockON feature, make sure that the proximity/light sensor
is not blocked by a sticker or any other foreign substance.

Turning the screen on
Double-tap the middle of the screen.

- Tapping the top or bottom of the screen may decrease the recognition
rate.

Turning the screen off
Double-tap on an empty space on the Home screen and Lock screen.
You can also double-tap an empty space on the status bar.

Disable KnockON

If you don't want to use the KnockON function, set as follows:

On the home screen, tap Settings > Extensions > KnockON and drag it
to disable the function.

Basic Functions 52



Memory card encryption

You can encrypt and protect data saved on the memory card. The
encrypted data in the memory card cannot be accessed from another
device.

7 On the home screen, tap Settings > Lock screen & security >
Encryption & credentials > Encrypt SD card.

7 Read the on-screen overview of memory card encryption and then tap
Continue to continue.
3 Select an option and tap Encrypt now.

- New data encryption: Encrypt only data that is saved on the
memory card after encryption.

Full encryption: Encrypt all the data currently saved on the memory
card.

Exclude media files: Encrypt all files, except for media files such as
music, photos and videos.

E + Once memory card encryption starts, some functions are not available.

- If the device is turned off while encryption is underway, the encryption
process will fail, and some data may be damaged. Therefore, be sure to
check if the battery level is sufficient before starting encryption.

Encrypted files are accessible only from the device where the files were
encrypted.

+ The encrypted memory card cannot be used on another LG device. To
use the encrypted memory card on another mobile device, format the
card.

+ You can activate memory card encryption even when no memory card
is installed into the device. Any memory card that is installed after
encryption will automatically be encrypted.
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Taking screenshots

You can take screenshots of the current screen you are viewing.

Via a shortcut

Press and hold the Power/Lock key and the Volume Down key at the
same time for at least two seconds.

+ Screenshots can be viewed from the Screenshots folder in the
Gallery.

Via Screenshot

On the screen where you want to take a screenshot, drag the status bar
downwards, then tap @.

5 + See Writing notes on a screenshot for details.

Content sharing

Playing content from another device
You can play photos, videos or songs saved on your device froma TV.
71 Connect the TV and your device to the same Wi-Fi network.

2 While viewing the items in the Gallery or Music app, tap : > Play on
other device.

3 Select the TV you want to connect to.

I_;,] » For use with Chromecast, Google Play services should be up to date.
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Viewing content from nearby devices

You can view content from various devices, such as a computer, NAS or
mobile device, by using the Gallery or Music apps.

Connecting the devices

Connect both your device and another device that support DLNA function
to the same wireless network.

5 « Make sure that File sharing (DLNA) is activated on both the device and
the connected device.

Searching for nearby devices

You can view a list of DLNA devices on the same network by selecting the
¢ >Nearby devices menu in each app.

Use content from nearby devices as if you were using it on your device.

Sending or receiving files
You can share files between your device and another LG device, or a tablet.

Sending files

From the Gallery or other apps, tap : > Share or «&, then select a device
on the file sharing list.

Receiving files
Drag the status bar downward and then tap File sharing.

If your device does not support the file sharing feature, on the home
screen, tap Settings > Connected devices > File sharing > SmartShare

Beam ().

I_;r] + Make sure that your device is connected to the same wireless network
as the file transfer target device.

« Make sure that File sharing is activated on both devices.
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Do not disturb

You can limit or mute notifications to avoid disturbances for a specific
period of time.
On the home screen, tap Settings > Sound > Do not disturb.
+ Mode and select the mode you want:
- Priority only: Receive sound or vibrate notifications for the selected
apps. Even when Priority only is turned on, alarms still sound.
- Total silence: Disable both the sound and vibration.
- Select priorities: Receive alarms and the notifications for the selected
apps.
- Calls from: Set up a range of notifications when receiving a call.

+ Repeated calls: Second call from the same caller within 15 min is not
silenced.

- Messages from: Set up a range of notifications when receiving a
message.

Use Do not disturb: Turn on the Do not disturb feature.

Sleeping: Set the schedule for which you want to turn on the Do not
disturb feature.

Help: View the help for Do not disturb.
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Installing and uninstalling apps

Installing apps
Access an app store to search and download apps.

+ You can use SmartWorld, Play Store or the app store provided by your
service provider.

E + Some app stores may require you to create an account and sign in.
+ Some apps may charge fees.

« If you use mobile data, you may be charged for data usage, depending
on your pricing plan.

+ Smart\World may not be supported depending on the area or service
provider.

Uninstalling apps

Uninstall apps that you no longer use from your device.

Uninstalling with the touch and hold gesture

Press and hold any empty area on the screen, and then press € of the
app you want to delete.

Uninstalling by using the settings menu
On the home screen, tap Settings > Apps > App info, select an app, then

tap Uninstall
E + Some apps cannot be uninstalled by users.

Uninstalling apps from the app store

To uninstall an app, access the app store from which you download the
app and uninstall it.
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Installing and uninstalling apps during the
setup

When you turn on the device for the first time, you can download
recommended apps.
You can skip to the next step without installation.

App trash
You can view the uninstalled apps. You can also reinstall apps which were
uninstalled within 24 hours from now.
1 On the home screen, tap Management > App trash.
You can also touch and hold an empty area of the Home screen, then
tap App trash.
2 Activate the desired function:
- Restore: Reinstall the selected app.
« 11 : Remove the uninstalled apps permanently from the device.

« Uninstalled apps are automatically removed from the device 24 hours
after they were uninstalled. If you want to reinstall the uninstalled apps,
you must download them again from the app store.

« This feature is activated on the default Home screen only. If you
uninstall apps while using the EasyHome screen or other launcher, they
are immediately and permanently removed from the device.
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App Shortcuts

On the Home screen, touch and hold an app icon such as Call, Message,
Camera, Gallery and Settings to display a quick access menu. Use apps
more easily through App Shortcuts.

- Tap & to set the widgets for the app.
+ Tap () to check the app information.

E « This feature is available only on some apps.
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Phone

Voice call

Make a phone call by using one of the available methods, such as manually
entering a phone number and making a call from the contact list or the
list of recent calls.

Making a call from the keypad
7 Onthe home screen, tap (@ > Dial.

2 Make a call by using a method of your choice:
- Enter a phone number and tap @@.
+ Touch and hold a speed dial number.

« Search for a contact by tapping the initial letter of a contact name
in the contact list, and then tap @@.

E + Toenter "+" when making an international call, touch and hold number
0.

+ See Adding contacts for details on how to add phone numbers to the
speed dial list.

Making Calls from Contacts
7 Onthe home screen, tap (8 > Contacts.

7 After selecting the number you want to call from the list of contacts,

tap &...
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Answering a call
To answer a call, drag @ on the incoming call screen.
+ When the stereo headset is connected, you can make calls by using the
call/end button on the headset.
+ To end a call without turning off the screen, on the home screen, tap
Settings > Network & internet > Call > Answer and end calls and
then activate End call with the Power key.

E + On the home screen, tap Settings > Network & internet > Call >
Answer and end calls > End call with the Power key, you can end a
call by pressing the Lock/Power key while the call-in-process screen is
turned on.

Rejecting a call
To reject an incoming call, drag @ across the incoming call screen.

- To send a rejection message, drag the rejection message option
across the screen.

- To add or edit a rejection message, on the home screen, tap Settings >
Network & internet > Call > Call blocking & Decline with message.

+ When a call is coming in, press the Volume Up, Volume Down or Power/
Lock key to mute ringtone or vibration, or to hold the call

Checking an incoming call while using an app

When a call comes in while using an app, a pop-up notification can be
displayed at the top of the screen. You can receive the call, reject the call,
or send message from the pop-up screen.

5 + On the home screen, tap Settings > Network & internet > Call >
Additional settings > Incoming voice call pop-up and then select the
desired way you would like to display the incoming call while using an

app.
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Viewing missed calls
If there is a missed call, the status bar at the top of the screen displays X.

To view missed call details, drag the status bar downwards. You can also
tap (@ > Call logs on the home screen.

Functions accessible during a call

During a call, you can access a variety of functions by tapping the
on-screen buttons:

- Contacts: View the contact list during a call.

+ Hold: Place the current call on hold.

- Dialpad: Display or hide the dial pad.

- Speaker: Turn on the speakerphone function.

- Mute: Mute your voice so that your voice cannot be heard by the other
party.

+ Bluetooth: Switch the call to a Bluetooth device that is paired and
connected.

- @ :Endacal

« ¢+ :Access additional call options.

« Available settings items may vary depending on the area or service
provider.
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Making a three-way calling
You can make a call to another contact during a call.
1 Duringacal, tap : >Add call

2 Enter a phone number and tap @.
+ The two calls are displayed on the screen at the same time, and the
first callis put on hold.

3 To start a conference call, tap Merge calls.

E + You may be charged a fee for each call. Consult with your service
provider for more information.

Viewing call records

To view recent call records, on the home screen, tap (8> Call logs. Then,
you can use the following functions:

- To delete call records, tap : > Delete.
« The displayed call duration may differ from the call charge. Consult with
your service provider for more information.
+ The deleted call history can not be restored.

« Pinch two fingers or spread your fingers apart to adjust the font size of
call logs or contacts.

Configuring call options
You can configure various call options.

T On the home screen, tap (3 > Dial or Call logs.

2 Tap : > Call settings and then configure the options to suit your
preferences.
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Messaging

Sending a message
You can create and send messages to your contacts using the Messaging
app.

5 + Sending messages abroad may incur additional charges. Consult with

your service provider for more information.

T Onthe home screen, tap ©.

2 Tap Gl

3 Specify a recipient and create a message.
+ To use multimedia options, tap ().
+ To access optional menu items, tap .

4 Tap B> to send the message.

Reading a message
You can view exchanged messages organised by contact.
T On the home screen, tap ©.

2 Select a contact from the message list.

Configuring messaging settings

You can change messaging settings to suit your preferences.
T On the home screen, tap ©.

2 Tap : > Settings from the message list.

E + You can designate settings for the notice window, blocking calls, disaster
alert, multimedia messages, etc.
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Camera

Starting the camera

You can take a photo or record a video to cherish all of your memorable
moments.

On the home screen, tap (&).

E

.

Before taking a photo or recording a video, wipe the camera lens with a
soft cloth.

Be careful not to stain the camera lens with your fingers or other
foreign substance.

Images included in this user guide may be different from the actual
device.

Photos and videos can be viewed or edited from the Gallery. See Gallery
overview for details.

.

Refrain from using the product for a purpose that may violate someone
else’s privacy or rights.
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Taking a photo
You can take photos with the camera in the product.
1 Tap () and focus on the subject.
+ You can touch the subject to focus on.
- You may spread or pinch two fingers to zoom in or out.
2 Tap(  totake aphoto.

+ You can also press the Volume Down or Volume Up key to take a
photo.

+ You can take a photo while recording a video by pressing @ on the
screen.

+ The options displayed on the shooting screen may differ depending
on the selected camera (front or rear) and camera mode.

+ The camera will turn off automatically if you do not use it for a while
after running the Camera app.

Start Google lens.
Set tl Tt
€L Hmer setting l_ Switch to front-facing/

ear-facing camera
Set flash setting — g r ing camer.

Apply filter effect — ==— Take photo

o5
B

Current camera mode

Set camera aspect ratio —gJ

Set camera —3

Select zoom

E + You can run the camera app by short-pressing the power key twice. On
the home screen, tap Settings > Extensions > Shortcuts and then tap
Open Camera to activate it.

+ When the screen is turned off or locked, start the camera by pressing
the Volume Down key twice.

+ On the home screen, tap Settings > Extensions > Shortcuts and then
tap Open Camera @ ) to activate it.
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Customising the camera options
You can customise a variety of camera options to suit your preferences.
Tap €33 on the screen.

E - Available options vary depending on the selected camera (front or rear
camera) and the selected camera mode.

Photo size

Select values for aspect ratio and size for taking photos.

HDR

Obtain photos in vivid colours and get compensated effects
even when they are taken against the light. These functions
are provided by the high dynamic range (HDR) technology
equipped in the camera.

Grid

Display guide grids so that you can take photos or record
videos based on the horizontal and vertical reference lines.

Cheese shutter

Allows you to take a photo by saying ‘Cheese] ‘Smile,
‘Whiskey, ‘Kimchi, or LG’

Tag locations

Save the image with GPS location data.

Select if you want to store the pictures and videos in the

Storage Internal storage or SD card. (Available when a memory card
is inserted.)
Help Provide Help for each camera menu.
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Additional options on the front camera

Save as flipped

Saves as flipped images when taking a selfie.

Selfie shot

Take a selfie by selecting its option between Gesture shot
and Auto shot.

E + You can apply the make-up effect when taking a selfie using the front

Camera.

- Gesture shot is taken by recognizing the shape of a hand and Auto
shot is taken by recognizing a face.

Mode Selection
You can conveniently select from the modes displayed on the screen
which are selected to suit the shooting environment.

Tap (&) and swipe the camera modes left or right, or swipe the screen left
or right to select a camera mode.
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Using camera modes

Recording a video
1 Tap (& and select Video by swiping camera modes.

2 Tap (e torecord a video.

Set camera —¢ EL— Set flash setting

Set video resolution Apply filter effect

l % rear-facing camera
Recording a video
- To take a photo while recording a video, tap ® .
- To pause the video recording, tap (1. To resume the video recording,
tap(e.

+ While recording a video, you may spread or pinch two fingers to
zoom in or out.

While recording a video, you may tap the desired area to adjust the
brightness.

3 Tap(= toend the video recording.
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Taking a photo
Tap (&) and select Photo by swiping camera modes.
See Taking a photo for more details.

Taking a photo with the Al feature

When taking a photo, the Al feature recognises a subject and applies the
optimum effect to the photo.

E - Tap ' to deactivate the Al feature.

Using additional camera modes
Tap (&) and select More by swiping camera modes.

Macro

You can take a close-up of a subject.
1 TapO> (@) then tap More >,
72 Tap( totake aphoto.
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Panorama

You can create a panoramic photo by moving the camera in one direction

to photograph and stitch continuous shots of a wide view.

1 Tap (3 and select More by swiping camera modes.

2 Tapq
+ Select a zoom from ) / @3.

3 Tap(  and then slowly move the camera in one direction.

/4 Tap @ to stop capturing the panoramic.

Set camera _.EI

E + \When moving the camera in one direction, make sure that the screen
you shoot is not out of the guide line.
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Flash Jump-Cut
Photos taken at a regular interval are saved as GIF files.
1 Tap(®, then tap More >R
2 Tap( totake aphoto.
+ Photos are taken every 3 seconds and saved as a GIF file.

- Tap (@) on the screen to select the number of photos you want to
take.

- While taking photos, tap @ to create GIF files with previously taken
photos.

5 + The flash automatically turns on to act as a timer.

+ The shots taken this time and the total number of shots are displayed
at the bottom of the screen.

- All taken photos are saved as GIF files only.
+ You may not change the GIF speed nor image order.

YouTube Live
You can record a video and directly upload to YouTube.

To use this feature, you must meet the eligibility requirements. Contact
YouTube for the requirements.

T On the home screen, tap ().
2 Select More by swiping camera modes, then tap ().
E + YouTube Live is available only when your device is connected to the

Internet. If you use mobile data, you may be charged for data usage,
depending on your pricing plan.
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Useful camera features

Google Lens

You can get more information or take action on items around you using
Google Lens, like landmarks, posters, restaurant menus, animals, flowers,
or barcodes, directly in the device.

Auto-Exposure/Auto-Focus lock

You can fix the current exposure level and focus position by touching and
holding the screen in the Auto mode. To turn off the feature, tap a blank
area on the screen.

Auto-Exposure/
Auto-Focus lock

E « This feature is available only in specific modes.
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Switching between cameras
You can switch between the front and rear cameras to suit your
environment.
- To switch between the front and rear cameras, swipe the screen up or
down on the shooting screen in the Camera app.

I_;'] « Use the front camera to take selfies. See Selfie shot for details.

Zoom in or out

You may spread or pinch two fingers to zoom in or out when you take
photos or videos.

- Zoom in/out function is not available in the selfie mode (front camera).
+ This function is not supported in a number of modes.
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Using the Burst Shot

You can take consecutive photos and view them as moving pictures in the
Gallery.

1 Tap () and select Photo.

2 Tapandhold
+ Multiple, consecutive photos are taken while you are holding down

Gesture shot

You can take selfies by using gestures.

Show your palm to the front camera and then clench your fist.

You can also clench your fist and then open it towards the front camera.
+ In three seconds, a photo is taken.

»

i

E - To use this feature, switch to the front camera mode, then tap @ >
Selfie shot > Gesture shot.

+ Make sure that your palm and fist are within the reference line so that
the camera can detect them.

+ This feature may not be available while using some of the camera
features.
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Auto shot

You can use the face detection feature to take selfies easily and
conveniently. You can set the device so that, when you look at the screen,
the front camera detects your face and takes a selfie automatically.

- The white coloured guide frame appears when the front camera
detects your face. If the subject within the guide frame stops moving,
the guide frame colour turns yellow, then the camera takes a photo.

5 - Tap §63 > Selfie shot > Auto shot to enable the Auto shot feature.

Interval shot
You can take selfies at an interval.

While using the front camera, you can show your palm to the camera,
then clench your fist twice quickly.

- Four photos are taken at regular intervals after a timer delay of three
seconds.

Save as flipped

Before taking a photo with the front camera, tap £63 > Save as flipped.
The image is flipped horizontally.

E + When using the front camera, you can change how selfies are taken in
the camera options. See Customising the camera options for details.

Selfie shot

You can use the front camera to view your face on the screen and take
selfies.

1 Tap () and select Photo by swiping camera modes.
2 Tap {0} to switch to the front camera.

3 Tap(  to take photos.
- Tap §) to apply various beauty effects.
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Gallery

Gallery overview
You can view and manage photos and videos saved on your device.

Viewing photos
You can view the photos saved to the product.
1 Tap @®and select a desired folder:

2 Tap adesired photo.
« The Gallery folder contains Photos, Albums, Memories and Play.

Back to the previous —
screen.

s — Access additional options.

| ey — Preview gallery
e el .
Add to or remove from —!-_-!— Delete images

our favourites —
y I— Share images
Edit images

E « Details menu appears when the screen is lightly touched. Touching the
screen once again makes the menu disappear.
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Playing a video
You can view the videos saved to the product.

Back to the —%
previous screen

e— Access additional
options

Pause or play the
video

e — review gallery

—-_-— Delete images

I— Share images

E + To adjust the sound volume, drag the right side of the video screen up
or down.

Add to or remove from
your favourites

Edit images

« To adjust the screen brightness, drag the left side of the screen up or
down.

+ Dragging the screen to the left on the video play screen allows you to
rewind (REW) and dragging to the right allows you to fast forward (FF).
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Deleting files
You can delete files by using one of the following options:
+ Touch and hold a file from the file list, then tap Delete.

- Deleted files are automatically moved to : > Trash and they can be
restored to the Gallery within 7 days.

- Tap [x] to completely delete the files. In this case, the files cannot be
restored.

Sharing files
You can share files by using one of the following options:

- While viewing photo or video, tap «& to share the file by using the
method you want.

E - If you take photos or videos after you tap (€) > 63 > Tag locations @ )

, the location-specific memories album is automatically created after a
certain time under the Memories tab of Gallery.

Some file formats may not be supported, depending on the installed
software.

.

- Some files may not be opened due to encoding.
+ Files that exceed the size limit may cause an error.
+ You need to activate the GPS feature to create Memory albums.
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Creating a movie

You can create a new movie by putting images and videos together.
1 Tap@®and select : > Create movie.

2 Select images or videos for your movie and tap Create movie.

3 Edit the selected images and videos and then tap Save.

Deleting files ———

-“ —+e————— Adding files

E + A maximum of 50 videos can be used to create a movie.
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Making a GIF

You can easily make a GIF file using recorded video.
Tap (M and select : > Create GIF.

Creating video
T At the desired starting point while watching a video, tap .

2 Select the length of the GIF you want to create.
+ GIF is generated for the time selected from the specified starting
point.
- For videos that are less than 5 seconds, GIF images are
automatically generated for the remaining time.

Creating GIF Photographs
1 Inthe photograph list in the Gallery, tap : > Create GIF.

2 Select a picture to turn into a GIF photograph, and then tap Create
GIF.

+ You can add/delete a photograph, adjust the speed or screen ratio,
and set the photograph order.

L;'] « Creating GIF photographs is a function provided for the user to produce
creative images. Violating rights such as intellectual property right
or defaming the reputation of another person by using the creating
GIF photographs function may lead to a civil or criminal liability in
accordance with the related laws. Be cautious not to copy or transmit
another person’s work without authorization. LG Electronics is not liable
in any way for such acts by users.

+ You can select up to 100 photographs to produce when you create a
GIF
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Contacts

Contacts overview
You can save and manage contacts.
On the home screen, tap Essentials > Contacts.

Adding contacts

Adding new contacts

1 Onthe contact list screen, tap -
- A pop-up appears for selecting the saving location for contact.
Select the location you want.

2 Enter contact details and tap Save.

Importing contacts
You can import contacts from another storage device.

T Onthe contact list screen, tap : >Manage contacts > Import.

2 Select the source and target locations of the contact you want to
import, and then tap OK.

3 Select the contacts and tap Import.

Adding contacts to the speed dial list
T Onthe contact list screen, tap : > Speed dial.
7 Tap Add contact from a speed dial number.

3 Select a contact.

E + While adding a new contact, tap {313} to add a speed dial number.
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Searching for contacts
You can search for contacts by using one of the following options:

- Tap the search bar at the top of the Contacts screen and enter the
desired contact or phone number you want to search for.

+ Scroll the contact list up or down.
+ From the index of the contact list screen, tap the initial letter of a
contact.

E + Pressing the search bar at the top of the Contacts screen and entering
a contact or phone number brings up the integrated search results from
the call history and contacts list saved onto the product.

Contacts list

Editing contacts
1 On the contact list screen, select a contact.
2 On the contact detail screen, tap / and edit details.

3 Tap Save to save changes.

Deleting contacts
You can delete contacts by using one of the following options:

+ On the contact list screen, touch and hold a contact you want to
delete, then tap [

- Tap ¢ > Delete on the contact list screen.

E + Deleted contacts may not be restored.
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Adding favourites

You can register frequently used contacts as favourites.
T On the contact list screen, select a contact.

2 On the contact detail screen, tap ¥y

Creating groups

T On the contacts group list, tap -+

2 Enter anew group name.

3 Tap Add members, select contacts, then tap Add.

/| Tap Save to save the new group.

QuickMemo+

QuickMemo+ overview

You can make creative notes by using a variety of options on this
advanced notepad feature, such as image management and screenshots,

which are not supported by the conventional notepad.

This device supports the Active Pen AES2.0 (Active Electrostatic).

Creating a note
71 On the home screen, tap Essentials > QuickMemo+.
2 Tap @ to create a note.

- @ :Saveanote.

+ <5 :Undo the previous edit.

+ > :Redo the recently deleted edits.

« T :Enter a note by using the keypad.

- o : Save your favorite pen types.

+ / :Write notes by hand.
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« A :Erase handwritten notes.
« ¢ :Access additional options.

3 Tap @ to save the note.

Writing notes on a screenshot
1 While viewing the screen you want to capture, drag the status bar
downwards and then tap @.
+ The screen is captured and displayed as a thumbnail on the right
bottom of the screen.
2 To write notes on the screen, tap ..
3 Write notes using the tools.
- T :Zoom in or out, or adjust the area to capture.
+ / :Write notes by hand.
+ & :Erase handwritten notes.
+ €5 :Undo the previous edit.
+ 2 :Redo the recently deleted edits.
+ (35 :Crop the screen as you desire.
4 Tap« and save the notes.
- Saved notes can be viewed in Gallery.
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Additional features after capturing a screenshot

Tap to capture entire
screen by using the scroll
capture feature.

< Tap to play the captured
g IE screen shot.

Tap to delete the captured
screen shot.

Tap to write notes on the
captured screen.

screen shot.

You can capture the entire screen by using the scroll capture feature.

While using an app such as Messaging and Chrome, drag the
notifications panel downwards and then tap @. Then, tap (v to
capture the entire screen you are currently viewing as a single file.

il

.

This feature is available only on some apps that support the scroll
capture feature.

.

Pinch two fingers or spread your fingers apart to change the memo
layout.
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Clock

Alarm

You can set an alarm to trigger it at a specified time.

7 On the home screen, tap Essentials > Clock > Alarm.
2 Tap-toadd a new alarm.

3 Configure the alarm settings and tap Save.

« If you select a previously set alarm, you can edit the alarm.

- Todelete an alarm, tap : > Delete at the top of the screen. You can also
touch and hold the alarm.

World clock

You can view the current time in cities around the world.

1 On the home screen, tap Essentials > Clock > World clock.
2 Tap-+andaddacity.

Timer
You can set the timer to trigger an alarm after a specified period of time.
7 On the home screen, tap Essentials > Clock > Timer.

2 Set the time and tap Start.
+ To suspend the timer, tap Pause. To resume the timer, tap Resume.

3 Tap Stop to stop the timer alarm.
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Stopwatch

You can use the stopwatch to record a lap time.
T On the home screen, tap Essentials > Clock > Stopwatch.

2 Tap Start to initiate the stopwatch.
- Torecord a lap time, tap Lap.

3 Tap Pause to suspend the stopwatch.
+ To resume the stopwatch, tap Resume.
+ To clear all the records and restart the stopwatch, tap Reset.

Calculator

You can use two types of calculators: the simple calculator and the
scientific calculator.

T On the home screen, tap Essentials > Calculator.

2 Use the keypad to make a calculation.
- If you want to calculate from the beginning, tap and hold (]
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Music

You can play and manage songs or music albums.
7 On the home screen, tap Essentials > Music.
7 Select a category.

3 Select a music file.
Turn on/off Flash Light.

Set sound effects.

Back to the previous — % il :s— Access additional options.
screen.

— Pause or play.

Tap to play from the — — Tap to play the next file /
beginning of the current - ] — Touch and hold to fast
file / Double-tap to play forward.

the previous file / Touch

and hold to rewind. oW |1 oo
Play in random order. — 1 L Selecta repeat mode.
Adjust the sound volume. —ea % s— Go to Now playing list.
Add to or delete from your
favourites.

.

Some file formats may not be supported, depending on the installed

E software.

Files that exceed the size limit may cause an error.

Music files may be protected by international copyright owners or
copyright laws. You may have to obtain legal permission before copying
a music file. To download or copy a music file, first check the copyright
law for the relevant country.

.

This model supports Hi-Fi audio playback. Hi-Fi audio files display the
Hi-Fi icon.

If you set the flashlight, flashlight blinks to fit the music being played.
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ThinQ

You can easily connect the product with loTl appliances to monitor and
conveniently use the appliances.

On the home screen, tap Essentials > ThinQ.

E + Washing machine, dryer, styler; dishwasher, oven, and robot cleaner can
only be registered when the product is in the standby mode.

« Look for the ThinQ mark on the product to see if it can be connected to
ThinQ app.
» Tap = to check various function of the ThinQ app.

Audio Recorder

You can record and save your voice or others' voices from important
events. Recorded voice files can be played back or shared.

1 On the home screen, tap Essentials > Audio Recorder.

2 Tap@.
« To pause recording, tap @.

3 Tap @ to end the recording.
+ The file is saved automatically and the recorded files screen appears.

4 Tap @ to play the recorded voice.

- Tap =0 to view the recorded files. You can play a recorded voice file from
the list
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Game Launcher

You can set whether to use the game launcher where you can view the
list of games installed on the product and select game settings such as
muting media volume, limiting alerts, etc.

7 On the home screen, tap Game Launcher.

2 Select the desired option.

Smart Doctor

You can use Smart Doctor to diagnose the device's condition and optimise
it

On the home screen, tap Management > Smart Doctor.

LG Mobile Switch

Easily transfer data from a used device to a new device via LG Mobile
Switch.

7 On the home screen, tap Management > LG Mobile Switch.
You can also tap Settings > System > Backup > LG Mobile Switch.
« If the app is not installed on the product, download and install the
LG Mobile Switch app from the Google Play Store.

7 Follow the on-screen instructions to select a desired method for
transfer.

E « Data in a Google Account will not be backed up. VWhen you synchronise
your Google Account, Google apps, Google contacts, Google Calendar,
Google memo app data and apps downloaded from the Play Store are
stored on the Drive app automatically.

« Fully charge the battery before transferring data to avoid unintentional
powering off during the process.
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App trash

You can see the list of apps deleted on the home screen. The app that was
deleted within the last 24 hours can be recovered.

On the home screen, tap Management > App trash.
For more details, refer to App trash.

RemoteCall Service

Your device can be remotely diagnosed for resolving issues. First, make a
phone call to an LG Customer Service Centre as follows:

+ To use this function, first you must agree to usage of the function.

« If you use mobile data, you may be charged for data usage depending
on your pricing plan.

7 On the home screen, tap Services > RemoteCall Service.
7 Connect a call to an LG Customer Service Centre.

3 After the call connects, follow the service associate’s instructions to
enter a six-digit access number.

« Your device is remotely connected and the remote support service
starts.

Cell Broadcast

You can view real-time text broadcasts on emergency situations, such as
typhoons, floods and earthquakes.

On the home screen, tap Services > Cell Broadcast.
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Google apps

You can use Google apps by setting a Google Account. The Google
Account registration window appears automatically when you use a
Google app for the first time. If you do not have a Google Account, create
one from your device. For details on how to use an app, see the Help in
the app.

E + Some apps may not work depending on the area or service provider.

Calendar

The Calendar app allows you to track your schedule of events (that you
created), organised by Day, 3-day, Week or Month.

Chrome
A fast, simple, and secure web browser, built for the modern web.

Docs

Docs is a collaborative, word-processing tool that powers productivity. Use
Docs to create, edit and work together in real-time.

Drive

Drive is a file storage and sharing app that makes it easy to find, share and
collaborate on work projects from anywhere, instantly.

Gmail

Gmail is an easy to use mail app that keeps your messages safe, makes
your inbox smarter; and helps you stay organised.

Google

The Google app keeps you in the know about the things you care about.
Find quick answers, explore your interests, and get a feed of stories and
updates on topics that matter to you.
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Maps

Going somewhere? Go with Maps, the app you can rely on for real-time
GPS navigation, traffic, transit, and details about millions of places, such as
reviews and popular times.

Photos

Home for all your photos and videos, automatically organised so you can
share and save what matters.

Play Movies & TV

Use your Google Account to rent or purchase movies. Purchase content
and play it anywhere.

YT Music

A new music streaming service from YouTube.

Sheets

Sheets is a collaborative spreadsheet processing tool that powers
productivity. Use Sheets to import, organise and analyse information
together in real-time.

Slides

Google Slides is a collaborative presentation creation tool that powers
productivity. Use Slides to organise information, present results, and make
decisions together in real-time.

YouTube

Watch your favourite channels, listen to music you love, and upload videos
to share with people around the world.
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Assistant
Your device has the Google Assistant built-in. Find answers and get things

done while on-the-go. To get started, just tap the Google Assistant key
on the side of the phone or touch and hold the home button of the phone.
E + The Google Assistant is not available in certain languages and countries.

Files

You can view and manage files saved on your device.
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Settings

You can customise the device settings in accordance with your
preferences.

On the home screen, tap Settings.

E « If you enter a keyword on the search window at the top of the screen,
you can conveniently run the items that need to be set.

Network & internet
Dual SIM card

You can configure Dual SIM settings.
T On the settings screen, tap Network & internet > Dual SIM Card.
2 Customise the following functions:

+ SIM card 1:Change the name and icon of the SIM card 1.

+ SIM card 2: Change the name and icon of the SIM card 2.

+ SIM card colour theme: Change the colour themes for the SIM
cards.

- Cost save mode: Activate or deactivate the cost save mode. In the

cost save mode, if you make a call to a contact to which a specific

SIM'is assigned, this SIM is used for the call even if the other SIM is

active, for example, it is using mobile data.

- Mobile data: Select a SIM card you want to use for mobile data
service. You can also turn off this function.

- Data roaming: Select this option to enable the device to use mobile

data when you are roaming outside your home network area.

- Mobile data during calls: Access mobile data using the nondefault

data SIM card temporarily during an HD voice call with the same
card.
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Wi-Fi

You can connect to nearby devices over a Wi-Fi network.

Connecting to a Wi-Fi network
1 On the settings screen, tap Network & internet > Wi-Fi.
2 Tap to activate it
- Available Wi-Fi networks appear automatically.
3 Select a network.
+ You may need to enter the network’s Wi-Fi password.

+ The device skips this process for previously accessed Wi-Fi
networks. If you do not want to automatically connect to a certain
Wi-Fi network, tap the network and then tap Forget.

Wi-Fi network settings
On the settings screen, tap Network & internet > Wi-Fi.

- Switch to mobile data:If the mobile data connection function is
activated but the device cannot connect to the Internet via Wi-Fi
connection, the device automatically connects to the Internet via the
mobile data connection.

I_;'] « This feature depends on the service provider.

« + :Customise Wi-Fi network settings.

Wi-Fi Direct
You can connect your device to other devices that support \Wi-Fi Direct to

share data directly with them. You do not need an access point. You can
connect with more than two devices by using \Wi-Fi Direct.

1 On the settings screen, tap Network & internet > Wi-Fi> : >
Advanced Wi-Fi > Wi-Fi Direct.

+ Nearby devices that support Wi-Fi Direct automatically appear.
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2 Select a device.
- Connection occurs when the device accepts the connection request.

E + The battery may drain faster when using \Wi-Fi Direct.

Mobile data

You can turn mobile data on and off. You can also manage mobile data
usage.

Turning on mobile data
71 Onthe settings screen, tap Network & internet > Mobile data.
2 Tap to activate it.

Customising mobile data settings
7 Onthe settings screen, tap Network & internet > Mobile data.
2 Customise the following settings:

+ Mobile data: Set to use data connections on mobile networks.

- Limit mobile data usage: Set a limit for mobile data usage to block
mobile data if the limit is reached.

« ¢ :Customise mobile data settings.

- Data usage volume is measured based on the product, and the
volume calculated by your mobile provider may be different.
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Call

You can customise call settings, such as voice call and international call
options.

+ Some features may not be supported depending on the area or service
provider.

7 Onthe settings screen, tap Network & internet > Call.

2 Customise the settings.

Tethering
USB tethering

You can connect the device to another device via USB and share mobile
data.

7 Connect your device and other devices via USB cable.

2 On the settings screen, tap Network & internet > Tethering > USB
tethering and then tap () ) to activate it.

E « This option uses mobile data and may incur data usage fees, depending
on your pricing plan. Consult with your service provider for more
information.

+ When connecting to a computer, download the USB driver from
wwwilg.com and install it on the computer:
+ You cannot send or receive files between your device and a computer

while USB tethering is turned on. Turn off USB tethering to send or
receive files.

Operating systems that support tethering are Window XP or higher, or
Linux.

Settings 101



Wi-Fi hotspot
You can set the device as a wireless router so that other devices can
connect to the Internet by using your device's mobile data.

1 On the settings screen, tap Network & internet > Tethering > Wi-Fi
hotspot and then tap to activate it.

7 Tap Set up Wi-Fi hotspot, and enter the Wi-Fi name (SSID) and
password.

3 Turn on Wi-Fi on the other device, and select the name of the device
network on the Wi-Fi list.

4 Enter the network password.

+ This option uses mobile data and may incur data usage fees, depending
on your pricing plan. Consult with your service provider for more
information.

« More information is available at this web site:
http7/www.android.com/tether#wifi

Wi-Fi hotspot turn off timer

When the Wi-Fi hotspot has not been used for a specific period of time,
it is automatically disconnected. You can set the time for automatic
disconnection.

Bluetooth tethering

A Bluetooth-connected device can connect to the Internet by using your
device’s mobile data.

1 On the settings screen, tap Network & internet > Tethering >
Bluetooth tethering and then tap to activate it.

2 Turn on Bluetooth on both devices and pair them.
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5 - This option uses mobile data and may incur data usage fees, depending
on your pricing plan. Consult with your service provider for more
information.

+ More information is available at this web site:
http//www.android.com/tether#Bluetooth_tethering

Help
You can view help on using tethering and hotspots.
On the settings screen, tap Network & internet > Tethering > Help.

Airplane mode

You can turn off the call and mobile data functions. When this mode is
on, functions that do not involve data, such as games and music playback,
remain available.

71 Onthe settings screen, tap Network & internet > Airplane mode.
2 Tap () toactivate it.

Mobile networks
You can customise the mobile networks settings.
7 Onthe settings screen, tap Network & internet > Mobile networks.
2 Customise the following settings:
+ Network mode: Select a network type.

+ Access Point Names: View or change the access point for using
mobile data services. To change the access point, select a choice
from the access point list.

+ Network operators: Search for network operators and connect
automatically to a network.
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VPN

You can connect to a safe virtual network, such as an intranet. You can
also manage connected virtual private networks.

Adding VPN
1 On the settings screen, tap Network & internet > VPN.
2 Tap+

5 - This feature is available only when the screen lock is activated. If the
screen lock is deactivated, a notification screen appears. Tap Change
from the notification screen to activate the screen lock. See Setting a
screen lock for details.

3 Enter VPN details and tap Save.

Configuring VPN settings
71 Tapa VPN from the VPN list.

2 Enter the VPN user account details and tap Connect.

- To save the account details, select the Save account information
checkbox.

Private DNIS

You can configure the Private DNS (Domain Name System) options.
71 On the settings screen, tap Network & internet > Private DNS.
2 Select the desired option and tap Save.
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Connected devices

Bluetooth

You can connect your device to nearby devices that support Bluetooth to
exchange data with them. Connect your device to a Bluetooth headset
and a keyboard. This makes it easier to control the device.

Pairing with another device

71 On the settings screen, tap Connected devices > Bluetooth.

2 Tap to activate it.
+ Available devices appear automatically.
+ To refresh the device list, tap (.

5 + Only devices set as visible are displayed on the list.

3 Select a device from the list.

4 Follow the on-screen instructions to perform authentication.

E « This step is skipped for previously accessed devices.

Sending data via Bluetooth

1 Select afile.
- You can send multimedia files or contacts.

2 Tap << > Bluetooth.

3 Select a target device for the file.
« The file is sent as soon as the target device accepts it.

E + File sharing processes may differ, depending on the file.
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NFC

You can use the device as a transportation card or credit card. You can also
share data with the other device.

71 On the settings screen, tap Connected devices > NFC.
2 Tap () toactivate it.

« Touch your device with other device that supports NFC to allow
sharing data.

E + NFC antenna may be located differently depending on the device type.
See Parts overview for details about the NFC antenna area.

Sharing panel

You can share contents from Gallery, Music and File Manager with nearby
devices. Also you can share the content with specific people in apps that
work with Google Direct Share.

1 On the settings screen, tap Connected devices > Sharing panel
2 Tap @  to deactivate each option.

+ Nearby devices: You can display the nearby devices to which you
can share contents on the Gallery, Music, and File Manager apps.

- Direct share: From an app which supports Google Direct Share, you
can display an icon which allows you to share contents to specific
people.

File sharing

You can send and receive files between your device and other LG devices
or tablets.

T On the settings screen, tap Connected devices > File sharing.

2 Customise the following settings:
+ K52:Change the device name.
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- Save to: Set the destination folder to save files sent from other
devices in.

File sharing: Permit receipt of files sent from other devices.

- SmartShare Beam: Share files with other devices via SmartShare
Beam.

+ Help: You can view help on sharing files.

Printing

You can connect your device to a Bluetooth printer and print photos or
documents saved on the device.

On the settings screen, tap Connected devices > Printing.

- Tap Default Print Service to search for printers you can connect to. Or;
tap ¢ > Add printer to manually add a printer.

+ Tap (+) Add service to download the printer app you want.

E + This is available only when the mobile network or the Bluetooth
function is turned on.

- To down the printer app in (+) Add service, first log on to your Google
account.

Sound

You can customise sound, vibrate and notification settings.
On the settings screen, tap Sound and customise the following settings:

- Sound profile: Change the sound mode to Sound, Vibrate only, or
Silent.

+ Volume: Adjust the sound volume for various items.
+ Ringtone: Select a ringtone for incoming calls. Add or delete ringtones.

- Notification sound: Select a notification ringtone. Set music saved on
the device as a notification ringtone.
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- Ring with vibration: Set the device to vibrate and play a ringtone
simultaneously.

- Ringtone ID: Create a ringtone for an incoming call from a particular
contact.

- Flash alert for incoming call: Set the flash to blink according to LG
ringtone.

- Do not disturb: Set the time, range and app type to receive
notification messages. Receive notification messages only on particular
days of the week.

- Sound quality and effects: Use the function to set the sound quality
and effects while playing a song or video.

- Volume: Adjust the sound volume for various items.

- Normalize volume: Use the function to normalise the volumes of
different sound sources.

- Equalizer: Use the function to adjust the equaliser settings.

- LG 3D Sound Engine: Use the function to play music or video in
three-dimensional, immersive and vivid sound when earphones,
speaker or other external audio devices are connected. See LG 3D
Sound Engine for detalls.

- Vibration type: You can select the type of vibration when receiving
calls.

- Dialing keypad sound: Select the keypad sound effect.
+ Touch sound: Select a sound effect for tapping an item.

- Screen lock sound: Select a sound effect when the screen is locked or
unlocked.
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Notifications

You can check a list of installed apps, and configure the settings for
notifications.

1 On the settings screen, tap Notifications.

2 Customise the settings as desired.

Display
You can customise detailed settings for each screen type.

On the settings screen, tap Display and customise the following settings:

- Home screen: Customise settings for the Home screen. See Home
screen settings for details.

Navigation bar: Set the style of the navigation bar with Gestures or
Buttons only. you can also change the button combination when you
set Buttons only as a style of the navigation bar. For details, see Using
Navigation bar.

Status bar: Set the colour of the status bar on the top of the screen,
or set the natification icon display and battery percentage display.

Comfort view: Set the device to reduce amount of blue light on screen
to reduce eye strain.

Night mode: You can apply a dimmed screen theme to avoid glare on
the screen at night time.

Font: Change the font size, bold text or type.

Accent colour: Change the point colour for settings, menus,
notification windows, etc.

Display size: Set the items on the screen to a size easy for you to see.
Some items may change position.

Full screen apps: Adjust the screen size of apps.

Brightness: Use the slide bar to change the device’s screen brightness.
To automatically adjust screen brightness according to ambient light
intensity, tap the Auto switch.
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- Auto: Set the device so that the screen brightness is automatically
adjusted in accordance with the ambient light intensity.

- Screen timeout: Automatically turn off the screen when the device is
left idle for a specified period of time.

- Auto-rotate screen: Automatically rotate the screen according to the
device's orientation.

- Screen saver: Display a screen saver when the device is connected to
the holder or charger: Select a screen saver type to display.

- One-handed screen: Make the screen size smaller to conveniently use
the device with one hand. Drag the Home touch button at the bottom
of the screen to the left or right.

Wallpaper & theme

You can select wallpaper, screen theme, icon style or AOD (Always-on
Display) for your device.

7 Onthe settings screen, tap Wallpaper & theme.

7 Tap Wallpaper or Theme to customise the settings.

Lock screen & security
You can customise lock screen and security settings.
1 On the settings screen, tap Lock screen & security.
2 Customise the settings.
- Google Play Protect: Scan your device daily for potentially harmful
apps.

- Find My Device: Remotely track the device location. You can also
protect your data securely if you lost your device.

- Security update: Check for software update and configure
automatic installation settings.
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- Select screen lock: Select the desired screen lock method. See
Setting a screen lock for details.

- Customize Lock screen: Change the information displayed on the
locked screen.

Secure lock settings: Change the secure lock settings.

- Fingerprints: Use your fingerprint to unlock the screen or content.
See Fingerprint recognition overview for details.

Content lock: Allow you to set a lock type (password or pattern)
for your Gallery files.

Encryption & credentials: Configure the settings for SD card
encryption and credentials.

Encrypt SD card: Encrypt the memory card to prevent use on
another device. See Memory card encryption for detalls.

- Credential protection: View the type of the storage where the
security certificate will be saved.

Trusted credentials: View your system's root CA certificates and
user-installed CA certificates.

User credentials: View and change secure certificate information
stored on your device.

- Install from storage: Install a secure certificate from a storage.

Clear credentials: Delete user-installed secure certificates and
related credentials.

Phone administrators: Allow privileges to restrict the control or
use of the device to particular apps.

Trust agents: View and use trust agents installed on the device.

Screen pin: Fix the app screen so that only the currently active app
can be used.

Usage access: VView details on usage of apps on the device.
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Privacy
You can find and adjust all your privacy settings.
7 On the settings screen, tap Privacy.

2 Customise the settings.
- Permission manager: Allows you to check and change the
permissions granted to the apps.

+ Lock screen: Allows you to set notifications to show on the lock
screen.

- Make passwords visible: Enable this option to briefly show each
character of the password as you type it so you can see what you've
entered.

+ Auto-fill service from Google: Enable this option to enter your
information saved in your account such as password, address,
or credit card number with a single tap. You can also disable this
option, use the Google Autocomplete feature, or add a new service
account.

- Google location history: Allows you to enable or disable Location
History. When enabled, Google periodically stores and uses your
phone's most recent location data in connection with your Google
Account.

From the Location History screen, tap & to view and/or manage
your location data.

+ Activity controls: Select activities and information which you want
Google to save.

+ Ads:Allows you to check the advertising ID and set the personalised
ads.

- Usage and diagnostics: Enable this option to help improve the
Android experience by automatically sending diagnostic, device, and
app usage data to Google.
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Location

You can check how your location information is shared and configure the
permission to access your location information.

On the settings screen, tap Location and set the desired function.

Extensions

Smart Doctor

You can use Smart Doctor to diagnose the device's condition and optimise
it

On the settings screen, tap Extensions > Smart Doctor.

Gaming

You can configure settings for game tools, graphics and battery saving
feature.

71 On the settings screen, tap Extensions > Gaming.
2 Customise the following settings:
- Game Launcher:Tap () ) to use the game launcher.

-+ Game tools: You can run the function while playing games by
touching the game tools icon among the home touch buttons.

- Game graphics: Adjust the game graphics.
E + \When you change the resolutions on some games, the screen display
feature may not work properly.

« This function may not be available in certain game apps.

- Break time: Reduce the screen brightness and performance
whenever you leave the game running for more than 5 minutes.
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Dual App

You can install duplicate messenger apps on the product and use two

accounts at the same time.

7 On the settings screen, tap Extensions > Dual App.

7 After reading the disclaimer, tap Confirm.

3 Inthe list of available apps, tap Install to install a copy of a desired app
and follow the on-screen instructions.

+ On the screen, the list of available dual apps is shown. During
installation, app icons are generated on the home screen.

Shortcuts
You can use buttons such as the Lock/Power, Volume, and Google
Assistant to run certain apps or functions right away.
1 On the settings screen, tap Extensions > Shortcuts.
2 Customise the following settings.
- Open Camera: Press Power key twice to open Camera.

- Open Screen-off memo: Press Volume Up key twice to open
Screen-off memo when the screen is locked or off.

+ Open Camera: Press Volume Down key twice to open Camera
when the screen is locked or off.

- Open Google Assistant: Press the Google Assistant key on the
side of the phone.

- Talk to Google Assistant: Press and hold the Google Assistant key
to quickly talk to your Assistant.

E + Google Assistant does not support certain languages.
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KnockON

Double-tap the screen to turn the screen on or off.
See KnockON for details.

Apps

You can check a list of installed apps, and configure the settings for
notifications, app permissions, and more.

7 On the settings screen, tap Apps.

2 Customise the settings.

Battery

You can view the current battery information or turn on power-saving
mode.

71 On the settings screen, tap Battery.

2 Customise the following settings:
- Battery usage: View the battery usage details.

- Adaptive battery: Allow you to save the battery by stopping apps
running in the background.

- Background restrictions: Enable this option to restrict background
apps to save the battery while using the device. Restricted apps
for power saving may not work properly or may not send you
notifications.

- Battery saver: Reduce battery consumption by cutting down some
device settings, such as the display brightness, speed and vibration
intensity.

- Power saving exclusions: Select apps to use without any
functional limitation while in power saving or battery optimisation
mode.
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Storage

You can view and manage internal storage on the device or storage space
of the memory card.

1 On the settings screen, tap Storage.

2 Customise the following settings:

- Internal storage: View the total storage space and free space in the
devices internal storage. View a list of apps in use and the storage
capacity for each app.

+ SD card: View the total storage space and free space in the
memory card. This option appears only when a memory card is
inserted. To unmount the memory card, tap

Accounts
You can add users to share your device and register a cloud account.
1 On the settings screen, tap Accounts.

2 Customise the settings.

Digital Wellbeing & parental
controls

You can view the product use time and set the timer for each app.

Also, you can manage the mobile phone use time by using the Sleep
Preparation Mode and Focus Mode.

Select Digital Wellbeing & parental controls on the settings screen and
set the desired function.
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Google

You can use Google settings to manage your Google apps and account
settings.

On the settings screen, tap Google.

System

Update centre

You can check and install the latest version of the app or software
provided by LG.

1 On the settings screen, tap System > Update Centre.

2 Customise the following settings:

+ App Updates: Check if an app update is available. If available, you
can install the update.

- Software Update: Check if a software update is available. If
available, you can install the update.

Language & keyboard

You can customise language and keyboard settings for your device.
1 On the settings screen, tap System > Language & keyboard.

2 Customise the following settings:
- Language: Select a language to apply for the device.

- Manage keyboards: You can change the product’s basic keyboard
setting, set the use environments for LG Keyboard or other installed
keyboards, and set the speech recognition function for Google Voice
input. Also, you can set whether to display the keyboard button in
the touch button area on the home screen so that you can quickly
switch to another keyboard.
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- Physical keyboard: Select to use the physical keyboard, or check
keyboard shortcut keys.

- Spell checker: Allows you to set various options for the Google
Spell Checker.

- Autofill service: Enable this option to enter your information saved
in your account such as password, address, or credit card number
with a single tap. You can also disable this option, use Google
Autocomplete, or add a new service account.

- Text-to-speech output: Configure the settings for text-to-speech
output.

« Pointer speed: Adjust the pointer speed of a mouse or trackpad.

- Reverse mouse buttons: Reverse the right mouse button to
perform primary direct-manipulation actions.

Date & time

You can customise date and time settings for your device.
1 On the settings screen, tap System > Date & time.

2 Customise the settings.

Memory

You can view the average amount of memory usage over a certain period
of time and the memory occupied by an app.

71 Onthe settings screen, tap System > Memory.

7 Tap w to set a time slot to retrieve data.
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Backup

You can back up data saved on your device to another device or account.
7 On the settings screen, tap System > Backup.

2 Customise the following settings:
+ LG Mobile Switch: Allow you to transfer data from an old LG device
to your new LG device. See LG Mobile Switch for detalls.

- Backup & restore: Back up your device data or restore data to your
device from a backup.

A + Resetting your device may delete backup files saved in storage. Make
sure to copy and store the important backup files to your PC.

+ Google backup: Change Google drive backup settings. You can
also check the backup account currently used, or add a new backup
account.

Restart & reset
You can reset the device including network and app settings.
71 Onthe settings screen, tap System > Restart & reset.

2 Customise the following settings:

- Auto-restart: Automatically restart and optimise the phone at a
set time. Tap () to activate this feature. The device automatically
restarts at a set time and optimise itself. Select a date and time for
restart.
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E + You can set the device to restart itself once a week. The device
automatically restarts in an hour from the preset time.

+ Once the device restarts, notifications and badges are erased. Save
important data before the preset time.

« The Auto-restart feature is not activated in the following situations:
When the screen is turned on, when the device is in use, when the
battery levelis 30% or less, or when the USIM card is locked.

- Depending on the telecommunication provider, the auto-restart
function may or may not be available.

+ Network settings reset: Reset Wi-Fi, Bluetooth and other network
settings.

Reset app preferences: Reset the settings for an app. The data
saved in the app will not be deleted.

- Factory data reset: Reset all settings for the device and delete
data.

E « Restarting and resetting your device deletes all data on it. Enter your
device name, Google Account and other initial information again.

« After data initialization, the data cannot be restored.

About phone

You can view information about your device, such as the name, status,
software details and legal information.

On the settings screen, tap System > About phone and view information.

Regulatory & safety
You can view regulatory marks and related information on your device.
On the settings screen, tap System > Regulatory & safety.
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Accessibility
You can manage accessibility plug-ins installed on your device.
T On the settings screen, tap Accessibility.

2 Customise the following settings:

- Vision > TalkBack: Set the device to notify screen status or actions
via voice.

- Vision > Voice notifications: Set the device to read the caller
information via voice.

« Vision > Font: Change the font size, bold text or type.

- Vision > Display size: Set the items on the screen to a size easy for
you to see. Some items may change position.

- Vision > Touch zoom: Zoom in or out by tapping the screen three
times.

- Vision > Window zoom: Zoom in or out within a window and invert
the colour.

- Vision > Large mouse pointer: Magnify the mouse pointer.

- Vision > High contrast screen: Turn the background colour into
black for a high contrast screen.

- Vision > Screen colour inversion:Increase the display colour
contrast for people with low vision.

- Vision > Screen colour adjustment: Adjust the display colour.
- Vision > Monochrome: Switch the screen to grayscale mode.

+ Vision > End call with the Power key: End a call by pressing the
Power/Lock key.

- Hearing > Caption preferences: Turn on the subtitle service when
playing videos for the hearing impaired.

- Hearing > Flash alerts: Set the device to notify you with a blinking
light for incoming calls, messages and alarms.
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+ Hearing > Mute all sounds: Mute all sounds and lower volume on
the receiver.

- Hearing > Audio channel: Select the audio type.

- Hearing > Sound balance: Adjust the audio output balance. Use the
slide bar to change the balance.

- Motor & cognition > Touch assistant: Turn on the touch board to
make buttons and gestures easier to use.

- Motor & cognition > Touch input: Enter text by touching and
holding the screen or modify it by simply touching the screen.

- Motor & cognition > Physical keyboard: Customise the keyboard
settings.

+ Motor & cognition > Auto mouse click: Automatically click the
mouse pointer in case of no movement.

+ Motor & cognition > Touch and hold for calls: Answer or decline
calls by touching and holding the call button instead of dragging it.

+ Motor & cognition > Screen timeout: Turn off the screen
automatically when the device is left idle for a specified period of
time.

+ Motor & cognition > Touch control areas: Limit the touch area
so that only a particular portion of the screen can be controlled by
touch input.

- Accessibility features shortcut: Quickly access a frequently
used function by pressing the Power key and the Volume Up key
simultaneously.

- Auto-rotate screen: Automatically change the screen orientation
according to the physical position of the device.

- Select to Speak: Allow you to tap items to hear spoken feedback.

+ Switch Access: Create key combinations to control your device.
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LG Language Settings

Select a language to use on your device.
+ On the home screen, tap Settings > System > Language & keyboard
> Language > Add language, and select a language.

- Touch and hold = and drag it to the top of the language list to set it
as a default language.

LG Bridge

LG Bridge overview
You can back up contacts, photos and more to the computer or update
the device software.

E + See LG Bridge help for detalils.
+ The supported features may vary depending on the device.

+ LG USB driver is a necessary program to connect your LG smartphone
with the computer and is installed when you install LG Bridge.

LG Bridge functions
- Back up data from the device to a computer or restore data from a
computer to the device via USB cable connection.

- Update the device software from a computer via USB cable connection.
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Installing LG Bridge on a computer
1 Go to wwwilg.com from your computer.
2 Select your region.
3 Click Support > Software & Firmware.
4 Enter the name of your device.
OR
Select by the Product Category.
5 Go to PC Sync > LG Bridge to download the setup file.

+ Go to Details to view the minimum requirements for installing
LG Bridge.

Phone software update

LG Mobile phone software update from the

Internet

For more information about using this function, please visit
http//wwwi.lg.com/common/index,sp, select your country and language.
This feature allows you to conveniently update the firmware on your
phone to a newer version from the Internet without needing to visit a
service centre. This feature will only be available if and when LG makes a
newer firmware version available for your device.

Because the mobile phone firmware update requires the user's full
attention for the duration of the update process, please make sure

you check all instructions and notes that appear at each step before
proceeding. Please note that removing the USB cable during the upgrade
may seriously damage your mobile phone.

+ LG reserves the right to make firmware updates available only for

selected models at its own discretion and does not guarantee the
availability of the newer version of the firmware for all handset models.
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LG Mobile Phone software update via Over-
the-Air (OTA)

This feature allows you to conveniently update your phone's software to
a newer version via OTA, without connecting a USB cable. This feature will

only be available if and when LG makes a newer firmware version available
for your device.

To perform the phone software update,

Settings > System > Update centre > Software Update > Check now
for update.

E « Your personal data from internal phone storage—including information
about your Google Account and any other accounts, your system/
application data and settings, any downloaded applications and your
DRM licence—might be lost in the process of updating your phone's
software. Therefore, LG recommends that you backup your personal
data before updating your phone’s software. LG does not take
responsibility for any loss of personal data.

« This feature depends on the area or service provider.
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Anti-Theft Guide

Set up your device to prevent other people from using it if it's been reset

to factory settings without your permission. For example, if your device is

lost, stolen, or wiped, only someone with your Google Account or screen

lock information can use the device.

All you need to make sure your device is protected is:

- Set a screen lock: If your device is lost or stolen but you have a screen

lock set, the device can't be erased using the Settings menu unless
your screen is unlocked.

+ Add your Google Account on your device: If your device is wiped but
you have your Google Account on it, the device can't finish the setup
process until your Google Account information is entered again.

After your device is protected, you'll need to either unlock your screen or
enter your Google Account password if you need to do a factory reset.
This ensures that you or someone you trust is doing the reset.

E « Do not forget your Google Account and password you had added to
your device prior to performing a factory reset. If you can't provide the
account information during the setup process, you won't be able to use
the device at all after performing the factory reset.
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Open Source Software Notice
Information

To obtain the source code under GPL, LGPL, MPL, and other open
source licenses, that is contained in this product, please visit
http://opensource.lge.com.

In addition to the source code, all referred license terms, warranty
disclaimers and copyright notices are available for download.

LG Electronics will also provide open source code to you on CD-ROM
for a charge covering the cost of performing such distribution (such
as the cost of media, shipping, and handling) upon email request to
opensource(@lge.com.

This offer is valid for a period of three years after our last shipment of this
product. This offer is valid to anyone in receipt of this information.

Regulatory information
(Regulation ID number, E-labeling, etc.)

For regulatory details, go to Settings > System > Regulatory & safety.
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Trademarks

+ Copyright ©2020 LG Electronics Inc. All rights reserved. LG and the
LG logo are registered trademarks of LG Group and its related entities.

+ Google, Google Maps, Gmail, YouTube, Google Duo, Google Play,
Android, Chrome, Google Photos, Google Play Protect, Google Calendar,
Google Docs, Google Drive, Google Sheets and other related marks and
logos are trademarks of Google LLC.

- Bluetooth®is a registered trademark of Bluetooth SIG, Inc. worldwide.

- Wi-Fi® and the Wi-Filogo are registered trademarks of the Wi-Fi
Alliance.

+ All other trademarks and copyrights are the property of their
respective owners.

HE HEVCAdvance™

‘E Covered by Patents at patentlisthevcadvance.com

Appendix 129



Laser safety statement

Caution!

This product employs a Laser system. To ensure proper use of this
product, please read this owner's manual carefully and retain for future
reference. Should the unit require maintenance, contact an authorised
service centre.

Use of controls, adjustments, or the performance of procedures other
than those specified herein may result in hazardous radiation exposure.
To prevent direct exposure to laser beam, do not try to open the enclosure
or make direct contact with the laser.

CLASS 1 LASER PRODUCT
KLASSE 1 LASER PRODUKT
LUOKAN 1 LASER LAITE

KLASS 1 LASER APPARAT
CLASSE 1 PRODUIT LASER

DECLARATION OF CONFORMITY

Hereby, LG Electronics declares that this LM-K520EMW product is in
compliance with the essential requirements and other relevant provisions
of Directive 2014/53/EU.

A copy of the Declaration of Conformity can be found at
http//wwwi.lg.com/global/declaration
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Contact office for compliance of

this product

LG Electronics European Shared Service Center BV.

Krijgsman 1, 1186 DM Amstelveen, The Netherlands

Wi-Fi (WLAN)

The use of the 5150 - 5350 MHz band is restricted to indoor use only.
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More information

Tempered glass parts

Tempered glass parts of this device are not permanent and they may wear
out over time.

- If you drop your device on a hard surface or subject it to severe impact,
the tempered glass may be damaged.

If this happens, stop using your device immediately and contact an LG
Customer Service Centre.

- You can purchase protective cases to protect your device from damage
on the market.

Note that these protective cases are not covered under the warranty
service provided by LG Electronics and safety is not guaranteed.

Aspect ratio
This device uses 20.5:9 aspect ratio.
+ Some downloaded apps may not support 20.5:9 aspect ratio.

In this case, select the most optimal screen ratio for the app or consult
the app provider for more information.
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Guide to data transfers

- For the data that can be exchange between LG devices or between the

LG device and a third party device, see the following table.

Third party
LG device Android iOS device
Type Item details - device —
LG device - LG device
LG device

Contacts, messages,

dial logs, calendar, voice @) O O
Personal | recordings
data Memos X O

Alarms X X
Media Photos, videos, songs,
data documents o o O

Home screen settings

(folders and widgets) % X X
Screen
settings Lock screen settings

(screen lock settings @) X X

excluded)

Downloaded apps O O
Apps Personal data of the o X B

downloaded app

Public certificate @) @) X
Others | Settings (Wi-Fi, Bluetooth,

Calls, sound & notification, @) X X

accessibility, battery)

E + Some data may not be transmitted depending on the software version,
app version, operating system, manufacturer or service provider's policy.
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Supported Frequency Bands Transmitter Output power

GSM 900 33.7dBm
GSM 1800 30.7dBm
WCDMA B1 25.0dBm
WCDMA B8 25.5dBm
LTEB1 24.7 dBm
LTEB3 247 dBm
LTEB7 24.7 dBm
LTE B8 252 dBm
LTE B20 252dBm
LTEB28 252 dBm
LTEB38 24.7 dBm
BT 9.5dBm
WLAN 2.4GHz 18.5dBm
WLAN 5GHz 15.0 dBm
NFC -13 dBuA/m

Travel Adapter Information can be found at
http//wwwi.lg.com/global/support/cedoc/cedoc
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Disposal of your old appliance

1. This crossed-out wheeled bin symbol indicates that waste electrical
and electronic products (WEEE) should be disposed of separately
from the municipal waste stream.

N 2 Old electrical products can contain hazardous substances so correct
disposal of your old appliance will help prevent potential negative
consequences for the environment and human health. Your old
appliance may contain reusable parts that could be used to repair
other products, and other valuable materials that can be recycled to
conserve limited resources.

3. You can take your appliance either to the shop where you purchased
the product, or contact your local government waste office for
details of your nearest authorised WEEE collection point. For
the most up to date information for your country please see
wwwi.lg.com/global/recycling

Disposal of waste batteries/accumulators

1. This symbol may be combined with chemical symbols for mercury
(Hg), cadmium (Cd) or lead (Pb) if the battery contains more than
0.0005% of mercury, 0.002% of cadmium or 0.004% of lead.

2. All batteries/accumulators should be disposed separately from the

municipal waste stream via designated collection facilities appointed
by the government or the local authorities.

3. The correct disposal of your old batteries/accumulators will help
to prevent potential negative consequences for the environment,
animal and human health.

4. For more detailed information about disposal of your old batteries/
accumulators, please contact your city office, waste disposal service
or the shop where you purchased the product.
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FAQ

This chapter lists some problems you might encounter when using your
device. Some problems require you to call your service provider, but most
are easy to fix yourself.

SIM card error
Make sure the SIM card is correctly inserted.

No network connection or dropped network
Signal is weak. Move to a window or an open area.
You are outside the carrier network area. Move and check the network.

Calls are not available

New network not authorised.

Make sure you have not set call barring for the incoming number:
Make sure you have not set call barring for the number you are dialling.

Device cannot be turned on
When the battery is completely discharged, your device will not turn on.
Fully charge the battery before turning on the device.

Charging error

Make sure device is charging at a normal temperature.
Check the charger and its connection to the device.

Use only in-box accessories which are authorised by LG.

The battery depletes faster than when first purchased

When you expose the device or the battery to very cold or hot
temperatures, the battery life may be reduced.

Battery consumption will increase when you use certain features or apps,
such as GPS, games or the Internet.

The battery is consumable and the battery life will get shorter over time.
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Error messages appear when launching the camera
Charge the battery.

Free some memory by transferring files to a computer or deleting files
from your device.

Restart the device.

If you are still having trouble with the camera app after trying these tips,
contact a LG Electronics Service Centre.

The photo quality is poor
The quality of your photos may vary, depending on the surroundings and
the photography techniques you use.

If you take photos and videos, standard angle quality is better than wide-
angle.

If you take photos in dark areas, at night or indoors, image noise may
occur or images may be out of focus.

If you have any problems, reset the options.

The touch screen responds slowly or incorrectly

If you attach a screen protector or optional accessories to the touch
screen, the touch screen may not function properly.

If you are wearing gloves, if your hands are not clean while touching the
touch screen or if you tap the screen with sharp objects or your fingertips,
the touch screen may malfunction.

The touch screen may malfunction in humid conditions or when exposed
to water.

Restart your device to clear any temporary software bugs.

If the touch screen is scratched or damaged, visit a LG Electronics Service
Centre.
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Hangs or freezes

Restart the device

- If your device freezes or hangs, you may need to close apps or turn the
device off and then on again.

Perform a boot-up

- Asoft reset may be used to reset the device if the screen freezes, or
the buttons, touch screen or device are no longer responding.

- To perform a soft reset of your device, simply press and hold the
Volume Down and Power keys until the device restarts.

Reset the device
- If the methods above do not solve your problem, perform a factory
datareset.

- On the settings screen, tap System > Restart & reset > Factory data
reset.

- This method resets all settings for the device and deletes data.
Before performing the factory data reset, remember to make back-
up copies of all important data stored in the device.

- If you registered a Google Account to the device, you must sign in to
the same Google Account after resetting the device.

Bluetooth device is not located
Make sure the Bluetooth wireless feature is activated on your device.

Make sure the Bluetooth wireless feature is activated on the device you
wish to connect to.

Make sure your device and the other Bluetooth device are within the
maximum Bluetooth range (10 m).

If the tips above do not solve your problem, contact a LG Electronics
Service Centre.
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A connection is not established when you connect the
device to a computer
Make sure the USB cable you are using is compatible with your device.

Make sure you have the proper driver installed and updated on your
computer.

Downloaded application causes a lot of errors
Application has problems.
Remove and reinstall the application.
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